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POUR COMMENCER

APPRENDRE À UTILISER MUSESCORE
Visites guidées
Partition Getting Started
Tutoriels vidéo
Autres tutoriels
Vidéos (traduction française disponible)

OBTENIR DE L'AIDE
Manuel
Aide contextuelle
Forums
How To's
Poser une question
Rapport de bug

INSTALLATION
Installation
Préférences initiales

INSTALLER SUR WINDOWS
Installation

Lancement de MuseScore
Utilisateurs expérimentés : installation silencieuse ou sans assistance

Désinstallation
Dépannage
Liens externes

INSTALLER SUR MACOS
Installation
Désinstallation
Installer avec Apple Remote Desktop

INSTALLER SUR LINUX
AppImage

Etape 1 - Télécharger
Etape 2 - Donner l’autorisation de s'exécuter en tant que programme
Etape 3 - Exécutez le !
Installer l'AppImage (optionel)
Utilisation des options de ligne de commande

Paquetages de distribution
Fedora

Liens externes

INSTALLER SUR CHROMEBOOK
Installation
Liens externes

LANGUE, TRADUCTIONS, ET EXTENSIONS
Changer la langue de l'interface
Gestionnaire de ressources

Installer / désinstaller une extension
Mettre à jour les traductions

Voir aussi
Liens externes

RECHERCHER LES MISES À JOUR
Vérification automatique des mises à jour
Rechercher les mises à jour
Voir aussi

BASES

CRÉER UNE NOUVELLE PARTITION
Centre de démarrage
Créer une nouvelle partition

Entrer les informations de la partition
Choisir un modèle de partition
Choisir les instruments et parties vocales

Ajouter des instruments
Ajouter une portée ou une portée liée
Changer l'ordre des instruments (portées)
Supprimer un instrument

Choisir l'armure et le tempo
Choisir l'indication de mesure, l'anacrouse et le nombre de mesures

Modifier une partition existante
Ajouter / supprimer / éditer des mesures
Ajouter / éditer du texte
Changer l'organisation des instruments
Cacher une portée
Ajuster la mise en page et la mise en forme
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Modèles de partition
Dossier système des modèles
Dossier des modèles de l'utilisateur

Voir aussi
Liens externes

SAISIE DES NOTES
Saisie des notes, notions de base

1ère étape. Sélectionnez un point de départ
2ème étape. Entrez en mode de saisie des notes
3ème étape. Sélectionnez une durée
4ème étape. Saisie des notes ou des silences

Sélectionnez la durée des notes et silences
Périphériques d'entrée

Clavier d’ordinateur
Saisie des notes et des silences
Déplacer la hauteur des notes vers le haut ou le bas
Ajouter des altérations
Accords
Insérer des notes
Supprimer des notes
Raccourcis clavier

Saisie à la souris
Saisie avec un clavier MIDI
Saisie avec le clavier de piano virtuel

Modes de saisie de notes
Coloriation des notes en dehors de la tessiture d’un instrument
Petites notes
Modification de notes ou de silences déjà saisies

Modifier la durée
Modifier la hauteur
Modification sur les voix
Transformer un silence en note et vice-versa

Propriétés des notes
Voir aussi
Liens externes

ESPACES DE TRAVAIL
Pour changer d'espace de travail
Ancrer/détacher
Créer un espace de travail personnalisé
Éditer un espace de travail
Voir aussi

MODE ÉDITION
Entrer/sortir du mode Édition
Texte
Lignes
Notes

Décaler des notes
Ajuster la longueur de hampe d'une note

Raccourcis clavier
voir aussi

PALETTES
Afficher ou masquer la palette
Ouvrir/fermer la palette

Mode palette unique

Appliquer des symboles à partir d'une palette
Personnalisez la liste des palettes

Changer l'ordre des noms de palette dans la liste
Créer une nouvelle palette
Cacher une palette de la liste
Afficher une palette masquée dans la liste
Supprimer une palette

Personnaliser les palettes
Ajouter un élément de partition existant à une palette
Ajouter un symbole à une palette à partir de la palette principale
Modifier l'ordre des symboles dans une palette
Modifier la position et la taille d'un symbole dans une cellule de palette
Supprimer un symbole d'une palette

Menu de la palette
Comportement du texte et des lignes appliqués
Voir également

INSPECTEUR
Afficher l'inspecteur
Ce que fait l'Inspecteur
les boutons "Réinitialiser au style par défaut" et "Définir comme style"
Les catégories dans l'inspecteur

Élément
Groupe d'éléments
Segment
Accord
Note
Sélection
Ligature
Clef
Articulation
Diagrammes d'accord
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Ligne
Détails de la ligne de texte

Boîtes de dialogue des propriétés
Voir aussi

OPÉRATIONS SUR LES MESURES
Sélection

Une mesure uniquement
Suite de mesures

Insertion
Insérer une mesure vide
Insérer plusieurs mesures

Ajout
Ajouter une mesure à la fin d'une partition
Ajouter plusieurs mesures à la fin d'une partition

Supprimer
Supprimer une simple mesure
Supprimer une suite de mesures
Supprimer les mesures de fin vides

Supprimer le contenu de la mesure
Propriétés

Portées
Durée de la mesure
Autres

Mesures non comptées
Diviser les pauses multimesures
Mode de numérotation de la mesure
Étirement de la mesure
Ajouter au numéro de mesure
Nombre de lecture

Numérotation
Scinder et joindre

Joindre les mesures
Scinder une mesure

Liens externes

VOIX
Comment les voix sont affichées
Quand utiliser des voix ?
Comment saisir des notes dans différentes voix
Suppression et masquage des silences

Restauration des silences supprimés

Échanger des Voix
Déplacer les notes vers une autre voix (sans échange)
Naviguer entre les voix
Voir également
Liens externes

ANNULER ET RÉTABLIR

COPIER / COLLER
Résumé des commandes
Notes

Copier ou Couper
Coller
Échanger avec le presse-papier
Copier seulement la hauteur d'une note

Autres éléments
Copier ou Couper
Coller

Répétition rapide
Duplication
Collage demi durée / double durée (version 3.1 et au dessus)
Filtre de sélection
Voir aussi
Liens externes

MODES D'AFFICHAGE ET NAVIGATION
Menu Affichage

Afficher les Barres Latérales / Panneaux
Zoom avant/arrière
Barres d'outils

Afficher / masquer les barres d'outils
Personnaliser la zone de la barre d'outils

Espaces de travail
Afficher la Barre d'état
Visualiser deux partitions
Options de visibilité
Marquer les mesures irrégulières
Plein écran

Affichage par page/continu
Affichage par page
Affichage continu
Affichage Une seule page

Panneaux latéraux
Navigation

Commandes
Navigateur
Timeline
Rechercher / Aller à

Voir aussi
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MODES DE SÉLECTION
Sélectionner un seul objet

Sélectionner une seule note
Sélectionner un accord
Sélectionner une mesure unique

Sélectionner une plage continue d'objets
1. Sélection avec Maj
2. Sélection Maj + Clic

Sélection d'une suite de mesures
3. Faire glisser la sélection
4. Tout Sélectionner
5. Sélectionner une section

Sélectionner une liste d'objets
Sélectionner tous les éléments similaires
Quelles sont les sélections utiles pour
Voir aussi

TONALITÉ RÉELLE
Voir aussi
Liens externes

OUVRIR / ENREGISTRER / EXPORTER / IMPRIMER
Ouvrir
Enregistrer
Exporter
Imprimer
Voir aussi

PARTAGER LES PARTITIONS EN LIGNE
Créer un compte
Partager une partition directement depuis MuseScore
Téléverser (upload) une partition sur MuseScore.com
Éditer une partition sur MuseScore.com

Passer à la méthode directe de mise à jour d'une partition en ligne

Liens externes

NOTATION

ARMURES
Ajouter une Armure

Ajout d'une nouvelle armure à toutes les portées
Ajout d'une nouvelle armure à une seule portée

Changement d'armure
Changement d'armure pour toutes les portées
Changement d'armure pour une seule portée

Supprimer une armure
Bécarres lors des changement d'armure
Changement d'armure lors silences multimesures
Rappel des armures
Armures personnalisées

BARRES DE MESURE
Changer le type de barre de mesure
Insérer une barre de mesure
Personnaliser des barres de mesure
Connecter des barres de mesure
Voir aussi

CLEFS
Ajouter une clef

Ajout d'une clé en début de mesure
Ajout d'une clé à l'intérieur d'une mesure

Clefs de rappel
Supprimer une clef
Masquer les clefs

Afficher les clefs uniquement sur la première mesure de la partition (pour toutes les portées)
Afficher la clef uniquement dans la première mesure d'une porté particulière
Masquer toutes les clefs d'un système particulier

ALTÉRATIONS
Ajouter une altération
Changer l'enharmonie
Recalculer les altérations
Voir aussi
Liens externes

INDICATIONS DE MESURE
Ajouter ou changer une indication de mesure
Supprimer une indication de mesure
Créer une nouvelle indication de mesure
Propriétés de l'indication de mesure

Modifier les ligatures par défaut
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Indication de mesure asymétrique
Indication de mesure propre à une seule portée

Ajuster la taille de l'indication de mesure
Anacrouses et cadences
Changement d'indication de mesure et pauses multi-mesures
Voir également
Liens externes

ARPÈGES ET GLISSANDOS
Arpèges
Glissandos et slides

Ajustement des points de départ et d'arrivée
Personnalisation des glissandos

Articulations pour instruments à vent
Slide in/out
Liens externes

ARTICULATIONS ET ORNEMENTS
Articulations
Ornements
Ajouter une articulation ou un ornement

Ajouter un ornement supplémentaire
Ajouter un point d'orgue à une barre de mesure
Raccourcis claviers

Ajuster la position d'un symbole
Propriétés des articulations, des ornements et des bends
Exécution des ornements et des articulations lorsque MuseScore joue la partition.
Voir aussi
Liens externes

BENDS
Ajouter un Bend
Éditer un Bend

Propriétés des textes et des lignes
Forme et largeur des Bends
Modifier l'affichage graphique

Ajuster la hauteur
Ajuster la position
Bends Personnalisés
Liens externes

LIGATURES
Symboles de ligature
Modifier une ligature
Ajuster l'inclinaison et la hauteur des ligatures

Rendre une ligature horizontale

Ajuster les Deccelerando ou Accelerando rythmiques
Nouvelle disposition locale
Changer la position de la ligature
Réinitialiser les propriétés d'une ligature
Voir aussi
Liens externes (en anglais)

CROCHETS
Ajout
Suppression
Changement
Édition
Style

FIORITURES
Interprétation des fioritures par MuseScore
Création des fioritures

Ajouter une fioriture
Ajouter une accord comme fioriture

Modifier la hauteur
Modifier la durée
Adjustment manuel

Position horizontale
Ajustements complémentaires

Liens externes

RESPIRATIONS ET PAUSES
Ajouter un symbole
Ajuster la durée de la pause

CRESCENDO / DECRESCENDO
Ajouter un Crescendo / Decrescendo
Modifier la hauteur et la longueur
Lignes texte de Crescendo/Decrescendo
Copier les Crescendos/Decrescendos
Modifier les propriétés d'un crescendo/decrescendo
Lecture des Crescendos/Decrescendos
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LIGNES
Appliquer des lignes à une partition

Pour appliquer une ligne entre deux notes
Pour appliquer une ligne sur un ensemble de notes
Pour appliquer une ligne depuis une note jusqu'à fin de la mesure
Pour appliquer une ligne sur un ensemble de mesures

Propriétés des lignes agissant sur la lecture sonore de la partition
Ajuster la position verticale d'une ligne
Modification de la longueur d'une ligne

En utilisant des raccourcis claviers
En faisant glisser la ligne (à partir de la version de MuseScore 3.5)
Ajustement fin

Lignes avec Texte
Lignes personnalisées
Copier une ligne
Lignes de fioritures "longues"
Liens externes

LIGNES D'OCTAVE
Ajouter une ligne d'octave
Modifier la position verticale
Modifier la longueur
Lignes personnalisées
Liens externes

PAUSES
Pauses

Créer une ou plusieurs pauses
Créer une pause dans une voix particulière

Silences multimesures
Afficher les pauses multimesures
Saut de pause multimesure

LIAISONS DE PHRASÉ
Ajouter une liaison de phrasé dans le mode "Ajout de notes"
Ajouter une liaison de phrasé dans le mode "Normal"

Première méthode
Deuxième méthode

Adjuster la liaison de phrasé
Pour ajuster la position d'une liaison de phrasé :
Pour modifier tous les paramètres d'une liaison de phrasé (longueur, position, sens de courbure, ...) :

Liaisons de phrasé étendues
Liaison de phrasé pointillées
Voir aussi

LIAISONS DE PROLONGATION
Ajouter des liaisons à partir de notes seules
Ajouter des liaisons aux accords
Ajouter des notes liées à un accord déjà lié
Ajouter des liaisons aux notes à l’unisson
Inverser une liaison
Voir aussi
Liens externes

TRÉMOLO
Ajouter un Trémolo

Trémolo sur une note ou un accord
Trémolo sur deux notes ou deux accords

Liens externes

ALTERNATIVES DE REPRISE
Ajouter une alternative de reprise
Modifier le nombre de mesures d'une alternative de reprise
Propriétés des alternatives de reprise
Jouer les alternatives de reprise

Nombre de lectures d'une mesure

Liens externes

DIVISIONS IRRÉGULIÈRES
Créer une division irrégulière

Création d'un Triolet en mode normal
Création d'un Triolet en mode Saisie de Notes
Créer d'autres divisions irrégulières
Divisions irrégulières personnalisées
Exemple de triolets

Supprimer une division irrégulière
Modifier l'affichage des divisions irrégulières

En utilisant l'inspecteur
En utilisant la boîte de dialogue Style des divisions irrégulière

Liens externes

RÉPÉTITIONS ET SAUTS
Répétitions simple
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Alternatives de reprise 1ère et 2ème fois
Lecture sonore

Jouer ou pas les reprises
Ajuster la lecture sonner des reprises

Symboles de reprise et textes
Sauts
Repères
Exemples de saut
Voir aussi
Liens externes

TRANSPOSITION
Transposition manuelle
Transposition automatique

Transposition chromatique
Par tonalité
Par Intervalle

Transposition diatonique
Options

Instruments transpositeurs
Tonalité réelle
Changer la transposition de la portée

Liens externes

NOTATION POUR PERCUSSION
Types de portées pour percussion
Méthodes de saisie des notes

Clavier MIDI
Clavier du piano virtuel
Clavier de l'ordinateur
Souris

Palette de saisie de batterie
Éditer le set de batterie
Sticking (doigté de batterie)
Ajouter un roulement de tambour
Liens externes

TABLATURE
Créer une nouvelle portée tablature

Avec l'Assistant Créer une Nouvelle Partition
Avec le dialogue instruments
En changeant le type de portée

Édition des cordes
Changement d'accord
Ajouter une corde
Supprimer une corde
Marquer une corde comme "Ouverte"
Changer le nombre de frettes d'instrument

Changer l'apparence d'une tablature
Depuis Propriétés de la portée/partie...
Depuis le dialogue Instruments

Combiner les portées standard et tablature
Créer un système [portée+TAB] avec l'Assistant "Créer une nouvelle partition"
Créer une paire [portée+TAB] dans une partition existante
Modifier une paire [portée+TAB] dans une portée existante

Saisir les notes dans la tablature
À l'aide d'un clavier d'ordinateur
Tablature ancienne
À l'aide de la souris d'ordinateur
Sélection de la durée des notes

Édition des repères de frettes
Changement de numéro de frettes
Changer le numéro de la corde
Notes en croix

Raccourcis clavier
Mode de saisie des notes
Mode normal

Liens externes

SON ET LECTURE SONORE

CHANGEMENT D'INSTRUMENT AU COURS D'UNE PORTÉE
Effet du changement d'instrument
Ajouter un changement d'instrument
Voir aussi
Liens externes

MÉLANGEUR
Ouvrir le Mélangeur
zone des Pistes
Le Gain Master (Volume Général)
Zone des pistes

Flèche d'affichage des pistes{#channel-display-arrow}
Mute (Couper le son) and Solo
Pan (Panoramique)
Volume
Nom de la piste

Zone de détail
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Nom
Couleur de Piste
Canal
Set de batterie
Son
Volume
Pan
Port et Canal
Reverb / Chorus
Couper le son de la Voix
Bouton pour masquer la Zone de Détail

Son
Changement de son au milieu d'une portée (pizz., sordino, etc.)
Voir aussi
Liens externes

ÉDITEUR PIANO ROLL
Ouvrir l'éditeur Piano Roll
Présentation
Navigation
Sélection des Notes
Édition des notes
Barre d'outil

Première ligne
Deuxième ligne

Clavier
Personnalisation

LECTURE : SYMBOLES D'ACCORDS / NUMÉROS NASHVILLE
Activer / Désactiver la lecture des accords

Pour toutes les partitions (à partir de la version 3.5.1)
Pour la partition courante

À partir de la version 3.5.1
À partir de la version 3.5

Changer le son des symboles d'accords
Modifier le volume des accords / Rendre la piste silencieuse (Mute)
Activer / Désactiver la lecture des symboles d'accord durant l'édition
Interprétation et harmonisation des symboles d'accord

MODES DE LECTURE
Barre d'outil du mode lecture
Commandes de lecture

Démarrer/Arrêter la lecture
Pendant la lecture
Boucle de lecture

Fenêtre de lecture

SOUNDFONTS ET FICHIERS SFZ
SoundFonts

Installation d’une SoundFont
Désinstallation

SFZ
Installation d’une SFZ
Désinstallation

Synthétiseur
Listes de SoundFonts téléchargeable

SoundFonts GM
SoundFonts pour orchestre
SoundFonts pour piano

SF2 Pianos
SFZ Pianos

Décompression des SoundFonts téléchargées

Dépannage
Voir aussi
Liens externes

SWING
Appliquer le swing à une section de partition

Triolet dans une marque de tempo

Revenir au rythme linéaire
Appliquer le swing à toute la partition
Liens externes

SYNTHÉTISEUR
Généralités
Enregistrer / charger les paramètres du synthétiseur
Fluid

Charger une SoundFont
Pour réorganiser les SoundFonts
Pour retirer une SoundFont

Zerberus
Volume
Effets

Réverbération Zita 1
Compresseur SC4

Réglage du diapason
Nuances (version 3.1 et ultérieures)
Voir aussi
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160

TEMPO
Ajouter une Indication de Tempo
Modifier le tempo
Modifier le texte du tempo
Passer outre les indications de tempo
Lecture Ritardando et Accelerando
Points d'orgue
Voir aussi

NUANCES
Ajouter des nuances
Ajuster les propriétés

Éditer la vélocité d'une nuance
Pour ajuster l'étendue des nuances
Déplacer une nuance (au dessus ou en dessous de la portée)

Personnaliser les nuances
Nuance pour une seule note (SND)
Liens externes

LECTURE AVEC CAPODASTRE
Ajouter un capodastre sur une seule portée
Ajouter un capodastre une portée et une tablature liées entre elles
Ajouter un capodastre à une portée et une tablature non liées entre elles
Annuler le capodastre

TEXTE

BASES SUR LES TEXTES
Ajout de texte
Formatage du texte
Ajuster la position des objets de texte
Ancres de texte

ÉDITION DES TEXTES
Entrer/sortir du mode d'édition de texte

Raccourcis clavier

Symboles et caractères spéciaux
Raccourcis pour les caractères spéciaux

Voir aussi

STYLES DE TEXTE ET PROPRIÉTÉS
Styles de texte
Objets texte
Enregistrer et charger des styles de texte
Voir aussi

TEXTES DE PORTÉE ET DE SYSTÈME
Texte de Portée

Propriétés des Textes de Portée

Texte de Système
Propriétés des Textes de Système

Voir aussi
Liens externes

SYMBOLES D'ACCORDS
Saisie d'un symbole d'accord

Commandes au clavier
Syntaxe des symboles d'accord
Édition d'un symbole d'accord

Transposition des symboles d'accord
Symboles d'accord en mode texte
Style de symboles d'accord

Apparence
Noms des notes (Spelling)

Majuscules Automatiques
Position
Position du capodastre

Système de numéro Nashville (NNS)
Analyse avec des chiffres romains (RNA)

Saisie RNA
Exemples de RNA

Lecture (à partir de la version 3.5)
Liens Externes

DOIGTÉ
Ajouter un doigté à une seule note
Ajouter un doigté à plusieurs notes
Mode de saisie à doigté facile (version 3.1 et supérieure) {#facilité de doigté}
Ajuster la position du doigté

Doigté unique
Doigtés multiples

Editer le texte du doigté
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163

163
163
163
163
163
163

164
164
164
164
164

164

164
164
165
165
165
167
167
167
167
168
168
168
168
168
168
168
169
169
169
169
169
170
170
170
170
170
170
170
170
171
171
171
171
171
171
171
172
172
172

172
172
173
173
173

173
173
173
173
174
174

174
174
174

175
176
176

PAROLES
Entrer une ligne de paroles

Première ligne
Lignes suivantes
Caractères spéciaux {#caractères spéciaux}
Numéros de versets {#Numéro-de-versets}
Mélisme {#mélisme}
Elision (liaison lyrique) / Synalèphe

Editer les paroles
Ajuster les propriétés des paroles
Ajuster la position des lignes de paroles individuelles
Copier les paroles dans le presse-papiers
Coller les paroles du presse-papiers
Voir aussi{#see-also}
Liens externes

REPÈRES
Ajoutez un repère de répétition

Placement manuel
Placement automatique

Ajouter une marque de répétition alphanumérique
Ajouter une marque de répétition de mesure

Répétition automatique des marques de répétition
Style de texte
Rechercher une marque de répétition
Voir aussi
Liens externes

MISE EN FORME

MISE EN PAGE ET MISE EN FORME
Mise en page
Menu "Style..."

Partition
Page
Tailles
En-tête, Pied de Page
Numéros de mesure
Système
Clefs de tablature
Altérations/Armures
Mesure
Barres de mesure
Notes
Ligatures
Divisions irrégulières
Arpèges
Liaisons de phrasé, liaisons de prolongation
Crescendo/Decrescendos
Alternatives de reprise
Octave
Pédale
Trille
Vibrato
Bend
Ligne de texte
Ligne de texte de système
Articulations, Ornements
Points d'orgue
Texte de portée
Tempo
Paroles
Nuances
Repères de répétition
Basses chiffrées
Symboles d'accord
Diagrammes d'accord de guitare
Styles de Texte
Boutons OK / Annuler

Paramètres de la page...
Ajouter / Supprimer des sauts de système
Étirement

Étirement / Rétrécir
Réinitialiser l'étirement des mesures

Réinitialiser les personnalisations de style de texte
Réinitialiser les ligatures
Réinitialiser les formes et les positions
Charger un style / Enregistrer le style
Voir aussi
Liens externes (en anglais)

MESURE
Introduction
Options

PARAMÈTRES DES PAGES
Taille de la page
Marges des pages paires/impaires
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176
176
177
177

177
177
177
177
177

178
178
178
178

178
179
179
179

179

179
179
179
179
180

180
180
180
180
180
181
181

181
181
181

181
181
181

182
182
182
182

182
182
182
182
182
183

183
183
183
184
184

184
184

184

184
184
185
185
185
186
186
187
187

187
187
187
188
188
188
189

189
189

189
190
190
190
190

Échelle
Unité {#unité}
Numéro de la première page
Appliquer à l'ensemble des parties

SAUTS ET ESPACEMENTS
Sauts

Ajouter un saut à une mesure
Utilisation d'un raccourci clavier
Utilisation des symboles de la palette

Ajouter un saut à un cadre
Supprimer les sauts
Déplacer un saut
Saut de section

Espacements
Ajouter un espacement
Ajuster un espacement
Supprimer un espacement

Voir aussi

CADRES
Cadre Horizontal

Insérer/Ajouter un cadre horizontal
Ajuster la largeur d'un cadre horizontal
Ajouter du texte ou une image à un cadre horizontal

Cadre Vertical
Insérer/Ajouter un cadre vertical
Ajuster la hauteur d'un cadre vertical
Modifier les propriétés d'un cadre vertical
Ajouter du texte ou des images à un cadre vertical
Insérer un cadre horizontal à l'intérieur d'un cadre vertical
Cadre "Titre"

Cadre Texte
Insérer/Ajouter un cadre Texte
Modifier les propriétés d'un cadre

Créer un cadre
Insertion d'un cadre dans une partition
Ajouter un cadre à une partition

Supprimer un cadre
Ajouter un saut
Voir aussi
Liens externes

IMAGES
Ajouter une image
Couper/Copier, Coller une image
Modifier une image
Voir aussi
Liens externes

CAPTURE D'IMAGE
Sauvegarder un instantané
Le Menu Capture d'image
Voir aussi
Liens externes

ALIGNEMENT DES ÉLÉMENTS
Aligner sur la grille

FONCTIONNALITÉS AVANCÉES

ACCESSIBILITÉ
Introduction
La configuration initiale
Se repérer dans l'interface de MuseScore
La fenêtre de partition
Lecture visuelle de la partition

Se déplacer en avant ou en arrière dans le temps
Se déplacer entre les notes à un moment donné
Filtrage de la lecture des partitions

Lecture audio de la partition
Création et édition de partitions

Créer une nouvelle partition
Saisie des Notes
Sélection
Palettes
Menus et raccourcis

Personnalisation
Liens externes

ALBUMS
Create album
Load album
Print album
Join scores
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190
190
191
191
191
191
192
192
193

193
193
194
195

195
195
195
196

196
196
197
197
197
197
197

198
198
199
199
199
200
200

200
201
201
202
202
203

204

204
204
204
205
205

205
205
205
205
205

205
205
206

206
206
207
207

207
207
208
208
208

208
208
208
208

208
209
209
209
209

209
209
209
209
210
210
210

Save album

BASSES CHIFFRÉES
Ajouter des indications de basses chiffrées
Format du texte

Chiffres
Altérations
Chiffres barrés et chiffres avec une croix
Parenthèses
Lignes de continuation
Durée

Modification de basses chiffrées existantes
Style
Syntaxe correcte
Résumé des touches

CHANGEMENT DE TYPE DE PORTÉE
Ajouter un changement de type de portée
Propriétés de changement de type de portée
Exemple

COMPARAISON DE PARTITIONS
Introduction
Sélectionner la partition {#score}.
Choisir la vue
Voir la comparaison
Quitter la comparaison
Exemple

DIAGRAMMES D'ACCORD
Aperçu des diagrammes d'accords
Aperçu de la palette d'accords standard de guitare
Aperçu de la création d'accords modifiés ou personnalisés
Création d'un diagramme d'accord

Symboles d'accords liés aux diagrammes d'accord
Utilisation des symboles d'accords avec les diagrammes d'accord

Ajuster les propriétés des éléments d'un diagramme d'accord (position, taille, couleur etc.)
Ajuster les propriétés de style d'un diagramme
Éditer un diagramme d'accord

Editer les propriétés d'un diagramme d'accord
Éditer les points de doigt (utilisation de base)
Édition de points multiples de doigt (utilisation avancée)

Liens externes

FRETBOARD DIAGRAMS (PRIOR TO VERSION 3.1)
Add a fretboard diagram
Edit a fretboard diagram
To adjust a diagram's element properties
To adjust a diagram's style properties

FICHIERS RÉCUPÉRÉS
Sauvegarde après récupération de session
Trouver des fichiers récupérés
Voir aussi
Liens externes

FONCTIONNALITÉS POUR MUSIQUE ANCIENNE
Unbarred (or unmetered) notation

Example

Mensurstrich
Ambitus
Mensural time signatures
See also

FORMATS DE FICHIER
MuseScore format natif

Format MuseScore (*.mscz)
Format MuseScore non compressé (*.mscx)
Fichier de sauvegarde MuseScore (.*.mscz,) ou (.*.mscx,)

Fichiers graphiques (exportation uniquement)
PDF (*.pdf)
PNG (*.png)
SVG (*.svg)

Fichiers audio (exportation uniquement)
WAV audio (*.wav)
MP3 (*.mp3)
FLAC audio (*.flac)
Ogg Vorbis (*.ogg)

Partage avec d'autres logiciels de musique
MusicXML (*.xml, *.musicxml)
MusicXML compressé (*.mxl)
MIDI (*.mid, *.midi, *.kar)
MuseData (*.md) (importation uniquement)
Capella (*.cap, *.capx) (importation uniquement)
Bagpipe Music Writer (*.bww) (import uniquement)

13



210
210
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212

212
212
212
212
212
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213
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214
214

215
217

217
218
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218
218
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219
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220

220
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222
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223
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223
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223
224
225
225
225

225

225
226
226
226
227
227
227
227

227
227
228
228

BB (*.mgu, *.sgu) (import uniquement)
Overture (*.ove) (import uniquement)
Guitar Pro (various-import uniquement)
Power Tab Editor (*.ptb) (importation uniquement)

Voir aussi
Liens externes

FORMES DE TÊTES DE NOTES
Liens externes

TÊTES DE NOTES
Groupes de tête de note
Changer de groupe de tête de note
Changer le type de tête de note
Têtes de notes partagées

Changer les têtes de note décalées en partagées
Exemples de partage de têtes de notes
Supprimer les numéros de frettes en double

Liens externes

IMPORTATION MIDI
Opérations disponibles

LAYER (EXPERIMENTAL)
See also

LIGATURES ENTRE DEUX PORTÉES
Voir aussi
Liens externes

MODES DE SAISIE DES NOTES
Une à une
Hauteur
Rythme
Temps réel (Automatique)
Temps réel (Manuel)

Raccourci Avance en temps réel

Insérer
Mode Normal
Voir aussi
Liens externes

OUTILS
Transposer...
Éclater
Rassembler

Pour Rassembler les notes d'une seule portée
Pour Rassembler les notes de plusieurs portées

Voix
Mesures
Supprimer un ensemble de mesures sélectionnées
Remplir avec des slashs
Activer/Désactiver la notation rythmique avec des slashs
Recalculer les altérations
Regrouper les Rythmes
Remettre les repères dans l'ordre
Linéariser les reprises (version 3.1 and above)
Copier les paroles dans le presse-papier
Capture d'image
Supprimer les mesures restantes
Voir aussi
Liens externes

PALETTE PRINCIPALE
Symboles

Trouver un symbole
Utiliser un symbole
Fusion de symboles

Voir également

PARTIES
Créer toutes les parties
Créer des parties spécifiques
Personnaliser les parties

Ajouter des instruments à une partie
Retirer des instruments d'une partie
Sélectionner les portées d'un instrument
Sélectionner des voix pour un instrument

Supprimer une partie
Exporter des parties
Enregistrer les parties
Imprimer une pièce
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228
228

228
228
229

229
229

229
229
229
229
230
230

230
230
231
231
231
231
231
231
231
231
232
232
232
232

232
232

232
232
233
234
235
235
235

236
236
236

236
237
237
237
237

237
238
238
238
238
238

238
239
239
239
239
239

239
240
241

241
241

241
241
242
242

243
244

244
244
245
246
246
246
247
247
247
248
249

249
249

249
249

PLACEMENT AUTOMATIQUE
Position par défaut

Modifier la Position par défaut d'un élément

Réglages manuels
Ajuster la position de l'élément
Positionner l'élément au-dessus / au-dessous de la portée

Désactiver le placement automatique
Position dans la pile (Z)

PLUGINS
Que sont les plugins ? Qu'est-ce que c'est ?
Installation

Windows
MacOS
Linux

Activer/désactiver les plugins
Créer/modifier/exécuter des plugins
Plugins installés par défaut

abc import
Notes → color-notes
createscore
helloQml
Notes → note-names
Panel
random
run
scorelist
ScoreView
walk

Voir aussi
Liens externes

PRÉFÉRENCES
Général
Fond
Saisie des notes

Saisie des notes
Jouer les notes pendant l'édition
Contrôle à distance MIDI

Partition
Fichiers par défaut
Affichage

E/ S
PortAudio (API / Périphérique)
MIDI Entrée/Sortie/Latence de la sortie
Serveur JACK Audio
Moteur Audio

Importer
Style utilisé pour l'import
Jeu de caractères utilisé pour l'import de fichiers binaires
MusicXML
MIDI
Lors de l'ouverture de partitions d'anciennes versions de MuseScore

Exporter
PNG
PDF
MIDI
Audio
MusicXML

Raccourcis
Mettre à jour

Vérification automatique des mises à jour

Avancé
Voir aussi

PROPRIÉTÉS DE LA PARTITION
Modifier les méta-tags
Métabalises préexistantes

Saisie des métadonnées de travail / mouvement / partie

En-tête/Pied de page
Voir aussi

PROPRIÉTÉS DES PORTÉES / PARTIES
Types de portée
Propriétés des Portées / Parties : commun à toutes les portées
Propriétés de la Portée / Partie : instruments à cordes pincées
Propriétés avancées de style

Modèle
Options pour les portées Standard et de Percussion
Options pour les portées Tablature
Options pour les portées 'Tablature' : Instruments à frettes
Options pour les portées 'Tablature' : Figures de rythme
Aperçu

Changer d'instrument
Liens externes

TIMELINE
Introduction
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250
251
251
251

251
251
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251

251
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251
251
252
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253
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253
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254

254

254
254
255
255
255
255
255

255
255
256
256
256
256
256

256
256
256
257
259
260
261
261
261
261
261

261
261
262
262
262
262
262

Présentation globale
Meta-étiquettes
Étiquettes des instruments
Méta-lignes
Grille principale
Méta-éléments

Actions de bases
Sélectionner une mesure
Sélectionner plusieurs mesures

Étendre la sélection
Sélectioner avec [Maj]
Sélectionner avec [Ctrl]

Effacer la sélection
Sélectionner des méta-valeurs

Naviguer dans la fenêtre
Navigation de base
Navigation [Maj]
Naviguer avec [alt]
Faire glisser le contenu de la fenêtre

Action sur les étiquettes
Réorganiser les méta-étiquettes
Masquer les méta-étiquettes
Masquer les portées

Zoomer
Menus Contextuels

Menus contextuels des méta-étiquettes
Menus contextuels des instruments

SUPPORT

AIDER À AMÉLIORER LES TRADUCTIONS
Traduction du logiciel
Traduction du site web et du manuel
Voir aussi

RESTAURER LES PARAMÈTRES PAR DÉFAUT
À partir de la barre de menus
À partir de la ligne de commande

Instructions pour Windows
Instructions pour MacOS
Instructions pour Linux

Voir aussi

COMMENT DEMANDER DE L'ASSISTANCE OU TRANSMETTRE UN RAPPORT DE BUG
Rapports de bugs
Demandes de nouvelles fonctionnalités
Problèmes de liaison croisée
Liens externes

ANNEXES

RACCOURCIS CLAVIER
Navigation
Saisie de notes

Durée
Voix
Hauteurs
Intervalles

Mise en page
Articulations
Saisie des Textes
Saisie des Paroles
Affichage
Divers
Voir aussi

OPTIONS DE LA LIGNE DE COMMANDE
NOM
SYNOPSIS
DESCRIPTION
Batch conversion job JSON format
ENVIRONMENT
FILES
EXAMPLES

Convert a score to PDF from the command line
Run a batch job converting multiple documents
MIDI import operations

DIAGNOSTIQUES
Voir aussi
STANDARDS
HISTORY
AUTEURS
CAVEATS
BUGS
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274
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275
275
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276
276
276
276
276
276
276
276
277
277
277
277
277
277
277

NOUVELLES FONCTIONNALITÉS DE MUSESCORE 3.6
Nouveaux paramètres de configuration et de mise en page des partitions

Mise en ordre automatique des instruments
Positionnement automatique des crochets et des accolades
Justification verticale des portées
Indentation du premier système

Appliquer les nouvelles fonctionnalités aux partitions existantes
Appliquer l’ordre automatique et de mise entre crochets des instruments
Appliquer la justification verticale des portées

Autres améliorations de la gravure dans la version 3.6
Espacement des ligatures
Longueur des lignes supplémentaires
Extrémités des hampes et positions des croches
Altérations entre parenthèses
Altérations dans la police Emmentaler

NOUVELLES FONCTIONNALITÉS DE MUSESCORE 3.X
Placement automatique

Position par défaut
Réglages manuels
Désactiver le placement automatique
Position dans la pile (Z)

Formatage du Texte
Styles de Texte
Propriétés du Texte
Formatage Personnalisé

Changement de type de portée
Temporary and Cutaway Staves
System Dividers
Staff Spacing
Don't Break
Parts from Voices
Explode and Implode
Insert mode
Split/Join Measures
Timeline
Score Comparison Tool
Mixer
Piano Roll Editor
Capo changes
Fretboard Diagrams
External links

LIMITATIONS CONNUES DE MUSESCORE 3.X
Indications de mesure locales
Rassembler les rythmes
Portée de tablature liée à la portée standard
Mélangeur
En-tête et Pied de page

MISE À NIVEAU DEPUIS MUSESCORE 1.X OU 2.X
Comment mettre à niveau MuseScore
Ouvrir des partitions 1.x ou 2.x dans MuseScore 3
Re-mise en page
Obtenir le son de MuseScore 1.x

INCOMPATIBILITÉS CONNUES
Incompatibilités matérielles
Incompatibilités logicielles

AVG Internet Security bloque MuseScore
Problème de police sur macOS
Problème de police sur Linux
Boîte de dialogue Enregistrer Sous vide sous Linux

GLOSSARY
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S

17



278
279
279
279

T
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V
External links
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Published on MuseScore (https://musescore.org)

Ce manuel est celui de MuseScore version 3.0 et supérieure, il est maintenu et traduit par la communauté MuseScore.
Si vous souhaitez contribuer à la traduction du manuel, du logiciel, ou du site, consultez la page Développement /
Traduction .
En cas de doute, consultez la version anglaise du manuel en ligne .
Ce manuel est également disponible en une seule page imprimable, y compris la table des matières

Si vous utilisez MuseScore 2, consultez le Manuel de MuseScore 2 .
Si vous utilisez MuseScore 1, consultez le Manuel de MuseScore 1 .

Pour commencer
Ce chapitre va vous aider à installer et lancer MuseScore pour la première fois. Et vous présentera les différentes
ressources d'aide et d'apprentissage.

Apprendre à utiliser MuseScore

MuseScore fournit quelques ressources d'apprentissage qui aideront le nouvel utilisateur à commencer.

Visites guidées

Au lancement de MuseScore pour la première fois, l'Assistant de démarrage apparaît et vous guide pour la configuration
de base de quelques fonctionnalités. L'une d'elle s'appelle Visites guidées, celles-ci vous feront découvrir le programme.

Pour activer les Visites guidées, Cliquez sur "Oui" dans l'Assistant de démarrage pour répondre à la question
"Souhaitez-vous voir ces Visites guidées ?"

Les Visites guidées seront lancées au démarrage du programme, elles vous présenteront les principales fonctionnalités
de l'interface utilisateur.

Pour terminer la visite : Cliquez sur le bouton Fermer button.
Pour ne plus voir la visite au démarrage de MuseScore : Décochez "Continuer d'afficher les visites guidées".
Pour réafficher les Visites guidées (au démarrage du programme) : Sélectionnez Aide→Visites guidées→Afficher les
visites guidées.
Pour revoir toutes les visites guidées (au redémarrage du programme) : Sélectionnez Aide→Visites
guidées→Réinitialiser les visites guidées.

Visites guidées disponibles :

Introduction à l'interface utilisateur.
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Saisie des notes et des silences.
Saisie des symboles à partir des palettes.
Se déplacer dans la partition avec la Timeline.
Se déplacer dans la partition avec les touches du clavier.
Saisie des pauses multimesure.
Placement automatique des symboles.
Modifier les propriétés avec l'inspecteur.
Sélection des éléments.
Ajouter et éditer des lignes dans la partition.

Partition Getting Started

La partition interactive Getting Started (en anglais) est une introduction aux bases de la création d'une partition. Au
premier lancement de MuseScore, elle sera affichée dans la fenêtre principale du Centre de démarrage : Cliquez dessus
pour l'ouvrir. Suivez les instructions en bleu, vous serez guidé à travers chaque étape de base de l'écriture d'une partition.

Note :
Si vous ne voyez pas la partition interactive Getting Started, vous pourrez la trouver dans le panneau de droite du Centre
de démarrage. Cliquez sur les flèches droite ou gauche jusqu'à ce qu'elle apparaisse.
La partition Getting Started est au format MuseScore 2.1 pour le moment, quelques erreurs de position des éléments
peuvent exister.

Tutoriels vidéo

MuseScore propose un ensemble complet de vidéos d'apprentissage, chacune traite d'un sujet spécifique. Vous pourrez y
accéder de différentes façons :

À partir de la page d’accueil de MuseScore.org : Support/Tutorials
Dans le Centre de démarrage : Naviguez jusqu'à la page Vidéos dans le bandeau de droite.
Utilisez la liste de liens de la section Vidéos (Ci-dessous).
Visionnez-les directement en cherchant "MuseScore in Minutes" sur You Tube

Autres tutoriels

Vous trouverez dans la section Tutoriels  de musescore.org, d'autres tutoriels sur des sujets plus spécifiques (par
exemple : MuseScore Drumline).

Vidéos (traduction française disponible)

Leçon 1- Configuration de la partition
Leçon 2 - Travailler avec MuseScore
Leçon 3 - Saisie de note
Leçon 4 - Saisie avec clavier MIDI
Leçon 5 - Astuces de saisie
Leçon 6 - Texte, Paroles, et Accords
Leçon 7 - Tablature et notation pour batterie
Leçon 8 - Répétitions et Fins, Partie 1
Leçon 9 - Répétitions et Fins, Partie 2
Leçon 10 - Articulations, Dynamiques et Texte
Leçon 11 - Mise en page et Parties

Obtenir de l'aide

Si vous rencontrez une difficulté durant l'utilisation de MuseScore, Vous avez plusieurs moyens d'obtenir de l'aide et du
support.

Manuel

Pour accéder au Manuel :

Depuis le site web de MuseScore  : Dans la barre de menu, sélectionnez Aide → Manuel
Depuis le programme MuseScore : Dans la barre de menu, sélectionnez Aide → Manuel en ligne

Vous pouvez parcourir le Manuel à l'aide des menus, ou effectuer une recherche .

Aide contextuelle

Si vous sélectionnez un élément de votre partition et que vous appuyez sur F1, une page web s'ouvre et affiche une liste
de liens associés à cet élément dans le Manuel .
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Forums

MuseScore propose un certain nombre de Forums  en ligne. Vous y trouverez des réponses à vos difficultés parmi les
messages existants. Une recherche générale  sur le site web renverra une liste de sujets les plus proches dans les
forums et dans le Manuel.

How To's

Certaines tâches nécessitent l'utilisation de plusieurs techniques différentes. Cela peut être difficile de trouver la réponse
dans le Manuel. Des solutions pour cela peuvent se trouver dans les How To's

Poser une question

Si vous ne trouvez pas de solution à votre problème, Vous pouvez poser une question dans le forum du Support .

Lorsque vous posez une question :

Essayez d'être le plus précis possible dans la description de ce que vous voulez faire. Décrivez chaque étape de ce
que vous avez tenté.
Joignez la partition qui montre le problème — utilisez l'option "Choisir un fichier" en bas de la page, juste au-dessus
des boutons Enregistrer et Aperçu

Rapport de bug

Si vous rencontrez un problème que vous pensez être un bug, la première étape est de poster un message dans le forum
du Support . Cela permettra aux autres utilisateurs de tester et de reproduire le bug, et de vous conseiller une méthode
de contournement, vous pourrez ainsi continuer à écrire votre partition. Vous trouverez plus de détails dans le chapitre
Rapports de bug et demandes de fonctionnalité.

Installation

MuseScore fonctionne sous différents systèmes d'exploitations, notamment Windows, macOS, et de nombreuses
distributions Linux  ainsi que plusieurs variantes BSD  ; et disponibles depuis la page Téléchargement .

Installation

Après avoir téléchargé le logiciel, suivez les instructions concernant votre système d'exploitation :

Installer sur Windows.
Installer sur macOS.
Installer sur Linux.
Installer sur Chromebook.

Préférences initiales

Au premier lancement de MuseScore, l'Assistant de démarrage s'affiche et vous demande de choisir les paramètres de
base du logiciel.
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Tout d'abord, depuis MuseScore 3.4, choisissez d'autoriser ou non MuseScore à collecter des données d'utilisation du
logiciel, cliquez sur Oui, envoyer des rapports anonymes , ou Ne pas envoyer pour continuer :

Cliquez sur Suivant pour continuer :
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L'assistant détecte la langue du système d'exploitation, vous pouvez garder ce réglage par défaut, ou le changer si vous
voulez utiliser MuseScore dans une autre langue. Cliquez sur Suivant pour continuer :

Suivi de la disposition du clavier, 6 claviers francophones sont disponibles : Français, Belge, Canadien, Suisse, Azerty,
Bépo. Choisissez dans la liste déroulante. Cliquez sur Suivant pour continuer :

La page suivante vous demande si vous voulez visualiser les Visites guidées. Si vous débutez avec MuseScore laisser la
case 'Oui' sélectionnée. Cliquez sur Suivant pour continuer :
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La configuration de base est terminée. Cliquez sur Terminer pour lancer MuseScore.

Installer sur Windows

Installation

Si vous êtes sous Windows 10, une version 32 bit de MuseScore est disponible dans le Windows Store.
Cliquez ici  pour ouvrir la page MuseScore du Store. Vous n'aurez qu'a cliquer sur Get the app > , MuseScore sera
téléchargé, installé, et mis à jour.

Sinon, vous trouverez le fichier d'installation Windows à la page Téléchargement  du site web de MuseScore. Cliquer
sur le lien pour lancer le téléchargement (choisissez la version qui correspond à votre système d'exploitation 64-bit ou 32-
bit). Votre navigateur vous demandera de confirmer que vous voulez télécharger le fichier. Cliquez sur Enregistrer.

À la fin du téléchargement, double cliquez sur le fichier pour lancer l'installation. Vous aurez certainement à répondre au
message de sécurité de Windows pour confirmer le lancement du logiciel. Click Executer pour continuer.
L'installation commence :

Si vous décidez de cliquer sur Cancel, l'écran suivant s'affiche :
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Si vous avez décidé de continuer l'installation, cliquez sur Next pour continuer, l'assistant d'installation affichera le contrat
de licence.

Lisez le contrat de licence, cohez la case "I accept the terms in the License Agreement", et cliquez sur Next pour
continuer.
L'écran suivant vous demande de choisir le dossier d'installation de MuseScore.
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Vous pouvez garder le dossier par défaut pour une première installation de MuseScore 3 ou une mise à jour, cependant
vous pouvez le modifier si vous souhaitez conserver la version précédente.
Notez que toutes les versions de MuseScore 3 partageront les mêmes dossiers de configurations et utilisateurs.
Notez aussi que MuseScore 1.x, 2.x, 3.x, cohabitent de façon indépendante sur le même PC, ils ne partagent aucuns
dossiers.
Cliquez sur Next pour continuer.

Cliquer sur Install pour continuer.

Quelques minutes sont nécessaires à l'installation des fichiers et des configurations.
L'écran suivant s'affiche pendant la progression :
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Et enfin l'installation est terminée :

Cliquez sur Finish pour quitter l'installateur. Le fichier d'installation que vous avez téléchargé peut être gardé ou supprimé.

Lancement de MuseScore

Pour lancer MuseScore depuis la barre des tâches, sélectionnez Démarrer→Tous les programmes→MuseScore 3→MuseScore 3.

Utilisateurs expérimentés : installation silencieuse ou sans assistance

Vous pouvez installer MuseScore en mode silencieux avec la commande suivante

msiexec /i MuseScore-X.Y.msi /qb-

Désinstallation

MuseScore peut être désinstallé à partir de la barre des tâches en sélectionnant Démarrer→Tous les programmes→MuseScore
3→Uninstall MuseScore ; ou à partir du Panneau de configuration.
Notez qu'aucun fichier de configuration, ni aucune partition ne sera supprimé.

Dépannage

L'installateur peut être bloqué par le système, si ce message apparaît "Ce fichier vient d'un autre ordinateur et doit être
bloqué pour proteger ce système", faites un clic droit sur le fichier téléchargé, sélectionnez Propriétés, cliquez sur
"Débloquer", puis "OK", vous pourrez relancer l'installation.
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Liens externes

How to install MuseScore on Windows without administrator rights
How to run MuseScore as Administrator on Windows
How to fix MuseScore installation error on Windows
MSI command-line options
Standard installer command-line options

Installer sur macOS

Installation

Vous trouverez le fichier DMG (Image disque) sur la page téléchargement  du site web de MuseScore. Cliquez sur le
lien pour commencer le téléchargement. À la fin du téléchargement, faites un double clic sur le fichier DMG pour monter
l'image disque.

Glissez / déposez l'icône de MuseScore sur l'icône du dossier Applications.

Si vous n'êtes pas identifié en tant qu'administrateur, macOS vous demandera un mot de passe :
Cliquez sur S'authentifier et saisissez votre mot de passe.

À la fin de la copie, éjectez l'image disque. Vous pouvez maintenant lancer MuseScore à partir du dossier Applications,
Spotlight, ou du Launchpad.

Note : Depuis macOS 10.15 "Catalina", il faut autoriser MuseScore à avoir accès a certaines parties du système de
fichiers. La première fois que vous l'utiliserez sous Catalina, le système vous demandera si vous voulez autoriser
MuseScore : répondez par "oui", si vous avez sauté cette étape par accident, vous pourrez autoriser MuseScore dans,
System Preferences > Security and Privacy > Privacy > Files and Folders. Logguer vous avec votre compte d'admin,
naviguez jusqu'a MuseScore, ajoutez le à la liste des applications, et sélectionnez les dossiers "Documents" et
"Downloads".

Désinstallation

Effacez simplement MuseScore du dossier Applications.

Installer avec Apple Remote Desktop
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MuseScore peut être déployé sur d'autres Mac en utilisant la fonction "Copie" de l'ARD. MuseScore est une application
autonome, vous n'aurez qu'à la copier dans le dossier '/Application' des machines cible. Vous pouvez aussi installer
plusieurs versions de MuseScore, à condition qu'elles ne portent pas le même nom.

Installer sur Linux

Depuis MuseScore 2.0.3, vous pouvez, pour la première fois, obtenir une copie pour Linux directement depuis la page de
téléchargement , tout comme les utilisateurs de Windows et Mac. Cela est possible grâce au format de paquetage
AppImage, qui fonctionne sur pratiquement toutes les distributions Linux. Si vous le préférez, il y a toujours la possibilité
de l’obtenir de manière traditionnelle via le gestionnaire de paquets de votre gestionnaire de paquets de distribution (mais
vous devrez peut-être attendre qu’il soit empaqueté). Bien sûr, vous pouvez toujours compiler depuis la source .

AppImage

Le format AppImage  est une nouvelle manière d'empaqueter les applications Linux. AppImages sont portables - ils
n'ont pas besoins d'être installé - et ils fonctionnent sur presque toutes les distributions de Linux. Dependencies are
included in the one AppImage file.

Etape 1 - Télécharger

Avant de télécharger un AppImage, vous devez connaitre l'architecture de votre processeur. Ces commandes pour le
terminal l’indiqueront :

    arch

ou

    uname -m

Vous obtiendrez quelque chose comme "i686", "x86_64" ou "armv7":

i686 (ou similaire) - processeur 32-bit Intel/AMD (trouvable sur les anciennes machines).
x86_64 (ou similaire) - processeur 64-bit Intel/AMD (ordinateurs portable et ordinateurs de bureau, la plupart du
temps Chromebooks).
armv7 (ou suivant) - processeur ARM (téléphones et tablettes, Raspberry Pi 2/3 fonctionnant avec Ubuntu Mate,
certains Chromebooks, généralement 32-bit actuellement).

Maintenant vous pouvez allez à la page de téléchargement  et trouver le AppImage qui correspond le mieux avec votre
architecture. Une fois téléchargé, le fichier sera nommé "MuseScore-X.Y.Z-$(arch).AppImage".

Etape 2 - Donner l’autorisation de s'exécuter en tant que programme

Avant de pouvoir utiliser l'AppImage vous devez lui donner l'autorisation de s'exécuter en tant que programme.

Depuis le Terminal:

Cette commande donne à l'utilisateur (u) la permission d'exécuter (x) l'AppImage. Cela fonctionne sur tous les systèmes
Linux.

    cd ~/Downloads
    chmod u+x MuseScore*.AppImage

Note : Utilisez la commande "cd" pour changer le répertoire à l'endroit où vous avez enregistré l'AppImage.

Depuis le Gestionnaire des Fichier :

Si vous préférez éviter les lignes de commande, il y a généralement un moyen de donner l’autorisation de s'exécuter à
l’intérieur d’un gestionnaire de fichier.

Depuis GNOME Fichiers (Nautilus), simplement :

1. Faites un clique droit sur l'AppImage et sélectionnez "Propriétés".
2. Ouvrez l'onglet "Permissions".
3. Activez l'option étiqueté "Autoriser l’exécution du fichier en tant que programme".

Le processus peut être légèrement différent avec d'autres gestionnaires de dossiers..

Etape 3 - Exécutez le !

Maintenant, vous devriez être en mesure d’exécuter le programme simplement en double-cliquant dessus !

Quand vous téléchargez l'AppImage il a probablement été enregistré dans votre dossier Téléchargements, mais vous
pouvez le déplacer ailleurs à tout moment (ex : vous pouvez le mettre sur votre bureau pour un accès simple). Si jamais
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vous voulez l'enlever, alors il suffit simplement de le supprimer.

Installer l'AppImage (optionel)

Vous pouver faire fonctionner l'AppImage sans l'installer, mais vous devez l’installer si vous voulez qu’il soit complètement
intégré à votre environnement. Cela apporte les avantages suivants :

Ajoute l’AppImage à votre menu Applications ou Lanceur
Met les bonnes icones pour les fichiers MuseScore (MSCZ, MSCX) et pour les fichiers MusicXML (MXL, XML)
Rend l'AppImage disponible depuis votre Gestionnaire de Fichier avec le menu du clique droit "Ouvrir avec..."

Pour l'installer, exécuter l’AppImage depuis le Terminal avec l’option "installer" (voir immédiatement ci-dessous). Cela
copie un fichier pour le bureau et diverses icônes sur votre ordinateur. Si vous voulez les supprimer, vous devrez exécuter
l’option "désinstaller" avant de supprimer l’AppImage. Cela n’affecte pas les partitions créées avec n’importe quelle
version de MuseScore.

Utilisation des options de ligne de commande

L’exécution de l’AppImage depuis le Terminal vous permet d’utiliser différentes options de ligne de commande.
L'AppImage a quelques options spéciales en plus des options de ligne de commande de base de MuseScore.

Vous devrez changer le répertoire (cd) à l’endroit où l’AppImage est enregistré sur votre système, par exemple :

    cd ~/Desktop
    ./MuseScore*.AppImage [option...]

Ou donner le chemin d’accès à l’AppImage :

    ~/desktop/MuseScore*.AppImage [option...]

Utilisez les options "--help" et "man" pour obtenir plus d'informations à propos des options de ligne de commande
disponibles :

    ./MuseScore*.AppImage --help   # affiche une liste complète des options de la ligne de commande
    ./MuseScore*.AppImage man      # affiche la page de manuel (explique ce que font les options)

Paquetages de distribution

Fedora

1. Importer la clé GPG :

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
 

2. Allez à la page de téléchargement  du site Web MuseScore. Cliquez sur le lien pour le téléchargement stable de
Fedora et choisissez le bon paquetage RPM pour votre architecture.

3. Selon votre architecture, utilisez l’un des deux ensembles de commandes pour installer MuseScore

pour l'architecture i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm
 

pour l'architecture x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm
 

Si vous avez des difficultés avec le son, regardez Fedora 11 et sons (commentaire du 17 Déc. 2009 à 13:30) .
Voir aussi les conseils pour les différentes distributions sur la page de téléchargement .

Liens externes

Comment exécuter l’AppImage MuseScore sur Linux  - vidéo (traduction disponible en sous-titre)
Comment changer la langue de MuseScore

Installer sur Chromebook

Installation
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MuseScore fonctionnera nativement sur la machine Linux de Chrome OS appelé Crostini. Suivez les étapes décrites dans
la vidéo :

1. Installez l'émulateur Linux appelé Crostini. Allez dans Paramètres -> Linux -> Activer
2. Téléchargez le paquetage AppImage de Musescore
3. Configurez AppImage pour s'exécuter. Mettez chmod +x pour le fichier AppImage
4. Exécutez AppImage avec ./ suivi du nom du paquetage de Musescore
5. Instalez les librairies requises si nécessaire, ex :

sudo apt-get install libvorbisfile3
sudo apt-get install libnss3

6. Installez AppImage (utilisez l'option de ligne de commande install ) pour éviter de l’exécuter depuis la ligne de
commande de Linux à chaque fois

7. Profitez !

Liens externes

Regardez la vidéo interactive  pour de plus amples détails
Comment faire pour exécuter MuseScore sur ChromeOS  (MuseScore HowTo)
Ce cours

Langue, traductions, et extensions

MuseScore fonctionne avec la langue de votre système d'exploitation (OS), dépendant généralement de votre pays et/ou
du réglage de votre session.

Changer la langue de l'interface

1. Dans le menu Édition→Préférences... (Mac : MuseScore→Préférences...) ;

2. Onglet Général, sélectionnez la langue choisie dans le menu déroulant de la section Langue (en haut à droite) :

Gestionnaire de ressources

Le Gestionnaire de ressources est utilisé pour installer ou désinstaller des extensions, et pour gérer les mise à jour des
traductions. Pour y accéder, utilisez une des méthodes suivantes :

Depuis la barre de menu Aide→Gestionnaire de ressources.

Depuis le menu Édition→Préférences... (Mac : MuseScore→Préférences...), onglet Général, puis en haut à droite cliquez Mettre
à jour les traductions.
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Installer / désinstaller une extension

Pour installer / désinstaller une extension :

1. sélectionnez l'onglet Extension dans le Gestionnaire de ressources.
2. sélectionnez l'extension.
3. Cliquez Installer ou Désinstaller.

Note : Les extensions comprennent la MuseScore Drumline (MDL) (depuis la version 3.0) et la SoundFont MuseScore
General HQ (depuis la version 3.1).

Mettre à jour les traductions

Pour mettre à jour les traductions :

1. sélectionnez l'onglet Langues dans le Gestionnaire de ressources.
2. Cliquez Mettre à jour sur chaque langue désirée.

Note : La langue des menus et des boites de dialogues changera immédiatement, cependant, un redémarrage du logiciel
est requis pour que le reste de l'interface puisse l'utiliser.

Voir aussi

Aider à améliorer les traductions

Liens externes

Comment changer la langue de MuseScore  (en anglais)

Rechercher les mises à jour

Note : Ces options ne sont disponibles que pour les versions Mac et Windows de MuseScore (à l'exception de la version
Windows Store), et uniquement celles qui peuvent être mises à jour à partir de MuseScore.org. Les distributions Linux et
celles du Windows Store, utilisent des mécanismes différents.

2 méthodes sont disponibles pour vérifier les mises à jour des versions qui supportent la mise à jour directe.

Vérification automatique des mises à jour

1. Dans la barre de menu, sélectionnez Édition→Préférences... (Mac : MuseScore→Préférences...) ;
2. Sélectionnez l'onglet Mettre à jour.
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3. Vérifiez que la case "Vérifier la disponibilité d'une nouvelle version" soit cochée (elle l'est par défaut) :

Si vous activez cette option, MuseScore vérifiera les mises à jour à chaque démarrage. Pour les versions Mac et
Windows (à l’exception de celle du Windows Store), cela activera une fonction de mise à jour automatique qui les
téléchargera et les installera automatiquement.

Rechercher les mises à jour

1. Dans la barre de menu, sélectionnez Aide→Rechercher les mises à jour  :

2. Une boite de dialogue affichera l'état des mises à jour : soit "Vous utilisez la version la plus récente" ou bien "Une
mise à jour de MuseScore est disponible :" suivi du lien de téléchargement.

Voir aussi

Préférences : Mettre à jour

Bases
Ce chapitre vous montre comment créer une nouvelle partition en utilisant l'Assistant de création de partitions de
MuseScore, ainsi que comment entrer et éditer les symboles de notation musicale de base. Les différentes fenêtres du
programme y sont décrites — barres d'outils, inspecteur, palettes, etc. — de même que les options de modes d'affichage
et de navigation.

Créer une nouvelle partition

Pour créer une nouvelle partition, ouvrez l'Assistant Créer une nouvelle partition (voir Créer une nouvelle partition, en
dessous) : également accessible via le Centre de démarrage.

Centre de démarrage

C'est la fenêtre qui s'affiche lorsque vous lancez MuseScore pour la première fois :
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Pour ouvrir le Centre de démarrage, plusieurs options :

Pressez F4.
A partir de la barre de menu, sélectionnez Fichier→Centre de démarrage...

Pour ne plus afficher le Centre de démarrage au lancement de MuseScore :

A partir de la barre de menu, sélectionnez Édition→Préférences... (Mac: MuseScore→Préférences...) et décocher la case
"Afficher le centre de démarrage" dans la section Démarrage du programme de l'onglet Général.

Depuis le Centre de démarrage, vous pourrez :

Créer une nouvelle partition, en cliquant la première vignette en haut à gauche (gros "+" ) ;
Accéder aux modèles ainsi qu'aux partitions précédemment ouvertes ;
Ouvrir une partition située sur votre ordinateur : Ouvrir une partition... (en bas à gauche) ;
Accéder à diverses facilités, dont la partition "Tutoriel interactif" : utiliser les flèches en bas du panneau de droite,
pour accéder aux liens ;
Chercher des partitions sur musescore.com .

Créer une nouvelle partition

Pour ouvrir l'Assistant Créer une nouvelle partition (quand le centre de démarrage n'est pas lancé), plusieurs options :

Cliquez sur l'icône dans la barre d'outil en haut à gauche de la fenêtre ;
Raccourcis clavier Ctrl+N (Mac : Cmd+N) ;
Depuis le menu Fichier→Nouveau....

Entrer les informations de la partition
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1ère étape : Entrer les informations de la partition.

Entrer le titre, le compositeur, etc, puis cliquez sur suivant >.
Cette étape est optionnelle, vous pourrez à tout moment éditer ces informations (voir Cadre vertical).

Choisir un modèle de partition

2ème étape : Choisir un modèle de partition.

Il y a dans la colonne de gauche une liste de modèles, pour solos, ensembles et orchestres, divisés en différents styles
musicaux. Si vous avez déjà sauvegardé des modèles dans votre répertoire personnel, ils seront répertoriés comme
Modèles personnalisés. Vous pouvez également utiliser la barre de recherche pour trouver des modèles.

Pour choisir le modèle de partition :

Cliquez sur le nom du modèle de partition, puis Suivant > ; ou double-clic, pour passer directement à l'étape suivante
de l’assistant (Choisir l'armure et le tempo, voir en dessous).
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Si vous désirez créer une partition en partant de rien, choisissez Général > "Choisir les Instruments", puis clic Suivant
> ; ou simplement double-clic sur Choisir les Instruments.

Choisir les instruments et parties vocales

La fenêtre Instruments est divisée en deux colonnes :

La colonne de gauche propose la liste des instruments et parties vocales, répartis par familles.

Les instruments communs sont proposés par défaut, mais vous pouvez évidemment en choisir d'autres, comme jazz ou
musique ancienne. La barre de recherche en bas de la fenêtre permet de rechercher dans "Tous les instruments".

La colonne de droite, initialement vide, contiendra la liste des instruments de votre nouvelle partition, dans l’ordre
ou ils ont été ajoutés.

Ajouter des instruments

Pour ajouter des instruments à votre partition, utilisez une des méthodes :

Sélectionnez un ou plusieurs instruments dans la colonne de gauche, puis Ajouter.
Double-cliquez un instrument dans la colonne de gauche.

Les noms d'instrument et leurs portées (ligne), apparaissent maintenant dans la liste des instruments, dans la colonne de
droite. Vous pouvez ajouter autant d'instruments ou parties vocales que souhaités. Chaque instrument ajouté de cette
façon aura son propre canal dans le Mélangeur.

Note : Si vous voulez plusieurs portées pour un même instrument, utilisez à la place Ajouter une portée ou Ajouter une
portée liée (voir en dessous).

Ajouter une portée ou une portée liée

1. Dans la colonne de droite, sélectionnez l'instrument (ex : portée 1 dans l'image suivante) et cliquez Ajouter une portée
ou Ajouter une portée liée .

2. Ajustez le type de portée par le menu déroulant, le cas échéant.
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Résumé des commandes :

Commande Portée
ajoutée

Édition
indépendante ?

Canal de mélangeur
partagé ? Examples

Ajouter une portée Non liée Oui Oui Portée/TAB Guitare, Portée de
Piano

Ajouter une portée
liée Liée Non. Édition

dupliquée Oui Portée / TAB de Guitare

Voir aussi, Portée combinée avec tablature.

Changer l'ordre des instruments (portées)

Dans la colonne de droite, sélectionnez l'instrument (ou portée) et cliquez sur une des flèches haut / bas

Supprimer un instrument

Dans la colonne de droite, sélectionnez l'instrument puis clic Supprimer.

Choisir l'armure et le tempo
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3ème étape : Choisissez l'armure et le tempo.

Choisissez l'armure initiale et le tempo puis Suivant > pour continuer.

Choisir l'indication de mesure, l'anacrouse et le nombre de mesures

4ème étape : Choisissez l'indication de mesure, etc.

Choisissez l'indication de mesure initiale. Si votre partition commence par une anacrouse, cochez la case Anacrouse et
ajustez sa "Durée".

32 Mesures sont définies par défaut : choisissez le nombre de mesures initial ou ajoutez les / supprimez les plus tard
directement depuis la partition.

Clicuer sur Terminer pour créer la nouvelle partition.

Modifier une partition existante
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Tous ces réglages initiaux faits depuis l'Assistant Créer une nouvelle partition sont modifiables depuis la partition elle-
même.

Ajouter / supprimer / éditer des mesures

Insérer des mesures.
Ajouter des mesures.
Supprimer des mesures.
Créer une anacrouse.

Ajouter / éditer du texte

Ajouter du texte (Bases sur les textes).
Éditer du texte.

Changer l'organisation des instruments

Pour ajouter, supprimer, ou changer l'ordre des instruments :

Dans la barre de menu, sélectionnez Édition→Instruments... ; ou utilisez le raccourci clavier, I. La boite de dialogue
Instruments s'ouvrira, quasiment identique à celle de Choisir des Instruments de l'Assistant Créer une nouvelle
partition (voir plus haut).

Voir aussi Changer d'instrument (Propriété de la portée).

Cacher une portée

Pour cacher une portée de façon permanente : Ouvrez la boite de dialogue Instruments (I) et décochez la case
"Visible" de cette portée.
Pour cacher une portée dans certains cas : Voir les options "Cacher" dans la boite de dialogue Style de partition,
et Propriétés de la portée.

Ajuster la mise en page et la mise en forme

Pour régler la distances entre les portées et les systèmes, définir les marges de page, etc., voir Mise en page et mise en
forme.

Modèles de partition

Un Modèle est simplement un fichier MusScore standard sauvegardé dans un des 2 dossiers "Modèles" : tous les fichiers
de ces 2 dossiers sont affichés dans la page "Choisir un modèle" de l'Assistant Créer une nouvelle partition. 2 dossiers de
modèles sont créés par défaut :

Un dossier système des modèles.
Un dossier des modèles de l'utilisateur.

Dossier système des modèles

Ce dossier contient les modèles inclus dans l'installation de MuseCore et ne doit pas être modifié. Il se trouve à
l'emplacement suivant :

Windows : Normalement à C:\Program Files\MuseScore 3\templates.

Linux : Sous /usr/share/mscore-xxx Si vous l'avez installé à partir du package manager. Si vous avez compilé MuseScore
vous même, alors cherchez sous /usr/local/share/mscore-xxx (avec xxx comme numéro de version utilisée).

MacOS : Sous /Applications/MuseScore 3.app/Contents/Resources/templates.

Dossier des modèles de l'utilisateur

Tous les modèles que vous créez doivent être sauvegardés dans ce dossier. Une fois placés dans le dossier des
"modèles" de l'utilisateur, ils seront automatiquement affichés dans la page "Choisir un modèle" de l'Assistant Créer une
nouvelle partition—sous le titre "Modèles personalisés".

Emplacement par défaut du dossier des modèles de l'utilisateur :

Windows : %HOMEPATH%\Documents\MuseScore3\Modèles.

MacOS et Linux : ~/Documents/MuseScore3/Templates.

Pour paramètrer l'emplacement du dossier de vos modèles :
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Dans la barre de menu, sélectionnez Édition→Préférences...→Général.

Voir aussi

Armure
Indication de mesure
Clef
Tempo
Propriété de la portée

Liens externes

Video tutorial: MuseScore in Minutes: Lesson 1 - Score Setup

Saisie des notes

MuseScore vous permet de saisir la notation musicale à partir d'un parmi quatre périphériques d'entrée : Le clavier de
l'ordinateur, la souris, un clavier maître MIDI, ou le clavier de piano virtuel. Le mode de saisie des notes par défaut est
Une à une, où les notes et les silences sont entrés les uns après les autres. Cependant, différents modes de saisie sont
proposés.

Après avoir créé une partition avec l'Assistant Créer une nouvelle partition, elle sera constituée de mesures ne contenant
que des silences :

Dès que vous saisissez des notes dans une mesure, les silences sont remplacés par des pauses ou soupirs
correspondants aux temps restant dans la mesure :

Les notes de durée différentes dans le même temps sont saisies en utilisant les Voix :

Saisie des notes, notions de base

Cette section vous présente les bases de la saisie des notes et des silences en mode par-étape à partir du clavier de
l'ordinateur. Nous vous recommandons de consulter le Centre de démarrage.

1ère étape. Sélectionnez un point de départ

Avec la souris, sélectionnez une point de départ pour la saisie de notes en cliquant sur une note ou un silence, ou en
sélectionnant une mesure. Si vous ne sélectionnez rien, le curseur sera placé automatiquement au début de la partition
lorsque vous entrerez en Mode de saisie des notes ("2ème étape " ci-dessous).

2ème étape. Entrez en mode de saisie des notes

Pour entrer en mode de saisie des notes utilisez l'une des options suivantes :
* Cliquez sur l'icône "N" (à l'extrême gauche de la barre d'outils Saisie des notes).
* Appuyez sur la touche N du clavier de l'ordinateur.

Pour quitter le mode de saisie des notes utilisez l'une des options suivantes :

Appuyez sur la touche N.
Appuyez sur la touche Échap.
Cliquez sur l'icône "N" de la barre d'outils.

3ème étape. Sélectionnez une durée

Toujours en mode de Saisie des notes, sélectionnez la durée de la note en utilisant l'une des options suivantes :

Cliquez sur l'icône de la note correspondante à la durée de la Barre d'outils de saisie des notes :
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Taper le raccourci clavier de la durée voulue (voir ci-dessous).

4ème étape. Saisie des notes ou des silences

Pour saisir une note de A à G, (de La à Sol), cliquez sur la lettre correspondante du clavier. (Les raccourcis clavier
correspondent aux noms des notes Anglo Saxonnes)
Pour saisir un silence, taper 0 (zéro).

Cette méthode de saisie fonctionne également si vous n'êtes pas en mode de saisie de notes, et qu'une note ou un soupir
est sélectionné, ou que la partition vienne d'être créée. (Auquel cas la saisie des notes démarrera au début de la
partition).

Sélectionnez la durée des notes et silences

Les raccourcis clavier suivants sont utilisés pour sélectionner la durée de notes et des silences en mode de Saisie des
notes :

1 : Quadruple croche
2 : Triple croche
3 : Double croche
4 : Croche
5 : Noire
6 : Blanche
7 : Ronde
8 : Carrée
9 : Longue
. : Point de prolongation (Change la durée en note ou silence pointé)

Note : Double, triple et quadruple points ainsi que la Quintuple croche peuvent être saisies depuis la barre d’outils de
saisie des notes de l’espace de travail avancé ou par un raccourci clavier personnalisé.

Voir aussi : Divisions irrégulières.

Périphériques d'entrée

La notation musicale est saisie au moyen de :

Clavier d’ordinateur.
Souris.
Clavier maître MIDI.
Clavier de Piano Virtuel.
Ou toute combinaisons des uns et des autres.

Clavier d’ordinateur

Cette section ajoute à "Saisie des notes, notions de base" (voir ci-dessus) l’ensemble de toutes les commandes
disponibles pour la saisie des notes et des silences à partir du clavier de l’ordinateur.

Saisie des notes et des silences

Vous saisissez une note en tapant sa lettre correspondante au clavier. Donc après être entré en mode de Saisie des
notes, tapez :
5 C D E F G A B C.

Note : Quand vous entrez une note depuis votre clavier, MuseScore choisit par défaut la hauteur la plus proche de la
note précédente (au-dessus ou au-dessous).

Pour saisir un silence, tapez "0" (zéro). Ce qui donne après être entré en mode de saisie des notes,
5 C D 0 E.
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Note : La durée sélectionnée dans la barre d’outils s’applique aux notes et aux silences.

Pour saisir une note pointée, tapez . (point), après avoir sélectionné la durée de la note.

Après être entré en mode de saisie des notes, tapez par exemple :
5 . C 4 D E F G A.

Pour saisir un triolet (ou autre division irrégulière) : Consultez le chapitre Divisions irrégulières.

Pour écrire 2 mélodies (ou plus) sur la même portée, consultez le chapitre Voix.

Déplacer la hauteur des notes vers le haut ou le bas

Pour monter ou descendre une note d’un demi ton :

Utilisez les flèches ↑ ou ↓.

Pour monter ou descendre une note d’un intervalle diatonique :

Tapez Alt+Maj+↑ ou Alt+Maj+↓.

Pour monter ou descendre une note d’une octave :

Tapez Ctrl+↑ (Mac: Cmd+↑) ou Ctrl+↓ (Mac: Cmd+↓).

Ajouter des altérations

Monter ou descendre la hauteur d’une note avec les flèches (voir ci-dessus) place automatiquement les altérations
nécessaires à la note. On peut aussi ajouter une altération manuellement, voir Altérations.

Accords

Pour ajouter une note au-dessus à l’accord :

Maintenez appuyé la touche Maj, et entrez une note de A à G.

Donc, saisir C, D, Maj+F, Maj+A, E, F donne :

Pour ajouter une note à un intervalle spécifique au-dessus ou au-dessous d’une ou plusieurs notes :

1. Assurez-vous qu’une ou plusieurs notes soient sélectionnées;
2. Utilisez l'une des options suivantes :

Choisissez dans le menu Ajouter→Intervalles celui souhaité dans la liste ;
Tapez Alt+1-9 pour les intervalles au-dessus (les intervalles au-dessous sont possible en ajoutant les raccourcis
correspondants à la liste dans Préférences).

Note : Pour créer des accords avec des notes de différentes durées, vous devez utiliser plus d’une Voix.

Insérer des notes

Normalement, quand vous saisissez de la musique dans Musescore, toute note ou pause existante est écrasée. Toutefois
il y a plusieurs moyens d'insérer des notes :

Insérer des mesures supplémentaires dans la partition.
Couper et coller une section de la partition, puis saisir dans l'intervalle laissé libre.
Pour insérer une note, appuyez surCtrl + Shift (Mac: ⌘ + Shift) + le nom de la note (A à G). Cela va insérer une note de
la durée sélectionnée et déplacer les autres notes vers la droite dans la même mesure. Si la mesure dépasse alors
sa durée (signature), un plus bleu va apparaître au-dessus de la mesure, comme dans le mode Insertion.
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Supprimer des notes

Pour supprimer une note:

Sélectionnez la note et appuyez sur Suppr.

Pour supprimer un accord:

1. Appuyez sur Esc pour vous assurez que vous êtes en Mode normal.
2. Appuyez sur Shift et cliquez sur une note pour sélectionner l'accord.
3. Appuyez sur Suppr.

La commande de suppression peut également être appliquée à une plage de notes/accords.

Raccourcis clavier

Voici une liste de raccourcis d’édition utiles disponibles en Mode Saisie de Note :

↑ (Up): Augmente la hauteur d’une note d’un demi-ton (utilise des ♯).
↓ (Down): Diminue la hauteur d’une note d’un demi-ton (utilise des ♭).
Alt+1-9: Ajoute un intervalle (de l’unisson à la neuvième) au-dessus de la note actuelle (construction d'accords)
J: Transforme la note en note enharmonique, d'abord au-dessus puis en- dessous (modifie l'écriture à la fois la
hauteur de concert et les modes transposés). Voir Altérations
Ctrl+J (Mac Cmd+J): Transforme la note en note enharmonique, d'abord au-dessus puis en- dessous (modifie
l'écriture uniquement dans le mode actuel). Voir Altérations
Alt+Shift+↑: Augmente la hauteur d'une note d'un ton en respectant l'armure.
Alt+Shift+↓: Diminue la hauteur d'une note d'un ton en respectant l'armure.
R: Répète la dernière note entrée.
Q: Réduit de moitié la durée de la dernière note saisie
W: Double la durée de la dernière note saisie
Shift+Q: Diminue la durée d'une note d’un point (par exemple, une noire pointée devient une noir et une noire devient
une croche pointée avec un quart de soupir.).
Shift+W: Augmente la durée d'une note d’un point (par exemple, une croche pointée devient une noir et une noire
devient une noire pointée).
Backspace: Annule la dernière saisie de note
Shift+←: Permet de créer une plage de note vers la gauche à partir d'une note.
Shift+→: Permet de créer une plage de note vers la droite à partir d'une note.
X: Change la direction de la queue de la note (peut être réinitialisée à la position automatique dans L'inspecteur)
Shift+X: Dirige la tête de la note dans la direction opposée (peut être réinitialisée à la position automatique dans
L'inspecteur)
Ctrl+Alt+1-4: Passe à la voix correspondante.

Saisie à la souris

Il est simple de saisir une note à la souris mais ce n'est pas la technique la plus simple pour saisir plusieurs notes.

1. Cliquez sur la durée désirée dans la barre d'outil.
2. Cliquez sur la hauteur voulue dans la portée pour ajouter la note.
3. Pour ajouter plus de note à un accord existant (ou pour en créer un), répétez simplement l'étape 2.
4. Pour remplacer un accord existant (plutôt que d'ajouter des notes), appuyez sur Shift avant de cliquer.
5. Pour ajouter un silence, faites un clique droit après avoir sélectionné la durée (comme à l'étape 1).

Note: Si vous placez le curseur sur la partition en mode Saisie de note, vous verrez un aperçu de la note que vous êtes
sur le point d’ajouter.

Saisie avec un clavier MIDI

Vous pouvez également saisir des hauteurs à l’aide d’un clavier MIDI.

1. Connectez votre clavier MIDI à votre ordinateur et allumez le;
2. Ouvrez MuseScore (cela doit être fait après que le clavier a été allumé);
3. Créez une nouvelle partition;
4. Cliquez sur le silence (sélectionnez le) là ou vous souhaitez commencer la saisie;
5. Appuyez sur N pour saisir mode de saisie de note;
6. Choisissez une durée de note (pour une noire appuyez sur 5), comme décrit plus haut;
7. Appuyez sur une note sur votre clavier MIDI.

La hauteur devrait être ajoutée sur la partition.

Note: La méthode de saisie par défaut, Par-étape vous permet de saisir une note à la fois. D’autres modes de saisie de
notes sont également disponibles : voir Modes de saisie de notes.
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Si vous avez plusieurs périphériques MIDI connectés à votre ordinateur, vous devrez peut-être informer MuseScore lequel
est le clavier MIDI :

1. Depuis le menu, selectionnez Edition→Préférences... (Mac: MuseScore→Préférences...).
2. Cliquez sur l'onglet E/S selectionnez votre appareil sous la section nommée "Entrée MIDI".
3. Cliquez sur OK pour quitter. Vous devrez redémarrer MuseScore pour appliquer les modifications.

Saisie avec le clavier de piano virtuel

Vous pouvez aussi saisir des notes en utilisant un clavier de piano dans la fenêtre de Musescore.

Pour activer et désactiver l’affichage: Appuyez sur P (ou sélectionnez Affichage→Clavier de piano).
Pour redimensionner le clavier: Positionnez le pointeur de la souris sur les touches du piano, maintenez appuyée
Ctrl (Mac: Cmd) et déplacer la molette de la souris vers le haut (plus grande) ou vers le bas (plus petite).

La méthode de saisie des notes est similaire à celle d’un clavier MIDI:

1. Assurez vous que vous êtes en Mode de saisie de note.
2. Pour saisir :

Une seule note: Cliquez sur la touche du clavier afin de saisir la note correspondante.
Un accord: Sélectionnez la note que vous voulez enrichir, appuyez et maintenez Shift, ensuite cliquez sur les
touches du piano voulues (dans les versions antérieures à la 2.1, maintenez Ctrl (Mac: Cmd)).

Modes de saisie de notes

MuseScore offre une variété de Modes de saisie de note en plus du par-étape. Tous sont accessibles en cliquant sur la
petite flèche à coté du bouton "N" à gauche de la barre d'outil de saisie de notes:

Par-étape (par défaut): Le mode par défaut de saisie de notes. Voir Saisie des notes, notions de base (plus haut).
Changer les hauteurs: Remplacez les hauteurs sans changer le rythme.
Rythme: Saisissez les durées en un seul clic ou en appuyant sur une touche.
Temps réel (Automatique): Jouez la pièce à un tempo fixe indiqué par le métronome.
Temps réel (Manuel): Jouez la pièce en appuyant sur une touche ou une pédale pour régler le tempo.
Insérer: (Nommé "Timewise" avant la version 3.0.2) Insérez des notes et des silences en plus dans la mesure
(temps ajoutés).

Coloriation des notes en dehors de la tessiture d’un instrument

Selon l’habileté du musicien, certaines notes sont considérées comme hors de la tessiture d’un instrument particulier. A
titre informatif, MuseScore colore facultativement les notes en rouge si elles sont hors de la tessiture d'un interprète
"professionel" , et en vert olive/jaune sombre si elles sont en dehors de la tessiture d'un interprète "amateur". Les couleurs
apparaissent sur l’écran de l’ordinateur, mais pas sur les copies imprimées.

Pour activer/désactiver la coloration des notes et pour paramétrer la tessiture d'un interprète "professionnel" ou
"amateur", voir Plage de hauteur utilisable (Staff properties: all staves).

Petites notes
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1. Sélectionnez la/les note(s) que vous souhaitez en petite taille.
2. Cochez la case "Taille petite" dans l' Inspecteur. Celle de la section « Note » sert uniquement à modifier la taille de

la tête de note; celle de la section Accord modifiera la taille de la tête de note, la hampe, la ligature, et le crochet.

Par défaut, la petite taille représente 70% de la taille normale. Vous pouvez modifier ce paramètre dans Format →
Style…→Tailles.

Modification de notes ou de silences déjà saisies

Modifier la durée

Version 3.3.3 et supérieurs
1. Assurez-vous que vous êtes en Mode normal.
2. Sélectionnez un(e) ou plusieur(e)s silences/notes, ou les hampes/crochets. Appliquez la durée désirée (listées plus
haut), ou cliquez l'icône de la durée équivalente dans la boite à outil.

Antérieur à la version 3.3.3
1. Assurez-vous que vous êtes en Mode normal.
2. Cliquez sur une note ou un silence. Appliquez la durée désirée (listées plus haut), ou cliquez l'icône de la durée
équivalente dans la boite à outil.

Note: Augmenter la durée d'une note écrasera les notes ou les silences qui la suivent; diminuer la durée ajoutera des
silences entre elle et les notes ou silences qui suivent.

Par exemple pour transformer trois demi-soupirs en un soupir pointé.
1. Cliquez sur le premier demi-soupir.
2. Appuyez sur 5 pour le transformer en un soupir.
3. Appuyez sur . pour le transformer en un soupir pointé.

Comme la durée de la note augmente, elle écrase les deux autres demi-soupirs.

Modifier la hauteur

Pour modifier la hauteur d'une seule note :

1. Assurez-vous que vous êtes en Mode normal et que vous n'avez aucune note de sélectionné.
2. Sélectionnez la note souhaité et utilisez l'une des méthodes ci-dessous:

Faites glisser la tête de la note vers le haut ou vers le bas à l'aide de la souris;
Appuyez sur les flèches du clavier : ↑ (Haut) or ↓ (Bas);
Utilisez les raccourcis de notes avec les lettres du clavier (A…G). Utilisez Ctrl+↓ or Ctrl+↑ (Mac: Cmd+↓ or Cmd+↑)
pour corriger l'octave, si nécessaire. Cela vous fera passer automatiquement en mode saisie de note.

Pour changer l'écriture enharmonique d’une note, sélectionnez la et utilisez la touche J. Pour plus d'information, voir
Altérations.

Pour modifier la hauteur d'une plage de note en conservant l'intervalle, voir Transposition.

Pour modifier la hauteur d'une plage de note vers une mélodie différente tout en conservant le rythme, voir Recalculer les
altérations.

Si votre partition contient plusieurs altérations erroné, essayez la commande Recalculer les altérations (see Altérations :
Recalculer les altérations).

Modification sur les voix

Pour échanger une ou plusieurs notes d'une voix avec une voix différente, voirVoix.

Transformer un silence en note et vice-versa

Pour transformer un silence en une note de même durée :

1. Assurez-vous que vous êtes en Mode normal.
2. Sélectionnez un silence.
3. Saisissez la hauteur désiré en appuyant sur un raccourci de note, A–G.

Pour transformer une note en un silence de même durée :

1. Assurez-vous que vous êtes en Mode normal.
2. Sélectionnez la note.
3. Appuyez sur 0 (Zéro).

Propriétés des notes
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Pour ajuster la positon horizontale de la note ou de l'accord : voir Décaler des notes .
Pour modifier les propriétés des notes en général (espacement, décalage, taille, couleur, sens de la tête de note,
lecture etc...): voir Inspecteur et propriétés d'objet.
Pour ajuster la disposition de toutes les notes de la partition : voir Mise en page et formatage, plus particulièrement
la section à propos des notes, altérations et Divisions irrégulières.

Voir aussi

Modes de saisie de notes
Notation de batterie
Tablature
Divisions irrégulières
Voix
Têtes de notes partagées
Préférences

Liens externes

Comment saisir un accord
Comment saisir un silence
Comment avoir une seule hampe sur plusieurs portées
Tutoriel vidéo : MuseScore en quelques minutes : Leçon 3 - Saisie de notes
Tutoriel vidéo : MuseScore en quelques minutes : Leçon 4 - Saisie avec un clavier MIDI
Tutoriel vidéo : MuseScore en quelques minutes : Leçon 5 - Astuces de saisie
Vidéo: Démo MIDI, saisie en semi-temps réel, Partie 1: Nouveaux modes de saisie de notes  (disponible à partir
de MuseScore 2.1)

Espaces de travail

Un espace de travail est un ensemble de composants dont le principal est l'espace palettes, situé à gauche de la fenêtre
de document.

Chaque palette est un dossier contenant des symboles musicaux (souvent en relation) pouvant être appliqués à la
partition. Cliquez sur le nom d'une palette pour l'ouvrir et la fermer.

Pour faire apparaître ou cacher l'espace palettes de l'espace de travail :

Appuyez sur F9; ou, dans le menu principal, sélectionnez Affichage → Palettes.

MuseScore fournit deux espaces de travail prédéfinis : De base (par défaut) et Avancé (une version avec plus de palettes
et symboles). Ils contiennent des symboles tirés de la Palette principale. De plus, vous pouvez créer vos propres espaces
de travail personnalisés (ci-dessous).

Pour changer d'espace de travail

Sélectionnez un nouvel espace de travail dans le menu déroulant, tout à droite de la barre d'outils (sous l'onglet
"Commentaire") ; ou sélectionnez Affichage → Espaces de travail et cliquez sur une des options.

Ancrer/détacher
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Pour ancrer/détacher un espace de travail, voir panneaux latéraux.

Créer un espace de travail personnalisé

Les espaces de travail de base et Avancé sont prédéfinis et ne peuvent être modifiés par l'utilisateur. Néanmoins,
MuseScore vous permet de créer votre propre espace de travail complètement configurable :

Pour créer un espace de travail personnalisé :

1. Sélectionnez un espace de travail existant : utilisez la liste déroulante, tout à droite de la barre d'outils (sous l'onglet
"Commentaire") ;

2. Cliquez sur le bouton + (à côté de la liste déroulante). La boîte de dialogue suivante s'affiche :

Note: vous pouvez aussi utiliser le menu Affichage→Espaces de travail→Nouveau...;
3. Entrez un nom pour l'espace de travail ;
4. Cochez les composants que vous voulez enregistrer dans l'espace de travail, à savoir :

Barres d'outils: vous permet de personnaliser l'affichage de la barre d'outils et l'ordre dans lequel les boutons
sont affichés. C'est accessible via Affichage→Barre d'outils→Personnaliser les barres d'outils .
Barre de menus: vous permet de changer les menus de la barre de menus et leurs éléments. PAS ENCORE
IMPLÉMENTÉ ;
Préférences de l'interface : sauvegarde les préférences sélectionnées pour l'interface dans
Édition→Préférences, comme les réglages de thème ou de canvas ;
Composants de l'interface: sauvegarde avec l’espace de travail les informations sur la position des
composants graphiques, et s'ils sont ouverts ou non (par ex. Inspecteur, Ligne de temps) ;

5. Appuyez surEnregistrer. Le nouvel espace de travail est ajouté au panneau.

Pour créer, supprimer, renommer et réordonner les palettes au sein d'un espace de travail, ou pour modifier l'affichage
d'une palette, ou pour modifier le contenu des palettes, voir menuPalette.

Pour ajouter, arranger ou supprimer du contenu aux palettes, voir Palettes personnalisées.

Éditer un espace de travail

Pour éditer un espace de travail ou modifier son association à des composants :

Sélectionnez Affichage→Espaces de travail→Éditer.

Cela affiche une fenêtre avec les mêmes options que la fenêtre Créer un nouvel espace de travail (au-dessus).

Voir aussi

Palettes
Palette principale

Mode édition

Le mode Édition permet de réaliser un large éventail d'opérations d'édition sur les éléments individuels de partition, telles
que :

ajuster la longueur et la forme de liaisons, lignes, barres de mesure, etc ;
ajouter, supprimer et formater le texte d'objets textuels ;
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ajuster la position de la plupart des éléments de partition (mais pas le texte).

Entrer/sortir du mode Édition

Pour entrer dans le mode Édition, utilisez l'une des méthodes suivantes :

Double-cliquez sur un élément ;
Cliquez droit sur un élément et, dans le menu, sélectionnez Éditer l'élément ;
Cliquez sur un élément et appuyez sur Alt+Maj+E.

Pour sortir du mode Édition, utilisez l'une des méthodes suivantes :

Appuyez sur Esc ;
Cliquez dans une zone vierge de la fenêtre Document.

Texte

Pour le mode d'édition de texte, voir Édition de texte.

Lignes

Voir Lignes: Changer la longueur, et Ajuster une liaison.

Notes

Décaler des notes

Il est parfois nécessaire de déplacer une note vers la droite ou la gauche pour éviter une collision avec un autre élément
ou pour remplacer le partage de tête de note automatique, par exemple:

1. Entrez dans le mode Édition de la note désirée ;
2. Appuyez sur la flèche du sens (gauche ou droite) dans lequel vous souhaitez décaler la note (ou utilisez Ctrl+← or

Ctrl+→ pour de plus grands ajustements) ;
3. Appuyez sur Esc. Cela va retracer la hampe de la note.

Sinon, vous pouvez aussi sélectionner la tête de note et change le "décalage X" du groupe "Accord" de l'Inspecteur.

Ajuster la longueur de hampe d'une note

1. Entrer dans le mode Édition de la hampe souhaitée;
2. Utilisez les raccourcis clavier (ci-dessous) pour étendre ou rétrécir la hampe ;
3. Quitter le mode Édition.

Sinon, vous pouvez aussi sélectionner la hampe et entrer une valeur dans "Modifier la longueur" du groupe "Hampe" de
l'Inspector.

Pour repositionner une hampe, vous devez la sélectionner et ajuster les valeurs "X" ou "Y" du "Décalage" sous
"Placement automatique" de la section "Élément" section de l'Inspecteur.

Raccourcis clavier

En mode Édition, les commandes clavier suivantes peuvent être utilisées pour changer la position, soit (1) d'un élément
de partition (par ex. ornement, accident, etc.), soit (2) une poignée d'ajustement (par ex. liaison, ligne, etc.) :

←: déplacer vers la gauche de 0,1 espace de portée.
→: déplacer vers la droite de 0,1 espace de portée
↑: déplacer vers le haut de 0,1 espace de portée
↓: déplacer vers le bas de 0,1 espace de portée
Ctrl+← (Mac: ⌘+←): déplacer vers la gauche de 1 espace de portée
Ctrl+→ (Mac: ⌘+→): déplacer vers la droite de 1 espace de portée
Ctrl+↑ (Mac: ⌘+↑): déplacer vers le haut de 1 espace de portée
Ctrl+↓ (Mac: ⌘+↓): déplacer vers le bas de 1 espace de portée
Alt+←: déplacer vers la gauche de 0,01 espace de portée
Alt+→: déplacer vers la droite de 0,01 espace de portée
Alt+↑: déplacer vers le haut de 0,01 espace de portée
Alt+↓: déplacer vers le bas de 0,01 espace de portée

Les commandes suivantes d'appliquent uniquement aux poignées d'ajustement:

Maj+← : déplacer l'ancrage de la poignée de fin d'une note ou d'un soupir vers la gauche
Maj+→ : déplacer l'ancrage de la poignée de fin d'une note ou d'un soupir vers la droite
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Tab : aller à la prochaine poignée

Pour annuler toutes les éditions, assurez-vous de ne pas être en mode Edition et appuyez sur Ctrl+R.

voir aussi

Édition de texte
Liaisons
Accolades
Lignes
Ligatures
Crescendos / Decrescendos

Palettes

Une Palette est un dossier contenant des symboles musicaux pouvant être utilisés dans les partitions. Les palettes par
défaut de MuseScore contiennent des recueils de symboles connexes, cependant vous pouvez personnaliser les palettes
pour afficher presque n'importe quel style de symbole, ligne ou texte. Les palettes constituent la partie principale d'un
espace de travail.

Au début Musescore possède deux ensembles de palettes prédéfinies: une De Base et une Avancé (contenues dans des
espaces de travail portant le même nom). Mais ce n'est que le début. Vous pouvez ajouter vos propres symboles et textes
aux palettes existantes ou aux palettes que vous créez dans de nouveaux espaces de travail. Dans d'autres termes, vous
pouvez personnaliser chaque espace de travail pour répondre exactement à vos besoins de notation. Voir Personnaliser
les palettes.

Afficher ou masquer la palette

La position par défaut de la palette se trouve à gauche de la fenêtre de MuseScore. Pour la visualiser ou la masquer :

Depuis le menu, selectionnez Affichage → Palettes, ou utilisez le raccourci clavier F9.
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Pour détacher la palette:

Cliquez sur le symbole à double chevron (encerclé dans l’image ci-dessous) ou double-cliquez sur la barre
supérieure du panneau.

Pour attacher la palette, double-cliquez sur la barre supérieure du panneau. Voir Panneaux latéraux pour plus
d'information.

Ouvrir/fermer la palette

Cliquez sur la flèche à côté du nom de la palette, ou double-cliquez sur le nom de la palette (dans les versions
antérieures à MuseScore 3.3, cliquez une fois sur la flèche ou le nom de la palette).

Les symboles attribués à la palette sont affichés dans une grille sous le nom de la palette. Si vous avez personnalisé l'une
des palettes par défaut de Musescore, cliquez Plus affichera tous les symboles que vous avez supprimés.

Mode palette unique

Si vous ne souhaitez qu’une seule palette ouverte à la fois, faites un clic-droit en haut de l’espace de travail et cochez la
case Une seule palette . N’importe quelle palette ouverte se fermera lorsque vous en ouvrirez une autre.

Appliquer des symboles à partir d'une palette

Versions 3.4 ou supérieures

Sélectionnez un ou plusieurs éléments de partition, puis cliquez sur le symbole de palette souhaité. Ou, faites glisser
et déposez le symbole sur l'élément de partition souhaité dans la portée.

Versions antérieures à 3.4

Sélectionnez un ou plusieurs éléments de partition, puis double-cliquez sur le symbole de palette souhaité. Ou,
faites glisser et déposez le symbole sur l'élément de partition souhaité dans la portée.

Si vous faites glisser un symbole sur la partition et décidez que vous ne voulez pas l'appliquer, appuyez surEsc.

Conseil: Pour éviter une réorganisation accidentelle du contenu pendant l'utilisation, cliquez avec le bouton droit sur le
nom d'une palette et décochez Activer l'édition.

Vous pouvez rechercher des symboles ou des noms de palette en cliquant sur le symbole � en haut de la liste pour faire
une Recherche. Au fur et à mesure que vous tapez, des symboles et / ou des palettes avec des noms correspondant à
vos frappes au clavier sont affichés ci-dessous, mis à jour en permanence au fur et à mesure que votre entrée saisie
change. Les symboles affichés peuvent provenir de n'importe quelle palette, ce qui en fait un moyen puissant de localiser
des symboles sans rechercher visuellement dans diverses palettes.

Les symboles peuvent être appliqués directement à partir des résultats de la recherche comme décrit ci-dessus.

Pour restaurer la liste des noms de palette, qui est temporairement masquée par les résultats de la recherche, cliquez sur
X dans la zone de recherche.

Tout ce qui est ajouté à la partition à partir d'une palette peut être copié, collé et dupliqué: voir Copier / coller.

Personnalisez la liste des palettes

Changer l'ordre des noms de palette dans la liste

Faites glisser le nom d'une palette vers le haut ou vers le bas jusqu'à la position souhaitée.

Créer une nouvelle palette

1.En haut de la liste des palettes, cliquez sur Ajouter des Palettes→Créer une palette personnalisée. Ou, cliquez avec le bouton
droit n'importe où dans la liste des noms de palette et choisissez Insérer une nouvelle palette.
2. Tapez le nom de la nouvelle palette dans la boîte de dialogue Créer une palette ?.

Voir Personnaliser les palettes pour savoir comment ajouter des symboles à la nouvelle palette.

Cacher une palette de la liste

Le masquage d'une palette dépend du fait qu'il s'agit de l'une des palettes par défaut de Musescore ou de celle que vous
avez créée vous-même en utilisant la méthode ci-dessus.
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Pour cacher une palette par défaut Musescore:

Cliquez avec le bouton droit sur le nom de la palette que vous souhaitez cacher et cliquez sur Cacher la palette.

Pour cacher une palette que vous avez créée:

Cliquez avec le bouton droit sur le nom de la palette que vous souhaitez masquer, cliquez sur Cacher / supprimer la
palette, puis cliquez sur Masquer dans la boîte de dialogue.

Afficher une palette masquée dans la liste

Cliquez sur Ajouter des Palettes en haut de la liste des palettes et cliquez sur Ajouter à côté du nom de la palette.

Supprimer une palette

Seules les palettes que vous avez créées vous-même peuvent être supprimées.

Cliquez avec le bouton droit sur le nom de la palette que vous souhaitez supprimer, cliquez sur Cacher / supprimer la
palette, puis cliquez sur Supprimer définitivement dans la boîte de dialogue.

Vous ne pouvez pas supprimer les palettes par défaut de Musescore. Si vous n'avez pas l'intention d'utiliser une palette
par défaut, masquez plutôt son nom dans la liste.

Personnaliser les palettes

Vous pouvez modifier n'importe quelle palette Musescore par défaut ou créée par l'utilisateur. Des symboles peuvent être
ajoutés ou supprimés et les mises en page peuvent être réorganisées.

À partir de MuseScore 3.3, toutes les palettes prédéfinies dans les espaces de travail de Base et Avancé peuvent être
personnalisées directement (si vous utilisez une version précédente, vous devrez Créer un Espace de travail d'abord).

Avant de personnaliser une palette:

1. Cliquez avec le bouton droit sur le nom de la palette et assurez-vous que Activer l'édition est coché. Il est
automatiquement coché pour les nouvelles palettes que vous créez vous-même.

2. Assurez-vous que la palette est ouverte.

Ajouter un élément de partition existant à une palette

Appuyez et maintenez Ctrl+Maj (Mac: Cmd+Maj), puis faites glisser l'élément de partition vers une palette. L'élément de
partition peut être un symbole, une ligne, du texte, une nuance, un diagramme d'accord, Ajouter une image etc.

Ajouter un symbole à une palette à partir de la palette principale

1. Si la Palette Principale n'est pas visible, sélectionnez Affichage → Palette principale... à partir du menu ou utilisez le
raccourci clavier Maj+F9 (Mac: fn+Maj+F9).

2. Faites glisser le symbole de la fenêtre Palette Principale sur une palette.

Modifier l'ordre des symboles dans une palette

Faites glisser le symbole vers la cellule dans laquelle vous souhaitez l'afficher. Les symboles à proximité se
déplaceront automatiquement pour libérer de l'espace.

Modifier la position et la taille d'un symbole dans une cellule de palette

Cliquez avec le bouton droit sur la cellule et cliquez sur Propriétés.... La boîte de dialogue suivante s'affiche:

Nom: L'info-bulle qui apparaît lorsque vous passez la souris sur la cellule.
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Décalage du contenu X, Y: Ajuste la position du symbole dans la cellule.
Échelle actuelle: Fait apparaître le symbole plus grand ou plus petit dans la cellule.
Dessiner la portée: Dessine les cinq lignes d'une portée musicale derrière le symbole.

Remarque: La modification de ces valeurs affecte uniquement l'apparence des symboles dans la palette. Il ne modifie ni
leurs tailles ni leurs décalages sur la page de partition.

Supprimer un symbole d'une palette

Cliquez avec le bouton droit sur le symbole et cliquez sur Supprimer. Ou sélectionnez le symbole et cliquez sur l'icône
de la corbeille à droite du nom de la palette.

La commande Plus fonctionne différemment dans une palette créée par l'utilisateur. Il affiche une palette à la fois dans la
liste des palettes, vous permettant d'ajouter des symboles à partir de cette palette en faisant glisser ou en sélectionnant
un élément et en cliquant Ajouter à. Utilisez < and > pour parcourir les palettes de la liste.

Menu de la palette

Le menu suivant apparaît soit en cliquant avec le bouton droit sur le nom d'une palette, soit en cliquant sur ... à droite du
nom:

Cacher la palette: Supprime le nom de la palette de la liste des palettes disponibles.
Cacher / Supprimer la palette: Vous permet de masquer ou de supprimer définitivement une palette que vous avez créée
vous-même. Montré à la place de l'élément de menu ci-dessus.
Insérer une nouvelle palette: Crée une nouvelle palette vide. Identique à Ajouter des palettes→Créer une palette personnalisée.
Activer l'édition: Vous permet de modifier le contenu et la disposition de la palette.
Réinitialiser la palette: Ignore toutes les personnalisations apportées à une palette et restaure son contenu et sa
disposition par défaut.
Enregistrer la palette ... : Enregistre la palette actuelle sous forme de fichier .mpal.
Charger une palette ... : Charge une palette à partir d'un fichier .mpal et affiche le nom de la palette dans la liste.

Propriétés de la palette ...: Affiche la boîte de dialogue suivante, dans laquelle vous pouvez ajuster l'apparence d'une
palette:

Nom : Le nom affiché dans la liste des palettes.
Taille de la cellule : Largeur, Hauteur : Les dimensions de chaque cellule individuelle de la palette.
Décalage de l'élément : Ajuste le décalage vertical de tous les symboles de la palette.
Échelle : Fait apparaître tous les symboles de la palette plus grands ou plus petits.
Afficher la grille : Dessine une bordure autour de chaque cellule de la palette.

Comportement du texte et des lignes appliqués

Si le symbole que vous ajoutez à la partition à partir d'une palette contient un élément de Texte (par exemple, texte de
portée, dynamique, doigté, reprise, etc.), les propriétés telles que le type de police, la taille de la police, la couleur du
texte et l'alignement s'adapteront selon les règles suivantes:

1. Les propriétés du texte qui n'ont pas été modifiées par l'utilisateur adopteront les Styles de texte.

2. Les propriétés de texte personnalisées (celles modifiées par l'utilisateur avant d'enregistrer le symbole dans une
palette personnalisée) restent telles que personnalisées.

En revanche, les propriétés de la ligne de Lignes appliquée à partir d'une palette reste toujours inchangée (c'est-à-dire tel
que défini par l'utilisateur avant l'enregistrement dans un espace de travail personnalisé, ou tel que prédéfini dans les
espaces de travail de Base / Avancé).

Voir également

Palette principale
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Inspecteur

Afficher l'inspecteur

L'Inspecteur apparaît par défaut à droite de l'écran. Pour le voir ou le cacher, plusieurs choix :

Depuis le menu Affichage cochez ou décochez Inspecteur ; sinon utilisez le raccourcis clavier F8 (Mac : fn+F8).

Pour décrocher/raccrocher le panneaux de l'Inspecteur:

cliquez sur le symbole double-chevron ou double cliquez sur la barre de titre.

Pour rattacher le panneau, double-cliquez à nouveau sur la barre supérieure. Voir aussi : Panneaux latéraux.

Ce que fait l'Inspecteur

Lorsque vous sélectionnez un objet dans la fenêtre de partition, ses propriétés sont automatiquement affichées dans
l'Inspecteur où ils peuvent être modifiés. Plusieurs éléments peuvent également être sélectionnés et édités ensemble, à
condition qu'ils soient du même type. Cependant, si les objets sélectionnés sont de types différents, l'inspecteur vous
limite à la modification de la couleur et de la visibilité uniquement.

les boutons "Réinitialiser au style par défaut" et "Définir comme style"

Lorsque vous sélectionnez un élément de la partition, deux types de boutons sont clairement visibles sur le côté droit de
l'inspecteur:

Réinitialiser au style par défaut: . Cliquez sur ce bouton pour réinitialiser une propriété particulière à sa valeur
par défaut, c'est-à-dire. celui montré dans le menu Style.

Définir comme style: . Cliquez sur ce bouton pour faire de la valeur d'une propriété particulière, la nouvelle
valeur par défaut du style. Cela mettra à jour le menu Style et tous les autres objets régis par ce style.

Remarque: Vous pouvez également modifier les styles directement à partir du menu Style.

Les catégories dans l'inspecteur

Les propriétés sont commodément répertoriées sous catégories dans l'inspecteur. Les différentes Catégories peuvent
être identifiées par leur écriture en gras. Par exemple, si vous sélectionnez une barre de mesure, vous verrez les
éléments suivants affichés en haut de l'inspecteur:
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Pour plus de détails sur les différentes catégories et leurs propriétés, voir ci-dessous:

Élément

Tous les éléments de partition, à l'exception des cadres, des sauts et des espacements, affichent cette catégorie dans
l'inspecteur lorsqu'ils sont sélectionnés. Les options sont les suivantes:

Visible: Décochez cette case pour rendre les éléments sélectionnés invisibles; ou utilisez le raccourci V (bascule).
Les éléments invisibles n'apparaissent pas dans la musique lorsqu'ils sont imprimés ou exportés sous forme de PDF
ou d'image. Si vous souhaitez qu'ils restent affichés dans la fenêtre du document, assurez-vous que l'option
"Afficher les éléments invisibles" est sélectionnée dansAffichage → Afficher les éléments invisibles . Les éléments invisibles
seront alors colorés en gris clair.

Couleur: Cliquez sur le rectangle pour ouvrir une boîte de dialogue "Choisir la couleur". Ajustez la couleur et
l'opacité des éléments sélectionnés.

Placement automatique: Voir Placement automatique.

Distance minimum: Distance minimum par rapport aux autres éléments lorsque le placement automatique est
activé.

Décalage X/Y: Vous permet de positionner exactement les éléments sélectionnés (en termes d'unités d'espace
(spatium en anglais)). Un nombre positif déplace les éléments vers la droite ou vers le bas; un nombre négatif
déplace les éléments vers la gauche ou vers le haut. Les boutons pour activer Aligner sur la grille horizontale ou
verticale sont proposés aussi.

Position dans la pile (Z): Voir Placement automatique: ordre d'empilage

Groupe d'éléments

Cette catégorie s'affiche uniquement lorsque vous avez sélectionné un mélange de différents types d'éléments et permet
uniquement de modifier la couleur, la visibilité et le placement automatique.

Segment

Espace de début: Utilisez cette option pour augmenter ou réduire l'espace avant un élément. Cela affecte
également toutes les syllabes lyriques associées.

Accord
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Décalage X/Y: Cela change la position de chaque note dans la même voix que la ou les notes sélectionnées. Si
vous souhaitez modifier la position de une seule note, utilisez la catégorie Élément à la place).
Taille réduite: Donne des têtes de notes et des hampes petites.
Sans hampe: Supprime les hampes.
Direction de la hampe: Choix de Automatique, Haut ou Bas.

Note

Cette catégorie vous permet d'apporter des modifications aux notes sélectionnées (mais pour la position des notes — voir
Élement). Il contient les propriétés suivantes:

Taille réduite: Réduisez la taille de la tête de note (vous pouvez spécifier la taille relative de toutes les petites notes
dans le menu: Format → Style… → Tailles).
Type de tête de note: Voir Formes de têtes de notes.
Groupe de tête: Voir Groupes de tête de note.
Type de tête: Voir Changer de type de tête de note.
Tête de note miroir: Positionnez la tête de note à gauche ou à droite de la hampe (la valeur par défaut est "Auto").
Fixer à la ligne: Lorsqu'elle est cochée, la note est fixée sur la ligne supérieure de la portée standard à 5 lignes.
Ligne: Un nombre positif déplace la note «fixe» vers le bas; un nombre négatif le déplace vers le haut.
Lecture: Décochez cette case pour rendre la note muette.
Réglage du diapason: Ajustez l'accordage de la note au plus proche cent.
Type de vélocité: Règle directement la vélocité MIDI des notes. Choisissez l'une des deux options:

Décalage: Rendre la valeur indiquée dans "Vitesse" _ relative_ par rapport au marquage dynamique
précédent.
Personnalisé: Rendre la valeur indiquée dans "Vélocité" absolue (c'est-à-dire que la vitesse MIDI n'est pas
affectée par les marquages dynamiques).

Vélocité: Réglez la vélocité MIDI en fonction de l'option affichée dans "Type de vélocité".

Sélection

Cette catégorie apparaît différemment selon la sélection que vous avez effectuée:

Si vous sélectionnez une tête de note, la catégorie "Sélection" affiche des boutons qui vous permettent de basculer
facilement la sélection sur la hampe, la ligature, le crochet, le point de durée (ou les points) ou le numéro de division
irrégulière associé à la tête de note (voir image ci-dessous).

Si vous sélectionnez une plage de mesures, la catégorie "Sélection" vous permet de sélectionner toutes les Notes,
Fioritures ou Silences.

Ligature

Cette section s'affiche dans l'inspecteur lorsque vous sélectionnez une ou plusieurs Ligatures de notes et vous permet
d'effectuer des réglages précis de la position et de l'angle de la ligature, ainsi que de modifier l'espacement des notes
ligaturées.

Clef

Cette section apparaît lorsque vous sélectionnez une clef: la case à cocher permet d'activer / désactiver l'affichage d'un
précédent Rappel de Clef.

Articulation
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Cette catégorie apparaît lorsque vous sélectionnez une Articulations ou ornements. Les options suivantes sont
disponibles:

Direction: Si le symbole pointe vers le haut ou vers le bas: applicable uniquement à certains symboles.
Point d'ancrage: Le placement vertical du symbole:
Lecture: Activez / désactivez l'effet de lecture.
Durée: Uniquement applicable aux points d'orgue. Vous permet de faire varier la pause de lecture.
Style d'ornement: Un choix de lecture par Défaut ou Baroque.

Diagrammes d'accord

Voir Diagrammes d'accord.

Ligne

Cette catégorie s'affiche lorsqu'une Ligne est sélectionnée. Ici, vous pouvez définir diverses propriétés générales.

Visible: Masquer ou afficher uniquement la ligne: tout texte reste visible.
Autoriser la diagonale: La valeur par défaut est horizontale (décochée). Cochez si vous souhaitez éditer la ligne
pour créer une pente.
Couleur/Épaisseur/Style de la Ligne: Définissez diverses propriétés de la ligne.

Détails de la ligne de texte

Cette catégorie s'affiche lorsqu'une Ligne est sélectionnée. Il vous permet de définir le libellé d'une ligne, de modifier les
propriétés du texte, de définir des crochets de ligne et d'aligner le texte par rapport à la ligne.

Début du crochet / Hauteur: Au début de la ligne, spécifiez Aucun, 90 ° (vertical), 45 ° (incliné) ou 90 ° centré;
régler la longueur du crochet.

Fin du crochet / Hauteur: Idem pour la toute fin de ligne.

Texte du début / Texte de prolongement / Texte de fin: Fait référence au texte au tout début de la ligne; au début
de toute ligne de prolongement; ou à la fin de la toute dernière ligne. Tous ont les mêmes propriétés, comme suit:

Texte: Créez ou modifiez le texte associé à la ligne.
Police / Taille / Style: Définit le Style de texte, et/ou modifie le Style de texte de la ligne.
Alignement: Définissez l'alignement horizontal et vertical du texte par rapport à la ligne.
Placement: Placez le texte sur (Au-dessus / Au-dessous) ou à Gauche de la ligne.
Décalage X / Y: Ajustez les décalages X et Y pour un positionnement exact.

Boîtes de dialogue des propriétés

Certains types d'objets ont des propriétés supplémentaires. On y accède en cliquant avec le bouton droit sur l'objet et en
choisissant une option "... propriétés" dans le menu contextuel. Les paramètres disponibles dans ces boîtes de dialogue
sont expliqués dans la description du type d'objet dans les rubriques Notation ou Fonctionnalités avancées.
Voir:

Articulations et ornements
Indications de mesure
Texte de portée et de système
Opérations sur les mesures
Propriétés de la portée / partie...

Voir aussi

Saisie des notes
Mise en page et formatage
Partie

Opérations sur les mesures

Remarque : Pour s'assurer que l'insertion ou l'ajout de mesures s'affichent correctement, Afficher les pauses
multimesures devrait être désactivé (bascule M).

Sélection

Une mesure uniquement

Pour sélectionner une mesure uniquement, cliquez dans un espace vide de cette mesure.
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Suite de mesures

Pour sélectionner une suite de mesures, voir Sélection d'une suite de mesures et Sélection avec Maj.

Insertion

Insérer une mesure vide

Utilisez l'une des options suivantes :

Sélectionnez une mesure ou un cadre, puis appuyez sur Insér. ou Ins (pas de raccourci sur Mac).
Sélectionnez une mesure ou un cadre, puis choisissez dans le menu : Ajouter→Mesures→Insérer une mesure.

Insérer plusieurs mesures

Utilisez l'une des options suivantes :

Sélectionnez une mesure ou un cadre, puis appuyez sur Ctrl+Insér. (pas de raccourci sur Mac); remplissez le champ
"Nombre de mesures à insérer" et cliquez sur OK.
Selectionnez une mesure ou un cadre, puis choisissez dans le menu : Ajouter→Mesures→Insérer des mesures...;
remplissez le champ "Nombre de mesures à insérer" et cliquez sur OK.

Ajout

Ajouter une mesure à la fin d'une partition

Utilisez l'une des options suivantes :

Appuyez sur Ctrl+B (Mac : ⌘+B).
Choisissez dans le menu : Ajouter→Mesures→Ajouter une mesure.

Ajouter plusieurs mesures à la fin d'une partition

Utilisez l'une des options suivantes :

Appuyez sur Alt+Maj+B (Mac : Option+Maj+B); remplissez le champ "Nombre de mesures à ajouter" et cliquez sur OK.
Choisissez dans le menu : Ajouter→Mesures→Ajouter des mesures...; remplissez le champ "Nombre de mesures à ajouter"
et cliquez sur OK.

Supprimer

Supprimer une simple mesure

Sélectionnez la mesure, et appuyer sur Ctrl+Suppr (Mac : Cmd+Suppr).

Supprimer une suite de mesures

1. Sélectionnez la suite de mesures à supprimer;
2. Appuyez sur Ctrl+Suppr (Mac : Cmd+Suppr).

Remarques : Dans les partitions multi-portées, la suppression de mesure supprime également toutes les mesures
correspondantes dans les autres portées du système;

Supprimer les mesures de fin vides

Pour supprimer automatiquement les mesures vides de la fin de la partition :

Choisissez dans le menu : Outils→Supprimer les mesures restantes .

Supprimer le contenu de la mesure

Si vous souhaitez supprimer uniquement le contenu de la mesure (et non la mesure elle-même) :

1. Sélectionnez une ou plusieurs mesures;
2. Appuyez sur Del.

Propriétés

Pour éditer les propriétés d'une mesure, clic-droit sur une partie vide de la mesure et sélectionner Propriétés de la mesure... :

57



Vous pouvez utiliser les flèches en bas à gauche de la fenêtre  pour naviguer vers les mesures précédentes ou
suivantes.

Portées

Visible cochez/décochez pour afficher/masquer les notes et les lignes de portée pour la mesure sélectionnée.
Sans hampe cochez/décochez pour afficher/masquer toutes les hampes de notes pour la mesure sélectionnée.

Durée de la mesure

Cette fonction vous permet d'ajuster la signature rythmique d'une seule mesure quelle que soit la signature rythmique
indiquée dans la partition. Vous pouvez l'utiliser pour créer une Anacrouse (également appelée Levée), cadence, section
ad lib etc.

Nominale est la signature rythmique apparente et ne peut pas être modifiée.
Réelle peut être réglé sur tout ce que vous voulez, quelle que soit la signature rythmique nominale.

Exemple : Dans la figure ci-dessous, la noire en Anacrouse a une durée Nominale de 4/4, mais une durée Réelle de 1/4.
Les mesures du milieu ont toutes les deux une durée Nominale et Réelle de 4/4. La mesure complémentaire avec une
blanche pointée à la fin présente une durée Réelle de 3/4 :

Remarque : Un petit signe - ou + apparaît au-dessus de la mesure lorsque sa durée est différente de celle indiquée par la
signature rythmique (voir l'image ci-dessous). Cela n'apparaît sur aucune copie imprimée ou PDF. Vous pouvez
désactiver ces marques en décochant "Marquer les mesures irrégulières" dans le Menu Affichage.
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Autres

Mesures non comptées

Mesure non comptée : Cochez pour exclure la mesure sélectionnée de la numérotation des mesures (par exemple,
une anacrouse).

Diviser les pauses multimesures

Diviser les pauses multimesures : Cocher pour éviter une pause multimesures au début de la mesure
sélectionnée. Cette option devrait être vérifiée avant de cocher l'option "Créer des pauses multimesures" dans
Format→Style...→Partition. Cette option est décochée par défaut pour la partition, et cochée par défaut pour les Parties.

Remarque : Les pauses multi-mesures sont automatiquement divisées lors d'importants changements tels que les
repères de répétition, les changements d'indications de mesure, les doubles barres, mesures irrégulières, etc.

Mode de numérotation de la mesure

Cela vous permet de contrôler si et comment les numéros de mesure s'affichent sur la mesure sélectionnée:

Automatique Suit le réglage de Format→Style...→Numéros de mesure .
Toujours afficher Force l'affichage du nombre.
Toujours masquer Cache le nombre.

Étirement de la mesure

Étirement de la mesure Contrôle la quantité d'espace horizontal entre les éléments de la partition (notes, silences,
etc.).

Ce réglage permet un degré de contrôle plus précis que celui offert par Étirer/Rétrécir ({ et }).

Ajouter au numéro de mesure

Vous pouvez aussi utiliser l'option "Ajouter au numéro de mesure" pour modifier le numéro de la mesure. Vous pouvez
entrer un nombre positif ou négatif. Merci de noter que cela affecte les mesures suivantes. Une valeur de "-1" a le même
effet que de marquer la mesure comme "Mesure non comptée".

Nombre de lecture

Si la mesure contient une barre de reprise Reprise , vous pouvez définir le nombre de fois qu'elle est jouée.

Numérotation

Par défaut, MuseScore numérote la première mesure de chaque système (à l'exception de la première mesure d'une
section), mais d'autres options de numérotation sont disponibles : voir Format→Style...→Numéros de mesure.

Scinder et joindre

Vous voudrez peut-être avoir une mesure plus longue ou plus courte sans changer la signature rythmique. Vous pouvez
modifier la durée de la mesure dans Propriétés de la mesure, mais il existe également la possibilité de scinder ou de
joindre des mesures.

Joindre les mesures

Méthode A. Pour joindre deux mesures seulement :

Sélectionnez la barre de mesure entre les deux mesures et appuyez sur Ctrl + Suppr.

Méthode B. Pour joindre plusieurs de mesures :

1. Sélectionnez les mesures que vous souhaitez joindre;
2. Dans la barre de menu, sélectionnez Outils→Mesure→Joindre les mesures sélectionnées .

Remarques :
(1) Si vous sélectionnez des mesures sur une seule portée dans une partition à plusieurs portées, les mêmes mesures
seront jointes dans chaque portée du système.
(2) Les ligatures seront automatiquement modifiées.

Scinder une mesure

59



Choisissez l'une des méthodes suivantes :

Sélectionnez une note; puis maintenez Ctrl et cliquez sur une barre de mesure dans une palette (double-cliquez sur
les versions antérieures à la 3.4).
Maintenez Ctrl et faites glisser une barre de mesure (à partir d'une palette) vers la note qui commence la mesure
suivante.
Sélectionnez une note; puis, dans la barre de menu, sélectionnez Outils→Mesure→Scinder la mesure avant la Note / Silence
sélectionné.

Remarque : Si vous sélectionnez une seule note sur une portée, chaque portée du système sera divisée au même
endroit.

Liens externes

Comment étirer une mesure à travers plusieurs systèmes  (MuseScore HowTo, 1.x) (en anglais)
Comment supprimer des mesures  (MuseScore HowTo) (en anglais)
Comment obtenir une partition sans indications de mesure (et sans clefs)  (MuseScore HowTo) (en anglais)

Voix

Une voix est une ligne ou une partie musicale qui peut avoir son propre rythme indépendamment des autres voix sur la
même portée. Les voix sont parfois appelées "Layers" ou "Couches" dans d'autres logiciels de notation.

Vous pouvez avoir jusqu'à 4 voix sur chaque ligne de portée. Dans une mesure polyphonique, les notes de la voix 1 (et
3) ont habituellement les hampes vers le haut tandis que les notes de la voix 2 (et 4) ont habituellement hampes vers le
bas.

N.B. Veillez à ne pas confondre le concept de voix MuseScore (1, 2, 3, 4) avec l'ordre des voix présentes dans les
partitions vocales SATB:

Dans les partitions Open score SATB (où quatre portées sont utilisées pour les quatre voix), utilisez la voix 1 (de
MuseScore) dans chaque portée.
Dans les partitions Close / Closed SATB (SATB complet) (où deux portées sont utilisées pour les quatre voix, par
exemple, comme dans les cantiques), n'utilisez que les voix 1 et 2 (de MuseScore) pour les portées supérieures et
inférieures, par exemple : utilisez les voix 1 & 2 pour les parties Soprano et Alto sur la portée du haut, et utilisez les
voix 1 & 2 pour les parties Ténor et Basse sur la portée du bas.
Il n'est pas nécessaire d'utiliser les voix 3 et 4 (de MuseScore) à moins qu'il y ait plus de deux parties dans la même
portée. Cela signifie que dans la clé de fa d'une SATB complet, le ténor est la voix 1 et la basse est la voix 2 - les
débutants souvent sans réfléchir attribuent la basse à 1, ce qui entraîne une confusion dans le sens de la racine, ou
assigne le ténor à la voix 3 et la basse à la voix 4, ce qui conduit alors à des silences déroutants apparaissant dans
la voix 1 (qui ne peuvent pas être supprimés).

Comment les voix sont affichées

La Sélection d'une partie de la partition met en évidence chaque voix dans une couleur différente: voix 1 bleue, voix 2
verte, voix 3 orange et voix 4 violette.

Quand utiliser des voix ?

Si vous avez besoin de hampes pointant dans des directions opposées dans un accord, sur une seule portée.
Si vous avez besoin de notes de durées différentes dans une seule portée, jouées simultanément.

Comment saisir des notes dans différentes voix

Les instructions suivantes vous montrent comment noter un passage de musique à deux voix:

1. Saisir les notes de la voix 1: Assurez-vous que vous êtes en mode Saisies de notes : le bouton Voix 1 devient

surligné en bleu dans la barre d'outils.  Saisissez d'abord les notes dans la voix supérieure. Lors de la
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saisie, certaines notes peuvent avoir des tiges vers le bas, mais celles-ci basculeront automatiquement lorsque la
deuxième voix sera ajoutée.

L'extrait suivant montre une portée aiguë avec juste les notes de la voix 1 entrées:

2. Déplacer le curseur au début de la portée: Lorsque vous avez terminé d'entrer une portée de notes de la voix 1,
appuyez sur la touche ← à plusieurs reprises pour déplacer le curseur, note par note, vers la première note de la
portée; ou bien utiliser Ctrl+← (Mac:Cmd+←) pour reculer le curseur d'une mesure à la fois. Ou bien vous pouvez
simplement quitter le mode Saisies de notes (appuyez sur Esc) et cliquez directement sur la première note.

3. Entrez les notes de la voix 2: Assurez-vous que vous êtes en mode de saisie de notes et que la note de la voix 1

au début de la section est sélectionnée. Cliquez sur le bouton "Voix 2"  (à droite de la barre d'outils), ou utilisez le
raccourci Ctrl+Alt+2 (Mac: Cmd+Alt+2). Entrez toutes les notes de la voix inférieure (hampe vers le bas).

L'image suivante montre l'exemple ci-dessus après l'ajout des notes de la voix 2:

Suppression et masquage des silences

Tous les silences peuvent être rendus invisibles, si nécessaire: sélectionnez le(s) silence(s) souhaité(s) et appuyez sur V,
ou décochez la case "Visible" dans l'Inspecteur. Les silences des voix 2, 3 ou 4 (mais pas la voix 1) peuvent également
être supprimés (en les sélectionnant et en appuyant sur Suppr) mais ce n'est pas recommandé: rendez-les plutôt
invisibles.

Un silence en Voix 1 ne peut être supprimé qu'en supprimant également cette partie de la mesure de la partition: voir
Supprimer la plage sélectionnée; ou Supprimer une ou des mesures.

Restauration des silences supprimés

Si un silence a été supprimé dans les voix 2-4, vous devrez le restaurer avant de pouvoir saisir une note sur ce temps
dans ces voix (le problème peut survenir, par exemple, dans des fichiers XML ou MIDI). Le moyen le plus simple de
corriger une telle mesure est d'échanger cette voix avec la voix 1 deux fois. Pour la méthode exacte, voir Échangez des
Voix (ci-dessous).

Échanger des Voix

Pour Échanger les notes entre deux voix:

1. Selectionner une ou plusieurs mesures continues (ou une suite de notes);
2. Dans la barre de menu, sélectionnez Outils → Voix;
3. Sélectionnez l'option des deux voix que vous souhaitez échanger.

Remarques: (a) La sélection peut englober le contenu de n'importe quelle voix, mais seulement deux seront traitées à la
fois. (b) Si vous sélectionnez une mesure partielle, l'opération s'appliquera toujours à la mesure entière.

Déplacer les notes vers une autre voix (sans échange)

Vous pouvez également déplacer des notes d'une voix à une autre (sans échange de notes):

1. Assurez-vous que vous n'êtes pas en mode de saisie de notes.
2. Sélectionnez une ou plusieurs têtes de note (dans n'importe quelle voix).
3. Cliquez sur la voix de destination dans la Barre d'outils Saisie des notes ou utilisez le raccourci Ctrl+Alt+1–4 (Mac:

Cmd+Alt+1-4).

Remarque: Pour un déplacement réussi, les conditions suivantes doivent être remplies:

L'accord (ou les accords) dans la voix de destination doit avoir la même durée que la note (qui doit changer de voix).
Il doit y avoir suffisamment d'espace de silence (temps) libre dans la voix de destination, pour insérer la note.
Les notes ne doivent pas être connectées par une liaison de prolongation.

Naviguer entre les voix

Pour sélectionner une note dans une voix plus élevée que la voix actuelle:

1. Utilisez Alt + ↓, pour déplacer la sélection vers la note la plus basse de la voix actuelle.
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2. Appuyez Alt + ↓, pour passer à la voix de numéro supérieur.
3. Répétez l'une des étapes ci-dessus, si nécessaire, jusqu'à ce que la note souhaitée soit sélectionnée.

Pour sélectionner une note dans une voix numérotée plus basse que la voix actuelle:

1. Utilisez Alt + ↑, pour déplacer la sélection vers la note la plus haute de la voix actuelle.
2. Appuyez Alt + ↑, pour passer à la voix la plus petite.
3. Répétez l'une des étapes ci-dessus, si nécessaire, jusqu'à ce que la note souhaitée soit sélectionnée.

Voir également

Raccourcis clavier: Voix
Têtes de notes: Têtes de notes Partagées

Liens externes

Comment fusionner / combiner / imploser deux portées en une avec deux voix  (MuseScore HowTo)
Comment saisir plusieurs notes sur une portée avec des durées différentes  (MuseScore HowTo)
Tutoriel Vidéo: Comment écrire deux parties sur une portée: voix

Annuler et rétablir

MuseScore se souvient d'un nombre illimité d'actions d'annulation / rétablissement.

Les raccourcis clavier standards sont :

Annuler Ctrl+Z (Mac : Cmd+Z)
Rétablir Ctrl+Maj+Z ou Ctrl+Y (Mac : Cmd+Maj+Z)

Ou bien utilisez les boutons de la barre d'outils : 

Copier / Coller

MuseScore prend en charge les opérations standard Copier, Couper, Coller et Échanger avec le presse-papier. Ces
commandes peuvent être appliquées à une plage de:

Notes de musique: pour répéter une plage musicale, ou décaler un passage d'un temps ou d'une mesure.
Éléments divers: tels que les articulations, le texte de portée, la dynamique, le doigté, etc.

Les commandes Copier/Couper/Coller/Échanger avec le presse-papier sont accessibles de trois manières:

Depuis le menu Édition (au-dessus de la fenêtre du document).
Depuis le menu affiché en faisant clic-droit sur un élément ou une plage d'éléments.
En Utilisant l'un des raccourcis clavier standards.

Résumé des commandes

Commande Racc. clavier
(Win)

Racc. clavier
(Mac) Menu clic droit Menu Principal

Couper Ctrl+X Cmd+X Couper Édition → Couper
Copier Ctrl+C Cmd+C Couper Édition → Copier
Coller Ctrl+V Cmd+V Coller Édition → Coller
Échanger avec le presse-
papier Ctrl+Shift+X Cmd+Shift+X

Échanger avec le
presse-papier

Édition → Échanger avec le
presse-papier

Remarque: Avant d'effectuer une procédure de Copier, Couper, Coller ou Échanger, vous devez être en mode normal.
Appuyez sur la touche Esc pour passer en mode normal.

Notes

Vous pouvez Couper, Copier, Coller ou Échanger des notes comme suit:

Copier ou Couper

Pour Copier ou Couper un simple accord

1. Maintenez Maj et cliquez sur une note dans l'accord.
2. Appliquez une commande Copier ou Couper (voir le tableau au dessus).
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Pour Copier ou Couper une suite d'accords

1. Clic sur la première note ou mesure que vous souhaitez sélectionner.
2. Maj+Clic sur la dernière note ou mesure que vous souhaitez sélectionner. Un rectangle bleu met en évidence la

région que vous avez sélectionnée.
3. Appliquez une commande Copier ou Couper (voir le tableau au dessus).

Coller

1. Clic sur la note ou la mesure où vous souhaitez que votre sélection collée commence.
2. Appliquez une commande Coller (voir le tableau au dessus).

Échanger avec le presse-papier

L'opération Échanger avec le presse-papier combine deux commandes en une seule: (1) Tout d'abord, il écrase une
partie sélectionnée de la partition avec le contenu du presse-papiers, tout comme la commande Coller; (2)
Deuxièmement, il transfère la partie écrasée de la partition vers le presse-papiers, tout comme la commande Copier.

Il peut être utilisé, par exemple, pour permuter deux sections de longueur égale d'une partition, A and B:

1. Sélectionnez la section A, puis appliquez la commande Couper;
2. Effacer la sélection (en appuyant sur Esc ou en cliquant sur une zone vide de la fenêtre du document);
3. Appuyez sur Maj et cliquez sur une note au début de la section B. Ou, si B commence au début d'une mesure, vous

pouvez aussi simplement sélectionner la mesure;
4. Appliquez une commande Échanger avec le presse-papier (voir [tableau](# command-summary) ci-dessus).
5. La section B est maintenant dans le presse-papiers. La Coller dans la zone vierge de partition laissée par l'étape

"1".

Copier seulement la hauteur d'une note

Il est possible de copier la hauteur d'une note uniquement (et aucune autre propriété), en cliquant sur la tête de note et en
appliquant la procédure standard de copier-coller ou de copier-échanger. La hauteur de la note de destination change
pour correspondre à celle de la note copiée, mais la durée reste la même.

Autres éléments

Certains éléments tels que le texte de portée, la dynamique, le doigté, etc. ne peuvent être coupés, copiés et collés que
un par un. Cependant, d'autres éléments permettent une "sélection-multiple" Couper/Copier/Coller: comme les
articulations (sforzato, staccato etc.), les diagrammes d'accord de guitare, et les symboles d'accords.

Remarque: La commande Échanger avec le presse-papier est uniquement destinée à être utilisée avec des plages de la
partition et pas avec d'autres éléments de partition.

Copier ou Couper

1. Sélectionnez l'élément (ou les éléments).
2. Appliquez une commande Copier ou Couper (voir tableau ci-dessus).

Coller

1. Clic sur la note où vous voulez que votre sélection collée commence.
2. Appliquez l'une des commandes Coller (voir tableau ci-dessus).

Dans le cas des articulations, elles sont collées sur les notes de destination exactement dans le même ordre (continu ou
intermittent) que lors de la sélection initiale.

Répétition rapide

Pour copier et coller rapidement une note, une mesure ou un passage:

1. Sélectionnez un accord, une mesure ou un passage comme décrit ci-dessus.
2. Appuyer sur R .

MuseScore copie et colle la notation sélectionnée à un point immédiatement après la dernière note de la sélection. Toute
musique existante dans la plage de destination est remplacée.

Duplication

Pour copier et coller instantanément un élément de texte, une ligne ou un autre objet:

1. Maintenez Ctrl+Maj (Mac: Cmd+Maj), cliquez sur l'élément et faites-le glisser n'importe où dans la partition.
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2. Relâchez le bouton de la souris et l'élément sélectionné est cloné vers le nouvel emplacement.

Collage demi durée / double durée (version 3.1 et au dessus)

Ces commandes vous permettent de Copier / Couper une section de la partition, puis de la coller n'importe où avec toutes
les durées de notes divisées par deux ou doublées.

1. En mode Normal, Sélectionnez une suite de notes dans la partition;
2. Couper ou Copier la sélection;
3. Sélectionnez une note de destination (ou une mesure);
4. Dans le menu, sélectionnez l'une des options suivantes:

Édition→Collage demi durée (Mac: MuseScore→Collage demi durée).
Édition→Collage double durée (Mac: MuseScore→Collage double durée).

Filtre de sélection

Le Filtre de sélection vous permet de choisir exactement les voix et les éléments que vous souhaitez inclure dans votre
sélection.

Pour afficher le Filtre de Sélection, appuyez sur F6 (Mac: fn+F6); ou dans le menu, choisissez Affichage→Filtre de
Sélection.

Le Filtre de Sélection apparaît par défaut sous les Palettes. Pour modifier l'emplacement de visualisation, voir Modes
d'affichage et navigation: Panneaux latéraux.

Exemple: Supposons que vous vouliez copier les mesures 1 et 2 dans le passage suivant (voir image), pour donner les
mesures 3 et 4:

1. Assurez-vous que le Filtre de Sélection est affiché (voir ci-dessus);
2. Décochez les cases "Articulations", "Ornements" et "Liaisons de phrasé";
3. Copiez et collez les mesures souhaitées (dans cet exemple, 1-2 dans 3-4).

Remarque: Le Filtre de Sélection fonctionne également avec la commande Échanger avec le presse-papier.

Voir aussi

Si vous souhaitez changer des notes sans modifier le rythme, vous pouvez combiner le mode hauteur avec Copier et
Coller.

Liens externes

Tutoriel vidéo: Paroles, Copier et nuances

Modes d'affichage et navigation

Ce chapitre décrit les options disponibles dans le menu Affichage et dans les menus Zoom et Affichage par page /
Affichage continu / Une seule page (situés dans la barre d'outils au-dessus de la partition). Il détaille également les
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différentes commandes et fonctions de navigation.

Menu Affichage

Afficher les Barres Latérales / Panneaux

Palettes: F9
Palette principale: Maj+F9 (Mac: Fn+Maj+F9)
Inspecteur: F8 (Mac: Fn+F8)
Fenêtre de lecture: F11 (Mac: Fn+F11)
Navigateur
Timeline: F12
Mélangeur: F10 (Mac: Fn+F10)
Synthétiseur
Filtre de sélection: F6 (Mac: Fn+F6)
Clavier de piano: P
Outil de comparaison des partitions

Zoom avant/arrière

Il existe plusieurs façons de faire un zoom avant ou arrière sur la partition:

Raccourci clavier:

Zoom avant: Ctrl++ (Mac: Cmd++)
Zoom arrière: Ctrl+- (Mac: Cmd+-).

menu Affichage:

Zoom avant: Affichage→Zoom avant
Zoom arrière: Affichage→Zoom arrière.

Souris

Zoom avant: Faites défiler vers le haut avec la molette de la souris tout en maintenant enfoncéeCtrl (Mac: Cmd)
Zoom arrière: Faites défiler vers le bas avec la molette de la souris tout en maintenant enfoncée Ctrl (Mac:
Cmd).

Menu déroulant: Pour définir un zoom spécifique, utilisez le menu déroulant de la barre d'outils standard pour
définir l'agrandissement de la vue du score (25–1600%) ou affichez-le à l'aide des options «Largeur de page»,
«Page entière» ou «Deux pages».

Vous pouvez saisir un % de zoom personnalisé dans le champ déroulant si le niveau de zoom souhaité n'est pas
disponible par défaut.

Pour revenir au zoom à 100%: Utilisez le raccourci Ctrl+0 (Mac: Cmd+0).

Barres d'outils

La zone Barres d'outils est située entre la Barre de menu et la Fenêtre du document.

Elle contient les barres d'outils suivantes:
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Opérations sur fichier: Créer une nouvelle partition, Charger une partition, Enregistrer la partition dans un fichier,
Enregistrer la partition sur Musescore.com, Imprimer la partition ou la partie, Annuler, Rétablir.
Zoom / Affichage de la page.
Commandes de lecture: Activer MIDI, Aller au début, Démarrer ou arrêter la lecture, Lecture en boucle, Jouer les
reprises, Métronome.
Tonalité réelle: Affiche la partition dans la tonalité réelle ou transposée.
Capture d'image: Vous permet de prendre un instantané d'une partie de la partition.
Saisie de notes: Mode de saisie des notes, Durée, Liaison de prolongation, Silence, Altérations, Sens des hampes,
Voix (1, 2, 3, 4).

Afficher / masquer les barres d'outils

Pour afficher ou masquer certaines barres d'outils:

Sélectionnez Affichage→Barres d'outils, et cochez / décochez les options selon les besoins.
Vous pouvez également cliquer avec le bouton droit de la souris sur un espace vide dans la zone de la barre
d'outils, ou sur la barre de titre de l'inspecteur, et, dans le menu, cocher ou décocher les options requises.

Remarque: Cette option vous permet également d'afficher ou de masquer la Timeline, l'Outil de comparaison de partition,
(Script Recorder pour développeurs et testeurs), le Clavier de piano, le Filtre de sélection et les Outils de set de batterie..

Personnaliser la zone de la barre d'outils

Sélectionnez Affichage→Barres d'outils, and cliquer sur "Personnaliser les barres d'outils…"

La boîte de dialogue affiche les barres d'outils personnalisables à gauche, les boutons d'outils actuels de la barre d'outils
sélectionnée au milieu et les boutons pouvant être ajoutés à droite. Lorsque vous avez sélectionné une barre d'outils dans
le panneau de gauche, vous pouvez effectuer l'une des actions suivantes:

Supprimer un bouton d’outil: Sélectionnez le bouton dans le panneau central et appuyez sur →.
Ajouter un bouton d'outil: Sélectionnez le bouton dans le panneau de droite et appuyez sur ←.
Déplacer un bouton d'outil: Sélectionnez le bouton dans le panneau central et déplacez-le vers le haut ou vers le
bas à l'aide de ↑ or ↓.

Remarque: La barre d'outils ne peut être personnalisée que si un espace de travail personnalisé est sélectionné (voir ci-
dessous).

Espaces de travail

Sélectionnez cette option pour Créer un espace de travail personnalisé or to Éditer un espace de travail.

Afficher la Barre d'état

La Barre d'état, en bas de l'écran, donne des informations sur la sélection active. Cochez/décochez cette option pour la
cacher ou la voir.

Visualiser deux partitions

Il est possible de fractionner l'affichage des partitions de manière à visualiser deux partitions à la fois, ou de visualiser
deux parties différentes de la même partition.Les onglets vous permettent de choisir la partition à afficher dans chaque
vue. Vous pouvez faire glisser la barre séparant les deux partitions pour ajuster la quantité d'espace dans la fenêtre
consacrée à chacune:

66



Ducuments côte à côte: Divise la fenêtre verticalement en deux vues de partition.
Documents empilés: Divise la fenêtre horizontalement en deux vues de partition, l'une au-dessus de l'autre.

Options de visibilité

Cette section vous permet de cacher/voir divers éléments non imprimables:

Afficher les éléments invisibles: cacher/voir les éléments rendus invisibles à l'impression et à l'export. Si cette
option est cochée, les éléments invisibles sont affichés dans la fenêtre de partition en gris clair.
Afficher les éléments non imprimables: cacher/voir les Sauts et espacements.
Afficher les cadres: cacher/voir les pointillés des Cadres.
Afficher les marges: cacher/voir les Marges des pages.

Marquer les mesures irrégulières

Un tiret en haut à droite d'une mesure indique que sa durée diffère de celle définie par la signature rythmique.

Plein écran

Le mode plein écran étend MuseScore sur tout votre écran pour obtenir un contenu plus visible.

Affichage par page/continu

Vous pouvez basculer entre différentes vues de la partition à l'aide de la liste déroulante dans la zone barre d'outils:

Pour faire défiler la partition:

Verticalement: Déplacez la molette de la souris vers le haut ou vers le bas.
Horizontalement: Pressez Maj et déplacez la molette de la souris vers le haut ou vers le bas.

Affichage par page

Avec Affichage par page, la partition est mise en forme telle qu'elle apparaîtra lorsqu'elle sera imprimée ou exportée
sous forme de fichier PDF ou image: c'est-à-dire page par page, avec des marges. MuseScore applique le saut de
système (ligne) et le saut de page Sauts automatiquement, selon les réglages effectués dans Paramètres de la page et
Style…. De plus, vous pouvez appliquer votre propre Saut de système (ligne), Saut de page ou Saut de section.

Pour choisir entre le défilement de page horizontal ou vertical, voir Préferences: Fond (Faire défiler les pages).

Affichage continu

Avec Affichage continu, la partition est présentée comme un système ininterrompu. Même si le point de départ n'est pas
visible, les numéros de mesure, les noms d'instruments, clefs, indications de mesures et armures seront toujours affichés
à gauche de la fenêtre.

Remarque: La mise en page étant plus simple, MuseScore peut fonctionner plus rapidement en affichage continu qu'en
affichage par page.

Affichage Une seule page

Avec Une seule page la partition est affichée sous la forme d'une seule page avec un en-tête mais pas de marges, et
avec une hauteur de page infinie. Les Sauts de système (ligne) Sauts sont ajoutés automatiquement, selon les
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paramètres définis dans Paramètres de la page et Style…. De plus, vous pouvez appliquer votre propre Saut de système
(ligne) ou Saut de section.

Panneaux latéraux

Les Espaces de travail (palettes), Inspecteur, et Filtre de sélection, sont proposés sous forme de panneaux latéraux
accrochés à la fenêtre principale. Pour les libérer et en faire des panneaux volants, plusieurs méthodes :

Faites glisser le panneau avec la souris;
Cliquez sur le double chevron en haut du panneau;
Double-cliquez dans la zone de titre en haut du panneau.

Pour ancrer un panneau, utilisez l'une des procédures suivantes:

Faites glisser le panneau vers le haut / bas d'un panneau latéral existant et il s'empilera verticalement au-dessus /
en dessous de ce panneau.
Faites glisser le panneau au milieu d'un panneau latéral existant et il superposera ce panneau. Les deux panneaux
sont alors accessibles par onglets.

Vous pouvez également double-cliquer sur la barre de titre du panneau pour le restaurer à sa position précédemment
ancrée.

Navigation

Commandes

Différentes commandes sont disponibles pour vous aider à naviguer plus facilement dans la partition. Celles-ci sont
répertoriées sous Raccourcis clavier: Navigation.

Navigateur

Le Navigateur est un panneau optionnel qui affiche des vignettes de page de la partition en bas ou à droite de la fenêtre
du document.

Pour afficher ou masquer le navigateur, sélectionnez Affichage→Navigateur; ou utilisez un raccourcis personnalisé
Raccourcis clavier.

Le navigateur apparaît au bas de la fenêtre du document si vous faites défiler les pages horizontalement; ou à droite si
vous faites défiler les pages verticalement (voir Préferences: Fond).

Le rectangle bleu représente la zone de la partition qui est actuellement visible dans la fenêtre du document: faites glisser
le rectangle, ou cliquez directement sur le panneau du navigateur pour faire apparaître une autre partie de la partition.
Vous pouvez également faire glisser la barre de défilement.

Timeline

Le panneau Timeline fournit un aperçu détaillé de la partition, avec des possibilités étendues de navigation et
d'interaction.

Pour afficher la Timeline, appuyez sur F12; ou sélectionnez Affichage→Timeline.

Pour plus de détails, consultez Timeline.

Rechercher / Aller à

La fonction Rechercher / Aller à vous permet de naviguer rapidement vers une mesure spécifique, un Repère ou un
numéro de page dans la partition:

1. Appuyez sur Ctrl+F (Mac: Cmd+F), ou sélectionnez Édition→Rechercher / Aller à. Cela ouvre la barre Rechercher / Aller à
au bas de l'espace de travail.

2. Utilisez l'une des options suivantes:
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Pour accéder à une mesure numérotée: entrez le numéro de mesure (en comptant chaque mesure, en
commençant par 1, indépendamment de Mesures non comptées, Sauts de section ou modifications manuelles
des intervalles de Numéros de mesure).
Pour accéder à une page numérotée: entrez le numéro de page au format pXX (où XX est le numéro de
page).
Pour aller à un Repère: entrez le numéro en utilisant le format rXX (où XX est le nom du Repère).
Pour aller à un Repère commençant par une lettre: entrez le nom du Repère (la recherche est insensible à
la casse).

N.B.: Il est préférable d'éviter de nommer les Repères avec des lettres simples "R," "r," "P", "p" ou l'une de ces
lettres suivie d'un entier (par exemple "R1" ou "p3"), car cela peut confondre l'algorithme de recherche.

Voir aussi

Ouvrir / Enregistrer / Exporter / Imprimer
Formats de fichier
Mise en page et formatage

Modes de sélection

Les objets de la partition - comme les notes, les mesures, les articulations etc.- peuvent être sélectionnés de différentes
façons (1), individuellement (#select-single-object), comme une sélection continue (#range-select) (2) ou (3) comme une
liste (#list-select).

Sélectionner un seul objet

La plupart des objets de la partition peuvent être sélectionnés en cliquant simplement sur eux dans le Mode normal.

Sélectionner une seule note

Dans le Mode normal, cliquer sur un en-tête de note.

Note__ : Sélectionner une seule note, puis la copier-coller, ne fera que copier-coller la hauteur et non la durée, ni aucune
autres propriétés. Pour copier la note entière, y compris toutes les propriétés, vous devez maintenir la touche Maj- comme
pour la sélection d'un accord (ci-dessous).

Sélectionner un accord

Dans Mode normal, maintenir enfoncé Maj, puis cliquer sur une tête de note dans l'accord.

Sélectionner une mesure unique

Cliquer sur un espace vide dans la mesure.

Note__ : Pour sélectionner une série de mesures consécutives, voir Sélection avec Maj et Sélection avec Maj + clic (ci-
dessous).

Sélectionner une plage continue d'objets

Il existe plusieurs façons de sélectionner une plage continue de notes, d'accords ou de mesures :

1. Sélection avec Maj

1. Assurez-vous que vous êtes en Mode normal ;
2. Sélectionnez la première note, accord, silence ou mesure de la gamme. Vous pouvez étendre la sélection vers le

haut ou vers le bas à des portées adjacentes, si nécessaire, en utilisant Maj+↑ ou ↓ ;
3. Choisissez ensuite l'une des options suivantes :

Pour faire avancer la sélection d'un accord à la fois vers la droite : Appuyez sur Maj+→.
Pour faire avancer la sélection d'un accord à la fois vers la gauche : Appuyez sur Maj Appuyez sur Maj+←.
Pour faire avancer la sélection d'une mesure à la fois vers la droite : Appuyez sur Maj Appuyez sur Maj+Ctrl+→ (Mac
: Maj+Cmd+→).
Pour faire avancer la sélection d'une mesure à la fois vers la gauche : Appuyez sur Maj+Ctrl+← (Mac :
Maj+Cmd+←).
Pour avancer la sélection au début de la ligne : Appuyez sur Maj+Home (Mac : Maj+Fn+←).
Pour faire avancer la sélection jusqu'à la fin de la ligne : Appuyez sur Maj+Fin (Mac : Maj+Fn+→).
Pour étendre la sélection au début de la partition : Appuyez sur Maj+Ctrl+Home (Mac : Maj+Cmd+Fn+←).
Pour prolonger la sélection jusqu'à la fin de la note : Appuyez sur Maj+Ctrl+Fin (Mac : Maj+Cmd+Fn+→).

2. Sélection Maj + Clic
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Pour sélectionner une gamme de notes ou de silences :

1. Assurez-vous que vous êtes en Mode normal ;
2. Cliquer sur la première note ou sur le reste de la plage ;
3. Maintenir la touche Maj enfoncée, puis cliquer sur la dernière note ou le dernier silence souhaité.

Note : Le dernier élément sélectionné peut être dans la même portée ou dans des portées au-dessus ou au-dessous de
la note/du repos initial. Tous les éléments sélectionnés seront inclus dans un rectangle bleu, y compris les lignes et
articulations associées (mais pas les reprises). Vous pouvez répéter l'opération pour étendre la portée sélectionnée selon
vos besoins.

Sélection d'une suite de mesures

1. Cliquer sur un espace vide dans la première mesure souhaitée ;
2. Maintenir la touche Maj enfoncée, puis cliquer sur un espace dans la dernière mesure de la plage souhaitée.

Note : Comme pour la sélection des notes, la plage peut être étendue verticalement et horizontalement.

3. Faire glisser la sélection

Cette méthode peut être utilisée pour sélectionner des notes ou des silences, ou, indépendamment, pour sélectionner des
symboles autres que des notes, tels que des points staccato, des paroles, etc. :

Appuyer et maintenir enfoncé Maj, puis faire glisser le curseur sur la plage souhaitée.

4. Tout Sélectionner

Cette méthode sélectionne la partition musicale globale comprenant les notes, les silences et les éléments associés.
Utiliser l'une des options suivantes :

Appuyer sur Ctrl+A (Mac : Cmd+A).
Dans la barre de menu, sélectionner Édition &rarr ; Tout sélectionner.

5. Sélectionner une section

Cette méthode est utilisée pour sélectionner une section -une zone de la partition- commençant et/ou se terminant par un
saut de section :

1. Cliquer sur un espace vide dans une mesure de la section ;
2. Dans la barre de menu, sélectionner Édition - Sélectionner la section.

Note : Voir Copier et coller : Filtre de sélection pour désactiver la sélection de certains types d'éléments dans une
sélection de plage.

Sélectionner une liste d'objets

Pour sélectionner une liste (ou une plage discontinue) d'éléments de la partition :

1. Cliquer sur le premier élément ;
2. Maintenir la touche Ctrl (Mac : Cmd) et cliquer successivement sur les éléments supplémentaires souhaités.

Note : Cette méthode ne peut pas être utilisée pour sélectionner des mesures. Utiliser plutôt la sélection simple ou par
plage.

Sélectionner tous les éléments similaires

Pour sélectionner tous les éléments d'un type spécifique (par exemple, toutes les barres de défilement, tous les éléments
de texte, tous les marquages staccato) :

1. Sélectionner un élément ;
2. Cliquer avec le bouton droit de la souris et choisir Sélection... ;

3. Plusieurs options sont disponibles :

Tous les éléments similaires : Sélectionne tous les éléments de la partition similaires à l'objet choisi.
Tous les éléments similaires de la même portée : Sélectionne tous les éléments de la même portée
similaires à l'objet choisi.
Tous les éléments similaires de la sélection : ne s'applique que si une portée a été sélectionnée.
Sélectionne tous les éléments de la portée similaires à l'objet choisi.
Plus... : ouvre une boîte de dialogue qui vous permet d'affiner d'autres options. Par exemple, si vous avez
sélectionné une tête de note, la boîte de dialogue ressemblera à ceci :
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Sélection

Même tête de note : Dans cet exemple, seules les têtes de note du même group seront sélectionnées ;
Même hauteur : Seules les têtes de note de même hauteur seront sélectionnées ;
Même corde : (tablature uniquement) sélectionne les frettes d'une même plage.
Même type : Toutes les têtes de note (de n'importe quel groupe) seront sélectionnées ;
Même durée : Seules les têtes de note de même durée seront sélectionnées ;
Même nom de note : les têtes de note de ce nom dans toutes les octaves seront sélectionnées ;
Même portée : Seules les têtes de notes de la même portée seront sélectionnées.
Même voix : sélectionne toutes les notes d'une même voix.

* En sélection
* Même système

Action
* Remplacer la sélection : L'option par défaut permet de recommencer la sélection à zéro ;
* Ajouter à la sélection : Conserve tout ce que vous avez déjà sélectionné, et y ajoute la sélection actuelle ;
* Rechercher dans la sélection :
* Retirer de la sélection : Conserve tout ce que vous avez déjà sélectionné, mais enlève la sélection actuelle.

Quelles sont les sélections utiles pour

Copier/coller
Mode Édition
Inspecteur et propriétés d'objets
Outils

Voir aussi

Chapitre Bases, en particulier Saisie de notes
Chapitre Notation, en particulier Altérations accidentelles
Chapitre Textes, en particulier Edition de texte et Mouvements de symboles et textes de portée sur la grille.

Tonalité réelle

Vous pouvez choisir d'afficher votre partition en Tonalité transposée ou en Tonalité réelle . La tonalité transposée
affiche les notes et armures de la partition telles qu'elles sont lues par les musiciens. Néanmoins, pendant l'arrangement
si vous préférez que les parties des instruments transpositeurs soient notées en sons réels, sans tenir compte de la
transposition, vous pouvez sélectionnez l'option "Tonalité réelle"

Pour choisir entre la Tonalité transposée ou la Tonalité réelle :

Cliquez sur le boutonTonalité réelle (situé sur la barre d'outils). Quand le texte du bouton est bleu, la partition est en
tonalité réelle, sinon la partition est en tonalité transposée.

Avant d'imprimer ou de publier en ligne la partition, assurez-vous que la Tonalité réelle est désactivée, et que chaque partie
instrumentale est transposée comme il faut.

Voir aussi
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Transposition: Instruments transpositeurs
Altérations: Recalculer les altérations

Liens externes

Concert pitch  (article Wikipedia en anglais)
Instrument transpositeur  (article Wikipedia)
Concert pitch or not?  (forum de discussion MuseScore)

Ouvrir / Enregistrer / Exporter / Imprimer

Vous trouverez dans le menu Fichier les commandes nécessaires pour ouvrir, enregistrer, exporter, et imprimer vos
partitions :

Ouvrir

Mise à part les fichiers au format natif (*.mscz et *.mscx), MuseScore ouvre aussi les fichiers MusicXML, MusicXML
compressé, MIDI, ainsi que quelques autres formats de fichiers.

Pour ouvrir un fichier pris en charge :

1. Utilisez l’une des méthodes suivantes :
Tapez Ctrl+O.
Cliquez sur l’icône "Charger une partition" à gauche dans la barre d’outils.
Dans la barre de menu, sélectionnez Fichier→Ouvrir....

2. Sélectionnez un fichier et cliquez sur Ouvrir; ou bien double cliquez sur le nom de fichier.

Partitions récentes vous affiche la liste des partitions ouvertes récemment.

Enregistrer

Enregistrer, Enregistrer sous…, Enregistrer une copie…, et Enregistrer la sélection… enregistrent les partitions au
format natif de MuseScore (.mscz et .mscx).

Enregistrer : Enregistre la partition en cours dans le fichier.
Enregistrer sous... : Enregistre la partition en cours dans un nouveau fichier.
Enregistrer une copie... : Enregistre la partition en cours dans un nouveau fichier, mais l’édition continue dans la
partition originale.
Enregistrer la sélection... : Enregistre les mesures sélectionnées dans un nouveau fichier.
Enregistrer en ligne... : Enregistre et partage vos partitions sur le site web MuseScore.com . Pour les
explications, consultez Partager les partitions en ligne.

Exporter

Exporter... et Exporter les parties... permet d’enregistrer les partitions dans un autre format que MuseScore, par
exemple PDF, MusicXML, MIDI, et différents formats d’image et audio. Vous choisissez le format désiré dans la boîte de
dialogue Exporter.
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Exporter... : Exporte la partition en cours au format de votre choix.
Exporter les parties... : Exporte la partition en cours et toutes les parties liées en fichiers séparés au format de
votre choix.
Note : 'Exporter les parties...' est désactivé (grisé), si celles-ci n’ont pas encore été générées.

MuseScore se souvient du format que vous avez choisi durant la dernière utilisation et vous proposera ce format par
défaut à la prochaine utilisation.

Imprimer

Imprimer... imprimera votre partition directement depuis MuseScore sur votre imprimante. En fonction des options
disponibles dans votre imprimante, vous pourrez spécifier une plage de pages, le nombre de copies, ou la méthode de
classement.

Si vous avez installé une imprimante PDF virtuelle, vous pouvez "exporter" vers celle-ci avec Imprimer, mais il est
préférable d'utiliser la fonction Exporter native pour une meilleure résolution.
Note : Assurez-vous que l’option "Utilisez les polices système, n'utilisez pas les polices de document" soit désactivée
dans les propriétés de l’imprimante.

Voir aussi

Formats de fichier
Parties

Partager les partitions en ligne

Musescore.com  vous permet de:

Afficher et écouter les partitions d'un vaste référentiel créé par la communauté MuseScore.
Télécharger n'importe quelle partition dans une variété de formats — MuseScore, MusicXML, PDF, MIDI, MP3.
Téléverser (upload) vos propres partitions: contrôler si vous souhaitez les partager publiquement ou en privé (via un
lien secret).
Synchronisez votre partition avec une vidéo YouTube ("Videoscores").

Remarque: Un compte MuseScore Pro est requis pour toutes les partitions non marquées comme PD (domaine public)
ou "Original", cette dernière doit également avoir l'approbation du propriétaire de la partition.

Créer un compte

1. Visitez MuseScore.com  et cliquez sur Log in en haut à droite puis sur "Create an account ". Entrez une
adresse email valide, choisissez un nom d'utilisateur et appuyez sur "Create new account".

2. Attendez quelques minutes pour recevoir un email du support de MuseScore.com. Si vous ne recevez rien, vérifiez
votre dossier spam.

3. Cliquez sur le lien de l'email et accédez à votre profil  pour changer votre mot de passe.

Partager une partition directement depuis MuseScore

Pour enregistrer une partition en ligne:

1. Assurez-vous que le bouton Tonalité réelle n'est pas activé, et que les différentes parties sont bien transposées.

2. Dans le menu, sélectionnez Fichier→Enregistrer en ligne.... La boîte de dialogue "Log in to MuseScore" apparaîtra:
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3. Entrez votre adresse email ou votre nom d'utilisateur, puis votre mot de passe et cliquez sur Log in. Remarque: Si
vous ne possédez pas encore de compte MuseScore, commencez par en créer un en cliquant sur le lien "Create an
account". Cela ouvrira votre navigateur internet et vous amènera à Create an account .

4. Une fois connecté, vous pourrez saisir les informations de votre partition.
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Title: Le titre de votre partition.
Description: Le texte descriptif qui apparaîtra à côté.
Private: Choisir si la partition est :
*PUBLIC tout le monde peut voir ou rechercher cette partition.
*UNLISTED Les partitions non répertoriées ne sont accessibles que par le lien secret ou aux membres des
groupes où la partition est publiée.
Vous pouvez obtenir le lien secret en cliquant sur le bouton "Share" sur la page de la partition.
*PRIVATE Ce mode empêche quiconque de voir la partition
Copyright and download settings: Choisissez une licence de droit d'auteur appropriée dans la liste
déroulante. Remarque: En utilisant une licence Creative Commons license  vous autorisez implicitement
l'utilisation de vos partitions sous les conditions de celle-ci.
Tags: Vous pouvez ajouter des balises tags séparées par une virgule, pour aider à identifier les partitions sur
MuseScore.com. Utilisez des virgules pour séparer plusieurs balises.

5. Si la partition existe déjà en ligne, elle sera mise à jour automatiquement - vous pouvez ajouter des informations
supplémentaires dans la section changelog de la boîte de dialogue si nécessaire. Cela peut être récupéré sur
MuseScore.com sous "Historique des révisions" pour cette partition. Décochez Update the existing score pour
enregistrer en ligne en tant que nouvelle partition.
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6. Si vous utilisez une SoundFont différente de celle par défaut et que votre configuration vous permet d'exporter en
fichier MP3 (peut ne pas être le cas sur certaines versions de Linux), une case à cocher Upload score audio sera
visible :

Si la case est cochée, MuseScore génèrera le son de la partition en utilisant les réglages du synthesizer et l'enverra
à MuseScore.com.

Téléverser (upload) une partition sur MuseScore.com

Vous pouvez également téléverser directement une partition sur MuseScore.com.

1. Cliquez sur le lien de téléversement  sur MuseScore.com.
2. Vous avez les mêmes options que dans le menu Enregistrer en ligne....
3. Vous avez aussi accès à plus d'informations, comme le Genre.

Éditer une partition sur MuseScore.com

Si vous souhaitez apporter des modifications à l'une de vos partitions sur MuseScore.com, modifiez le fichier MuseScore
sur votre propre ordinateur, enregistrez-le, puis procédez comme suit:

Si vous avez initialement partagé la partition directement depuis MuseScore, allez simplement à Fichier→Enregistrer en
ligne... à nouveau pour mettre à jour la partition en ligne.
Si vous avez initialement téléchargé la partition via la page de téléchargement  sur MuseScore.com, vous devez
suivre ces étapes pour mettre à jour la partition en ligne:

1. Accédez à la page des partitions sur MuseScore.com.
2. Cliquez sur le menu à trois points ⋮ à droite et choisissez "Update this score".
3. Dans le formulaire, vous pouvez télécharger un fichier de partition de remplacement ainsi que modifier les

informations d'accompagnement et les paramètres de confidentialité.

Passer à la méthode directe de mise à jour d'une partition en ligne

Il est beaucoup plus pratique de mettre à jour les partitions en ligne directement depuis MuseScore qu'en mettant à jour
manuellement la partition depuis la page des partitions. Suivez ces étapes si vous avez initialement téléchargé la partition
via la page de téléchargement  et vous voulez maintenant passer à la méthode directe:

1. Accédez à la page de partition sur MuseScore.com et copiez l'URL.
2. Ouvrez le fichier de partition sur votre ordinateur avec MuseScore.
3. Dans le menu, sélectionnez Fichiers→Propriétés de la partition... et collez l'URL dans le champ "Source".

Désormais, chaque fois que vous souhaitez mettre à jour la partition en ligne, accédez simplement à Fichiers→Enregistrer en
ligne....

Liens externes

Comment supprimer une partition enregistrée sur MuseScore.com (MuseScore HowTo en anglais)
Score download becomes a part of the Pro subscription  (sur MuseScore.com)
Download becomes a part of the Pro subscription  (Discussion sur MuseScore.com)

Notation
Dans le chapitre précédent →"Bases", vous avez appris la Saisie des notes et comment interagir avec les Palettes. Le
chapitre "Notation" décrit maintenant les différents types de notation en détail, et inclut des notations musicales plus
avancées.

Voir aussi →"Fonctionnalités avancées".

Armures

L'armure est un ensemble d'altérations réunies à la clé. Elle est composée soit exclusivement de dièses, soit
exclusivement de bémols, en dehors du cas particulier du changement d'armure où l'on trouve des bécarres. Ces
altérations correspondent en général à la tonalité principale des notes qui suivent.

Les armures standards sont disponibles dans la palette Armures que l'on trouve dans l'espace de travail de Base ainsi
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que dans l'espace de travail Avancé. Il est possible de créer des armures personnalisées (voir ci-dessous).

Ajouter une Armure

Ajout d'une nouvelle armure à toutes les portées

Utiliser l'une des méthodes suivantes :

Faire glisser une armure de la palette et la déposer sur la partie vide d'une mesure.
Sélectionner une mesure et faire un double-click que l'armure dans la palette (simple clic à partir de la version 3.4) .
Sélectionner une note et faire un double-click (simple clic à partir de la version 3.4) que l'armure dans la palette.

Ajout d'une nouvelle armure à une seule portée

Ceci permet de changer l'armure d'une seule portée en laissant les autres portés du système inchangées :

Maintenir la touche Ctrl (Mac: ⌘) enfoncée lorsque vous glissez/déposez l'armure depuis la palette jusqu'à une
mesure.

Changement d'armure

Changement d'armure pour toutes les portées

Utiliser l'une des méthodes suivantes :

Faire glisser une armure de la palette et la déposer sur l'armure à remplacer ou sur une mesure qui contient
l'armure à remplacer.
Sélectionner l'armure à remplacer et double-cliquer sur la nouvelle armure dans la palette (simple clic à partir de la
version 3.4).

Changement d'armure pour une seule portée

Ceci permet de modifier l'armure d'une seule portée en laissant les autres portés du système inchangées :

Maintenir la touche Ctrl (Mac: ⌘) enfoncée lorsque vous glissez/déposez l'armure depuis la palette jusqu'à l'armure à
remplacer ou jusqu'à une mesure contenant l'armure à remplacer.

Supprimer une armure

Utiliser l'une des méthodes suivantes :

Cliquer sur l'armure à supprimer et presser la touche Suppr.
Faire glisser l'armure vide depuis la palette sur l'armure à supprimer ou sur la mesure qui contient l'armure à
supprimer.

Bécarres lors des changement d'armure

Par défaut, MuseScore n'affiche les bécarres que lorsque l'armure fait revenir la tonalité en Do majeur ou en La mineur
naturel (aucun dièse, aucun bémol). Dans les autres cas, MuseScore n'affiche que la nouvelle armure :
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Mais il est possible d'afficher tous les bécarres annulant les altérations précédentes :

1. Dans le menu, sélectionner Format → Style... → Altérations. On y trouve les options suivantes :

2. Sélectionner l'une de ces options

3. Si vous êtes à l'intérieur d'une partie et que vous voulez que l'option concerne toutes les parties, cliquer sur le
bouton Appliquer à l'ensemble des parties  (Bouton en bas à gauche de la boîte de dialogue).

4. Cliquer sur le bouton OK pour sortir.

Exemple avec sélection de l'option "Avant l'armure si le changement utilise moins de ♯ ou ♭" :

Exemple avec sélection de l'option "Avant l'armure si le changement utilise moins de ♯ ou ♭. Avant s'il passe de ♯ à
♭" :

Changement d'armure lors silences multimesures

Silences multimesures sont interrompus lors des changement d'armure :

Rappel des armures

Pour masquer certains rappels d'armure :

Sélectionner l'armure à masquer et décocher "Afficher le rappel" dans la section "Armure" de l'Inspecteur.

Pour masquer de tous les rappels d'armure :

Dans le menu, sélectionner Format → Style... → Page, et décocher "Créer le rappel des armures".

Note : Les rappels d'armure ne sont pas affichés à lors dest sauts de section.

Armures personnalisées

Pour créer une armure personnalisée :

1. Presser la touche Maj+K pour faire afficher la section Armures de la Palette principale.
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2. Dans la zone Créer une armure, faire glisser les altérations de la palette sur la "portée" pour créer l'armure désirée.
Utiliser le bouton Effacer pour supprimer toutes les altérations de l'armure.

3. Utiliser le bouton Ajouter pour insérer la nouvelle armure dans la bibliothèque (zone centrale).

Note : Lorsque MuseScore joue une partition avec une armure personnalisée, il ne tient pas compte de ces altérations.

Pour ajouter une armure de bibliothèque de la Palette Principale à une palette personnalisée  :

Faire glisser l'armure sur la palette.

Pour appliquer directement à une portée une armure se trouvant dans la palette principale, utiliser l'une des méthodes
suivantes :

Sélectionner une mesure et double-cliquer sur une armure dans la palette principale (simple clic depuis la version
3.4).
Faire glisser une armure depuis la palette principale et la déposer sur une mesure.

Barres de mesure

Les symboles de barres de mesure sont disponibles dans la palette Barres de mesure :

Changer le type de barre de mesure

Pour changer le type d'une barre de mesure existante, utilisez l'une des méthodes suivantes :

Sélectionnez une barre de mesure ou une mesure, puis double-cliquez sur une icône de la palette Barres de
mesure ;
Glissez une icône depuis la palette Barres de mesure sur une barre de mesure ou une mesure de la partition ;
Sélectionnez une barre de mesure existante, puis ajustez son "style" dans la section "Barre de mesure" de
l'Inspecteur.
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Pour changer une barre multiple en barre simple:

Sélectionnez la barre de mesure et appuyez sur Del.

Pour cacher une barre de mesure:

Sélectionnez la barre de mesure et appuyez sur V, ou décochez Visible dans l'inspecteur.

Insérer une barre de mesure

Pour insérer une nouvelle barre de mesure entre des barres existantes, soit :

Glissez une icône de la palette Barres de mesure sur une note ou un silence ;
Sélectionnez une note ou un silence, puis double-cliquez sur une icône de la palette Barres de mesure.

Personnaliser des barres de mesure

Il est possible de créer des barres de mesure personnalisées en sélectionnant un ou plusieurs barres de mesure et en en
ajustant les propriétés dans la section Barres de mesure de l'Inspecteur :

Style: permet de choisir parmi un ensemble de barres de mesure prédéfinies ;
Étendre jusqu'à la portée suivante: étend la barre de mesure sélectionnée à la barre de mesure de la portée du
dessous ;
Étendre à partir de: indique la position du haut de la barre de mesure. "0" représente la ligne supérieure de la
portée. Les nombres positifs indiquent une position vers le bas de la portée, les nombres négatifs vers le haut de la
portée ;
____Étendre jusqu'à__: indique la position du bas de la barre de mesure (voir "Étendre à partir de").
Préréglage des extensions: utilisez les boutons pour appliquer des réglages prédéfinis.

Voir aussi Mensurstrich.

Les changements de couleur et de décalage horizontal ou vertical peuvent être aussi effectués grâce à l'Inspecteur.

Connecter des barres de mesure

Les barres de mesure peuvent s'étendre sur plusieurs portées, comme dans une partition complète de piano, ou dans une
partition d'orchestre pour regrouper les instruments d'une même section. Pour connecter les barres de mesure :

1. Double-cliquez sur une barre de mesure pour entrer en mode Édition.

2. Cliquez sur la poignée bleue inférieure et glissez-la vers la portée avec laquelle vous souhaitez la connecter. La
poignée se positionne automatiquement, inutile donc de la positionner précisément.

3. Appuyez sur Esc pour sortir du mode Édition. Cela mettra à jour toutes les autres barres de mesure concernées.

Voir aussi

Opérations sur les mesures
Ajouter un point d'orgue à une barre de mesure

Clefs

Les clefs les plus souvent utilisées sont disponibles dans la palette Clefs de l'espace de travail de Base. Pour disposer de
toutes les clefs, il est nécessaire d'utiliser l'espace de travail Avancé (voir l'image ci-dessous).
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Ajouter une clef

Ajout d'une clé en début de mesure

1ère Méthode : Ajout d'une clef en début de mesure, qu'elle soit ou pas la première mesure d'un système :

Sélectionner une mesure et double-cliquer sur une clef dans la palette des Clefs, ou
Faire glisser une clef depuis cette palette et la déposer sur une mesure.

2ème Méthode: Pour modifier une clef au début d'un système :

Sélectionner la clef existante au début du système et double-cliquer sur la nouvelle clef dans la palette des Clefs, ou
Faire glisser la nouvelle clef de cette palette et la déposer sur la clef à remplacer.

Ajout d'une clé à l'intérieur d'une mesure

Cliquer sur une note ou sur un silence, puis double-cliquer sur une clef dans la palette des Clefs.

Note : Si cette clef n'est pas la première d'un système, elle sera dessinée avec une taille réduite.

Dans l'image ci-dessous, la portée débute avec une clef de Sol, puis passe immédiatement en clef de Fa, puis, après une
note et un silence, revient en clef de Sol.

Note : Le remplacement d'une clé ne modifie pas la hauteur des notes. Les notes se déplacent sur la portée en tenant
compte de la nouvelle clef. En cas de besoin, vous pouvez utiliser la Transposition en complément du remplacement des
clefs.

Clefs de rappel

Lorsqu'un changement de clef subvient au début d'un système, une clef de rappel est ajoutée à la fin du système
précédent.

Pour Afficher/Masquer toutes les clefs de rappel :

1. Dans le menu, sélectionner Format→Style...→Page;
2. Cocher/Décocher "Créer le rappel des clefs".

Il est possible d'Afficher/Masquer les clefs de rappel au cas par cas :

1. "Créer le rappel des clefs" doit être coché dans la fenêtre de style (voir ci-dessus)
2. Sélectionner la clef puis Cocher/Décocher "Afficher le rappel" dans la section Clef de l'Inspecteur.

Supprimer une clef

Sélectionner la clef et presser la touche Del.

Masquer les clefs

Afficher les clefs uniquement sur la première mesure de la partition (pour toutes les portées)
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1. Dans le menu, sélectionner Format→Style...→ Page;
2. Décocher la case "Créer une clef pour tous les systèmes".

Afficher la clef uniquement dans la première mesure d'une porté particulière

1. Click-Droit sur la portée, sélectionner Propriété de la postée/partie... et décocher "Afficher la clef".
2. Ouvrir la palette principale et sélectionner la section "Symboles".
3. Faire glisser une clef de la palette principale et la déposer sur la première mesure de la portée OU sélectionner la

première note et double-cliquer sur une clef de la palette principale.

Note : Cette option peut être utile aux utilisateur de TAB qui ne souhaitent pas que cette clef se répète sur chaque ligne.

Masquer toutes les clefs d'un système particulier

1. Click-Droit sur la portée, puis sélectionner Propriété de la portée/partie...;
2. Décocher "Afficher la clef".

Altérations

Les altérations les plus courantes sont disponibles dans la barre d’icônes Saisie des notes au dessus de la partition et
dans la palette altérations de l'Espace de travail de base.

La liste exhaustive des altérations est disponible dans la même palette, mais de l'espace de travail avancé.

Ajouter une altération

Les Altérations sont ajoutées automatiquement àux note quand vous augmentez ou diminuez leur hauteur :

↑ : Augmente la hauteur d'une note d'un demi-ton (dièse).
↓ : Diminue la hauteur d'une note d'un demi-ton (bémol).

Pour ajouter soit un double dièse (ou double bémol), un rappel d’altération ou une altération non standard, utilisez une des
options suivantes :

Sélectionnez une note et cliquez sur l'altération dans la barre d'icônes (au-dessus de la partition).
Sélectionnez une note et double-cliquez sur une altération dans la palette altérations (basique ou avancée).
Glissez une altération depuis la palette altérations jusqu'à la note.

Si vous souhaitez ajouter des parenthèses à une altération accidentelle, utilisez une des options suivantes :

Sélectionnez l'altération dans la partition et double-cliquez sur le symbole parenthèses dans la palette altérations.
Glissez une parenthèse depuis la palette sur l'altération.
Sélectionnez l'altération et choisissez le type dans le menu déroulant de la section Parenthèses dans l'Inspecteur.

Une altération peut être supprimée par la touche Suppr.

Changer l'enharmonie

Une enharmonie désigne deux notes nommées différemment mais produisant le même son. Des notes enharmoniques
ont donc la même hauteur, mais des noms différents. Exemple : La dièse et Si bémol, Do double dièse et Ré, Do bémol
et Si, etc...

Pour changer une ou plusieurs notes par leurs enharmonies, que ce soit pour la tonalité écrite ou pour la tonalité de
concert :

1. Sélectionnez une note, ou un groupe de notes ;
2. Pressez J ;
3. Continuez à presser J pour faire défiler les équivalents enharmoniques.

Pour changer l'enharmonie dans la tonalité écrite, sans affecter la tonalité de concert, et vice-versa :

1. Sélectionnez une note, ou un groupe de notes ;
2. Pressez Ctrl+J (Mac : Cmd+J) ;
3. Continuez à presser la même combinaison de touches pour faire défiler les équivalents enharmoniques.

Note : Si les altérations des notes sélectionnées ne sont pas identiques, le résultat obtenu peut être assez imprévisible.
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Recalculer les altérations

Dans le menu, sélectionner Outils→Recalculer les altérations.

Voir aussi

Changement d’armure

Liens externes

Altérations  sur Wikipédia
Enharmonie  sur Wikipédia

Indications de mesure

Les indications de mesure se trouvent dans la Palette du même nom dans les espaces de travail "de Base" et "Avancé"
.

Ajouter ou changer une indication de mesure

Utiliser l'une des méthodes suivantes :

Sur la partition, sélectionner une indication de mesure, une mesure, une note ou un silence, puis cliquer sur une
indication de mesure dans la Palette (double clic pour les versions antérieures à 3.4).
Faire glisser une indication de mesure depuis la palette et la déposer sur une mesure, une note, un silence, ou sur
une précédente indication de mesure.

Supprimer une indication de mesure

Pour supprimer une indication de mesure, la sélectionner et utiliser la touche Suppr.

Créer une nouvelle indication de mesure

Si l'indication de mesure nécessaire à votre partition n'existe pas dans la palette, il est possible de la créer ainsi :

1. Appuyer sur Maj+T pour afficher la palette des indications de mesure de la Palette Principale.
2. Sélectionner une indication de mesure à éditer dans la zone centrale.
3. Dans la zone Créer l'indication de mesure, modifier les différents éléments (numérateur, dénominateur, texte,

valeur, groupes de note) pour obtenir l'indication de mesure attendue. Utiliser le bouton Réinitialiser pour restaurer les
groupes de note initiaux.

4. Utiliser le bouton Ajouter pour que la nouvelle indication de mesure rejoigne la collection dans la palette. Pour
supprimer une indication de mesure de la palette, clic-droit sur cette indication de mesure puis choisir Supprimer dans
le menu déroulant.

5. Faire glisser la nouvelle indication de mesure depuis la palette principale et la déposer à l'endroit voulu sur la
partition.

La nouvelle indication de mesure peut être enregistrée pour de futurs usages dans une palette personnalisée .

Propriétés de l'indication de mesure

Pour accéder aux propriétés d'une indication de mesure :

Clic-droit sur l'indication de mesure, puis sélectionner Propriétés de l'indication de mesure….
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Valeur globale : Affiche l'indication de mesure globale et se règle automatiquement lorsque vous ajoutez une
indication de mesure à la partition. C'est la référence pour les temps (indiqués dans la barre d'état).

Valeur réelle : Affiche l'indication de mesure associée à une portée particulière. Il s'agit normalement des mêmes
valeurs que celles de la Valeur globale , mais peut être réglée localement de façon indépendante en cas de besoin.
Voir Indication de mesure locale.

Apparence : Vous permet de modifier le texte affiché sans modifier les valeurs réelles de l'indication de mesure.
Exemple, Indication de mesure asymétrique.
Groupes de note : Permet de changer les ligatures de regroupement des notes, associés par défaut à l'indication
de mesure. Voir Modifier les ligatures par défaut.

Modifier les ligatures par défaut

Pour modifier les ligatures de regroupement des notes pour une indication de mesure :

1. Clic-droit sur l'indication de mesure, puis sélectionner Propriétés de l'indication de mesure…;
2. Pour couper une ligature, dans la zone Groupes de note, cliquer sur la note où la ligature doit être coupée. Pour

remettre la ligature en place, cliquer à nouveau sur cette note. Une autre façon de procéder consiste à faire glisser
une ligature depuis la zone Propriétés des ligatures et de la déposer sur l'une des notes de la zone Groupes de note
:

 Démarrer la ligature à cette note.

 Ne pas terminer la ligature à cette note.

 ligature d'1/8ème de note à gauche de cette note.

 Ligature d'1/16 ème de note à gauche de cette note.

Si vous cochez la case "Modifier aussi les notes plus courtes", toute modification apportée à une ligature de ce niveau est
automatiquement appliqué à aux durées plus courtes. Le bouton Réinitialiser annule toutes les modifications effectuées.

Indication de mesure asymétrique

Il arrive que des indications de mesure asymétriques (ou composite) soient utilisées pour clarifier la décomposition des
temps au sein d'une mesure. Pour créer une Indication de mesure asymétrique :

1. Clic-droit sur une indication de mesure de la partition puis choisir Propriétés de l'indication de mesure… dans le menu
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déroulant.
2. Dans la zone Apparence, modifier le "Texte" comme vous le souhaitez
3. Modifier les ligatures dans la section Groupes de note si nécessaire.

Note : Voir Créer une nouvelle indication de mesure pour travailler à partir de la palette principale.

Indication de mesure propre à une seule portée

Dans certains cas, il peut être nécessaire d'avoir des indications de mesure différentes en fonction des portées. En voici
un exemple, la pièce "Bach's 26. Goldberg Variation" :

Dans cet exemple, l'indication de mesure globale est 3/4, mais l'indication de mesure de la première portée est fixée à
18/16.

Pour créer une indication de mesure locale utiliser par une seule portée :

Maintenir enfoncée la touche Ctrl (Mac: Commande) tout en faisant glisser une indication de mesure depuis la palette
et en la déposant sur une mesure vide.

Ajuster la taille de l'indication de mesure

Sélectionner une ou plusiques indications de mesure puis, dans la section "Indication de mesure" de l'Inspecteur,
ajuster les valeurs de "Échelle X" (largeur) et "Échelle Y" (hauteur).

Anacrouses et cadences

Il arrive qu'il soit nécessaire d'augmenter ou de diminuer le nombre de temps d'une mesure sans vouloir modifier
l'indication de mesure. Par exemple, c'est souvent le cas pour les Anacrouses ou pour les Cadences. Voir Opérations
sur les mesures : Durée des mesures.

Changement d'indication de mesure et pauses multi-mesures

Les Pauses multi-mesures sont interrompues lorsqu'un changement d'indication de mesure advient. De plus, un saut de
section empêchera l'affichage du rappel de l'indication de mesure à la fin de la mesure précédente.

Voir également

Armures

Liens externes

How To Using Polyrhythm, mixed meters and local time signatures in MuseScore  (en anglais)
Additive meters  Wikipedia (en anglais).

Arpèges et glissandos

Les symboles Arpèges et Glissandos se trouvent dans la palette "Arpèges & Glissandos" de tous les espaces de travail.
Cette palette comprend également des flèches indiquant le sens des arpèges (flèches ondulées ou droites, vers le haut ou
vers le bas), des articulations pour instruments à vent et les symboles de glissando.
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Pour ajouter un symbole à la partition, utiliser l'une des méthodes suivantes :

Sélectionner une ou plusieurs notes, puis cliquer sur un symbole dans la palette "Arpèges et Glissandos" (double-
click pour les versions de MuseScore antérieures à 3.4).
Faites glisser un symbole de la palette "Arpèges et Glissandos" sur une note.

Tout symbole peut être personnalisé en ajustant ses propriétés dans l'Inspecteur. Des poignées de manipulation sont
présentes dans la plupart des cas pour permettre l'ajustement de la longueur/courbure dans le Mode Édition. Si
nécessaire, vous pouvez enregistrer le symbole obtenu pour une utilisation ultérieure dans une Palette Personnalisée.

Arpèges

Lorsqu'un symbole d'arpège ou de flèche indiquant le sens de l'arpège (flèche ondulée ou droite vers le haut ou vers le
bas) est ajouté à la partition, il ne s'étend que sur une seule voix. Vous pouvez ajuster sa hauteur en double-cliquant sur
le symbole et en faisant glisser les poignées de manipulation vers le haut ou vers le bas (pour un ajustement plus fin,
utilisez les flèches du clavier). La lecture du symbole peut être activée ou désactivée dans l'Inspecteur.

Glissandos et slides

Un Glissando ou, plus généralement un slide, relie deux notes consécutives, appartenant en principe à une même voix.

Les glissandos d'accords sont également disponibles.

Ajustement des points de départ et d'arrivée

1. Double-cliquer sur le symbole pour entrer dans le Mode Édition
2. Cliquer sur la poignée de début ou de fin :

Utiliser Ctrl+↑↓ (Mac Command+↑↓) pour déplacer la poignée sélectionnée verticalement de note en note
Utiliser Ctrl+←→ (Mac : Command+←→) pour déplacer la poignée sélectionnée horizontalement de note en note

Cette méthode permet également de déplacer les poignées entre les notes de différentes voix ou même d'une portée à
l'autre - pour les glissandos croisés, par exemple. Vous pouvez également utiliser les touches fléchées du clavier Ctrl (Mac
: Command) + flèches pour effectuer un réglage fin de la position des poignées.

Personnalisation des glissandos

Pour personnaliser un glissando selon vos besoins, sélectionnez-le et ajustez ses propriétés dans l'Inspecteur :

Type : Choisir entre Trille (ligne ondulée) ou Linéaire (ligne droite)
Afficher le texte : Modifier ou supprimer le texte, choisir la police, la taille et le style. Remarque : s'il n'y a pas assez
de place entre les notes, le texte n'est pas affiché.
Style de jeu : Choisir comment le glissando sera joué : Chromatique, Touches blanches, Touches noire,
Diatonique, Portamento.
Lecture : Cocher ou décocher cette case pour que le glissando soit joué ou pas.

Articulations pour instruments à vent

Les symboles Fall, Doit, Plop et Scoop sont disponibles. Pour modifier la longueur et la courbure, sélectionnez le
symbole, entrer en Mode Édition et ajustez les poignées comme décrit dans le paragraphe Mode Édition : Lignes.

Slide in/out
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Les symboles Slide in et Slide out sont également présents dans la palette "Arpèges & Glissandos". Pour modifier la
longueur et l'angle de la ligne, double-cliquer sur celle-ci et faire glisser les poignées (utiliser les flèches du clavier pour
un réglage plus précis).

Liens externes

Arpège  sur Wikipedia
Glissando  sur Wikipedia

Articulations et ornements

Les articulations disponibles sont disponibles dans la palette Articulations (Espace de travail Avancé) :

Les ornements se trouvent dans la palette Ornements (Espace de travail Avancé) :

On dispose aussi d'une version allégée de ces palettes dans l'Espace de travail de Base.

Articulations

Les Articulations sont des symboles ajoutés à une partition pour indiquer comment un accord ou une note doit être
jouée. Les principales articulations sont les suivantes :

Point d'orgue
Bend
Accent (>)
Différents type de Staccato : mezzo-staccato, portato, staccatissimo.
Tenuto
Marcato

On y trouve également des articulations plus spécialisées pour les cordes frottées et pincées, les instruments à vent, etc.

Certaines articulations ne sont pas exécutées lorsque MuseScore joue la partition.

Ornements

Dans les Ornements se trouvent :

Mordants, Mordants inversés, Mordents, Gruppetto
Trilles, Tremblements,
Slides

Note: Les Appoggiatures se trouvent dans la palette Fioritures.

Ajouter une articulation ou un ornement

Deux méthodes sont disponibles :

Sélectionner une note ou une série de notes, puis cliquer sur l'un des symboles de la palette (double-click pour les
versions antérieures à 3.4).
Glisser/Déposer un symbole de la palette sur la tête d'une note.
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Ajouter un ornement supplémentaire

Il est possible d'ajouter un ornement supplémentaire à une note déjà ornementée, comme par exemple un Trille :

1. Sélectionner une note ayant déjà un ornement ;
2. Ouvrir la section Symboles de la Palette principale;
3. Chercher et appliquer le symbole correspondant à ce nouvel ornement (de très petits symboles sont disponibles

dans la section "Figured bass") ;
4. Glisser/Déposer le symbole sur sa destination et le repositionner en utilisant les raccourcis clavier ou en utilisant

l'Inspecteur).

Ajouter un point d'orgue à une barre de mesure

Deux méthodes sont disponibles :

Sélectionner une barre de mesure, puis cliquer sur le symbole "Point d'orgue" dans la palette des Articulations
(double-click dans les versions antérieures à 3.4).
Glisser/Déposer le "Point d'orgue" depuis la palette jusqu'à la barre de mesure dans la partition.

Note: Les points d'orgue n'ont aucun effet lorsque MuseScore joue la partition.

Raccourcis claviers

Pour Ajouter ou Supprimer une articulation à une note ou à un groupe de notes sélectionnées :
* Staccato: Maj.+S
* Tenuto: Maj.+N
* Sforzato (accent): Maj.+V
* Marcato: Maj.+O
* Acciaccatura (appoggiature): /

Il est possible de personnaliser ces raccourcis dans les Préférences de MuseScore.

Ajuster la position d'un symbole

Immédiatement après avoir ajouté une articulation ou un ornement à partir d'une palette, le symbole est automatiquement
sélectionné : Il peut ensuite être déplacé vers le haut ou vers le bas à partir du clavier en procédant ainsi :

Utiliser les touches fléchées pour un positionnement fin (0.1 sp à la fois);
Utiliser Ctrl+↑ ou Ctrl+↓ (Mac : Commande+↑ ou Cmd+↓) pour un ajustement plus large (1 sp à la fois).
Pour faire passer un symbole de l'autre coté d'une note (lorsque c'est possible), le sélectionner et utiliser la touche
X.

Pour activer l'ajustement dans toutes les directions à partir du clavier :

1. Entrer dans le mode édition du symbole ;
2. Utiliser les touches fléchées pour un positionnement fin (0.1 sp à la fois) ou utiliser Ctrl+Flèches (Mac:

Commande+Flèches) pour un ajustement plus large (1 sp à la fois).

Il est également possible de changer les valeurs de positionnement X et Y dans l'Inspecteur. Pour positionner plusieurs
symboles en même temps, les sélectionner tous et utiliser l'inspecteur.

Note: En plus des méthodes ci-dessus, il est possible de positionner les symboles en les déplaçant à l'aide de la souris..

Propriétés des articulations, des ornements et des bends

Les propriétés peuvent être modifiées dans les section Ornement ou Articulation ou Bend de l'Inspecteur :

Direction : Automatique / Haut / Bas.
Point d'ancrage : au dessus ou en dessous de la portée, de l'accord, ou relatif à l'accord.
Lecture : est exécuté ou pas lorsque MuseScore joue la musique
Style d'ornement : Défaut ou Baroque.

Pour les propriétés des Bends, voir Bends.

D'autres paramètres de style sont disponibles pour les articulations et les ornements, voir Articulations, Ornements.

Exécution des ornements et des articulations lorsque MuseScore joue la partition.

Pour avoir une idée de la façon dont MuseScore s'y prend pour jouer les ornements, il est possible d'aller dans l'Éditeur
de Piano Roll et d'observer quelles sont les notes effectivement jouées. Idem pour les articulations pour voir la durée
réelle du son. (Click-droit sur la portée, Editeur de Piano Roll)
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Voir aussi

Fioritures

Liens externes

How to create trills and ornaments with accidentals (and playback)  (MuseScore HowTo)
Ornaments  at Wikipedia

Bends

Le Bend est une technique guitaristique également utilisée sur certains autres instruments à cordes. Elle consiste à tirer
latéralement une ou plusieurs cordes afin d'augmenter leur tension, cela a pour effet de monter légèrement la hauteur du
son. L'effet est également possible avec certains instruments sans cordes (harmonica, synthétiseur, saxophone).

Les Bends peuvent être créés et modifiés avec l'outil Bend . Cet outil se trouve dans la palette Articulations de
l'espace de travail avancé. Chaque Bend ajouté à la partition peut être paramétré dans la section Bend de l'Inspecteur.

Ajouter un Bend

Pour appliquer un ou plusieurs Bend à la partition, utilisez l'une des options suivantes :

Sélectionner une ou plusieurs notes et cliquer sur un symbole Bend dans la palette (double-clic pour les version
antérieure à 3.4).
Faites glisser un symbole de Bend de la palette et le déposer sur une note.

Éditer un Bend

Propriétés des textes et des lignes

1. Sélectionnez le Bend
2. Ajustez les propriétés suivantes dans la section Bend de l'inspecteur :

Épaisseur de la ligne.
Police, Taille, Style : Propriétés du texte.
Lecture : Cocher cette case pour que le Bend soit exécuté à la lecture.

Les propriétés du texte et des lignes pour tous les Bends de la partition peuvent être éditées de façon globales dans
Format→Style...→Bend.

Forme et largeur des Bends

Versions 3.4 et suivantes

1. Sélectionner le Bend.
2. Dans la section "Bend" de l'Inspecteur, utiliser la liste déroulante Type de Bend pour choisir parmi une série de

préréglages. "Bend" est l'option par défaut.
3. Effectuez les ajustements nécessaires à l'affichage graphique du Bend dans l'Inspecteur : voir Modifier l'affichage

graphique (ci-dessous).

Versions antérieures à 3.4

1. Sélectionner le Bend et cliquez sur Propriétés dans l'inspecteur ; vous pouvez également cliquer avec le bouton
droit de la souris sur le Bend et sélectionner "Propriétés du Bend".

2. Choisissez parmi une série de préréglages sous Type de Bend. "Bend" est l'option par défaut.
3. Ajustez, si nécessaire, l'affichage graphique du Bend : voir Modifier l'affichage graphique (ci-dessous).

Modifier l'affichage graphique
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Le Bend est représenté par un graphique composé de lignes grises reliées par des points, les nœuds bleus (voir image
ci-dessus). La pente de la ligne indique ce que fait le Bend :

Pente ascendante = Bend ascendant
Pente descendante = Bend descendant
Ligne horizontale = maintien

L'axe vertical du graphique représente la valeur de la hauteur de la note : une unité correspond à un quart de ton, 2
unités à un demi-ton, 4 unités à un ton entier, etc. L'axe horizontal du graphique indique la longueur du Bend : chaque
segment de ligne grise représente 1 espace (sp) dans la partition.

Un Bend est modifié en ajoutant ou en supprimant des nœuds dans le graphique :

Pour ajouter un nœud, cliquez sur une intersection vide.
Pour supprimer un nœud, cliquez sur celui-ci.

L'ajout d'un nœud allonge la longueur du Bend de 1 sp dans la partition. La suppression d'un nœud réduit la longueur du
Bend de 1 sp dans la partition. Les points Début et Fin du Bend ne peuvent être déplacés que vers le haut ou vers le bas.

Ajuster la hauteur

La hauteur du symbole du Bend est automatiquement dimentionée de manière à ce que le texte apparaisse juste au-
dessus de la portée. Cette hauteur peut être ajustée, si nécessaire, en utilisant l'astuce suivante :

1. Créer une autre note verticalement au-dessus de la note (en raccourcissant la ligne) ou en dessous de la note (en
prolongeant la ligne) à laquelle vous voulez que le Bend commence.

2. Appliquez le bend à la note créée.
3. Pour ajuster la hauteur du Bend, déplacer cette note créée verticalement afin que le symbole du Bend arrive à la

hauteur souhaitée.
4. Faire glisser le symbole du Bend à la position correcte (sur la note originale).
5. Rendre la note créée invisible et silencieuse en utilisant l'Inspecteur.

Ajuster la position

Pour ajuster la position, utilisez l'une des techniques suivantes :

Faire glisser le symbole du Bend avec la souris.
Cliquer sur le symbole et ajuster les décalages X et Y dans l'Inspecteur.
Double-cliquer sur le symbole , ou cliquer dessus et appuyer sur Ctrl+E (Mac : Command+E) ou cliquer avec le bouton
droit de la souris sur le symbole et sélectionnez "Éditer l'élément". Utiliser ensuite les touches fléchées pour un
positionnement fin (0,1 sp à la fois) , ou Ctrl+Flèche (Mac : Command+Flèche) pour des réglages plus importants (1 sp à
la fois).

Bends Personnalisés

Une fois qu'un Bend a été créé dans la partition, il peut être enregistré pour une utilisation ultérieure en le faisant glisser
dans une palette tout en maintenant la touche Ctrl+Maj (Mac : Command+Maj). Voir Espace de Travail Personnalisé.

Liens externes

Bend  sur wikipedia

Ligatures

La Ligature des notes entre elles se fait automatiquement selon l'indication de mesure.

Pour ajuster la ligature par défaut : clic-droit sur une indication de mesure puis sélectionner "Propriétés de
l'indication de mesure". Voir Modifier les ligatures pas défaut pour plus de détails.

Il est également possible de modifier une ligature localement, pour cela utiliser palette Propriété des ligatures disponible
dans les espaces de travail de Base et Avancé :

Symboles de ligature

Liste des symboles de ligature et effet :
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 Début de ligature : La ligature démarre à cette note (ou à ce silence). La note sera reliée uniquement à la note
suivante. Elle ne le sera pas reliée à la note précédente.

 Milieu de Ligature : La note sera reliée à la note d'avant ou d'après. Cela s'applique également aux ligatures
pour doubles et triples croches.

 Pas de ligature : La note ne sera pas reliée à une autre note.

 Ligature double croche : Commencer un deuxième niveau de ligatures à cette note.

 Ligature triple croche: Commencer un troisième niveau de ligatures à cette note.

 Mode automatique : Utiliser les ligatures par défaut de l'indication de mesure.

 Deccelerando rythmique : Exécuter un deccelerando rythmique sur un groupe de notes.

 Accelerando rythmique : Exécuter un accelerando rythmique sur un groupe de notes.

Sachez que la ligature entre deux notes/silences est déterminée par les options choisies pour ces deux notes/silences.
Par exemple : Deux notes consécutives devant débuter une ligature ne peuvent pas être reliées entre elles. Si les deux
notes consécutives peuvent à se relier l'une à l'autre, elles se relieront. Si l'une d'entre elles ne le peut pas, les deux notes
ne seront pas reliées.

Modifier une ligature

Pour modifier une ou plusieurs ligatures, utiliser l'une des méthodes suivantes :

Faire glisser un symbole de ligature sur une note à l'endroit où la modification est nécessaire.
Sélectionner une ou plusieurs notes dans la partition et cliquer sur le symbole de la palette (double-click pour les
version de MuseScore antérieures à 3.4)

Pour appliquer un Deccelerando ou Accelerando rythmique, utiliser l'une des méthodes suivantes :

Glissez et déposez un symbole Deccelerando ou Accelerando rythmique depuis la palette sur une ligature de la
partition.
Sélectionnez une ou plusieurs ligatures de la partition, puis double-cliquez sur un symbole Deccelerando ou
Accelerando rythmique de la palette.

Remarques:
(1) les Deccelerando ou Accelerando rythmique s'appliquent sur des doubles croches ou des triples croches
(2) Pour créer un Deccelerando ou Accelerando rythmique de deux lignes, il est nécessaire de démarrer par une ligature
de doubles croches
(3) Pour créer un Deccelerando ou Accelerando rythmique de trois lignes, il est nécessaire de démarrer par une ligature
de triple croches
(4) Lors de la lecture, les Deccelerandi ou Accelerandi rythmique n'ont aucun effet.

Ajuster l'inclinaison et la hauteur des ligatures

Pour ajuster à l'aide du clavier ou de la souris :

1. Entrer dans le Mode Édition de la ligature. La poignée d'édition de droite est automatiquement sélectionnée.
2. Utiliser les flèches vers le haut ou vers la droite, ou faire glisser la poignée d'édition pour modifier l'angle de la

ligature.
3. Si nécessaire, utiliser Maj+Tab ou cliquer sur la poignée d'édition de gauche pour la sélectionner et ajuster la hauteur.
4. Utiliser Echap pour sortir du mode Édition.

Pour ajuster en utilisant l'Inspecteur:

1. Cliquer sur une ligature
2. Cocher la case "Position personnalisée" dans la section "Ligature" de l'Inspecteur.
3. Fixer les "Positions" X et Y values pour obtenir l'angle désiré.

Rendre une ligature horizontale

1. Cliquer sur la ligature
2. Cocher la case "Horizontale" dans la section "Ligature" de l'Inspecteur.
3. Vous pouvez également utiliser la souris pour ajuster la position de la ligature.

Si vous souhaitez que toutes les ligatures de la partition soient horizontales, il existe une option "Aplanir l'ensemble les
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ligatures" dans Format→Style...→Ligatures.

Ajuster les Deccelerando ou Accelerando rythmiques

Pour ajuster les Deccelerando ou Accelerando rythmiques :

1. Sélectionner la ligature.
2. Ajuster les valeurs "Augmenter à gauche" et "augmenter à droite" dans la section "Ligature" de l'Inspecteur.

Nouvelle disposition locale

MuseScore espace les notes en fonction de leur valeur temporelle, en tenant compte des altérations accidentelles, des
paroles, etc. Dans les systèmes où il y a plus d'une portée, cela peut entraîner un espacement irrégulier des notes,
comme dans l'exemple suivant :

Nouvelle disposition locale est une case à cocher dans le Inspecteur vous permettant de spécifier les passages de la
partition où vous voulez que l'espacement des notes soit indépendant des autres portées du système. L'application cette
nouvelle disposition locale aux notes dans la portée supérieure de l'exemple précédent permet une distribution plus égale
des notes :

Nouvelle disposition locale :

1. Sélectionner une ou plusieurs ligatures dans la partition.
2. Cocher l'option Nouvelle disposition locale dans la section "Ligature" de l'Inspecteur.

Changer la position de la ligature

Pour faire passer une ligature au-dessous ou au-dessus des notes, :

1. Sélectionner une ou plusieurs ligatures.
2. Utiliser l'une des méthodes suivantes :

Utiliser la touche X.

Cliquer sur l'icône "Changer de sens"  dans la barre d'outils.
Sélectionner une "Direction" (Automatique, Haut ou Bas) dans la section "Ligature" de l'Inspecteur.

Réinitialiser les propriétés d'une ligature

Pour réinitialiser les propriétés d'une ligature en fonction de l'indication de mesure :

1. Sélectionner la zone de votre partition où vous voulez réinitialiser les propriétés des ligatures. Si rien n'est
sélectionné, cette opération s'appliquera sur la totalité de la partition.

2. Sélectionner Format→Réinitialiser les ligatures.

Voir aussi

Notation inter-système
Mode Edition
Saisie des notes
How beams work

Liens externes (en anglais)
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How to add a beam over a rest
How to place a beam between notes

Crochets

Des crochets et une accolade sont disponibles dans la palette Crochets système (espace de travail Avancé).

En créant une nouvelle partition à l'aide d'un modèle, MuseScore utilisera le crochet correspondant.

Ajout

Il y a deux moyens d'ajouter un crochet ou une accolade à un système :

Faire glisser l'icone du crochet ou de l'accolade de la palette sur la portée ou vous voulez qu'il soit.
Sélectionner une mesure de la portée où vous voulez placer le crochet ou l'accolade, et cliquez sur l'icone désirée
dans la palette (double-clic pour les versions antérieures à 3.4).

Suppression

Sélectionnez le crochet et appuyez sur Suppr.

Changement

Faire glisser l'icone de la palette sur un crochet ou une accolade existante de la partition.

Édition

Après avoir déposé un crochet, il ne couvre que la portée où il est placé. Pour l'étendre aux autres portées :

1. Passez en Mode édition.
2. Faites glisser la poignée vers le bas pour l'étendre aux portées voulues. La poignée se place automatiquement au

bon endroit, aucun ajustement n'est nécessaire.

Style

L'épaisseur par défaut et la distance entre le système et le crochet ou l'accolade sont modifiables dans
Format → Style... → Système.

Les propriétés des crochets et des accolades sont ajustable dans la section Crochets système, les cases à cocher de
gauche sont pour les crochets, et celles de droite pour les accolades.

Fioritures

En musique, une fioriture, appelée aussi note d'agrément ou ornementation, ou encore selon le terme italien abbellimenti
(« embellissements »), est un symbol généralement composé de notes de plus petites tailles, désignant des notes
secondaires dont la fonction est d'embellir la ligne mélodique principale. On les trouve également sous le nom
d'Appoggiature.

Il existe deux sortes d'appoggiatures, la longue et la brève. Toutes deux sont habituellement attaquées sur le début du
temps.

Une appoggiature longue est une petite figure de note de valeur déterminée (une blanche, une noire, une croche, etc).
Elle peut être simple ou double, voire triple.
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Une appoggiature brève ou acciacatura est une petite figure de note barrée, le plus souvent une croche, qui s'exécute
très rapidement. On lui affecte très souvent le quart de la valeur de la note qu'elle précède. Les règles d'interprétation
sont très souples et il existe des appoggiatures de plusieurs notes placées plus librement.

Interprétation des fioritures par MuseScore

Notes :

Longueur des sons joués par MuseScore :

Création des fioritures

Les fioritures brèves et longues se trouvent dans la palette "Fioriture" dans les espaces de travail de base et avancé.
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Ajouter une fioriture

Voici les méthodes pour ajouter une fioriture :

Sélectionner une note ordinaire et cliquer sur une fioriture dans la palette (double-clic dans les versions inférieures à
3.4).
Faire glisser une fioriture depuis la palette jusqu'à une note ordinaire.
Sélectionner une note ordinaire et presser la touche / pour créer une fioriture courte.

Cela permet d'ajouter une fioriture de la même hauteur que la note ordinaire. Pour ajouter plusieurs appoggiatures à une
même note régulière, il suffit de répéter les actions ci-dessus autant de fois que nécessaire.

Il vous reste à ajuster la hauteur des fioritures ainsi ajoutées. Voir, Modifier la hauteur (ci-dessous)

Note : Lorsqu'une fioriture est insérée, la ligne de liaison n'est pas ajoutée automatiquement. Vous devez le faire vous-
même (Voir la page Liaisons)

Ajouter une accord comme fioriture

Vous pouvez construire une accord de fioriture de la même façon que vous construisez les accords de notes ordinaires :

1. Insérer la première fioriture comme vu ci-dessus.
2. Sélectionner cette première fioriture et ajoutez les suivantes comme vous le feriez pour un accord de notes

ordinaire. Par exemple, en utilisant le nom des notes : Maj.+A...G. Ou par exemple en utilisant les intervals : Alt+1...9.

NDT : pour les intervals, utiliser la touche Option sur Mac

Modifier la hauteur

La hauteur d'une fioriture se modifie de la même façon que celle des notes ordinaires :

1. Sélectionner une ou plusieurs notes fioritures
2. Modifier la hauteur en utilisant les touches fléchées :

↑ ou ↓ pour monter ou descendre d'un demi ton;
Alt+Maj.+↑ ou Alt+Maj.+↓ pour monter ou descendre la hauteur d'une note à la fois en fonction de l'armure de la
portée.

NDT : utiliser la touche Option à la place de la touche Alt sur Mac

Modifier la durée

Deux façon de procéder :

Sélectionner la note fioriture puis cliquez sur la figure de note voulue dans la barre des outils.
Sélectionner la note fioriture puis utiliser le raccourci approprié : 1...9 (voir Ajout des notes).

Adjustment manuel

Position horizontale

Pour ajuster l'espace entre la fioriture et la note ordinaire, il est possible d'utiliser l'une des façons suivantes :

Cliquer sur la fioriture puis entrer dans le mode édition (Alt+Maj.>/kbd>+E) et utiliser les touches fléchées pour le déplacement.
Sélectionner la fioriture et modifier la valeur du décalage X dans la section Élément de l'inspecteur.

Ajustements complémentaires

Il est possible d'ajuster la plupart des autres propriété des notes fioritures en utilisant l'inspecteur (voir "Élément,"
"Accords", et "Note" sections). Il est impossible de modifier l'espace de début pour une fioriture.

Liens externes

Grace note  at Wikipedia
Appoggiatura  at Wikipedia
Acciaccatura  at Wikipedia

Respirations et pauses

Les symboles de Respirations et Pause sont disponibles dans la palette Respirations et pauses palette (espace de
travail avancé).
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Ajouter un symbole

Pour placer un symbole de respiration, ou de pause (césure) à la partition, vous pouvez utiliser au choix :

Sélectionnez une note, puis cliquez sur le symbole dans la palette (double-clic pour les versions antérieures à 3.4).
faites glisser le symbole depuis la palette jusqu'à une note dans la partition.

Le symbole sera placé après la note. On ajuste sa position en modifiant les valeurs X et Y dans l'Inspecteur, ou, en mode
édition avec les flèches.

Ajuster la durée de la pause

Vous pouvez ajuster la durée (en secondes) des pauses et respirations dans l'Inspecteur.

Crescendo / Decrescendo

Ajouter un Crescendo / Decrescendo

Les Crescendos / Decrescendos indiquent un changement de volume sonore dans la partition. Les crescendos
augmentent le volume tandis que les decrescendos le diminuent.

Pour ajouter un Crescendo / Decrescendo :

1. Selectionnez une suite de notes
2. Utilisez l'un des raccourcis suivants :

<: pour ajouter un Crescendo.
>: pour ajouter un Decrescendo.

Vous pouvez également utilisez une des options suivantes :

Sélectionnez une suite de notes, et cliquer sur le symbole voulu dans la palette Lignes (double-cliquez pour les
versions antérieures à 3.4).
Glissez et déposez le Crescendo / Decrescendo depuis la palette vers une portée.

Modifier la hauteur et la longueur

Les Crescendos et Decrescendos sont tous les deux des Lignes dont ils partagent les propriétés. La longueur peut-être
ajustée comme pour les autres lignes.

1. Entrer dans le mode Edition du Crescendo ou du Decrescendo puis cliquer sur la poignée de fin :

2. Utiliser l'un des raccourcis suivants :

Maj+→ pour déplacer la poignée de fin et l'ancre associée, vers la droite, une note ou un silence à la fois.
Maj+← pour déplacer la poignée de fin et l'ancre associée vers la gauche, une note ou un silence à la fois.

Cette méthode pour modifier la longueur d'un Crescendo/Decrescendo est prise n compte dans la lecture sonore de la
partition, ainsi qu'avec le franchissement des sauts de ligne ou des sauts de page.
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3. Pour ajuster finement la position horizontale de la poignée de fin, sans que cela n'affecte la lecture sonore, utiliser
l'un des raccourcis suivants :

→ pour déplacer la poignée vers la droite de 0.1 sp.
← pour déplacer la poignée vers la gauche de 0.1 sp.
Ctrl+→ (Mac: Commande+→) pour déplacer la poignée vers la droite de 1 sp.
Ctrl+← (Mac: Commande+→) pour déplacer la poignée vers la gauche de 1 sp.

Changer la hauteur des Crescendo/Decrescendo:

*Ajustez la poignée inférieure du Crescendo/Decrescendo (le carré bleu dans l'image ci-dessous):

Lignes texte de Crescendo/Decrescendo

Dans la palette Lignes, en plus des symboles Crescendo/Decrescendo, on dispose des lignes cresc. _ _ _ _ _ et
dim. _ _ _ _ _ ayant les mêmes fonctions que les symboles. Il est possible de modifier le texte, si nécessaire, dans la
section Détails de ligne de texte de l'Inspecteur.

Pour changer un Crescendo/Decrescendo en son équivalent texte :

Sélectionner la ligne à modifier et, dans la section Crescendo/Decrescendo de l'Inspecteur, sélectionner le "Type"
de ligne approprié.

Copier les Crescendos/Decrescendos

Depuis la version 3.1 de MuseScore, les Crescendos/Decrescendos peuvent être" copier/coller" comme les éléments
textes : voirRésumé des commandes copier/couper/coller.

Pour les versions antérieures à la 3.1, il est uniquement possible de dupliquer les Crescendo/Decrescendo : voirCopier
les lignes.

Modifier les propriétés d'un crescendo/decrescendo

Les propriétés d'un crescendo/decrescendo sont modifiables dans l'inspecteur :

Elément : Décalage X/Y, placement du symbole au-dessus ou au-dessous de la portée.
Ligne : Couleur de ligne, style de ligne, épaisseur de ligne.
__Détail de ligne de texte_ : Ajout de texte et propriétés des textes ajoutés.
Crescendo/Decrescendo :

Type : Choix entre crescendo et decrescendo, ou texte.
Entourer : Un petit cercle est ajouté à la pointe du symbole.
Hauteur : Largeur de l'ouverture du symbole Crescendo/Decrescendo.
Hauteur du prolongement : largeur du symbole à la fin d'un système, avant qu'il ne se poursuive sur le
système suivant.
Position : Placer le symbole ou la ligne au-dessus ou au-dessous de la portée.
Etendue des nuances : Précise si le Crescendo/Decrescendo concerne la portée, la partie ou tout le système.
Changement de vélocité : modification du son des notes concernées par le symbole ou la ligne (entre 0 et
127).
Utiliser les nuances sur une seule note (à partir de la version 3.1) : Lorsque cette case est cochée (par
défaut), permet au Crescendo/Decrescendo de modifier la dynamique d'une seule note si l'instrument supporte
les dynamiques sur une seule note.
Type de nuance (à partir de la version 3.1) : Choisir la méthode voulue, Linéaire (par défaut), Entrée-Sortie
progressive, Entrée progressive, Sortie progressive ou exponentielle.

Lecture des Crescendos/Decrescendos

Par défaut, un Crescendo/Decrescendo affecte toujours la lecture lorsqu'elle s'applique à une série de notes distinctes.
Pour les instruments supportant la dynamique sur une seule note (par exemple les cordes, les cuivres, etc.), la lecture est
également activée sur une seule note ou une série de notes liées  . (Note : Avant la version 3.1, les
crescendos/decrescendos n'affectaient que la lecture d'une série de note, et non celle des notes simples ou des notes
liées).

Un Crescendo/Decrescendo n'affecte la lecture que s'il y a des marques de dynamique juste avant et après le symbole.
Par exemple, un crescendo entre la dynamique p et f affectera la lecture ; mais un diminuendo entre p et f sera ignoré. Et
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s'il y a deux crescendos ou plus entre p et f, tous seront ignorés sauf le premier.

Un Crescendo/Decrescendo peut être utilisé sans marque de dynamique, en réglant "Changement de vélocité" dans le
Inspecteur (valeurs comprises entre 0 et 127).

Lignes

La palette Lignes de l'espace de travail Avancé propose les lignes suivantes :

Cette palette propose entre autres les lignes suivantes : Liaisons de phrasé, Crescendo et Decrescendo, Alternatives de
reprise, Octavation,etc.

Appliquer des lignes à une partition

La plupart des lignes (à l'exception des Liaisons de phrasé, des Alternatives de reprise et de l'Ambitus) peuvent être
appliquées de la façon suivante :

Pour appliquer une ligne entre deux notes

1. Cliquer sur la note, puis Ctrl+Clic sur la note d'après
2. Dans la palette Lignes, cliquer sur la ligne souhaitée (double-clic dans les versions de MuseScore antérieures à

3.4).

Pour appliquer une ligne sur un ensemble de notes

1. Sélectionner un ensemble de notes
2. Dans la palette Lignes, cliquer sur la ligne souhaitée (double-clic dans les versions de MuseScore antérieures à

3.4).

Pour appliquer une ligne depuis une note jusqu'à fin de la mesure

Utiliser l'une des méthodes suivantes :

Cliquer sur une note puis, dans la palette Lignes, cliquer sur la ligne souhaitée (double-clic dans les versions de
MuseScore antérieures à 3.4).
Faire glisser la ligne depuis la palette Lignes et la déposer sur la partition à l'endroit voulu.

Pour appliquer une ligne sur un ensemble de mesures

1. Sélectionner une ou plusieurs mesures,
2. Dans la palette Lignes, cliquer sur la ligne souhaitée (double-clic dans les versions de MuseScore antérieures à

3.4).

Propriétés des lignes agissant sur la lecture sonore de la partition
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Certaines lignes, par exemple Crescendo - Décrescendo, Alternatives re reprise, Octavation etc., ont un effet sur la
lecture sonore de la partition. Chaque poignée de manipulation est reliée par une ligne pointillée à une ancre sur la
portée (visible lorsqu'on est dans le mode Édition). Cette ancre indique l'étendue précise où sera appliqué l'effet sonore.

Ajuster la position verticale d'une ligne

En mode Normal, utiliser l'une des méthodes suivantes :

Sélectionner sur une ou plusieurs lignes et changer le décalage Y dans l' Inspecteur;
Cliquer sur une ligne, presser et maintenir la touche Maj et faire glisser la ligne vers le haut ou vers le bas à l'aide de
la souris.

Note: Il est également possible de modifier la position horizontale d'une ligne dans le mode Édition.

Modification de la longueur d'une ligne

Note : Les deux méthodes suivantes modifient la position de la fin de la ligne et de son ancre en même temps. Cela
permet de garder une cohérence entre la position de la ligne et l'endroit où l'effet sonore (s'il existe) est appliqué lors de la
lecture de la partition, en particulier si la ligne peut être prolongée sur plusieurs systèmes.

En utilisant des raccourcis claviers

1. Entrer dans le mode Édition et cliquer sur la poignée de fin
2. Appliquer l'un de ces raccourcis clavier :

Maj+→ pour déplacer la poignée de fin et l'ancre vers la droite d'une note à la fois (ou, dans le cas des
Alternatives de reprise, d'une mesure à la fois)
Maj+←pour déplacer la poignée de fin et l'ancre vers la gauche d'une note à la fois (ou, dans le cas des
Alternatives de reprise, d'une mesure à la fois)

En faisant glisser la ligne (à partir de la version de MuseScore 3.5)

Cliquer sur la poignée de fin et la faire glisser à l'aide de la souris.

Ajustement fin

Pour ajuster avec précision la position finale d'une ligne (sans changer la position de l'ancre) :

1. Entrer dans le mode Édition et cliquer sur la poignée de fin
2. Utiliser l'un de ces deux raccourcis clavier :

→ pour déplacer la poignée vers la droite de 0.1 sp (1 sp = un espace de portée = distance entre deux lignes
d'une portée).
← pour déplacer la poignée vers la gauche de 0.1 sp.
Ctrl+→ (Mac: Cmd+→) pour déplacer la poignée vers la droite de 1 sp.
Ctrl+← (Mac: Cmd+→) pour déplacer la poignée vers la gauche de 1 sp.

Lignes avec Texte

Une ligne avec texte est une ligne qui comporte du texte embarqué avec la ligne, par exemple les Alternatives de reprise,
Octavation, ligne de guitare basse, etc.

Lorsque vous appliquez une ligne avec du texte à la partition à partir d'une palette, les propriétés de la ligne restent les
mêmes que pour une autre ligne, mais les propriétés du texte peuvent, dans certaines circonstances, refléter celles du
style en cours pour les lignes de texte. Pour plus de détails, voir Comportement des lignes avec texte.

Lignes personnalisées

Chaque ligne d'une partition peut être personnalisée en modifiant ses propriétés dans l'Inspecteur :

1. Sélectionner la ligne
2. Si un crochet est nécessaire, ajuster les paramètres Début du crochet, Extrémité du crochet and Hauteur dans la

section Détail de ligne de texte
3. Pour ajouter du texte, cocher la case Texte de début, Texte de prolongement et/ou Texte de fin, puis saisir le

texte dans la case "Texte" :
Texte de début: sera affiché au début de la ligne
Texte de prolongement: sera affiché au début de la ligne de continuation
Texte de fin: sera affiché à la fin de la ligne

4. Ajuster les propriétés du texte et son alignement si nécessaire
5. Choisir la Position : "Automatique", "Au dessus", "En dessous" pour placer le texte par rapport à la ligne. "À gauche"

place le texte à gauche de la fin de la ligne
6. Vous pouvez régler la couleur de la ligne, son épaisseur et son style (continue, pointillée, etc) dans la section Ligne.

L'option Autoriser la diagonale vous permet de créer des lignes diagonales en déplaçant la poignée de fin
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7. Pour mémoriser vos choix et pouvoir les réutiliser dans d'autres partition, voir Palettes personnalisées.

Copier une ligne

Une fois installées sur une partition, les lignes ne peuvent pas êtres copiées avec les Copier/Collerpaste habituels. Il est
néanmoins possible de dupliquer les lignes en procédant ainsi :

Maintenir enfoncées les touches Ctrl+Maj (Mac: Commande+Maj), cliquer sur la ligne et faire glisser jusqu'à la position
voulue.

Lignes de fioritures "longues"

Pour ajouter une altération à une ligne de fioriture longue (une ligne de trille par exemple), sélectionner la ligne et cliquer
sur l'un des symboles de la palette Altérations (double-clic pour les versions de MuseScore antérieures à 3.4).

Liens externes

Piano pedal marks  at Wikipedia
Barré à la Guitare  (Wikipedia en anglais)

Lignes d'octave

Les Lignes d'octave sont utilisées pour indiquer qu'un endroit une partition doit être jouée une ou plusieurs octave(s) au
dessus ou en dessous des notes telles qu'elles sont écrites. La ligne peut être continue ou pointillée. Les Lignes
d'octave sont disponibles dans la palette Lignes des espaces de travail de travail de Base et Avancés.

8─────┐ou 8va─────┐: Jouer une octave au dessus des notes écrites
8─────┘ou 8va─────┘: Jouer une octave au dessous des notes écrites

Les lignes 8va alta/bassa sont très courantes dans les partitions pour piano, bien qu'elles soient parfois utilisées par
d'autres instruments de musique.1 15ma alta (2 octaves au dessus) et 15ma bassa (2 octaves au dessous) se rencontrent
occasionnellement.

MuseScore ajuste automatiquement la hauteur des notes jouées lorsqu'il rencontre des lignes d'octave.

Ajouter une ligne d'octave

Voir Ajouter des lignes aux partitions.

Modifier la position verticale

Voir Lignes : Ajuster la position verticale.

Modifier la longueur

Voir Lignes : Modifier la longueur.

Lignes personnalisées

Les Lignes d'octave peuvent être personnalisées comme toutes les autres lignes. Voir Personnalisation des lignes et de
leurs propriétés.

Les propriétés propres aux Lignes d'octave peuvent être modifiées dans la section Octave de l'Inspecteur :

Type : Définir le nombre d'octave à appliquer.
Position : "Au dessus" ou "Au dessous" de la portée.
Nombres seulement : Décocher cette case pour avoir le nombre et le texte (ex : "8va"). Cocher cette case pour
n'avoir que le nombre (ex : "8").
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Liens externes

Octave  at Wikipedia

1. Gerou/Lusk. Essential Dictionary of Music Notation (Archive Internet ) (en anglais). ↩︎

Pauses

Pauses

Une pause, centrée sur une mesure (figure ci-dessous) indique qu'une mesure entière (ou une voix d'une mesure) est
silencieuse, quel que soit le chiffrage de mesure.

Créer une ou plusieurs pauses

Utilisez la méthode suivante si toutes les mesures sélectionnées sont "standards" — i.e. sans durées personnalisées :

1 Sélectionnez une mesure, ou un ensemble de mesures ;
2. Appuyez sur Del.

Si une ou plusieurs mesures contiennent une durée personnalisée, utilisez plutôt la méthode suivante :

1 Sélectionnez une mesure, ou un ensemble de mesures ;
2. Appuyez sur Ctrl+Shift+Del (Mac : Cmd+Shift+Del).

Créer une pause dans une voix particulière

1. Dans la voix concernée, entrez un silence qui s'étend sur la mesure entière ;
2. Assurez-vous que le silence est sélectionné, puis appuyez sur Ctrl+Shift+Del (Mac : Cmd+Shift+Del).

Silences multimesures

Un silence multimesure indique une période de silence pour un instrument : le nombre de mesures est indiqué par le
nombre au dessus de la portée.

Les pauses multimesures sont automatiquement interrompues aux endroits importants comme les doubles barres de
mesure, marques de répétition, les changements de clefs et d'indications de mesure, sauts de section, etc.

Afficher les pauses multimesures

Pour afficher ou non les pauses multimesures:

Appuyez sur M sur votre clavier.

Ou :

1. Dans le menu, choisissez Format→Style…
2. Cliquez sur l'onglet "Partition", s'il n'est pas déjà sélectionné
3. Cochez/décochez "Créer des pauses multimesures". Vous pouvez indiquer ici le nombre minimum de mesures à

combiner en une pause multimesure (voir aussi Mise en page et formatage : Partition).

Note: Il est recommandé de saisir toutes les notes de la partition avant d'activer l'affichage des pauses multimesures.

Saut de pause multimesure

Il est possible de diviser en deux une pause multimesure :

1. Assurez-vous que l'option d'affichage des pauses multimesures est désactivée (voir ci-dessus)
2. Cliquez droit sur la mesure où vous souhaitez faire commencer la seconde pause multimesure
3. Dans le menu, choisissez Propriétés de la mesure ... et cochez "Diviser les pauses multimesures"

Voir aussi : Opérations sur les mesures: Diviser les pauses multimesures.

Liaisons de phrasé
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Une liaison de phrasé est représentée par une ligne courbe qui relie deux ou plusieurs notes. Elle indique à l'interprète
que le passage doit être joué Légato, les notes liées entre elles sans séparation. Attention, il ne faut pas confondre les
liaisons de phrasé avec les liaisons de prolongation qui joignent deux notes de même hauteur, ce qui prolonge la durée du
son. (Voir Liaisons de prolongation pour plus d'information)

Il y a plusieurs façon d'ajouter une liaison de phrasé dans une partition, toutes utiles en fonction du contexte. Ajouter une
liaison de phrasé à partir de la Palette Lignes est également possible mais néanmoins non recommandé.

Ajouter une liaison de phrasé dans le mode "Ajout de notes"

1. Entrer dans le mode Saisie des notes et saisir la première des notes de la phrase devant être jouée legato ;
2. Presser la touche S pour démarrer la liaison de phrasé ;
3. Saisir les autres notes de la phrase musicale ;
4. Presser la touche S une nouvelle fois pour terminer la liaison de phrasé.

Ajouter une liaison de phrasé dans le mode "Normal"

Première méthode

1. S'assurer d'être dans le mode Normal ;

2. Sélectionner la première note de la phrase musicale :

3. Presser la touche S pour ajouter une liaison de phrasé jusqu'à la note suivante:

4. (Optionnel) Maintenir la touche Maj. et presser la touche → (flèche droite) pour agrandir la liaison de phrasé jusqu'à la
dernière note de la phrase. :

5. (Optionnel) Presser le touche X pour modifier le sens de courbure et la position de de la liaison de phrasé :

6. Presser la touche Echap. pour sortir mode édition:

Deuxième méthode

1. S'assurer d'être dans le mode Normal ;
2. Sélectionner la première note de la phrase musicale :
3. Choisir l'une des option suivantes :

Pour ajouter une liaison de phrasé sur une seule voix : Maintenir la touche Ctrl (Mac: Commande) et sélectionner
la dernière note de la phrase.
Pour ajouter une liaison de phrasé sur toutes les voix : Maintenir la touche Maj. et sélectionner la dernière note
de la phrase.

4. Presser ls touche S pour ajouter le liaison de phrasé.

Adjuster la liaison de phrasé

Pour ajuster la position d'une liaison de phrasé :

1. Sélectionner la ligne de liaison de phrasé ;
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2. Utiliser l'une de ces méthodes :
Faire glisser la ligne de liaison de phrasé.
Adjuster les valeurs de décalage X et Y dans l'Inspecteur.

Pour modifier tous les paramètres d'une liaison de phrasé (longueur, position, sens de courbure, ...) :

1. S'assurer d'être dans le mode Normal ;
2. Faire un double-click sur la liaison de phrasé pour entrer dans le Mode édition ;
3. Cliquer sur une poignée de manipulation ou utiliser la touche Tab pour se déplacer de poignée en poignée.;
4. Pour déplacer les poignées qui définissent la longueur de la liaison de phrasé, utiliser les raccourcis suivants :

Maj.+→ : Aller à la note suivante.
Maj.+← : Aller à la note précédente.
Maj.+↑ : Passer la liaison de phrasé sur la voix inférieure (voix 2 à voix 1 etc.).
Maj.+↓ : Passer la liaison de phrasé sur la voix supérieure (voix 1 à voix 2 etc.).

5. Pour déplacer les autres poignées, utiliser les raccourcis suivants :
Faire glisser la poignée.
Utiliser les touches fléchées pour un ajustement fin (0.1 sp. la fois). Pour de plus grands déplacements (1 sp. à
la fois) utiliser les touches Ctrl+→ ← ↑ ↓ .

6. Presser Echap pour sortir du mode Édition.

Note : Les deux poignées extérieures ajustent le début et la fin de la liaison de phrasé, tandis que les trois poignées de la
courbe ajustent le contour. La poignée du milieu sur la ligne droite sert à déplacer l'ensemble de la liaison de phrasé vers
le haut/le bas/la gauche/la droite.

Liaisons de phrasé étendues

Une liaison de phrasé peut s'étendre sur plusieurs systèmes, voir sur plusieurs pages. Le début et la fin de la liaison sont
ancrés à une note/un accord ou un silence. Si les notes sont repositionnées en raison de changements dans la mise en
page, l'étirement ou le style, la liaison se déplace et s'ajuste également en taille.

Cet exemple montre une liaison de phrasé qui s'étend de la clé de Fa à la clé de Sol. Avec la souris, sélectionner la
première note de la phrase, maintenir enfoncée la touche Ctrl (Mac: Commande) et sélectionner la dernière note de la
phrase. Presser la touche S pour ajouter la liaison de phrasé.

X Change le sens de courbure de la liaison de phrasé sélectionnée.

Liaison de phrasé pointillées

Les liaisons de phrasé en pointillé sont parfois utilisées dans les chansons où la présence d'une liaison varie d'une
strophe à l'autre. Les liaisons de phrasé en pointillé sont également utilisées pour indiquer une suggestion de l'éditeur (par
opposition aux marques originales du compositeur). Pour changer une liaison existante en liaison pointillée (ou une liaison
en tirets), sélectionnez cette ligne puis, dans l'inspecteur (F8) changez "Type de ligne" de "Continue" à "Pointillé" ou
"Tireté".

Voir aussi

Liens
Mode édition
Saisie des notes

Liaisons de prolongation

Une liaison de prolongation est une ligne en forme d’arc de cercle qui relie deux notes de la même hauteur, la durée de
la seconde note est ajoutée à la première pour ne faire entendre qu’un seul son, (voir les liens externes ci-dessous).
Les liaisons de prolongation sont créées pour relier deux notes adjacentes de la même voix, Cependant MuseScore
permet aussi d’en créer entre deux notes non adjacentes et d’une autre voix.

Une liaison sera placée automatiquement si vous le voulez après avoir saisi une note ou un accord en étant en mode de
saisie des notes, la seconde note sera automatiquement trouvée et liée.
Vous pouvez aussi créer une liaison entre deux notes déjà existantes.

Note : Ne pas confondre les liaisons de prolongation entre deux notes de même hauteur et les liaisons de phrasé qui lient
plusieurs notes de hauteurs différentes signalant un legato.
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Ajouter des liaisons à partir de notes seules

En Mode normal :

1. Cliquez sur une note, ou sélectionnez en plusieurs, en maintenant appuyé la touche Ctrl (Mac: Cmd) et cliquez sur les
notes désirées :

2. Appuyez sur la touche + ou le bouton liaison de liaison de la barre d’outils,  :

.

Les liaisons seront créées entre les notes sélectionnées et les notes suivantes de la même hauteur.

En Mode de saisie des notes :

1. Sélectionnez une note (qui ne fait pas partie d’un accord).
2. Sélectionnez une durée de note pour la note suivante si besoin (voir la "Note" ci-dessous).
3. Tapez + ou le bouton liaison de la barre d’outils.

Note : Ce raccourci ne fonctionne que s’il n’y a pas d’accord après la note sélectionnée. S’il y a un accord, la durée sera
ignorée et la note liée sera ajoutée au lieu de l’accord suivant.

Ajouter des liaisons aux accords

En Mode normal :

1. Utilisez l’une des méthodes suivantes :
Maintenez appuyé la touche Maj et cliquez sur n’importe quelle note de l’accord ;
Cliquez sur la hampe de l’accord ;

2. Tapez +, ou cliquez sur le bouton liaison de la barre d’outils .

Les liaisons seront créées entre toutes les notes de l’accord sélectionné et toutes les notes suivantes de même hauteur.

En Mode de saisie des notes :

1. Assurez-vous qu’une note soit sélectionnée dans un accord.
2. Sélectionnez une durée de note pour l’accord suivant si besoin (voir la "Note" ci-dessous).
3. Tapez + ou le bouton liaison de la barre d’outils.

Note : Ce raccourci ne fonctionne que s’il n’y a pas d’accord après la note sélectionnée. S’il y a un accord, la durée sera
ignorée et la note liée sera ajoutée au lieu de l’accord suivant.

Ajouter des notes liées à un accord déjà lié

Vous pouvez avoir besoin de revenir sur un accord déjà lié pour y ajouter d’autres notes liées. Une commande différente
est utilisée, par exemple :

1. Ajouter des notes au premier accord.

2. En Mode de saisie des notes, après avoir sélectionné n’importe quelle note du premier accord, tapez Alt++. Les
notes correspondantes sont ajoutées à l'accord suivant et les notes supplémentaires sont liées :
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Ajouter des liaisons aux notes à l’unisson

On a besoin d’une méthode de contournement pour créer des liaisons entre notes à l’unisson :

1. Créez la première note comme d’habitude ;
2. Toutes les notes à l’unisson doivent être ajoutées à un intervalle diffèrent de l’unisson : Seconde, tierce, quarte, etc.
3. Créez un accord lié (comme ci-dessus) :

4. Déplacez les notes à l’unisson à leur position prévue :

Inverser une liaison

La touche X inverse le sens de la liaison sélectionnée, soit au-dessus des notes, soit au-dessous.

Voir aussi

Liaisons de phrasé

Liens externes

Comment créer des liaisons vers la 2ème alternative de reprise
Liaison de prolongation)  sur Wikipedia

Trémolo

Un Trémolo est une répétition très rapide s'une note ou d'un accord, ou une alternance rapide entre deux notes ou deux
accords. Le symbole Trémolo est disponible dans la palette Trémolos de l'espace de travail avancé. Les deux types de
trémolo y sont présents.

Un trémolo sur une note ou un accord est indiqué par des traits dans la hampe de la note ou de l'accord (ou au-
dessus/en dessous s'il s'agit d'une ronde). Par exemple :

Un trémolos sur deux notes ou deux accords, est indiqué par des barres dessinées entre les notes. Par exemple :

Les symboles Tremolo sont également utilisés pour noter les roulements de batterie.

Ajouter un Trémolo

Trémolo sur une note ou un accord

1. Dans le cas d'une note seule, la sélectionner ; s'il s'agit d'un accord, sélectionner toutes les notes de l'accord;
2. Cliquer sur le symbole Trémolo dans la palette (double click dans les versions de MuseScore antérieures à 3.4).

Il est également possible de glisser/déposer le symbole sur la note.

Trémolo sur deux notes ou deux accords

1. Saisir les notes à la moitié de la durée finale souhaitée
2. S'il s'agit d'une seule note, sélectionnez la première note de la paire ; s'il s'agit d'un accord, sélectionner n'importe

quelle note du premier accord
3. Cliquer sur le symbole souhaité dans la palette Tremolo (double-clic dans les versions antérieures à 3.4).

Il est également possible de glisser/déposer le symbole sur la note.
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Exemple : Pour faire un trémolo sur deux notes d'une durée de 1 noire, entrer deux croches. Après avoir appliqué un
symbole de trémolo à la première note, les deux notes se combinent pour former une seule noire.

Liens externes

Tremolo  (Wikipedia)
How to create 'old style' and other special tremolos?  (MuseScore HowTo)

Alternatives de reprise

Une barre de reprise est constituée d'une double barre de mesure précédée ou suivie de deux points. Deux barres de
reprise encadrent une phrase musicale devant être jouée deux ou plusieurs fois.

MuseScore joue automatiquement les reprises si le bouton  est activé :

On utilise deux barres de reprises différentes, l'une pour marquer le début et une autre pour marquer la fin du fragment
musical à rejouer. (Voir Répétition simple). Les deux points de chaque barre sont tournés vers l'intérieur du fragment
concerné. Si la première barre de reprise est située au tout début du morceau, il est possible de ne pas la noter.

Exemple :

Lorsque la fin des deux phrases musicales identiques diffèrent, il est possible d'ajouter des alternatives de reprise :
* l'alternative de 1ère fois (1.) ne sera jouée que la 1ère fois
* l'alternative de 2ème fois (2.) ne sera jouée que la 2ème fois
Les alternatives de reprise numérotées sont disponibles dans la palette lignes.

Exemple

Ajouter une alternative de reprise

Utiliser l'une des méthodes suivantes :

Sélectionner une mesure ou une plage de mesures et cliquer sur l'icône alternative de reprise dans la Palette
'Lignes' (double-clic dans les versions antérieures à 3.4).
Glissez-déposez une alternative de reprise depuis la Palette 'lignes', puis ajustez la longueur selon vos besoins (voir
ci-dessous).

Modifier le nombre de mesures d'une alternative de reprise

1. Entrer dans le Mode Édition de l'alternative de reprise (double-clic sur la ligne). La poignée de fin est automatiquement
sélectionnée mais vous pouvez sélectionner celle de début.

2. Utiliser les touches Maj.+→ ou Maj.+← pour agrandir ou rétrécir l'alternative de reprise d'une ou plusieurs mesures.

Note: Lorsque vous êtes en mode Édition (double clic) d'une alternative de reprise, deux lignes pointillées apparaissent,
reliant les poignées début et fin à deux points d' ancrage sur la portée (voir le schéma ci-dessous). Ces points d'ancrage
indiquent la position de début et de fin de l'alternative de reprise. Les touches fléchées combinées avec la touche Maj.
déplacent les points d'ancrage de barre de mesure en barre de mesure. Il est possible de déplacer la ligne de l'alternative
de reprise pour effectuer des ajustements visuels précis en utilisant les flèches du clavier sans la touche Maj., ou en
faisant glisser les poignées avec la souris.

Propriétés des alternatives de reprise

Modifier le texte des alternatives de reprise:

Sélectionner l'alternative de reprise et modifier les propriétés Texte de début dans l'Inspecteur.
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Définir l'ordre des répétitions:

Sélectionner l'alternative de reprise puis, dans l'inspecteur dans la zone Alternatives de reprise, dans le champ
Liste des reprises, entrer un nombre ou une suite de nombres séparés par des virgules (une virgule et un espace)
spécifiant à quelle répétition l'alternative doit être joué.

Par exemple, une première répétition est notée "1", une seconde répétition est notée "2" et ainsi de suite. Pour un
enchaînement plus complexe de répétitions, on peut, par exemple, indiquer "1, 2, 4, 5, 7" dans le champs Liste des
reprises. MuseScore jouera les mesures de cette alternative de reprise la 1ère fois, le 2ème fois, la 4ème fois, la 5ème
fois et la 7ème fois.

Note: La dernière mesure de chaque alternative de reprise doit comporter une barre de mesure "fin de répétition", à
l'exception de la dernière alternative de reprise.

Jouer les alternatives de reprise

Lorsqu'une alternative de reprise doit être jouée plus de 2 fois par MuseScore, il est indispensable d'aller dans les
propriétés de la dernière mesure de cette alternative, celle qui contient la barre de mesure "Fin de répétition" et de
modifier le champ "Nombre de lectures". (Clic-droit sur la mesure, Propriétés de la mesure..., Nombre de lectures). Voir
Opérations sur les mesures: Autres propriétés ainsi que la note sur l'exécution des répétitions par MuseScore dans
Répétitions et sauts,fragment=.

Nombre de lectures d'une mesure

La propriété nombre de lectures d'une mesure contenant une barre de mesure "Fin de répétition" doit être égale au
nombre de fois que vous voulez que cette mesure soit jouée augmenté de 1.

Par exemple, dans la partition suivante :

Le champ Nombre de lectures de la mesure 4 doit être fixé à 4
Le champ Nombre de lectures de la mesure 6 doit être fixé à 3

Liens externes

MuseScore in Minutes, Lesson 8: Repeats and Endings, Part 1
How to create ties leading into a 2nd ending  (MuseScore HowTo)

Divisions irrégulières
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Les Divisions irrégulières sont utilisées pour écrire les durées de note que l'indication de mesure rend impossible. Par
exemple, un triolet de croches en 4/4 divise une noire en trois au lieu de deux.

Un duolet permet de jouer deux notes dans le temps de trois :

Créer une division irrégulière

La méthode exacte de saisie des divisions irrégulières dépend du fait que vous démarriez en Mode saisie de note ou
Mode normal. Nous commencerons par un exemple simple : la création d'un triolet de croches.

Création d'un Triolet en mode normal

1. Sélectionnez une note ou un silence ayant la durée complète du triolet souhaité. Dans le cas d'un triolet de croches,
vous devrez sélectionner une noire ou un silence, comme dans l'exemple ci-dessous :

2. Utiliser le raccourci clavier pour insérer le triolet, Ctrl+3 (Mac: Commande+3). Il est également possible d'utiliser le menu
Ajouter→Divisions irrégulières→Triolet. Cela donne le résultat suivant :

3. MuseScore passe automatiquement en mode de saisie de notes et sélectionne la durée la plus appropriée - dans
cet exemple, une croche. Saisissez maintenant les notes/silences souhaités. Par exemple :

Création d'un Triolet en mode Saisie de Notes

1. S'assurer qu'on est bien dans le mode Saisie de note (N).
2. Se déplacer jusqu'à la note, le silence, ou la mesure où vous voulez placer le triolet (utiliser les touches fléchées

droite et gauche si nécessaire).
3. Sélectionner la durée finale de l'ensemble du triolet. Dans le cas d'un triolet de croches, cliquer sur la noire dans la

barre d'outil ou utiliser la touche 5 sur le clavier.
4. Utiliser le raccourci clavier pour un triolet, Ctrl+3 (Mac: Commande+3) ou utiliser le menu, Ajouter→Divisine

irrégulières→Triolet. Ceci crée un triolet avec le numéro et le crochet et divise la note d'origine en notes/silences. Voir
l'exemple ci-dessus.

5. MuseScore sélectionne automatiquement la durée la plus appropriée - dans cet exemple une croche - ce qui vous
permet de commencer immédiatement à entrer la série de notes/silences souhaitée.

Créer d'autres divisions irrégulières

Pour créer d'autres divisions irrégulières, remplacez l'une des commandes suivantes à l'étape correspondante ci-dessus :

Utiliser Ctrl+2–9 (Mac: Commande+2–9). 2 pour un duolet, 3 pour un triolet, etc.
Dans le menu, sélectionner Ajouter→Divisions irrégulières, et cliquer sur l'option désirée.

Pour des cas plus complexes, voir ci-dessous.

Divisions irrégulières personnalisées

Pour créer d'autres divisions irrégulières absentes des options par défaut (par exemple, 13 doubles-croches dans la
durée d'une noire) :

1. Dans le Mode saisie de note, sélectionner une note ayant la durée totale de la division irrégulière à créer. Dans le
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Mode normal, sélectionner une note ou un silence ayant la durée totale de la division irrégulière à créer.
2. Ouvrir la boîte de dialogue Créer une division irrégulière dans le menu : Ajouter→Divisions irrégulières→Autres...;

3. Sélectionnez le rapport de nombres souhaité (par exemple 13/4 pour treize doubles croches dans la durée d'une
noire) sous "Ratio" dans la section "Type". Choisir les types de "Numéro" et de "Crochet" en utilisant les boutons
radio de la section "Format".

4. Cliquer sur OK pour refermer cette boîte de dialogue :

5. Il ne reste plus qu'à saisir notes et silences.

Exemple de triolets

Supprimer une division irrégulière

Utiliser l'une des méthodes suivantes :

Sélectionner le numéro ou le crochet puis presser la touche Suppr.
Sélectionner la totalité de la division irrégulière en utilisant la méthode du lasso puis presser la touche Suppr.
Sélectionner n'importe quel élément de la division irrégulière puis, dans l'inspecteur, cliquer sur le bouton en bas à
droite "Division irrégulière" puis presser la touche Suppr.

Modifier l'affichage des divisions irrégulières

En utilisant l'inspecteur

Pour modifier les propriétés d'affichage des divisions irrégulières, sélectionnez le numéro ou le crochet, et ajustez les
propriétés souhaitées dans la section "Division irrégulière" de l'Inspecteur :
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Direction : 'Auto' positionne le numéro et le crochet automatiquement. 'Haut' positionne le numéro et le crochet
toujours au dessus des notes. 'Bas' positionne le numéro et le crochet toujours au dessous des notes.
Type de numéro : Choisir entre 'Numéro', 'Ratio', ou 'Aucun'.
Type de crochet : 'Automatique' masque le crochet pour les notes avec ligatures et affiche le crochet si la division
irrégulière comprend des notes sans ligatures ou des silences. 'Crochet' affiche toujours le crochet. "Aucun" masque
toujours le crochet.

En utilisant la boîte de dialogue Style des divisions irrégulière

Pour ajuster avec précision l'affichage de toutes les divisions irrégulières d'une partition, dans le menu, sélectionner
Format → Style...→Divisions irrégulières.

L'image ci-dessous montre les propriétés qui peuvent être ajustées dans le dialogue de style des divisions irrégulières :

(2) Distance verticale de la hampe.
(3) Distance verticale entre les têtes de note.
(5) Distance avant la hampe de la première note.
(6) Distance après la hampe de la dernière note.

Liens externes

How to create triplets and other tuplets  (MuseScore HowTo)
How to create nonstandard tuplets  (MuseScore HowTo)
How To create triplets and other tuplets across measures  (MuseScore HowTo)
Triolets  sur Wikipedia en français
The User Guide to Tuplets in MuseScore  [video]

Répétitions et Sauts

Répétitions simple

Il est possible de créer une répétition simple en utilisant les barres début et fin de reprise disponibles dans les palettes
barres de mesures et Reprises.

Note : Si le début d'une reprise coïncide avec le début de la partition ou un début de section, la barre de reprise de début
peut être omise. De la même façon la barre de fin de reprise peut être omise si elle coïncide avec la fin de la partition ou
la fin d'une section.
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Alternatives de reprise 1ère et 2ème fois

Dans une premier temps, créer une reprise simple comme vu au paragraphe précédent. Définir ensuite les alternatives
première et la deuxième fois : Alternatives de reprise.

Lecture sonore

Jouer ou pas les reprises

Activer ou désactiver le bouton  dans la barre d'outil.

Ajuster la lecture sonner des reprises

Les reprises simples comme celles illustrées ci-dessus, ou les "Alternatives de reprise "1, 2", sont généralement lues
correctement la première fois. Les reprises plus complexes peuvent nécessiter un réglage supplémentaire comme suit :

1. Assurez-vous que les barres de début et de fin de reprise sont correctement positionnées. Assurez-vous que
chaque alternative de reprise, sauf la dernière, se termine par une barre de fin de reprise.

2. Dans la cas d'une simple reprise, lorsque plus d'une reprise est nécessaire, cliquez avec le bouton droit de la
souris sur la mesure contenant la barre de reprise finale et sélectionnez Propriétés de la mesure.... Ajustez Nombre
de lecture pour qu'il soit égal au nombre de fois que vous voulez que la section soit lue.

3. Dans le cas de reprises complexes, comme par exemple :

Assurez-vous que la "liste des reprises" de l'alternative de reprise est correctement configurée - voir Propriétés des
alternatives de reprises. Faites un clic droit sur la mesure contenant la barre de reprise de fin et sélectionnez
Propriétés de la mesure.... Ajustez le Nombre de lecture pour qu'il soit supérieur d'une unité au nombre de mesures
listées dans la "liste des reprises" d'alternative de reprise. Dans ce cas, puisque 5 mesures sont listées, le "Nombre
de lecture" doit être réglé sur 6.

Symboles de reprise et textes

Les textes et les symboles concernant les reprises sont disponibles dans la palette "Reprise" (dans les espaces de travail
de base et avancé). Cette palette propose :

Les symboles pour reprendre des mesures Segno, Segno Serpent, Coda, Coda carrée (Codetta)
D.S., D.C., al Coda, al Fine, To Coda, et le texte Fine
Les barres de début et de fin de reprise.

Pour ajouter un symbole de reprise, utiliser l'une des méthodes suivantes :

Sélectionner une mesure, puis cliquer sur le symbole désiré dans la palette Reprises (double-click dans les
versions MuseScore antérieures à 3.4).
Faire glisser un symbole depuis la palette et le déposer sur (et pas au dessous) la mesure choisie. (la mesure
sélectionnée change temporairement de couleur).

Sauts

Les sauts sont des symboles dans la partition qui indiquent au musicien de passer à un repère nommé (voir ci-dessous).
Les sauts comprennent les différents types de texte D.C. (Da Capo) et D.S. (Dal Segno).

Pour que la lecture sonore tienne compte des sauts :
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S'assurer que le bouton "Jouer les reprises"  de la barre des outils soit sélectionnée. (Il s'agit d'un bouton
marche/arrêt).

Après le saut, et selon la convention musicale établie, les reprises ne seront pas jouées. Si vous souhaitez que la
lecture joue les reprises :

1. Sélectionner le symbole de saut
2. Dans la section "Saut" de l'Inspecteur, cocher "Jouer les reprises".

Note : Les sauts ne sont effectués qu'après l'exécution de toutes les reprises simples de la section.

Si vous cliquez sur un saut, la section Saut de l'Inspecteur propose les options suivantes :

Aller à : La lecture saute jusqu'au repère dont la propriété "Étiquette" contient la même valeur que champ "Aller à".
Jouer jusqu'à : La lecture se poursuit jusqu'à rencontrer le repère dont la propriété "Étiquette" contient la même
valeur que le champ "Jouer jusqu'à".
Continuer à : La lecture sautera jusqu'au prochain repère dont la propriété "Étiquette" contient la même valeur que
le champ "Continuer à".
Jouer les reprises : Cochez cette case pour que MuseScore joue les répétitions après les sauts de D.C. (Da Capo)
ou D.S. (Dal Segno). Si cette option n'est pas cochée, les [reprises simples] (#simple-repeats) ne sont pas jouées
après les sauts et la lecture fonctionne comme si c'était la dernière répétition.

Note : Les balises start et end, qui font référence au début et à la fin d'une partition ou section, sont implicites et n'ont pas
besoin d'être ajoutées par l'utilisateur.

Repères

Les Repères sont les emplacements auxquels se réfèrent les sauts. Les repères de début et de fin (start et end) sont
implicites. Voici la liste des autres repères :

: Segno (étiquette : segno)

 : Segno Serpent (étiquette : varsegno)

: Coda (étiquette : codab)

 : Var Coda (étiquette : varcoda)
Fine : (étiquette : fine)
To Coda : (étiquette: coda)

Si vous cliquez sur un repère, les propriétés suivantes s'affichent dans l'Inspecteur :

Type de repère : Peut être modifié avec les options présentes dans la liste déroulante.
Étiquette : Il s'agit de l'identifiant du repère. Voir Jumps.

Exemples de saut

Da Capo (D.C.) : Au symbole "D.C.", la lecture recommence au début de la partition (c'est à dire à l'étiquette
implicite start) et rejoue toutes les sections jusqu'à l'étiquette implicite end .
Da Capo (D.C.) al Fine : Au symbole "D.C. al Fine", la lecture recommence au début de la partition (c'est à dire à
l'étiquette implicite start) et rejoue toutes les sections jusqu'au marqueur Fine.
Dal Segno (D.S.) al Fine : Au symbole "D.S. al Fine", la lecture saute au symbole Segno et rejoue toutes les
sections jusqu'au marqueur Fine.
Dal Segno (D.S.) al Coda : Au symbole "D.S. al Coda", la lecture saute au symbole Segno puis joue jusqu'au
symbole To Coda. Après quoi la lecture saute au symbole Coda.

Note: Les propriétés des sauts et des repères peuvent être modifiées dans l'Inspecteur.

Il est nécessaire de les ajuster lorsque vous utilisez plusieurs sauts et marqueurs.

Voir aussi

Barres de mesure
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Alternatives de reprise

Liens externes

MuseScore in Minutes: Repeats and Endings, part 2  (video tutorial)
How to separate a coda from the rest of the score  (MuseScore HowTo)
How to create a 2-measure repeat sign with playback  (MuseScore HowTo)
How to use Jumps and Repeats  (MuseScore HowTo)

Transposition

La transposition décale d’un même intervalle une sélection de notes vers l'aigu ou vers le grave. Vous pouvez utiliser la
Transposition manuelle des notes, ou la Transposition automatique.

Transposition manuelle

1. Sélectionnez les notes à transposer.
2. Utilisez les touches suivantes :

Transposition chromatique : Tapez ↑ ou ↓. Répéter autant de fois que nécessaire.
Transposition diatonique : Tapez Alt + Maj + ↑ ou ↓. Répéter autant de fois que nécessaire.
Transposition à l’octave : Tapez Ctrl + ↑ ou ↓ (Mac: Cmd + ↑ ou ↓).

Transposition automatique

La fenêtre de dialogue Transposer de MuseScore permet plus de possibilités.

Note : Ouvrez la fenêtre de transposition à partir du menu Outils, par ailleurs vous pouvez lui affecter un raccourci (voir
Préférences).

Transposition chromatique

Par tonalité

Pour transposer les notes vers le haut ou le bas jusqu'à la tonalité souhaitée :

1. Sélectionnez les notes à transposer ; la partition sera entièrement transposée si aucune note n’est sélectionnée.
2. Dans la barre de menu, cliquez sur Outils → Transposer….
3. Cochez "Transposition chromatique" et "Par tonalité".
4. Cochez ou décochez "Transposer les armures" et "Transposer les symboles d’accord" si nécessaire.
5. Cochez "Au plus près", "Haut", ou "Bas", et choisissez la tonalité voulue dans la liste déroulante.
6. Cliquez sur OK.
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Par Intervalle

Pour transposer les notes vers le haut ou le bas par pas d’un demi-ton :

1. Sélectionnez les notes à transposer ; la partition sera entièrement transposée si aucune note n’est sélectionnée.
2. Dans la barre de menu, cliquez sur Outils → Transposer….
3. Cochez "Transposition chromatique" et "Par intervalle".
4. Cochez ou décochez "Transposer les armures" et "Transposer les symboles d’accord" si nécessaire.
5. Cochez "Haut", ou "Bas", et choisissez l’intervalle voulu dans la liste déroulante.
6. Cliquez sur OK.

Transposition diatonique

Pour transposer les notes vers le haut ou le bas par intervalle diatonique :

1. Sélectionnez les notes à transposer ; la partition sera entièrement transposée si aucune note n’est sélectionnée.
2. Dans la barre de menu, cliquez sur Outils → Transposer….
3. Cochez "Transposition diatonique".
4. Cochez ou décochez "Transposer les armures" et "Transposer les symboles d’accord" si nécessaire.
5. Cochez "Haut" ou "Bas" et choisissez l’intervalle voulu dans la liste déroulante.
6. Cliquez sur OK.

Options

La zone options propose deux contrôles communs aux modes de transposition chromatique et diatonique :

Transposer les symboles d’accord, si nécessaire.
Et le choix entre Utiliser des double ♯ ou ♭ ou ♯ et ♭ simples seulement.

Instruments transpositeurs

Certains Instruments transpositeurs, comme la trompette en Si bémol ou le saxophone alto en Mi bémol, sonnent au-
dessus ou au-dessous de leurs notes écrites. MuseScore dispose d'une prise en charge intégrée facilitant l’écriture de
partitions avec ces instruments.

Tonalité réelle

Le mode d’affichage par défaut de la notation musicale par MuseScore est en tonalité écrite (transposée), vous pouvez
toutefois afficher la partition en tonalité réelle. Dans ce mode d’affichage, la notation musicale de tous les instruments sera
affichée en tonalité jouée et entendue pendant la lecture sonore.

Pour passer l’affichage en tonalité réelle : Cliquez sur le bouton Tonalité réelle.

Assurez vous de revenir en tonalité écrite (transposée) avant d’imprimer la partition principale ou l’une ou l’autre des
parties.

Changer la transposition de la portée

Les transpositions d’instrument sont déjà paramétrées dans MuseScore. Si vous voulez utiliser un instrument rare, ou une
transposition indisponible dans MuseScore, vous pouvez éditer la transposition manuellement.

1. Faites un clic droit dans un espace libre de la portée de l’instrument et sélectionnez Propriétés de la portée / partie… .
2. La sélection de l’intervalle et de l’octave de transposition se trouve au bas de la fenêtre, ainsi que le choix vers

l’aigu, "Haut" (sonne plus haut qu’écrit), ou vers le grave, "Bas" (sonne plus bas qu’écrit).

De plus, vous pouvez dans la même fenêtre des Propriétés de la portée / partie, choisir de changer d’instrument
transpositeur en cliquant sur le bouton Changer d’instrument….

Liens externes

How to transpose  (MuseScore How-To en anglais)
Concert pitch or not?  (forum discussion en anglais)
How to change enharmonic key signatures for transposing instruments  (MuseScore How-To en anglais)

Notation pour percussion

La saisie de la notation des percussions est quelque peu différente de la saisie de la notation des instruments à notes
fixes (comme le piano ou le violon).

Types de portées pour percussion
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Lorsque vous créez une portée pour percussion en utilisant l'assistant Assistant Nouvelle Partition ou la boîte de dialogue
Instruments, MuseScore choisit automatiquement le type de portée le plus approprié (1, 3 ou 5 lignes) en fonction de
l'instrument : Ceci peut être modifié en utilisant la colonne "Type de portée" sur la page Choix des instruments. Toute
modification supplémentaire (par exemple, une portée de 2 lignes) peut être effectuée à partir de la partition elle-même
(voir Propriétés Style Avancées).

Sur une portée de percussion à 5 lignes, chaque instrument se voit attribuer une position sur la portée (ligne ou inter-
ligne) et une forme de tête de note. Pour une batterie, une ou deux voix peuvent être utilisées. Dans ce dernier cas, la
voix1 (la voix supérieure) contient généralement les notes (up-stem) jouées par les mains tandis que voix 2 (la voix
inférieure) contient généralement les notes (down-stem) jouées par les pieds (voir image ci-dessous).

Méthodes de saisie des notes

Vous pouvez ajouter des notes à une portée de percussion à partir des moyens suivants :

Clavier MIDI externe
Clavier du piano virtuel
Clavier de l'ordinateur
Souris

Ces moyens peuvent être utilisées dans toute combinaison souhaitée :

Clavier MIDI

Pour ajouter des notes à une portée de percussion à partir d'un clavier MIDI :

1. Assurez-vous que le clavier MIDI est connecté et fonctionne correctement.

Remarque : Si vous cliquez sur la portée de percussion sans entrer en mode Saisie des notes, vous pouvez
essayer les instruments de percussion à partir du clavier MIDI.

2. Cliquer sur la note ou le silence où vous voulez commencer.

3. Entrer dans le mode Saisie des notes.
4. Sélectionner la voix. Par exemple, les caisses claires, les sidesticks et toutes les cymbales sont normalement

ajoutés à la voix 1 ; la grosse caisse à la voix 2.
5. Définir la Durée de la note.
6. Appuyer sur une touche d'instrument pour ajouter une note à la partition. Pour ajouter une autre note à la même

position, maintenez la première touche enfoncée tout en appuyant sur la seconde.

Remarque : Reportez-vous à la General MIDI PERCUSSION Key Map pour savoir quelle touche du clavier MIDI
correspond à quel instrument de percussion. Certains claviers (par exemple, Thomann) affichent des symboles de
percussion au-dessus des touches pour aider l'utilisateur.

Clavier du piano virtuel

Pour ajouter des notes à une portée de percussion à partir du Clavier de piano virtuel :

1. Pour afficher le clavier de piano virtuel, appuyer sur P (ou sélectionnez-le dans le menu, Affichage→ Clavier de piano).

Remarque : Si vous cliquez sur la portée de percussion sans entrer en mode Saisie des notes, vous pouvez tester
les instruments de percussion à partir du clavier de piano.

2. Cliquer sur la note ou le silence où commencer.

3. Entrer dans le mode Saisie des notes.
4. Sélectionner la voix. Par exemple, les caisses claires, les sidesticks et toutes les cymbales sont normalement

ajoutés à la voix 1 ; la grosse caisse à la voix 2.
5. Définir la Durée de la note.
6. Cliquer sur une touche de piano virtuel pour ajouter une note à la partition.
7. Pour ajouter une autre note à une note existante, appuyer sur Maj et maintenir tout en cliquant sur la nouvelle note

(dans les versions antérieures à 2.1, utilisez Ctrl (Mac : Commande)).

Remarque : Reportez-vous à la General MIDI PERCUSSION Key Map pour savoir quelle touche du clavier MIDI
correspond à quel instrument de percussion. Certains claviers (par exemple, casio) affichent des symboles de percussion
à coté des touches pour aider l'utilisateur.
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Par défaut, le clavier de piano est fixé au bas de l'écran, à gauche de la palette d'entrée Percussion. Vous pouvez
toutefois le déplacer en le faisant glisser, puis l'ancrer à nouveau de plusieurs façons :

Faites glisser le panneau vers le bas jusqu'au centre et il se superpose à la palette d'entrée Percussion, sur toute sa
longueur. Les deux panneaux sont alors accessibles par des onglets.
Faites glisser le panneau vers le bas, vers la droite ou la gauche, et il se fixe à droite ou à gauche de la palette de
saisie de la batterie.

Clavier de l'ordinateur

Pour entrer des notes sur une portée de percussion en utilisant le clavier de votre ordinateur :

1. Cliquer sur la note ou le silence où commencer.
2. Entrer en mode Saisie des notes. La palette de saisie de batterie apparaît maintenant en bas de l'écran (voir ci-

dessous).
3. Sélectionner la durée de la note.
4. Appuyer sur la touche de raccourci (A-G) de l'instrument à saisir - se reporter à la fenêtre palette de saisie de

batterie.
5. Pour ajouter une autre note à une note existante dans cette voix, appuyez sur Maj + [A-G].

Remarque : L'attribution des voix est déterminée par la couleur de la note dans la palette de saisie de la batterie : bleu
pour la voix 1, vert pour la voix 2...

Souris

Ajouter une note à une portée de percussion

Utilisez la méthode suivante pour ajouter une nouvelle note_ ou pour remplacer une _ note existante_ Accords.

1. Sélectionner la note ou le silence où commencer. Il est également possible de sélectionner une mesure.
2. Appuyez sur N pour entrer dans mode Saisie des notes. La palette de saisie de batterie apparaît au bas de l'écran

(voir ci-dessous).
3. Définir la durée de la note.
4. Choisir l'une des options suivantes :

Double-cliquer sur une note dans la palette de saisie de batterie.
Sélectionnez une note (par exemple, la grosse caisse ou la caisse claire) dans la palette de saisie de batterie,
puis cliquez sur une note ou un silence dans la partition.

Ajouter une note à un accord existant dans la portée de percussion.

1. Passer en mode Saisie des notes.
2. Sélectionner une durée pour la note à ajouter.
3. Cliquer sur la nouvelle note dans la palette de saisie de batterie.
4. Cliquer au-dessus ou au-dessous de la note existante dans la portée de percussion.

Remarque : L'attribution des voix est déterminée par la couleur de la note dans la palette de saisie de la batterie : bleu
pour la voix 1, vert pour la voix 2...

Palette de saisie de batterie

Lorsqu'une portée de percussion est sélectionnée et que le mode Saisie des notes est activé, une fenêtre s'ouvre en bas
de l'écran appelée Palette de saisie de batterie. Cette fenêtre est essentielle pour la saisie à la souris, et affiche des
raccourcis pour la saisie au clavier d'ordinateur. Elle peut être ignorée si vous utilisez un clavier MIDI ou le clavier de piano
virtuel.

Chaque note de la palette représente un instrument de percussion : en passant le pointeur de la souris sur la note, le nom
de l'instrument s'affiche.

Les lettres A-G (affichées au-dessus de certaines notes dans la palette) sont assignées comme raccourcis clavier pour
saisir des instruments particuliers (grosse caisse, caisse claire, charleston fermé, etc.), plutôt que de faire référence aux
hauteurs des notes. Elles peuvent être modifiées ou réaffectées comme vous le souhaitez dans la fenêtre Éditer le set de
batterie.

Lorsque la palette de saisie de batterie est ouverte, un double-clic sur une note dans la palette ou la saisie d'une lettre
de raccourci ajoutera cette note à la portée de percussion. La couleur de la note dans la palette indique la voix attribuée à
cette note : bleu pour la voix 1, vert pour la voix 2. Cette couleur peut être modifiée dans la boîte de dialogue Éditer le set
de batterie si nécessaire.
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Cette attribution de voix ne s'applique qu'à la saisie des notes au clavier d'ordinateur et à la souris : la saisie via un clavier
MIDI ou le clavier de piano virtuel permet d'utiliser n'importe quelle voix.

Éditer le set de batterie

Pour ouvrir la fenêtre Éditer le set de batterie, utiliser l'une des méthodes suivantes :

Cliquez sur le bouton Éditer le set de batterie à gauche de la palette de saisie de batterie.
Faire un clic droit sur une portée de percussion et sélectionnez "Éditer le set de batterie...".

La fenêtre Éditer le set de batterie affiche les instruments de percussion disponibles et les notes/numéros MIDI auxquels
ils sont attribués. Il détermine également comment chaque instrument est affiché sur la portée : son nom, sa position, le
type de tête de note et la direction de la hampe. Les changements effectués ici sont automatiquement sauvegardés dans
le fichier MuseScore.

En cliquant sur une ligne des colonnes de gauche, vous pouvez modifier les propriétés d'affichage de cette note comme
suit :

Nom : Le nom que vous voulez voir apparaître dans la palette de saisie batterie lorsque vous passez la souris sur la note.
Laisser vide pour supprimer cette note de la palette de saisie de batterie.
Groupe de tête de note : Choisir une tête de note pour cet instrument dans une liste déroulante d'options (Remarque :
en choisissant "Personnalisé", vous activez "éditer les têtes de note" (au-dessous).
Éditer les têtes de note : Vous permet de personnaliser davantage l'affichage en spécifiant les têtes de note pour des
durées de note particulières.
Voix par défaut : Affecter la note à l'une des quatre voix. Cela n'affecte pas les entrées provenant d'un clavier MIDI ou du
clavier de piano virtuel.
Ligne de portée : Ce numéro indique la ligne ou l'inter-ligne de la portée sur laquelle la note est affichée. "0" signifie que
la note est affichée sur la ligne supérieure de la portée à 5 lignes. Les nombres négatifs déplacent la note vers le haut pas
à pas, tandis que les nombres positifs la déplacent vers le bas de la même manière.
Raccourci : Attribuer un raccourci clavier pour entrer cette note.
Direction de la hampe : Automatique, vers le haut ou vers le bas.

Ce set de batterie personnalisé peut être enregistré dans un fichier .drm en appuyant sur Enregistrer sous.... Vous pouvez
également importer un set de batterie personnalisé en utilisant le bouton Charger....

Sticking (doigté de batterie)

Pour entrer les doigtés de batterie (R, L) :

1. Sélectionner une note de départ ;
2. Dans le menu, sélectionner Ajouter→Texte→Doigté de batterie. Vous pouvez également créer un raccourci clavier pour

faire la même chose dans les Préférences ;
3. Saisisr le symbole comme vous le feriez pour du texte normal. Pour avancer ou reculer jusqu'à la note suivante,

utilisez les mêmes raccourcis clavier que pour les Symboles d'accord.
4. Pour quitter, appuyez sur Echap, ou cliquez sur une partie vide de la partition.

Ajouter un roulement de tambour

Ajouter un roulement de tambour, utiliser un Tremolo.

Liens externes
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How to create jazz drum notation  [MuseScore How-To]
Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation
Drum Parts  [video]
Editing the Drum Palette in MuseScore 1.1  [video]
Saving Drumset Changes in MuseScore 1.1  [video]
Guide to Drum and Percussion Notation

Tablature

La musique pour les instruments à cordes pincées est couramment notée en utilisant la tablature, également désignée
par TAB, qui fournit une représentation visuelle des cordes et des frettes.

La tablature peut également être combinée avec la notation standart traditionnelle :

Créer une nouvelle portée tablature

Si vous souhaitez créer une tablature dans le cadre d'une nouvelle partition, utilisez l'assistant de création de partition
(#with-the-new-score-wizard). Si vous voulez ajouter une tablature à une partition existante, utilisez la boîte de dialogue
Instruments. Vous pouvez également convertir une portée standard existante. Voir ci-dessous pour plus de détails.

Avec l'Assistant Créer une Nouvelle Partition

Utilisez la méthode suivante si vous souhaitez créer une tablature dans une nouvelle partition (pour les systèmes
combinés standard/tablature, voir → [ci-dessous] (#multiple-staves)) :

1.Ouvrir l'Assistant Créer une Nouvelle Partition
2.Saisir les détails de la partition (optionnel). Cliquer Continuer.
3. Dans la page Choisir un fichier modèle, cliquer sur choisir les instruments sous "Général".

4. Dans la page instruments, sélectionner la tablature souhaitée dans la catégorie "Cordes pincées", dans la colonne
de gauche. Cliquer ensuite sur Ajouter.

5. Compléter le reste de l'assistant de création.

Note__ : Si la tablature souhaitée n'est pas disponible dans la liste des instruments, ajouter quand même une portée avec
tablature comme décrit à l'étape 4 (ci-dessus). Ensuite, modifier la tablature selon vos besoins en utilisant la boîte de
dialogue Propriétés de la portée/partie.

Avec le dialogue instruments

Pour ajouter une seule portée de tablature à une partition existante (pour les systèmes combinés standard/tablature voir
ci-dessous) :

1. Ouvrir la boîte de dialogue instruments (appuyer sur I ; ou dans la barre de menu, sélectionner Édition →
instruments...).

2. Ajouter la portée à tablature comme décrit dans Ajouter instruments ("Créer une nouvelle partition").

En changeant le type de portée

Pour convertir une portée standard existante en tablature, ou une tablature en portée standard :

1. Faire un clic droit sur la portée et sélectionner Personnel/Propriétés de la portée.... Si "instrument" est déjà réglé sur un
type de cordes pincées, alors passez à l'étape 3.

2. Si "instrument" n'est pas un type de cordes pincées, cliquez sur Changer d'instrument et sélectionnez un instrument
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approprié dans la catégorie "Cordes pincées."
3. Cliquer sur Propriétés avancées de style… , sélectionnez l'option de tablature appropriée dans "Modèle", puis appuyez sur

< Rétablir par rapport au modèle . Vous pouvez affiner l'affichage si nécessaire en utilisant les onglets "Frettes" et "Figures
de rythme".

4. Cliquer deux fois sur OK pour quitter.

Édition des cordes

Changement d'accord

Note : Si vous souhaitez seulement visualiser (plutôt que de modifier) l'accord de l'instrument, suivez uniquement les
étapes 1 et 2.

1. Faites un clic droit sur la portée et sélectionnez Propriétés de la portée/partie....

2. Appuyez sur le bouton Éditer les paramètres des cordes...  en bas de la boîte de dialogue. La boîte de dialogue Accord
des cordes s'ouvre :

3. Cliquer sur la hauteur d'une corde et sélectionner Éditer la corde.... Ou, alternativement, double-cliquer simplement sur
la hauteur de la corde.

4. Sélectionner une nouvelle hauteur dans la boîte Sélection des notes et cliquer sur OK. Ou, alternativement, double-
cliquer simplement sur la nouvelle hauteur.

5. Cliquer sur OK pour fermer la boîte de dialogue "Accord des cordes". Cliquer ensuite sur OK pour fermer la boîte de
dialogue "Propriétés de la portée/partie".

Notes : (1) Si l'accord est modifié alors que la tablature de cet instrument contient déjà quelques notes, les marques de
frettes seront ajustées automatiquement (si possible) ; (2) Tout changement d'accord pour un instrument particulier
s'applique seulement à la partition en question, et ne modifie aucun des paramètres par défaut du programme.
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Ajouter une corde

1. Faire un clic droit sur la portée, sélectionner Propriétés de la portée/partie..., puis appuyer sur Éditer les parmètres des cordes .
2. Cliquer sur la hauteur d'une corde et sélectionner Nouvelle corde....
3. Sélectionner la nouvelle hauteur et appuyer sur OK-ou, alternativement, double-cliquer simplement sur la nouvelle

hauteur. La nouvelle corde est insérée sous la chaîne sélectionnée.

Note__ : Après avoir ajouté une corde de tablature, vous devrez ajuster le nombre de lignes dans la boîte de dialogue
Propriétés de la portée/partie….

Supprimer une corde

1. Faire un clic droit sur la portée, sélectionnez Propriétés de la portée/partie…, puis appuyer sur Éditer les paramètres des
cordes..

2. Cliquer sur la hauteur d'une corde et sélectionner Supprimer la corde.

Note__ : Après avoir supprimé une corde d'une tablature, vous devez ajuster le nombre de lignes dans la boîte de
dialogue Propriétés de la portée/partie….

Marquer une corde comme "Ouverte"

Cette option est utilisée pour les cordes non frettées (par exemple la harpe), comme pour les cordes additionnelles des
luths ou des théorbes. Ceci signifie que seul le numéro de frette "0" (zéro) ou "a" est accepté. Tout autre numéro de frette
sera converti en "O" ou "a".

1. Faire un clic droit sur la portée, sélectionner Propriétés de la portée/partie..., puis appuyer sur Éditer les paramètres des cordes .
2. Cocher une ou plusieurs cases dans la colonne "Ouvert".

Changer le nombre de frettes d'instrument

Cette propriété définit le nombre maximal de frettes pouvant être saisies sur la portée d'une tablature.

1. Faire un clic droit sur la portée, sélectionnez Propriétés de la portée/partie..., puis appuyer sur Éditer les parmètres des cordes .
2. Sélectionner ou entrer un nouveau numéro dans la case "Nombre de frettes".

Changer l'apparence d'une tablature

Depuis Propriétés de la portée/partie...

Pour accéder à l'ensemble des options d'apparence des tablatures, utiliser la boîte de dialogue Propriétés de la
portée/partie... :

1. Faire un clic droit sur la portée et sélectionner Propriétés de la portée/partie....
2. Cliquer sur le bouton Propriétés avancées de style....

Depuis le dialogue Instruments

Certaines options de base d'affichage des tablatures sont disponibles dans le dialogue Instruments :

1. Appuyer sur le raccourci clavier I ; ou dans la barre de menu, sélectionner Edit → Instruments....
2. Sélectionner un type de tablature dans la liste déroulante sous "Type de portée" dans le panneau de droite :

Simple : Affiche uniquement les marques de frets. Convient bien aux systèmes de portée/tablature.
Courant : Affiche les frettes, les hampes et les ligatures des notes.
Complète : Affiche les frettes, les hampes, les barres et les silences.
Tab italienne/française 6 cordes : Options de tablature historique pour le luth.

Les mêmes options sont disponibles à partir de la page Choisir les instruments de l'assistant de création de nouvelle
partition.

Combiner les portées standard et tablature

Les instruments à cordes pincées - comme la guitare - sont généralement notés en utilisant à la fois une portée musicale
et une tablature (TAB). MuseScore vous offre la possibilité d'avoir les deux portées soit non liées soit liées :

1. Les portées non liées : L'avantage d'utiliser cette option est que chaque portée peut être éditée indépendamment.
Pour transférer la notation musicale d'une portée à l'autre, utiliser sélection sur la portée souhaitée puis copier-coller
sur l'autre portée.

2. Portées liées : Les portées sont "mutuellement mises à jour" : c'est-à-dire que toute modification apportée à la
notation d'une portée est immédiatement appliquée à l'autre portée.
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Remarques : Lorsqu'une même note est entrée dans deux voix différentes, MuseScore essaie de s'assurer que les
numéros de frettes ne se chevauchent pas sur la même corde. Les chevauchements qui se produisent sont indiquées par
des carrés rouges : ceux-ci apparaissent seulement dans la fenêtre du document et pas sur la partition imprimée. Dans
presque tous les cas (par exemple, les frettes 0 à 4 sur la 6ème corde), le chevauchement est le résultat souhaité et
aucun autre ajustement n'est nécessaire. Vous pouvez masquer les marques rouges en sélectionnant "Affichage" et en
décochant "Afficher les éléments non imprimables".

Créer un système [portée+TAB] avec l'Assistant "Créer une nouvelle partition"

1. Ouvrir l'Assistant Créer une nouvelle partition.
2. Entrer les détails de la partition (facultatif). Cliquer sur Continuer.
3. Sur la page Choisir une fichier modèle, cliquer sur Choisir les instruments sous "Général".
4. Sélectionner une portée musicale (sans TAB) dans la section "Cordes pincées" de la colonne de gauche. Cliquer

ensuite sur Ajouter.
5. Dans la colonne de droite, cliquer sur la ligne nouvellement créée, intitulée "Staff 1". Cela fait apparaître les options

"Ajouter une portée/Ajouter une portée liée" dans la colonne centrale :
Cliquer sur Ajouter une portée pour créer une deuxième portées/TAB non liée.
Cliquer sur Ajouter une portée liée  pour créer une deuxième portées/TAB liée.

6. Dans la colonne Type de portée, cliquer sur la liste déroulante de la portée nouvellement créée et sélectionner une
option de tablature (celle-ci peut être modifiée ultérieurement, si nécessaire, sur la page de la partition - voir
Propriétés de la portée/partie).

7. Changer l'ordre de la portée en utilisant le bouton ↑ si nécessaire.
8. Complétez le reste de l'assistant de nouvelle partition, ou cliquez sur Finir.

Note_ : Pour créer des portées non liées avec des canaux de mixage séparés, au lieu de l'étape "5" (ci-dessus),
sélectionner une portée Tablature dans la colonne de gauche et cliquez sur Ajouter. Continuer ensuite avec les étapes 6 et
7.

Créer une paire [portée+TAB] dans une partition existante

1. Ouvrir l'éditeur d' instruments (appuyer sur I, ou dans la barre de menu, sélectionnez Édition → Instruments...).
2. Ensuite, suivre les étapes 4 à 8 ci-dessus.

Modifier une paire [portée+TAB] dans une portée existante

Pour ajouter une tablature à une portée d'instrument à cordes pincées (ou vice versa) :

1. Ouvrir l'éditeur d'instruments (appuyez sur I, ou dans la barre de menu, sélectionnez Édition → Instruments...).
2. Dans la colonne de droite, sélectionner la portée à partir de laquelle vous souhaitez ajouter une TAB, puis suivre

l'une des options indiquées à l'étape 5 ci-dessus.
3. Continuer avec les étapes 6 à 8 ci-dessus.

Saisir les notes dans la tablature

À l'aide d'un clavier d'ordinateur

1. Dans mode normal, sélectionner la mesure ou la note existante à partir de laquelle vous voulez commencer la saisie
de la note.

2. Passer en mode de saisie de note (N) : un petit "rectangle bleu" apparaît autour d'une ligne de tablature : c'est la
corde actuelle.

3. Sélectionner la durée de la note ou du silence que vous souhaitez entrer (voir ci-dessous).
4. Appuyer sur les touches fléchées haut/bas pour déplacer le curseur sur la chaîne souhaitée. Utilisez les touches

fléchées gauche/droite pour naviguer dans la partition.

5. Appuyer sur 0 à 9 pour saisir un numéro de frette entre 0 et 9 sur la corde actuelle ; pour saisir des numéros à
plusieurs chiffres, appuyez sur chaque chiffre dans l'ordre. Les touches A à K (en sautant I) peuvent également être
utilisées : c'est pratique pour travailler en tablature française. Pour L , M, N, utiliser le clavier alphanumérique et taper
respectivement 10, 11, 12. .. (Note : Vous ne pouvez pas entrer un nombre supérieur à la valeur "Nombre de frettes"
définie dans le dialogue Changer le nombre de frettes d'instrument). Appuyer sur ; (point-virgule) pour entrer un
silence de la durée sélectionnée.

6. Vous pouvez entrer des notes dans différentes voix si nécessaire - comme vous le feriez dans une portée standard.

Voir aussi, Edit notes (ci-dessous).

Tablature ancienne

La notation des cordes basses (luths et assimilés) est supportée :

Tablature française : lettres précédées de slashs juste en dessous de la portée : à savoir 7ème corde : "la", 8ème
corde : "/a", 9ème corde : "//a" et ainsi de suite, le tout aligné sur la même position en dessous de la TAB.
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Tablature italienne : chiffres avec des lignes supplémentaires - comme un segment de corde au-dessus de la TAB
: à savoir 7ème corde : "0" une position au-dessus de la TAB avec une "ligne supplémentaire" ; 8ème corde : "0"
deux positions au-dessus de la TAB avec deux "lignes supplémentaires", et ainsi de suite.

La saisie des notes se fait uniquement via le clavier de l'ordinateur : en déplaçant le curseur en dessous (Tab française)
ou au-dessus (tab italienen) de la TAB, les slashs provisoires et les lignes supplémentaires indiqueront la corde cible à
laquelle le numéro de frette sera appliqué; en appuyant sur l'une des touches du clavier, vous entrerez et disposerez la
note sur cette corde.

À l'aide de la souris d'ordinateur

Pour saisir des notes dans la tablature avec une souris d'ordinateur :

Entrer dans le mode de saisie des notes et sélectionner la valeur de la note (voir ci-dessous).
Cliquer sur une corde pour créer une note à cet endroit. Les notes sont initialement créées sur la frette 0 (ou a pour
la tablature française) : pour corriger, taper le bon numéro au clavier.
Vous pouvez également augmenter/diminuer le numéro de frette en utilisant Alt+Maj+↑ ou Alt+Maj+↓.
Vous pouvez entrer des notes dans différentes voix  comme vous le feriez sur une portée standard.

Voir aussi, Édition des repères de frettes (ci-dessous).

Sélection de la durée des notes

En mode de saisie des notes, vous pouvez utiliser l'une des méthodes suivantes pour définir la durée des notes dans la
tablature :

Appuyer sur Maj+1 à Maj+9 : permet de définir la durée d'une 128ème note à une longa (la disponibilité de ces
raccourcis peut dépendre de la plate-forme et/ou de la disposition du clavier) ;
Appuyer sur NumPad1 à NumPad9 : définit la durée d'une 128ème note à une longue (si un clavier numérique existe et
que Verr. num est activé) ;
Cliquer sur une icône de durée de note dans la barre d'outils pour la saisie au-dessus de la fenêtre principale ;
Appuyer sur Q pour diminuer la valeur sélectionnée et sur W pour l'augmenter.

Édition des repères de frettes

Changement de numéro de frettes

En mode Saisie des notes :

Positionner le curseur au-dessus du repère de frette et entrer la nouvelle valeur.
Incrémenter ou décrémenter le repère de frette en utilisant Alt+Maj+↑ ou Alt+Maj+↓ (Le repère de frette change
automatiquement de corde, si nécessaire, pour obtenir la position de la frette la plus basse possible).

Dans mode normal_ :

1. Sélectionner un ou plusieurs repères de frettes.
2. Utiliser l'une des commandes suivantes :

Pour incrémenter ou décrémenter, sans changer la chaîne de caractères : Appuyez sur ↑ / ↓.
Pour incrémenter ou décrémenter, en changeant les cordes, si possible, pour minimiser le nombre de frettes :
Appuyer sur Alt+Maj+↑ / ↓

Note : Le repère de frettes ne peut pas être supérieure à la valeur "Nombre de frettes" définie dans le dialogue Changer
le nombre de frettes d'instrument.

Changer le numéro de la corde

Pour déplacer le numéro de frette sur une corde adjacente sans changer la hauteur (si la corde est libre et peut produire
cette note) :

En mode de saisie de note :

Positionner le curseur sur une marque de frette et appuyer sur Ctrl+↑ / ↓ (Mac : Cmd+↑ / ↓).

En mode normal :

Sélectionner une ou plusieurs numéro de frette, et appuyer sur Ctrl+↑ / ↓ (Mac : Cmd+↑ / ↓).
Faites glisser un numéro de frette vers le haut ou vers le bas jusqu'à une corde adjacente.

Notes en croix

Pour remplacer un repère de frette par une "ghost note" :
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1. Sélectionner un ou plusieurs numeros de frettes (hors mode saisie de note).
2. Appuyer sur Maj+X pour activer/désactiver la "ghost note".

Raccourcis clavier

Mode de saisie des notes

TAPER: POUR OBTENIR:
↑ Sélectionne la corde au-dessus de l'actuelle.

↓
Sélectionne la corde au-dessous de
l'actuelle.

Maj+1 à Maj+9 Sélectionne une durée
PavéNum 1 à PavéNum 9 Sélectionne une durée
Q Diminue la durée d'entrée en vigueur.
W Augmente la durée d'entrée en vigeur.
0 à 9 Saisir un numéro de frette/lettre.
A à K Saisir un numéro de frette/lettre (I exclus).
Alt+Maj+↑ Augmente le numéro de frette actuel.
Alt+Maj+↓ Diminue le numéro de frette actuel.
; (point-virgule) Saisir une pause

Mode normal

TAPER: POUR OBTENIR:
0 à 9 Change la durée de la note ou du reste sélectionné

Alt+Maj+↑
Augmente la hauteur de la note sélectionnée (MuseScore choisit la
corde).

↑ Augmente la hauteur sans changer de corde.
Alt+Maj+↓ Diminue la hauteur de la note sélectionnée (MuseScore choisit la corde).
↓ Diminue la hauteur sans changer de corde.
Ctrl+↑ (Mac :
Cmd+↑) Déplace la note à la corde supérieure, en gardant la hauteur.

Ctrl+↓ (Mac :
Cmd+↓) Déplace la note à la corde inférieure, en gardant la hauteur.

Maj+X Active/désactive la "ghost note".

Liens externes

Tutoriel vidéo : MuseScore en quelques minutes : Leçon 7 - Notation de la tablature et de la batterie

Son et lecture sonore
MuseScore a des fonctionnalités de "Son et lecture sonore" intégrées. Ce chapitre traite du contrôle de la lecture sonore
et les façons d'étendre les possibilités de jeux des instruments.

Changement d'instrument au cours d'une portée

Lorsqu’un musicien doit changer d'instrument pour une section d’une pièce, l’instruction de changer d’instrument est
généralement placée au-dessus de la portée au début de cette section. Un retour à l’instrument principal est traité de la
même manière.

MuseScore permet aux utilisateurs d’insérer un type spécial de texte appelé Changer d'instrument à cet effet. Ce type
de texte est différent du texte de la Portée ou du texte du Système car il relie le texte à la lecture et modifie le son afin qu'il
corresponde à celui du nouvel instrument.

Effet du changement d'instrument

Quand un changement d'instrument est opéré :

Le son joué sera modifié afin de correspondre à celui du nouvel instrument à partir de ce point, mais l'affichage du
mélangeur restera inchangé.
Les notes suivantes sont automatiquement ajustées pour indiquer la bonne tonalité (instruments transpositeurs)
pour le nouvel instrument (mais la nouvelle armure doit parfois être ajouté manuellement—voir ci-dessous).
Le nom du nouvel instrument s’affiche devant les systèmes suivants.

123

https://www.youtube.com/watch?v=wnXLaZW9uA8


Ajouter un changement d'instrument

1. Sélectionnez le point de départ de la modification en cliquant sur une note ou un silence;
2. Ouvrez les palettes en appuyant sur F9 (ou en cochant la case 'palettes' dans le Menu 'affichage' ), et en cliquant

sur__Texte__ pour ouvir la sous-palette de texte:

3. Cliquez sur Change. Instr. (double-cliquez pour les versions antérieures à la 3.4);
4. Sélectionnez l'instrument désiré puis appuyé sur OK;

5. Les mots "To 'nom de l'instrument' " apparaitront au-dessus de la note ou du silence sélectionné;
6. Insérer une nouvelle armure est parfois requis au changement pour la portée en question.

Pour modifier le texte :
1. Double-cliquez sur le texte puis appuyé sur Ctrl+A pour le sélectionner dans son entièreté;
2. Ecrivez le texte que vous souhaitez voir affiché, et quittez le mode d'édition de texte;

Note: Les changements d'instruments dans une portée sont limités au même type d'instrument. Par exemple, vous ne
pouvez pas passer d'une percussion (à hauteur indéterminé comme une batterie) à un instrument à vent ou vice-versa.

Voir aussi

Changer d'instrument
Changement de son au cours d'une portée

Liens externes

Comment changer le son d’un instrument (p. ex., pizz., con sordino) à mi-chemin de la partition  (MuseScore
HowTo)

Mélangeur

Le Mélangeur vous permet de changer les sons des instruments lors de l'exécution musicale de chaque portée, d'en
ajuster le volume, le panoramique, d'ajuster le chorus, la reverb, muter des portées ou des voix, etc...

Ouvrir le Mélangeur
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Pour afficher/masquer le Mélangeur, deux possibilités :

Utiliser la touche F10 (Mac: fn+F10).
Dans la barre de menu principal, Choisir Affichage→Mélangeur.

Le Mélangeur présente deux zones, la zone Détails en haut et la zone des Pistes en bas.

zone des Pistes

La zone des Pistes se situe en bas de la fenêtre du Mélangeur, elle affiche le Gain Master (Volume général) et le volume
de chacune des pistes.

Le Gain Master (Volume Général)

Le Gain Master (Volume Général) contrôle le volume global. Pour le régler, cliquez et faites glisser le curseur ou entrez
une valeur dans la case en dessous de celui-ci.

Zone des pistes

La zone d'affichage des pistes vous permet de régler le volume des instruments utilisés par chacune de vos portées.

MuseScore crée une piste pour chaque portée de votre partition.

Ces pistes peuvent être subdivisées en "pistes de canaux" correspondant aux différents sons des instruments utilisés
dans la portée. La plupart des instruments n'ont besoin que d'une seule piste de canal car ils ne produisent qu'un seul son
par note. D'autres nécessitent plusieurs canaux pour que l'instrument puisse jouer plusieurs [sons] (#mid-staff-change)
(par exemple un violon peut jouer dans les notes normales, tremolo ou pizzicato) . Il se peut également qu'il y ait un
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Changement d'instrument au cours d'une portée. Ces pistes auxiliaires peuvent être affichées ou masquées en cliquant
sur le bouton fléché en haut du contrôle de la piste.

Piste violon, avec en jaune ses pistes auxiliaires.

Flèche d'affichage des pistes{#channel-display-arrow}

Chaque Piste possède un bouton, sur le dessus, avec une flèche. Ce bouton est actif, lorsque cet instrument utilise
plusieurs canaux (par exemple le violon qui utilise les canaux voix normale, pizzicato, tremolo). Ce bontn n'est pas activé
si l'instrument n'utilise qu'un seul canal. En cliquant sur ce bouton, on peut afficher ou ne pas afficher les pistes des
canaux . Les pistes des canaux n'ont pas ce bouton, à la place, le nom de la piste dont elles font partie est affiché.

Mute (Couper le son) and Solo

En haut de chaque piste se trouve un bouton vert Solo et un bouton rouge Mute : chacun peut être activé ou désactivé.
Lorsqu'un Solo est actif, seules les pistes qui sont allumées en solo seront jouées. Si aucun solo n'est allumé, toutes les
parties peuvent potentiellement être jouées. Le bouton Mute fait l'inverse : toute piste dont le bouton Mute est allumé ne
sera pas jouée. En utilisant une combinaison de boutons mute et solo, vous pouvez contrôler quels instruments sont
entendus pendant la lecture.

Pan (Panoramique)

Le potentiomètre situé sous le bouton Mute contrôle le panoramique à gauche et à droite. Pour modifier le panoramique,
cliquer sue le potentiomètre et, tout en maintenant le bouton de la souris enfoncé, faire monter ou descendre le pointeur.
Note : MuseScore ne prend pas encore en charge les valeurs de panoramique pour les pistes de canaux, la piste de
canal partielle affiche la valeur du canal principal. Le réglage de la valeur de panoramique de la piste principale mettra
automatiquement toutes pistes de canal à la même valeur.

Volume

Le curseur au milieu de la piste contrôle le volume de lecture. Note : MuseScore ne prend pas encore en charge les
valeurs de volume pour les pistes des canaux, la piste première piste de canal affiche la valeur de de la piste principale.
Le réglage du volume de la piste principale mettra automatiquement toutes les pistes de canal à la même valeur.

Nom de la piste

La zone de texte en bas de la piste présente le nom actuel de la piste ou des pistes de canal.
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Zone de détail

La zone de détails affiche les données de la piste actuellement sélectionnée. Elle permet un contrôle plus complet des
valeurs ajustables.

Nom

Nom de la piste associée à la portée. Le nom est affiché à la fois à cet endroit et sur la piste associée à la portée. Note:
Le nom de la portée est modifiable, mais cela n'impacte que le Mélangeur. Le nom du canal n'est pas modifiable.

Couleur de Piste

C'est la couleur que l'utilisateur peut choisir pour aider à mieux distinguer les pistes les unes des autres. Un double clic
sur cet endroit permet de choisir une couleur différente pour l'affichage du nom de cette piste. La couleur d'une piste
changera automatiquement les couleurs de toutes ses pistes de canal.

Canal

Si une piste de canal est sélectionnée, ici s'affiche le nom du canal.

Set de batterie

Indique si cette la piste sélectionnée est un instrument mélodique ou une percussion. Pour les instruments mélodiques
ordinaires, chaque hauteur de son dans le même patch a généralement le même timbre, tandis que les patchs de batterie
ont généralement des timbres différents pour chaque hauteur de son.

Son

Il s'agit du nom du son, en provenance de la soundfont, utilisé pour faire entendre l'instrument.

Volume

Règle le volume sonore de la piste sélectionnée.

Pan

Règle le panoramique de la piste sélectionnée.

Port et Canal

Le port MIDI de sortie et le canal sur lequel la piste est jouée.

Reverb / Chorus

La valeur de réverbération et de chorus envoyée à la sortie MIDI. Il s'agit d'informations envoyées aux appareils MIDI et
n'affecteront pas la lecture audio intégrée de MuseScore

Couper le son de la Voix

Cela vous permet de mettre de couper le son les voix individuellement au sein de chaque portée. Par exemple, si vous
activez le bouton "2", la deuxième voix de la piste sélectionnée sera coupée.

Bouton pour masquer la Zone de Détail
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Au bas de la zone de détail se trouve un bouton large sur lequel se trouve un petit triangle. En cliquant sur ce bouton, la
zone de détail sera masquée pour vous donner plus de place. En cliquant à nouveau sur ce bouton, la zone de détail sera
rétablie.

Son

La liste déroulants "Son" propose tous les instruments présents dans vos SoundFont. Si plusieurs sont SoundFonts
chargées dans le Synthétiseur, tous les instruments de toutes les SoundFonts (et/ou fichiers SFZ) apparaîtront dans une
seule liste longue, dans l'ordre défini dans le Synthesizer.

Astuce: Pour trouver facilement in instrument, cliquez sur la liste déroutante "Son", puis saisissez autant de fois que
nécéssaire la première lettre de l'instrument.

Changement de son au milieu d'une portée (pizz., sordino, etc.)

Certains instruments présentent plusieurs canaux dans le Mélangeur, ils peuvent être utilisés pour changer de son au
milieu d'une partition. Par exemple, une portée pour un instrument à cordes (violon, alto, violoncelle, etc.) se voit attribuer
trois canaux : un pour "arco" (ou "normal"), un autre pour "pizzicato" et un autre pour "tremolo". Une portée de trompette
aura un canal pour "normal" et un autre réservé pour "muet", et ainsi de suite.

Les instructions suivantes utilisent pour l'exemple les cordes pizzicato, mais le même principe peut être appliqué à toute
autre portée d'instrument qui permet des changements de son.

1. Sélectionnez la première note de la portée que vous voulez entendre jouer pizzicato ;
2. Dans le menu principal, choisissez Ajouter→Texte→Texte de Portée ;
3. Tapez "pizz." Ce texte est uniquement destiné à servir de référence visuelle et n'affecte pas la lecture ;
4. Faites un clic-droit sur le texte ce portée et sélectionnez Propriétés du texte de portée... ;
5. Dans l'onglet "Changer de Canal" de la boîte de dialogue, sélectionnez une ou plusieurs voix sur la gauche ;

6. Dans le menu déroulant, sélectionnez pizzicato ;

7. Clicquer sur le bouton OK pour revenir à la partition.

Chaque note après le texte de la portée que vous avez ajouté sonne maintenant pizzicato. Pour revenir à un son de
normal plus loin dans le morceau, suivez les mêmes indications que ci-dessus, sauf que vous devez taper "arco" à l'étape
3 et sélectionner arco à l'étape 6.

Voir aussi

SoundFont
Synthétiseur
Changer d'instrument

Liens externes

How to change instrument sound (e.g. pizz., con sordino) midway through score

Éditeur Piano Roll

L'éditeur Piano Roll Editor permet d'éditer les notes en intervenant sur la duré du son, le décalage de l'attaque et la
dynamique (vélocité). Il est également possible d'ajouter des notes, de les modifier, d'en supprimer, toutes choses qu'il est
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par ailleurs possible de faire dans l'éditeur de partition.

Ouvrir l'éditeur Piano Roll

Pour ouvrir l'éditeur Piano Roll, faire un click-droit sur une mesure dans la partition et choisir l'option "Éditeur Piano roll"
dans le menu déroulant. L'éditeur piano roll s'ouvrira alors positionné sur la mesure de la portée sélectionnée. Si l'éditeur
était déjà ouvert, l'affichage sera mis à jour en fonction de la mesure et de la portée sélectionnée.

Présentation

La fenêtre de l'éditeur Piano Roll se compose de plusieurs zones. Tout en haut, on trouve une série de boutons
permettant de gérer l'écoute de la partition et de modifier les notes. Le nom de la partie est affichée dans cette barre de
menu.

La zone centrale permet de visualiser les notes, de les sélectionner et de les modifier. Chaque note est représentée par
un rectangle jaune pour une note sélectionné ou verte pour une note non sélectionnée (ces couleurs peuvent être
changées dans les préférences). Lorsqu'il y a suffisamment de place, chaque rectangle représentant une note contient le
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nom de la note sur la gauche et le numéro de sa voix sur la droite. La modification de la taille des notes sera traité dans la
section navigation.

Sur la gauche de la zone d'affichage se trouve une Clavier de piano. Vous pouvez cliquer dessus pour entendre les
notes. Lorsque le pointeur de votre souris survole la zone d'affichage des notes, la touche du clavier change de couleur
pour montrer sur la ligne de quelle note il se trouve. En haut à gauche, sous la barre de boutons, l'indication "Curseur"
indique à tout moment où pointe la souris. Si vous utilisez une portée pour percussions, les touches du clavier indiquent
l'instrument qui est assigné à cette valeur de note. Pour les instruments transpositeurs, le clavier sera ajusté afin que le
Do du clavier corresponde au Do de l'instrument.

En haut de la zone d'affichage des notes se trouve des indications qui affichent la position actuelle de la tête de lecture,
ainsi que la plage de bouclage actuelle si elle a été définie.

Dans le bas de la zone des rectangles, il y a la zone d'affichage de la vélocité (dynamique) et de la durée des sons. Il
s'agit d'une présentation graphique où chaque barres montre la valeur attribuée à chaque note. À gauche de la zone
d'affichage des valeurs se trouve un menu déroulant permettant de sélectionner quelles données vous souhaitez afficher
ou éditer.

Navigation

Il y a plusieurs façons de se déplacer dans l'éditeur Piano Roll. Dans un premier temps, vous pouvez vous servir des
barres de défilement sur les bords de la zone d'affichage des notes.

La molette de la souris peut également être utilisée pour effectuer un déplacement dans la partition ou un zoom :
* Défilement vertical : Molette de la souris.
* Défilement horizontal : Maj. + Molette de la souris.
* Zoom vertical : Ctrl + Molette de la souris.
* Zoom horizontal : Ctrl+Maj. + Molette de la souris.

NDT Le zoom fonctionne pas avec toutes les souris ni avec les trackpad

Pour aller à une mesure particulière, revenez à la fenêtre qui affiche la partition, trouvez la mesure que vous souhaitez
voir, cliquez avec le bouton droit de la souris sur la mesure et ouvrez à nouveau l'éditeur Piano Roll. La fenêtre de l'éditeur
Piano Roll va défiler jusqu'au centre de la mesure sélectionnée.

Sélection des Notes

Dans la zone d'affichage des notes, vous pouvez sélectionner les notes en cliquant dessus, ou utilier le lasso pour
sélectionner un groupe de notes. En utilisant les touches de modification, vous pouvez affiner votre sélection :

Maj. : Ajoute ou supprime une note de la sélection.
Ctrl : Ajoute une note à la sélection.
Ctrl+Maj.: Supprime la note de la sélection.

Édition des notes

NDT : Les fonctions d'édition des notes dans l'éditeur Piano Roll est encore expérimentale dans les versions 3.5 et 3.6.

Pour changer la hauteur des notes sélectionnées : Faire glisser une note sélectionnée vers le haut ou vers le bas
jusqu'à la hauteur voulue ; ou appuyer sur les flèches ↑ ou ↓.

Pour changer la position des notes sélectionnées : Faire glisser les notes horizontalement pour changer leurs position
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sur la portée. Les notes se déplacent en fonction de la sous-division sélectionnée sur le haut de l'écran.

Pour supprimer les notes sélectionnées : Appuyer sur la touche Suppr..

Pour déplacer les notes sélectionnées vers une autre voix : Cliquer sur le numéro de voix dans la barre des boutons
en haut de la fenêtre.

Pour ajouter des notes :

Choisir la figure de note à insérer (ronde, noire, croche, ...) et la sous-division de mesure à utiliser. Choisir également le
numéro de voix. Les notes seront insérées à l'endroit où vous cliquerez sur la zone d'affichage des notes.

Ctrl : Une note est ajoutée à l'endroit précis où vous cliquez. Sa longueur est la même que si vous l'aviez entré dans
la partition. Si vous devez modifier la longueur de la note, vous devez passer par l'éditeur de partition car l'éditeur
Piano Roll ne propose encore cette fonction. Si des notes existent déjà à cet endroit, un morceau sera découpé
pour faire de la place à la note que vous insérez, à moins qu'elles ne démarrent au même moment et qu'elles aient
la même durée que la note que vous ajoutez, auquel cas la nouvelle note sera simplement ajoutée à l'accord
existant. Les divisions irrégulières (duolets, triolets, etc) ne sont pas pris en charge actuellement, ils seront ignorés.

Maj. : Regarde s'il existe déjà une note ou un accord à l'endroit où vous cliquez. Si c'est le cas, il ajoute une note à
cet accord. Sinon, il s'agit d'un silence et ce silence sera remplacé par la note désirée.

Ctrl+Maj. : Regarde s'il y a une note, un accord ou un silence à cet endroit. L'accord sera coupé en deux à cette sous-
division. Les divisions irrégulières (duolets, triolets, etc) ne sont pas pris en charge actuellement, ils seront ignorés.

Édition de la durée du son et de la vélocité :

Il ne faut pas confondre la durée d'une note avec la durée du son. Par exemple, on peut jouer des notes noires légato,
dans ce cas la durée du son est équivalente à la durée de la note, ou jouer ces mêmes noires staccato, dans ce cas, la
durée du son aura environ 50% de la durée d'une noire.

La vélocité désigne une valeur indiquant la force avec laquelle une touche est enfoncée. Cette donnée reflète la nuance
musicale avec laquelle la note a été jouée, c'est-à-dire sa puissance sonore.

Les données de durée du son et vélocité sont modifiables dans la zone d'ajustement graphique des valeurs. Pour modifier
ces données, sélectionnez les notes que vous souhaitez traiter dans la zone des notes. Ensuite, cliquez dans la zone
d'ajustement graphique des valeurs sur la barre correspondante et ajustez la hauteur de cette barre. Vous pouvez
également modifier les valeurs de plusieurs notes en même temps si vous souhaitez en maintenant la touche Maj.
enfoncée. Seules les notes sélectionnées verront leur valeur modifiée, toutes auront la même valeur.

Dans cette zone d'ajustement graphique des valeurs, les données peuvent être affichées et modifiées soit de façon
absolue (c'est-à-dire par rapport au volume MIDI de sortie) , soit de façon relative (c'est-à-dire comme un décalage par
rapport à la valeur de départ). Vous pouvez passer d'un mode d'affichage à l'autre comme bon vous semble.

Barre d'outil

De la gauche vers la droite, les boutons en haut de la fenêtre de l'éditeur Piano Roll ont les fonctions suivantes :

Première ligne
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Undo : Annule la dernière action action

Redo : Recommence la dernière action

MIDI : Active/Désactive l'entrée MIDI

Rewind : Place la tête de lecture au début de la partition.

Play : Démarre la lecture de la partition.

Boucle : Bascule la lecture de la partition en boucle entre les marqueurs sélectionnés.

Jouer les répétitions : Active/Désactive la lecture des répétitions.

Défilement de l'écran lors de la lecture : Si cette option est active, la tête de lecture reste au centre de l'écran qui défile
au fur et à mesure de l'exécution de la partition.

Métronome : Active/Désactive le métronome.

Onde : Fonction non implémentée pour le moment.

Numéro de voix : Pré-sélection de la voix pour l'insertion des notes. Déplace les notes sélectionnées vers la voix
sélectionnée.

Partie : Nom de la partie en cours d'édition.

Deuxième ligne

Curseur : Affiche le numéro de la mesure, le numéro du temps et la sous division du temps (en millième de temps) qui se
trouve sous le pointeur de la souris dans la zone d'affichage des notes.

Subdiv : subdivisions du temps pour l'insertion des notes. Par exemple, en 4/4, une subdivisions de 2 tracera des lignes
de grille à chaque croche ; une subdivisions de 3 à chaque double croche, et ainsi de suite. Le réglage de la subdivisions
est nécessaire pour ne pas placer les notes en dehors des temps.

Pour un plus grand nombre de subdivisions, il peut être nécessaire de faire un zoom pour voir les lignes de grille
supplémentaires car les lignes de grille ne sont pas tracées en dessous d'une certaine densité. Se combine avec le
contrôle des divisions irrégulières (duolets, triolets, etc.), ce qui affecte également le placement des lignes de la grille.

Divisions irrégulières : Ajoute des lignes de grille supplémentaires, subdivisant le rythme pour montrer le placement
rythmique des tuplets. Par exemple, si vous réglez les divisions irrégulières sur 3, le rythme sera subdivisé en trois
parties. Se combine avec la commande de subdivision pour montrer les subdivisions du tuplet. Par exemple, en réglant
les divisions irrégulières sur 3 et la commande de subdivision sur 2, on obtient des lignes de grille montrant les
battements des divisions irrégulières subdivisés en deux parties, c'est-à-dire que le battement sera subdivisé en 6.

La sélection d'une valeur de divisions irrégulières autre que 1 désactivera certains des outils d'insertion de notes de
l'éditeur de Piano Roll. Pour un plus grand nombre de subdivisions, vous devrez peut-être faire un zoom avant pour voir
les lignes de grille supplémentaires, car les lignes de grille ne sont pas tracées en dessous d'une certaine densité.
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Motif des bandes : Modifie la répartition des lignes grises et des lignes blanches figurant à l'arrière plan dans la zone
d'affichage des notes. Les lignes blanches représentent les notes de la gamme selon le choix affiché dans le menu
déroulant "Motif des bandes", et les lignes grises représentent les notes altérées. Par défaut, la gamme de Do majeur est
sélectionnée.

Vélocité : Affiche la valeur de la vélocité de la note sélectionnée (une seule note doit être sélectionnée). Plus cette valeur
est élevé, plus l'attaque de la note (du son) est franche. Cela cherche à représenter la vitesse à laquelle la touche d'un
piano est enfoncée. Cette avec cette valeur que MuseScore gère les notes accentuées. Cette valeur peut être exprimée
de façon absolue ou de façon relative.

relative : la valeur saisie est traitée comme un coefficient multiplicateur de la valeur actuelle.
absolue : il s'agit de la valeur à envoyer au canal MIDI, comprise entre 0 et 127. La valeur 64 est un compromis pour
une attaque ni trop dure ni trop molle.

Hauteur : Montre la hauteur de la note et le numéro d'octave (par exemple F#4). La hauteur peut être modifiée en faisant
glisser la note vers le haut ou vers le bas dans la zone des notes. Pour l'instant, on ne peut pas l'éditer.

Position : Il est possible de décaler le début du son en le retardant ou en l'avançant afin d'adapter la façon de jouer la
partition. Une valeur négative avance le son, une valeur positive retarde le son. Les valeurs admises vont de -1000 à
+1000. La durée d'une note correspond à la valeur 1000. Décaler de 250, par exemple, décale la note d'1/4 de sa valeur.

Durée : Fixe la longueur du son d'une note. C'est avec cette valeur que MuseScore gère les articulations (légato, louré,
tenuto, staccato, etc). La valeur 1000 représente 100% de la durée de la valeur de la note. Si toutes les durées des notes
sont à 1000, cela correspond à un jeu "légato". Avec 950, les notes sont jouées "non légato". Avec la valeur 800 elles
sont jouées détachées. Avec la valeur 500 elles sont jouées "staccato", et ainsi de suite.

Clavier

Certaines touches permettent de réaliser des actions spéciales :

↑ : Monte les notes sélectionnées d'un demi ton
↓ : Descend les notes sélectionnées d'un demi ton
Suppr. : Supprime les notes sélectionnées
Espace : Démarre/Arrête la lecture de la partition

Personnalisation

L'éditeur Piano Roll s'affiche en mode normal et en mode sombre. Si vous souhaitez modifier les couleurs utilisées pour
s'afficher dans ces modes, vous pouvez les ajuster dans les Préférences sous l'onglet Avancé. Toutes les propriétés de
l'éditeur Piano Roll commencent par ui/pianoroll/light pour le mode clair et ui/pianoroll/dark pour le mode foncé.

Lecture : Symboles d'accords / Numéros Nashville

À partir de la version 3.5 du logiciel, les symboles d'accord et les Numéros Nashville (mais pas les Chiffres Romains
d'Analyse') sont joués automatiquement lorsque la partition est exécutée par MuseScore.
À partir de MuseScore 3.5.1, cela ne se produit plus que pour les partitions créées initialement avec MuseScore 3.5 ou
versions supérieures. Pour les partitions plus anciennes, vous devez l'activer, en utilisant l'une des méthodes décrites ci-
après.

Activer / Désactiver la lecture des accords

Note : Les réglages effectués ci-dessous affectent également les réglages Audio, MIDI et export.

Pour toutes les partitions (à partir de la version 3.5.1)

Pour activer / désactiver la lecture des symboles d'accord de toutes vos partitions :

Avec le menu Édition (Mac: menu MuseScore)→Préférences… puis l'onglet Avancé, choisir les options suivantes :
Pour Activer / Désactiver la lecture des accords d'une partition pré-version 3.5: Cocher / Décocher
score/harmony/play/disableCompatibility (par défaut, l'option est cochée : ne joue pas les accords)
Pour Activer / Désactiver la lecture des accords d'une partition version 3.5 ou ultérieure: Cocher /
Décocher score/harmony/play/disableNew (par défaut, l'option n'est pas cochée : joue les accords)

Pour la partition courante

À partir de la version 3.5.1

Pour Activer / Désactiver la lecture de TOUS les symboles d'accord :

Cocher / Décocher la case "Play" dans le formulaire ouvert par le menu Format→Style…→Symboles d'accord→Play.
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À partir de la version 3.5

Pour Activer / Désactiver la lecture de TOUS les symboles d'accord :

1. Sélectionner un symbole d'accord ou un Numéro Nashville
2. Dans la section "Symbole d'accord" de l'Inspecteur, cocher/décocher la case "Lecture".
3. Cliquer sur la lettre S (Définir comme un style) située à l'extrême droite de la case "Lecture". Si vous ne voyez pas

cette lettre, faire défiler un peu l'écran vers la gauche.

Une autre façon de procéder consiste à rendre silencieuse (bouton Mute) les pistes de lecture des symboles d'accord
dans le Mélangeur (Voir ci-dessous). Ceci peut être utile, par exemple, si vous voulez entendre jouer les symboles
d'accord de l'une des portées et pas d'une autre si plusieurs portées en comportent. Les parties d'une partition ne peuvent
pas être traitées séparément.

Pour Activer / Désactiver la lecture d'un ensemble de symboles d'accord sélectionnés :

1. Sélectionner un ensemble de symboles d'accord ou de Numéros Nashville.
2. Clic-droit sur l'un des symboles sélectionnés.
3. Dans le menu contextuel qui s'affiche, cliquer sur Sélection→Tous les éléments similaires de la sélection , OK.
4. Dans la section "Symbole d'accord" de l'Inspecteur cocher/Décocher la case "Lecture".

ou

1. Cliquer sur le premier symbole d'accord à sélectionner.
2. Shift+click sur le dernier symbole d'accord ou Numéro Nashville à sélectionner.
3. Dans la section "Symbole d'accord" de l'Inspecteur cocher/Décocher la case "Lecture".

Note: Cela n'affecte pas les parties qui doivent être traitées séparément.

Changer le son des symboles d'accords

Le son par défaut pour jouer les symboles d'accords est "Grand Piano". À partir de la version 3.5.1, les partitions créées à
partir des 3 Modèles de guitare, Guitare/Guitare+Tablature/Tablature (catégorie "Solo" dans l'Assistant de création), voir
Guitare, utilisent "Nylon String Guitar" à la place.

Pour changer le son de lecture des symboles d'accord :

1. Ouvrir le Mélangeur (raccourci : F10, Mac: Fn+F10)
2. Dans la zone des pistes, localiser la piste qui contient les symboles d'accord concernés.
3. Cliquer sur la flèche qui ouvre les pistes de canaux située juste au dessus du bouton "Solo" de la piste.
4. Cliquez sur la piste dont le nom contient les mots "Harmonie" ou "Chord syms". (peut être tronqué, doit être le plus à

droite).
5. Sélectionner un nouveau "son" dans la liste déroulante Son de la Zone Détail.

Cette sélection est partagée par la partition et ses parties.

Modifier le volume des accords / Rendre la piste silencieuse (Mute)

1. 1. Ouvrir le Mélangeur (raccourci : F10, Mac: Fn+F10)
2. Dans la zone des pistes, localiser la piste qui contient les symboles d'accord concernés.
3. Cliquer sur la flèche qui ouvre les pistes de canaux située juste au dessus du bouton "Solo" de la piste.
4. Cliquez sur la piste dont le nom contient les mots "Harmonie" ou "Chord syms". (peut être tronqué, doit être le plus à

droite).
5. Ajuster le curseur du volume cliquer sur le bouton M pour rendre la piste silencieuse.

Vous devez le faire pour la partition et/ou les parties, séparément.

Activer / Désactiver la lecture des symboles d'accord durant l'édition

Pour Activer / Désactiver la lecture des symboles d'accord durant l'édition :

1. Dans le menu Édition (Mac: MuseScore)→Préférences… ouvrir l'onglet Saisie des notes.
2. Cocher/Décocher la case "Jouer les notes pendant l'édition".

Interprétation et harmonisation des symboles d'accord

Il est possible de modifier les propriétés du ou des symboles d'accord sélectionnés :

1. Sélectionner un ou plusieurs symboles d'accord.
2. Dans l'inspecteur, vous pouvez agir sur :

Interprétation. Les options sont :
Littéral
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Jazz. Cette option permet d'ajouter des couleurs aux accords (ex : neuvième majeur), permet d'omettre
certaines notes en fonction de l'accord et de son contexte (en particulier en fonction de l'accord suivant).

Harmonisation. Les options sont :
Auto
Fondamentale seulement = Juste la note basse
Toutes les notes = place toutes les notes dans un seul octave
Saut de 2 notes = abaisse d'une octave la deuxième note la plus haute de l'accord
Six Notes (les plus importantes)
Quatre Notes (les plus importantes) = tierce, quinte, septième et neuvième
Trois Notes (les plus importantes).
Note: Toutes les harmonisations incluent une note basse située 2 octaves sous la fondamentale.

__Durée_ . Les options sont :
Jusqu'au symbole d'accord suivant
Jusqu'à la fin de la mesure
Durée de l'accord ou du silence.

Voici comment les options Interprétation et Harmonisation modifient la lecture d'un accord de Do Maj 7
(Cmaj7 ou CM7).

Note : Les options "Toutes les notes" et "Auto" donnent le même résultat pour cet accord particulier, mais ce n'est pas
nécessairement le cas pour tous les accords.

Modes de lecture

Barre d'outil du mode lecture

MuseScore dispose d'un séquenceur intégré et d'un synthétiseur pour jouer votre partition. Les fonctions basiques de
lecture sont accessibles à partir de la barre d'outils (au-dessus de la fenêtre principale). On y retrouve les fonctions de
lecture habituelles :

Soit, de la gauche vers la droite :

Activer/Désactiver l' "Entrée MIDI"
Retour au debut (Rewind) : La lecture retourne au début de la partition ou au début de la boucle s'il y en a une de
définie.
Démarrer/Arrêter la lecture (Play) : Voir ci-après Démarre/Arrêter la lecture.
Activer/Désactiver la lecture en boucle: Voir ci-après Boucle de lecture.
Jouer les répétitions: Permet de jouer ou d'ignorer les barres de répétition.
Faire défiler la partition durant la lecture: Permet de faire défiler la partition en suivant la tête de lecture ou de la
laisser fixe.
Métronome: Active/Désactive le métronome.

Commandes de lecture

Démarrer/Arrêter la lecture

Pour faire démarrer la lecture:

1. Cliquer sur une mesure, une note, un silence ou un accord pour définir le point de départ. Note: Si aucune sélection
n'est proposée, la lecture commencera au début de la partition ou reprendra au point où elle s'était arrêtée lors de la
précédente exécution.

2. Cliquer sur le bouton Démarrer/Arrêter la lecture (Play) ou appuyer sur la touche Espace.

Pendant la lecture, vous pouvez sauter à n'importe quel endroit de la partition juste en cliquant dessus.

Pour arrêter la lecture :

Cliquer sur le bouton Démarrer/Arrêter la lecture (Play) ou appuyer sur la touche Espace.
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Pendant la lecture

Lorsque la lecture est démarrée, les commandes suivantes sont disponibles :

Reculer d'une note, d'un silence ou d'un accord : ←
Avancer d'une note, d'un silence ou d'un accord : →
Reculer au début de la mesure : Ctrl+← (Mac: Commande+←)
Avancer à la mesure suivante : Ctrl+→ (Mac: Commande+→)
Revenir au début de la partition : Home (Mac: Commande+Home) ou utiliser le bouton Retour au début dans la barre
d'outils.

Pendant la lecture, vous pouvez utiliser les raccourcis clavier pour ouvrir et fermer les fenêtres outils, comme par exemple
la Fenêtre de lecture, le Synthétiseur, le Mélangeur, l'Inspecteur, etc/

Boucle de lecture

Pour définir un ensemble de notes ou de mesure à lire en boucle :

La lecture doit être arrêtée, le bouton "Activer/Désactiver la lecture en boucle" doit être activé.
Sélectionner la partie de la partition à faire jouer en boucle.
Appuyer sur le bouton de lecture.

La lecture se fera en boucle entre les deux marqueurs de boucle visible en bleu sur la partition.

Utiliser le bouton "Activer/Désactiver la lecture en boucle" pour arrêter ou pour reprendre le jeu en boucle.

Fenêtre de lecture

Pour ouvrir la fenêtre de lecture, deux possibilités :

Presser la touche F11 (Mac: Fn+F11).
Dans le menu principal, sélectionner Affichage → Fenêtre de lecture.

La fenêtre de lecture vous permet de faire des modifications temporaires de tempo et de volume ainsi que de boucler
entre des points spécifiés.

Jouer en boucle : Sélectionner le première note et cliquer sur le bouton "Définir la position intiiale de la boucle".
Sélectionner la dernière note et cliquer sur le bouton "Définir la position finale de la boucle". Cliquer sur le bouton
"Démarrer ou Arrêter la lecture". Ces commandes fonctionnent également pendant la lecture.
"Aller au début", "Démarrer ou Arrêter la lecture" : Contrôle de la lecture.
Métronome : Démarrer/Arrêter le métronome durant la lecture.
Décompte : Ajouter/Supprimer un décompte avant de démarrer la lecture au début d'une mesure. Des temps
supplémentaires seront ajoutés si la lecture doit démarrer au milieu d'une mesure.
Tempo : Ajuste la vitesse de lecture. La modification est affichée en pourcentage du tempo initial et en BPM
(Battements Par Minute). Double-cliquer sur le curseur pour retrouver le tempo initial. (Note : Pour modifier de façon
définitive le tempo, modifier le texte indication de tempo dans la partition).
Volume : Ajuste le volume de la lecture (cette valeur sera réinitialisée à chaque ouverture du programme). Note :
Pour modifier le volume de lecture de façon définitive, voir les fonctions du Synthésiseur.

SoundFonts et fichiers SFZ

MuseScore utilise son synthétiseur intégré pour le son des partitions, celui-ci héberge une importante sélection
d’instruments virtuels (ou logiciels), ainsi que des effets sonores et des percussions.

Deux formats d’instruments virtuels sont utilisables par MuseScore :
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SoundFont (.sf2 / .sf3) : Un fichier unique qui peut contenir de un à plusieurs instruments virtuels
SFZ (.sfz) : Un ensemble de fichiers audio et de définition qui peut contenir de un à plusieurs instruments virtuels.

SoundFonts

MuseScore est équipé de sa propre SoundFont GM (General MIDI ), MuseScore_General.sf3, contenant plus de 128
instruments et kits de batterie et percussions.

GM (General MIDI) est un format universel, une fois votre partition paramétrée pour la lecture avec la SoundFont intégrée
de MuseScore, vous pourrez l’exporter au format de votre choix et pouvoir l’écouter sur n’importe quel autre ordinateur.

Beaucoup de SoundFonts sont disponible sur Internet, certaines sont gratuites, d’autres sont payantes, vous trouverez ci-
dessous une liste de SoundFonts gratuite.

Installation d’une SoundFont

Après avoir choisi et décompressé une SoundFont (voir →ci-dessous), double cliquez pour l’ouvrir, le type de fichier est
déjà associé à MuseScore, qui s’ouvrira et présentera une boîte de dialogue vous demandant si vous voulez installez la
SoundFont. Au cas ou le type de fichier soit associé à une autre application, vous aurez à faire un clic droit sur le fichier
de SoundFont pour ouvrir le menu de sélection de l’application à ouvrir. Dans les deux cas, répondez "oui" à la demande
d’installation de la boîte de dialogue, la SoundFont sera copiée dans le dossier des SoundFonts de MuseScore. Le
chemin du dossier peut être visualisé et modifié dans les Préférences de MuseScore, le chemin par défaut se trouve :

Windows : %HOMEPATH%\Documents\MuseScore3\Soundfonts

macOS et Linux : ~/Documents/MuseScore3/Soundfonts

Le dossier de la SoundFont installée par défaut avec MuseScore est système, et placé là uniquement pour cet usage, il
ne doit pas être modifié. Ce dossier et sa SoundFont par défaut se trouve :

Windows x86 (32-bit) / MuseScore x86 : %ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3
Windows x64 (64-bit) / MuseScore x86 : %ProgramFiles(x86)%\MuseScore 3\sound\MuseScore_General.sf3

Windows x64 (64-bit) / MuseScore x86_64 : %ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3

macOS : /Applications/MuseScore 3.app/Contents/Resources/sound/MuseScore_General.sf3

Linux (Ubuntu) : /usr/share/mscore-xxx/sounds/MuseScore_General.sf3 (xxx étant la version de MuseScore)

Désinstallation

Pour désinstaller une SoundFont, il suffit d’ouvrir le dossier ou elle se trouve et de supprimer le fichier.

SFZ

Une SFZ est en ensemble de fichiers et de dossiers, un fichier SFZ une collection de fichiers audio au formats WAV,
FLAC, ou OGG, le fichier SFZ est un fichier texte décrivant l’emplacement des fichiers sons et leurs paramètres.

Installation d’une SFZ

Après avoir choisi une SFZ (voir →ci-dessous) vous aurez à extraire tous les fichiers et sous dossiers de la SFZ dans le
dossier décrit au-dessus. Gardez l’arborescence des dossiers et leurs contenus tel quel.

Désinstallation

Pour désinstaller une SFZ, ouvrez dossier qui la contient (voir au-dessus) et supprimez le fichier SFZ est ses sous
dossiers.

Synthétiseur

Le Synthétiseur est le panneau de contrôle central de la sortie son de MuseScore. Dès qu’une SoundFont ou SFZ a été
installée, elle doit etre chargée dans le Synthétiseur pour que MuseScore puisse l’utiliser. Pour changer de SoundFont par
défaut, charger une autre SoundFont dans le Synthétiseur et cliquez sur Définir comme valeur par défaut .

Pour afficher le Synthétiseur, cliquez dans la barre de menu Affichage → Synthétiseur.
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Listes de SoundFonts téléchargeable

SoundFonts GM

Les banques de sons suivantes sont conformes au standard General MIDI (GM2). Cette spécification permet 128
instruments virtuels ainsi que des kits de batterie et percussions.

MuseScore 3 et 2 (depuis la version 2.2) sont fournies avec MuseScore_General.sf3  (35.9 MiO) (Version SF2
(208 MiO)).
Licence : publiée sous la MIT license
Avec l’autorisation de S. Christian Collins
MuseScore_General est régulièrement mise à jour, MuseScore_General v0.2  (version SF3 35.9 MiO, version
SF2 208 MiO)
Licence : publiée sous la MIT license
Avec l’autorisation de S. Christian Collins
De plus MuseScore 3 propose une version HQ (Haute Qualité) de cette SoundFont dans les Extensions
MuseScore_General_HQ est régulièrement mise à jour, MuseScore_General_HQ v0.2  (version SF3 82 MiO,
version SF2 477 MiO)
Licence : publiée sous la MIT license
Avec l’autorisation de S. Christian Collins
MuseScore 2 (jusqu’à la version 2.1) était fournie avec FluidR3Mono_GM.sf3  (13.8 MiO).
Fluid R3 GM  (141 MiO décompressée.)
Licence : publiée sous licence MIT (incluse dans l’archive) La SoundFont par défaut de MuseScore est basée sur
Fluid R3.
MuseScore 1 était fournie avec TimGM6mb  (5.7 MiO décompressée)
Licence : GNU GPL, version 2
Avec l’autorisation de Tim Brechbill
GeneralUser GS  (29.8 MiO décompressée)
Avec l’autorisation de S. Christian Collins
Magic SoundFont, version 2.0  (67.8 MiO décompressée)
Arachno SoundFont, version 1.0  (148 MiO décompressée)
Avec l’autorisation de Maxime Abbey
Timbres of Heaven, version 3.2  (369 MiO décompressée)
Avec l’autorisation de Don Allen

SoundFonts pour orchestre

Sonatina Symphonic Orchestra (503 MiO décompressée)
Téléchargements : SoundFont  | Format SFZ
Licence : Creative Commons Sampling Plus 1.0
Aegean Symphonic Orchestra
Avec l’autorisation de Ziya Mete Demircan  (352 MiO décompressée)

SoundFonts pour piano

SF2 Pianos

Acoustic grand piano, version 2016-08-04
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Description : Yamaha Disklavier Pro Grand Piano, format SF2, 36MiO compressée, 113MiO décompressée, 121
échantillons, 5 couches de vélocités
Information complementaire : http://freepats.zenvoid.org/ , d’autres SoundFonts aussi disponibles.
Licence : Creative Commons Attribution 3.0
Avec l’autorisation de Roberto Gordo Saez
Salamander C5 Light
Avec l’autorisation de Ziya Mete Demircan  (24.5 MiO décompressée)

SFZ Pianos

Salamander Grand Piano
Téléchargements : version 2  | version 3
Description : Yamaha C5, 48kHz, 24bit, 16 couches de vélocités, entre 80 MiO 1.9 GiO décompressée
Licence : Creative Commons Attribution 3.0
Avec l’autorisation d’Alexander Holm
Detuned Piano  (244 MiO decompressée)
Licence : Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings
Description : 44.1kHz, 16bit, stéréo, 168 MiO decompressée
Licence : Creative Commons Attribution-ShareAlike 3.0
The City Piano
Description : Baldwin Baby Grand, 4 couches de vélocité, 696 MiO décompressée
Licence : Public domain
Avec l'autorisation de Big Cat Instruments
Kawai Upright Piano, version 2017-01-28
Description : 68 échantillons, 44KHz, 24bit, stéréo, 2 couches de vélocité, 58MiO décompressée
Licence : GNU General Public License version 3 ou supérieure, avec exception spéciale
Avec l’autorisation de Gonzalo et Roberto

Décompression des SoundFonts téléchargées

Les SoundFonts sont téléchargeables dans un format compressé du fait de leur taille, les formats de compression sont
principalement .zip, .sfArk, et .tar.gz. Vous aurez à les décompresser avant de pouvoir les utiliser.

ZIP est un format de compression standard présent dans la plupart des systèmes d’exploitation.

sfArk est un format de compression spécialement développé pour la compression des SoundFonts. Pour les
décompresser, vous pouvez utiliser Polyphone  (logiciel multiplateforme) ; ou bien ce service en ligne :
https://cloudconvert.com/sfark-to-sf2

.tar.gz est un format de compression couramment utilisé sous Linux, les utilisateurs sous Windows
décompresserons ces fichiers avec 7-Zip  ; les utilisateurs sous macOS peuvent utiliser The Unarchiver , ou
Archive Utility intégré au système. A noter qu’avec 7-Zip il est nécessaire de lancer la décompression en 2 temps, la
première pour GZip, et la seconde pour TAR.

Dépannage

Si la barre d’outils de lecture est grisée, ou masquée, suivez les indications ci-dessous pour retrouver les fonctionnalités
sonores :

1. Faites un clic droit sur la barre de menu et assurez vous que la case Outils de lecture soit cochée. Si cette vérification
ne résout rien, passez à l’étape 2.

2. Si la fenêtre de lecture disparaît après avoir changé de SoundFont, ouvrez le menu Edition → Préférences... → onglet E /
S et cliquer sur OK sans faire de modifications. La fenêtre de lecture doit réapparaître au redémarrage de
MuseScore.

Si c’est votre premier changement de SoundFont, nous vous recommandons d’utiliser l’une de celles listée ci-dessus.

Si le son est haché, il est possible que les ressources de votre ordinateur ne puissent pas prendre en charge la
SoundFont installée. Suivez les conseils suivants :

Utilisez une SoundFont de taille moins grande pour réduire la mémoire RAM utilisée par MuseScore. Voir la Liste ci-
dessus.
Fermer toutes les applications, sauf MuseScore, pour libérer le plus de mémoire RAM possible, ou ajoutez de la
mémoire à votre ordinateur si l’utilisation de cette SoundFont est essentielle.

Voir aussi

Synthétiseur
Mélangeur

Liens externes
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How to change the SoundFont or add another  (en anglais)
The SFZ Format  (pour plus de détails sur la spécification SFZ (en anglais))

Swing

La fonction Swing de MuseScore permet de changer la lecture de la partition d’un rythme linéaire à un rythme swingué.
Le Swing peut être global pour l’ensemble de la partition ou seulement appliqué à une section, le Swing est de plus
totalement paramétrable.

Appliquer le swing à une section de partition

Pour appliquer le Swing à toutes les portées d’un système :

1. Cliquez sur la note ou vous voulez que le Swing démarre ;

2. Cliquez sur Swing dans la palette Texte (double-clic pour les versions antérieurs à 3.4) ;

3. Éditer le texte Swing si besoin ;

4. Pour modifier les paramètres par défaut du Swing, faire un clic droit sur le texte Swing, sélectionnez Propriétés du texte
de système..., cliquez sur l’onglet "Paramètres du swing" et ajustez la durée de la note et le "Ratio du swing".

Pour appliquer le Swing seulement à des portées spécifiques d’un système :

1. Cliquez sur la note ou vous voulez que le Swing démarre ;
2. Ajoutez un Texte de portée ;
3. Éditer l’apparence du texte si besoin ;
4. Faites un clic droit sur le texte, sélectionnez Propriétés du texte de portée..., cliquez sur l’onglet "Paramètres du swing".

Modifiez pour l’effet voulu ;
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5. Répétez les étapes 1 à 4 pour d’autres portées si nécessaire.

Le texte de Swing peut être édité et mis en forme comme tout autre objet texte.

Triolet dans une marque de tempo

Cette notation est souvent utilisée pour indiquer le Swing :

Il n’est pas possible d’ajouter un triolet dans une marque de tempo avec MuseScore, mais un moyen facile permet d’y
arriver :

1. Ajouter un texte de Swing comme décrit au-dessus et rendez le invisible (raccourci V, ou décochez "Visible" dans
l’Inspecteur) ;

2. Ajoutez l’Image correspondante au tempo souhaité dans la partition. Ces images sont téléchargeable en bas de la
page : How to create a visual swing marking  (en anglais).

3. Redimensionnez et repositionnez l’image si besoin.

Revenir au rythme linéaire

Pour revenir au rythme linéaire après une section swinguée, utilisez l’une des méthodes suivantes :

Utilisez et modifiez un texte de Swing. (Pour les versions antérieures à 3.4).

1. Ajoutez un texte de Swing à la première note ou silence de la section "linéaire" (voir au-dessus).
2. Éditer le texte pour indiquer le retour à un rythme linéaire : Par exemple "Linéaire".
3. Faites un clic droit sur le texte et sélectionnez Propriétés du texte de système…. Cliquez sur l’onglet "Paramètres du

swing" et cochez le bouton radio "Sans".

Utilisez le texte système Linéaire depuis la version 3.4.

Ajoutez le texte système Linéaire depuis la Palette principale à la première note ou silence de la section "linéaire"
(voir au-dessus).

Appliquer le swing à toute la partition

Pour appliquer le Swing à l’ensemble de la partition depuis la barre de menu :

1. Sélectionnez Format → Style... → Partition.

2. Dans la section "Paramètres du Swing", réglez la durée de note et le ratio désiré.
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2. Dans la section "Paramètres du Swing", réglez la durée de note et le ratio désiré.

Liens externes

How to create a visual swing marking  (En anglais).
Swing (jazz performance style)  (Wikipedia (En anglais))

Synthétiseur

Généralités

Pour afficher le Synthétiseur : Sélectionnez Affichage→Synthétiseur depuis la barre de menu.

Le Synthétiseur est le panneau de contrôle de la sortie son de MuseScore, il permet de :

Charger et organiser les banques de sons pour lire la musique.
Appliquer des effets de réverbération et de compression.
Régler la hauteur du diapason.
Changer le volume de sortie.
Sélectionner les Contrôleurs Midi pour l'utilisation des Nuances sur une Seule Note (version 3.1 et ultérieure).

La boîte de dialogue du Synthétiseur est divisée en plusieurs onglets :

Fluid : Un synthétiseur logiciel qui utilise les banques de sons au format SoundFont SF2 / SF3.
Zerberus : Un synthétiseur logiciel qui utilise les banques de sons au format SFZ.
Effets principaux : Appliquent des multi-effets à la partition.
Réglage du diapason : Pour changer la hauteur du diapason.
Nuances (version 3.1 et ultérieures) : Configure les contrôleurs Midi utilisés par les Nuances sur une Seule Note.

Enregistrer / charger les paramètres du synthétiseur

Les boutons au bas de la fenêtre du Synthétiseur ont les fonctions suivantes :

Bouton Fonction
Définir comme
valeur par défaut

Enregistre toutes les valeurs en cours d'utilisation du synthétiseur comme valeurs par défaut. Celles-ci
seront chargées automatiquement au démarrage de MuseScore.

Charger les valeurs
par défaut

Charge les dernières valeurs sauvegardées par défaut du Synthétiseur.

Enregistrer dans la
partition

Sauvegarde tous les paramètres actuels du synthétiseur dans la partition active uniquement.
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Charger depuis la
partition

Charge les paramètres du synthétiseur depuis la partition active.Bouton Fonction

Notes : (1) Sont inclus dans les "paramètres du Synthétiseur" l'ordre des SoundFonts et des fichiers SFZ, le set-up des
effets, la hauteur du diapason, et le volume. (2) Un seul jeu de paramètres du Synthétiseur peut être actif à la fois — par
exemple, si plusieurs partitions sont ouvertes en même temps, il est impossible de faire des modifications dans le
Synthétiseur pour une partition en conservant les paramètres des autres partitions inchangés. (3) Les changements de
paramètres du synthétiseur ne seront pas entendues lors de l'export des fichiers audio tant qu'ils ne sont pas d'abord
sauvegardés dans la partition (voir le tableau ci-dessus). Voir aussi Réglage du diapason (ci-dessous).

Fluid

Cliquez sur l'onglet Fluid pour afficher le panneau de contrôle des banques de sons SoundFont SF2 / SF3. La SoundFont
MuseScore_General.sf3 est déjà installée par défaut.

Il est possible de charger, ordonner et supprimer les SoundFonts comme vous le souhaitez. La lecture des différents
instruments peut-être répartie sur une ou plusieurs SoundFonts (et / ou fichiers SFZ). L'ordre des SoundFonts dans Fluid
modifie l'ordre par défauts des instruments dans le Mélangeur.

Charger une SoundFont

1. Cliquez sur ajouter button
2. Sélectionner une SoundFont dans la liste.

Pour charger une SoundFont dans le synthétiseur, vous devez d'abord l'installer dans le dossier Soundfonts afin qu'elle
apparaisse dans la liste du point 2 ci-dessus

Pour réorganiser les SoundFonts

1. Sélectionnez la SoundFont
2. Positionnez là dans la liste via les flèches haut / bas (à droite de la fenêtre).
3. Procédez de même avec les autres SoundFonts si besoin.
4. Ou alors utilisez la double-flèche vers le haut (partie supérieure droite de la fenêtre) pour positionner une soundfont

tout en haut de la liste

L'ordre des instruments disponibles dans le Mélangeur correspond à l'ordre des SoundFonts établi dans le synthétiseur.
Donc, si la bonne lecture d'une partition nécessite l'utilisation de certains instruments, il est préférable d'enregistrer la
configuration du synthétiseur avec la partition concernée en cliquant sur Enregistrer dans la partition. Avant de faire jouer la
partition, il vous suffit alors de cliquer sur Charger depuis la partition pour revenir à la configuration enregistrée. Toutefois,
notez que cela n'enregistre que l'ordre des instruments — pas les instruments eux mêmes, qui doivent être installés sur
votre ordinateur.

Pour retirer une SoundFont

1. Cliquer sur le nom de la SoundFont
2. Cliquer sur le bouton Suppr.

Cela supprime la SoundFont du synthétiseur mais ne la supprime pas du dossier SoundFonts : elle sera toujours
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disponible si vous souhaitez la recharger plus tard.

Zerberus

Cliquez sur l'onglet Zerberus pour accéder au panneau de contrôle des bibliothèques d'échantillons sonores SFZ. Il est
possible d'ajouter, de supprimer ou de réorganiser des fichiers de la même manière que dans l'onglet Fluid. Notez que,
comme pour Fluid, les fichiers SFZ doivent d'abord être installés dans votre dossier SoundFonts avant de pouvoir être
chargés dans le synthétiseur.

Volume

Le curseur sur la droite du synthétiseur contrôle le volume de la lecture : toute modification effectuée ici ne dure que
jusqu'à la fin de la session, sauf si elle est enregistrée dans la partition ou définie comme nouvelle valeur par défaut.

Effets

L'onglet Effets principaux du Synthétiseur vous permet d'ajouter de la réverbération et de la compression lors de la
lecture de votre partition.

Effets principaux avec la Réverbération Zita1 et le Compresseur SC4.

Pour activer / Désactiver un effet :

Sélectionnez une option dans la liste déroulante à côté de Effet A ou Effet B (les effets sont appliqués en série, A
→ B).

Pour stocker et charger les configurations d'effets, utilisez les boutons en bas de la fenêtre du synthétiseur. Voir
Paramètres du synthétiseur (ci-dessus) pour plus de détails.

Réverbération Zita 1

Le module de réverbération stéréo Zita 1 vous permet de simuler l'ambiance d'une petite pièce à un grand hall. Le pré-
décalage, le temps de réverbération et la tonalité de la réverbération peuvent être réglés avec précision à l'aide des
commandes fournies :

Delay : Régler un pré-délai pour la réverbération de 20 à 100 ms.
Low RT60 (temps de réverbération des basses fréquences) : Utilisez la commande grise pour régler la fréquence
centrale (50-1000 Hz) de la bande de basse fréquence que vous voulez affecter : la commande verte règle le temps
de réverbération (1-8 sec) de cette bande de fréquence.
Mid RT60 (Temps de réverbération moyen) : Ajustez le temps de réverbération (1 à 8 secondes) de la bande de
fréquence moyenne.
HF Damping : Ajuste la composante haute fréquence de la réverbération. En augmentant cette valeur, la fréquence
du point de coupure augmente et la réverbération apparaît plus brillante et plus longue.
EQ1 : Permet de couper ou d'augmenter (-15 à +15) une bande de fréquence (centre = 40 Hz - 2 KHz) dans la
partie inférieure du spectre.
EQ2 : Permet de couper ou d'augmenter (-15 à +15) une bande de fréquences (centre = 160 Hz - 10 KHz) dans la
partie haute du spectre.
Output : Contrôle la quantité d'effet appliquée. "Dry" => Pas d'effet. "Wet" => effet appliqué à 100%. "Mix" est un
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équilibre 50/50 entre le son de base et la son transformé par l'effet.

Attention : EQ1 et EQ2 n'affectent que la tonalité de la réverbération, et non le son de base.

Pour mettre rapidement en place une réverbération, régler "Output" sur "Mix" et ajuster la commande "Mid RT60" sur le
temps de réverbération souhaité. Ensuite, ajuster l'effet comme expliqué ci-dessus.

Compresseur SC4

Le compresseur stéréo SC4 vous permet de contrôler avec précision la plage dynamique de la lecture, en réduisant la
variation de volume entre les sons forts et faibles. Il offre les commandes suivantes :

RMS : Ajuste l'équilibre entre la compression RMS (0) et la compression Peak (1). En compression RMS, le
compresseur réagit aux niveaux moyens du signal ; en mode Peak, le compresseur réagit aux pointes.
Attaque : (1,5-400 ms) Temps nécessaire à la compression pour s'engager complétement après que le signal ait
dépassé le niveau de seuil.
Retour : (2-800 ms) Le temps qu'il faut à la compression pour revenir à zéro après que le signal soit tombé en
dessous du niveau seuil.
Seuil : (en dB) Le niveau du signal au-dessus duquel la compression commence à prendre effet. L'abaissement du
seuil augmente la quantité de signal compressé.
Ratio : La quantité de compression appliquée au signal au-dessus du seuil. Plus le ratio est élevé, plus la
compression est importante. Varie entre 1:1 et 20:1.
Knee : Permet de sélectionner une plage entre "soft knee" et "hard knee". Cela permet d'adoucir la transition entre
le signal non compressé et le signal compressé.
Gain : La compression a tendance à diminuer le volume, utiliser cette commande pour rétablir le signal selon les
besoins.

Pour une configuration rapide, essayez de régler RMS = 1, Threshold = -20 dB, Ratio = 6. Augmentez le Gain pour
rétablir le volume perdu. Ensuite, effectuez un réglage fin comme expliqué ci-dessus.

Réglage du diapason

L'onglet Réglage du diapason est l'endroit où vous pouvez ajuster le diapason principal du programme. Par défaut,
pour les instruments de concert, le diapason est réglé à A4 = 440 Hz.

Pour régler le diapason du programme :

Entrer la nouvelle valeur dans le champ Réglage du diapason puis cliquer sur le bouton Changer la fréquence du
diapason.

Remarques :
(1) Cet ajustement ne s'applique qu'aux les partitions de la session courante. Pour en faire le réglage par défaut ou pour
le stocker sur une partition particulière, voir [Sauvegarder/charger les paramètres du synthétiseur] (#synth-settings).
(2) Pour appliquer le nouveau réglage aux fichiers audio exportés (WAV, MP3, OGG), cliquer sur le bouton Enregistrer dans
la partition avant l'exportation.

Nuances (version 3.1 et ultérieures)

Remarque préliminaire : Pour pouvoir agir sur les nuances, la Soundfont utilisée doit pouvoir répondre aux messages
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MIDI CC (Control Change) 1, 2, 4 ou 11 - c'est le cas de la SoundFont native de MuseScore, MuseScore_General_HQ,
par exemple. À partir de MuseScore 3.1, la lecture SND est activée par défaut.

Cliquez sur l'onglet Nuances pour accéder au panneau de contrôle :

Type de nuances : Choisir entre 1) Par défaut (sur une seule note et vélocité), 2) Vélocité (pas de nuance sur une
seule note), 3) Événements CC seuls (vélocité constante).
Note : Les nuances constantes sont des nuances comme f, mp et pp entre autres, les nuances variables sont des
nuances qui changent la vitesse d'attaque comme fz, fp, pf ou sffz entre autres.
CC à utiliser : En fonction de la SoundFont que vous utilisez, vous devrez peut-être choisir l'effet à utiliser, 1) CC 1,
2) CC 2 (par défaut), 3) CC 4, 4) CC 11. (CC => Contrôle Change).
Note : Si vous utilisez une SoundFont qui ne supporte pas CC2, elle peut généralement être configurée pour utiliser
le MIDI CC11.

Dans la zone Paramètres avancés, vous pouvez choisir d'activer ou de désactiver le contrôle d'expression pour le son
des instruments :

Configurer tous les sons : Sélectionnez 1) Avec expression (pour activer l'expression de tous les sons des
instruments), 2) Sans expression (pour désactiver l'expression de tous les sons des instruments), 3) Tout réinitialiser
(Réinitialiser l'expression de tous les sons des instruments aux valeurs par défaut)

Voir aussi

SoundFont
Mélangeur
How to : Utilisation des nuances sur une seule note

Tempo

Les Indications de Tempo peuvent être trouvées dans la Palette Tempo de l'Espace de travail de base et Avancé. Elles
sont fournies sous forme d'indications métronomiques, mais peuvent être modifiées ultérieurement pour afficher le tempo
ou la variation de tempo de votre choix. Le tempo de lecture peut être modifié tout au long de la partition en utilisant
plusieurs indications de tempo, visibles ou invisibles.

Ajouter une Indication de Tempo

Utilisez l'une des méthodes suivantes:

Sélectionnez une note ou un silence et appuyez sur le raccourci clavier Alt+Maj+T.
Sélectionnez une note ou un silence, et dans la barre de menu, choisissez Ajouter→Texte...→Indication de tempo.
Sélectionnez une note ou un silence et cliquez sur une indication de tempo appropriée dans la palette Tempo
(double-cliquez sur les versions antérieures à 3.4);
Glissez-déposez une indication de tempo depuis la palette Tempo directement sur une note ou un silence.

Remarque: Si une indication de tempo est appliquée à partir du menu ou à l'aide d'un raccourci clavier, la note de
l'indication de tempo (blanche, noire, croche, pointée ...) se basera automatiquement sur la signature rythmique.
L'avantage d'appliquer à partir d'une palette est que vous pouvez choisir la note de l'indication de tempo (blanche, noire,
croche, pointée ...) à utiliser.

146

https://musescore.org/fr/node/307736


Modifier le tempo

Pour changer le tempo d'une indication de tempo existante dans la partition:

1. Allez à mode d'édition sur l'indication de tempo en question;
2. Modifiez la valeur du tempo et/ou la note de l'indication de tempo (blanche, noire, croche, pointée ...) selon vos

besoins;
3. Quitter le mode d'édition.

Vous pouvez également remplacer la valeur d'une indication de tempo existante depuis l'Inspecteur:

1. Sélectionnez l'indication de tempo;
2. Décochez "Suivre l'indication du texte" dans la section Texte de tempo de l'Inspecteur;

3. Réglez le tempo de lecture souhaité dans le champ "Tempo" en dessous.

Remarque: La lecture peut être plus rapide ou plus lente si le réglage de tempo de la Fenêtre de lecture est à un
pourcentage autre que 100% (voir ci-dessous).

Modifier le texte du tempo

Les indications de tempo peuvent être Éditées et formatées comme n'importe quel autre type de Texte. Pour définir les
propriétés du texte ou le style de texte, voir Styles de texte et propriétés.

Le tempo indiqué par une indication métronomique persiste généralement même s'il est écrasé par une expression -
comme Andante, Moderato, etc. Vous pouvez également ajouter du texte à une indication de métronome simple. Par
exemple:

Passer outre les indications de tempo

Vous pouvez temporairement passer outre le tempo indiqué, et jouer la partition à n'importe quel tempo que vous
souhaitez en utilisant la Fenêtre de lecture:

1. Afficher la fenêtre de lecture: Affichage→Fenêtre de lecture ou F11 (Mac: Fn+F11):

2. Déplacez le curseur de tempo vers le haut ou vers le bas selon les besoins. Le tempo est affiché à la fois en valeur
absolue et en pourcentage de l'indication de tempo actuellement indiquée. Double-cliquez sur le curseur de tempo
pour le réinitialiser.

Remarque: Le BPM est toujours mesuré et affiché en battements de noire par minute, quel que soit la (dénominateur de
la) signature rythmique en vigueur.

Lecture Ritardando et Accelerando
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Vous pouvez simuler la lecture avec effet ritardando ("rit.") et accelerando ("accel.") en ajoutant des indications de
tempo cachées dans la partition. L'indication imprimée au musicien doit être ajoutée comme texte de portée et de
système en plus.

Dans l'exemple illustré ci-dessous, le tempo était à l'origine de 110 BPM (battements par minute). Au ritardando, le tempo
diminue de 10 BPM sur la première note de chaque mesure. Chaque changement de tempo est rendu invisible en
décochant la case Visible dans l'Inspecteur, de sorte que seul le ritardando apparaisse sur la partition imprimée:

Un plugin a été développé pour automatiser ce processus: TempoChanges

Points d'orgue

Les points d'orgue, disponibles dans la palette Articulations, ont une propriété Durée qui peut être définie via l'Inspecteur.
Par défaut, cette propriété est définie sur 1,00. Pour que MuseScore lise un point d'orgue pendant deux fois sa durée
normale, cliquez sur le point d'orgue et réglez "Durée" à 2,00. Cela ne fonctionne bien sûr pas pour un point d'orgue
ajouté à une barre de mesure, car les barres de mesure n'ont pas de durée qui puisse s'étirer.

Voir aussi

Modes de lecture
Indications de mesure

Nuances

Les nuances sont des symboles donnant des indications d'intensité sonore relative pour une note ou pour toute une
phrase musicale. On les trouve dans la palette "Nuances" dans les espaces de travail de Base et Avancé .

Il est possible de trouver d'autres symboles de nuance dans la Palette Principale (Maj.+F9).

Note : Pour agir sur le volume sonore de toute la partition, utiliser le curseur de volume dans la Fenêtre de lecture ou
dans le Synthétiseur.

Ajouter des nuances

Pour ajouter des nuances à une partition, utiliser l'une des méthodes suivantes :

Sélectionner une note puis cliquer sur un symbole dans dans la palette "Nuances" (double-click dans les versions
antérieures à 3.4).
Faire glisser un symbole de la palette "Nuances" sur une note.

Pour ajouter un crescendo ou un decrescendo, voir la page du manuel Crescendos / Decrescendos.

Ajuster les propriétés

La nuance par défaut de la partition est mf (mezzoforte), c'est à dire réglée sur la valeur MIDI 80 (127). En fonction de la
nuance à ajouter à un endroit de la partition, cette valeur (et le volume sonore qui en résulte) peut être modifiée, inférieure
ou supérieure .

Éditer la vélocité d'une nuance

Sélectionner une nuance sur la partition, puis modifier la valeur de Vélocité présente dans la section "Nuances" de
l'Inspecteur.

Pour ajuster l'étendue des nuances
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Note : Étendue des nuances = portées dans un système concernées par la nuance.

Sélectionner une nuance dans la partition, puis dans la section Nuances de l'Inspecteur, choisir l'une des options
de la liste déroulante "Étendue des nuances". Par défaut, une nuance agit sur la "Partie", c'est à dire que la nuance
agit sur toutes les portées de l'instrument concerné. "Portée" limite l'effet de la nuance à la portée où est attachée la
nuance. "Système" indique que toutes les portées du système sont concernées par la nuance.

Déplacer une nuance (au dessus ou en dessous de la portée)

Pour déplacer un seul symbole de nuance, le sélectionner et presser la touche X. Ceci fera changer la nuance de
au-dessus à en-dessous de la portée et réciproquement. Il est aussi possible d'utiliser l'inspecteur, voir ci-dessous.

Pour déplacer toutes les nuances d'une portée :

1. Clic-droit sur l'un des symboles de nuance, Choisir Sélection -> Tous les éléments similaires de la même
portée

2. Dans la section Nuances de l'Inspecteur choisir "Au dessus" ou "Au dessous" dans la liste déroulante
"Position".

Pour déplacer toutes les nuances d'une partition :
Faire comme indiqué ci-dessus puis cliquer sur le bouton S (Définir comme style) dans l'inspecteur situé à droite de
la liste déroulante "Position".

Personnaliser les nuances

Les symboles de Nuance peuvent être édités de la même façon que tous les autres objets texte.

Les Raccourcis d'insertion de caractères spéciaux peuvent être utilisé pour insérer les nuances :

Ctrl+Maj.+P (Mac: Commande+Maj.+P): Piano p.
Ctrl+Maj.+F (Mac: Commande+Maj.+F): Forte f.
Ctrl+Maj.+M (Mac: Commande+Maj.+M): Mezzo m.
Ctrl+Maj.+R (Mac: Commande+Maj.+R): Rinforzando r.
Ctrl+Maj.+S: Sforzando s.
Ctrl+Maj.+N (Mac: Commande+Shift+N): Niente n.
Ctrl+Maj.+Z (Mac: Commande+Maj.+Z): Z z.

Il est possible d'éditer la vélocité et l'étendue des nuances, (voir Ajuster les propriétés plus haut dans cette page). Pour
enregistrer les modification, il est possible d'utiliser les Palettes personnalisées.

Nuance pour une seule note (SND)

Depuis la version 3.1, MuseScore prend en charge les nuances sur une seule note. En plus de la possibilité de modifier la
vélocité, il est également possible de changer la vélocité dans l'inspecteur. Saisir une valeur positive ou négative dans le
champ "Changement de vélocité", la vélocité initiale de la note sera augmentée (ou diminuée) d'autant. Un nombre
négatif sera utilisé pour diminuer le volume et un nombre positif sera utilisé pour augmenter le volume initial. Voir les liens
(ci-dessous) pour plus de détails.

Liens externes

Video tutorial: Lesson 10 - Articulations, Dynamics and Text
Using Single Note Dynamics (SND)  (MuseScore HowTo)
How to restore correct playback of dynamics and hairpins in an imported MIDI file  (MuseScore HowTo)
Dynamics  (Wikipedia)
Nuances  (Wikipedia)

Lecture avec capodastre

MuseScore est capable de jouer une partition en la transposant sans avoir à modifier l'écriture des notes. Cela simule
l'utilisation d'un capodastre  (Wikipedia) sur l'instrument, quel que soit l'instrument.

Ajouter un capodastre sur une seule portée

1. Ajouter un texte de portée à une note ou à un silence à l'endroit où la transposition doit commencer.
2. Clic-droit sur le texte de portée, puis choisir "Propriétés du texte de portée" dans le menu qui s'affiche. Ou cliquer

sur le bouton "Propriétés" dans la section "Texte de Portée" de l'Inspecteur. Dans la fenêtre qui s'ouvre, choisir
l'onglet Paramètres du Capo.

3. Cocher la case "Paramètres du Capo" puis indiquer sur quel numéro de frette mettre le Capo (chaque frette
augmente la tonalité d'un demi ton).

4. Cliquer sur le bouton Ok.
5. Éditer le texte de portée à votre convenance.

149

https://www.youtube.com/watch?v=KnoKgja20fg
https://musescore.org/fr/node/290616
https://musescore.org/fr/node/277424
https://en.wikipedia.org/wiki/Dynamics_%28music%29
https://fr.wikipedia.org/wiki/Nuance_%28musique%29
https://fr.wikipedia.org/wiki/Capodastre


Ajouter un capodastre une portée et une tablature liées entre elles

Même méthode que ci-dessus, mais à l'étape 1, n'ajouter le texte de portée qu'à la portée contenant les notes.

Ajouter un capodastre à une portée et une tablature non liées entre elles

Même méthode que ci-dessus, mais appliquer le texte de portée à la fois à la portée et à la tablature.

Note : La transposition par Capodastre sera active depuis la note portant le texte de portée jusqu'à une prochaine note
ayant le Capo actif, ou jusqu'à la fin de la partition.

Annuler le capodastre

Pour supprimer un capodastre plus loin dans la partition et revenir à la tonalité d'origine :

Ajouter un texte de portée avec le paramètre "Frette du Capo" fixé à "Sans capo".

Texte
Il y a de nombreux types de texte dans MuseScore, (voir le tableau ci-dessous) ; les lignes peuvent aussi contenir du
texte. Ce chapitre vous explique comment créer, mettre en forme, et éditer les objets texte, il fournit également des
informations sur les types de texte suivants.

Type de texte Usage
Texte de portée Texte à usage général attaché uniquement à la portée de l’instrument et à sa partie.
Texte de
système

Texte à usage général attaché à une seule potée de l’ensemble des instruments d’ un système et de
toutes leurs parties.

Symboles
d’accord Affiche les accords de la mélodie : Habituellement au-dessus de la portée.

Doigtés Chiffres ou lettres attachés aux notes indiquant les doigts à utiliser.
Paroles Crée les paroles attachées à la mélodie.
Repères Facilite les répétitions, divise la partition en sections, marque page de passages, etc.

Suivez les liens ci-dessous pour tous les autres types de texte de MusScore.

Type de texte Usage
Nuances Indique le volume d'une note ou d'une phrase.
Basse chiffrée Notation de période pour les claviéristes.
Cadre de texte Titre / compositeur / parolier, informations en début de partition ; paroles de la partition, etc.
En-tête / Pied de page Numéros de page, information de copyright, etc. En haut ou en bas de page.
Texte d’instrument Applique un changement d’instrument en milieu de portée.
Répétitions et sauts Da Capo, Dal segno, Fine, etc.
Chiffre Romain d'analyse
(RNA) Un système d’analyse d’accords.

Doigtés de batterie Les lettres (G et D) attachées aux notes (de batterie) indiquent de quelle main ou quel pied
elles doivent être jouées.

Texte de Swing Change d’un rythme linéaire à un rythme swingué, et inversement.
Indications de Tempo Appliquent les indications de métronome et / ou des indications d'interprétation .
Lignes de texte Voltas, ottavas, pédale, ligne de guitare, etc.

Bases sur les textes

Ajout de texte

Pour ajouter un élément textuel à la partition, utilisez l'une des méthodes générales suivantes :

Raccourcis clavier: Par exemple, appuyer sur Ctrl+T pour entrer Ajouter un texte à la portée, Ctrl+L pour entrer des
Paroles, et ainsi de suite…
Barre de Menu: Ajouter→Texte vous permet de choisir parmi une gamme d'éléments textuels.
Palettes: Sélectionner une note et cliquer sur une icône dans une des palettes (double-clic dans les versions
antérieures à 3.4) ; ou, alternativement, faire glisser un symbole d'une palette sur la portée. par ex.. Swing, Tempo
etc.

Notes : (1) La méthode exacte dépend du type de texte que vous ajoutez (voir Texte). (2) Pour les boîtes de texte à
usage général attachées aux portées, voir Texte de portée.
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Formatage du texte

Lorsqu'un Objet Texte est créé dans MuseScore, il suppose que le Style de Texte: corresponde à tous les textes de la
portée, un style de texte unique, les marques de tempo, les dynamiques, les symboles d'accords, etc.

Chaque style de texte est constitué d'un certain nombre de propriétés de texte (police de caractères, taille de la police,
style de la police, etc. ), qui peuvent être consultées, principalement, dans le dialogue Format (Format→Style…→Styles de
Texte).

Une nouvelle création Objet Texte commence avec des propriétés de texte identiques à celles du style de texte. Celles-ci
peuvent être consultées dans l'inspecteur :

Cependant, ces propriétés de texte ne sont pas limitées à celles du style de texte par défaut : si nécessaire, vous pouvez
les modifier dans l'inspecteur indépendamment du style de texte.

Enfin, si vous souhaitez appliquer un formatage à des caractères spécifiques dans un objet texte (police de caractères,
taille de la police, gras, italique, souligné, exposant, indice), vous pouvez le faire dans Mode Edition de Texte.

Ajuster la position des objets de texte

Pour positionner un objet texte, utilisez l'une des méthodes suivantes :

Faire glisser l'objet.
Sélectionner l'objet et ajustez les valeurs de décalage X ou Y dans l'Inspecteur.
Sélectionner l'objet et appliquer l'un des raccourcis clavier suivants :
← : Déplacer le texte vers la gauche 0.1 sur l'espace de portée.
→ : Déplacement du texte vers la droite de 0,1 sur l'espace de portée.

↑ : Déplacer le texte vers le haut de 0,1 sur l'espace de portée.
↓ : Déplacer le texte vers la droite de 0,1 de l'espace de portée : Déplacer le texte vers le bas de 0,1 sur
l'espace de portée.
Ctrl+← (Mac : Cmd+←) : Déplacer le texte en laissant un espace de portée.
Ctrl+→ (Mac : Cmd+→) : Déplacer le texte vers la droite d'un espace de la portée.
Ctrl+↑ (Mac : Cmd+↑) : Déplacer le texte vers le haut d'un espace de portée.
Ctrl+↓ (Mac : Cmd+↓) : Déplacer le texte vers le bas d'un espace de portée.

Ancres de texte

Lorsque vous appliquez un élément de texte à la partition, sa position anchor dépend du type :

Titre, sous-titre, compositeur, poète : Ancré à un cadre.
Doigté: Ancré à des têtes de notes.
Paroles: Ancré à une position temporelle (une note/un accord, mais pas un repos).
Symbole d'accord : Ancré à une position temporelle.
Texte de Portée : Ancré à une position temporelle.
Texte de Système : Ancré à une position temporelle.
Doigtés de Batterie : Ancré à une position temporelle.

Édition des textes

Le mode d'édition de texte permet d'ajouter ou de supprimer du texte et d'appliquer un formatage (par exemple, gras,
italique, souligné, etc.) aux différents caractères.
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Entrer/sortir du mode d'édition de texte

Pour entrer en mode d'édition de texte, utilisez l'une des méthodes suivantes :

Double-cliquer sur un objet texte.
Cliquer sur un objet texte déjà sélectionné.
Cliquer avec le bouton droit de la souris sur un objet texte, et sélectionner Éditer l'élément.
Cliquer sur un objet texte et appuyer sur Alt+Shift+E.

Note : La création d'un nouvel objet texte (voir Text basics) place également le programme en mode d'édition de texte.

Vous pouvez accéder aux différentes fonctions de formatage à partir de la barre d'outils Texte qui apparaît sous la fenêtre
du document :

Pour quitter le mode d'édition de texte, utilisez l'une des options suivantes :

Appuyer sur Esc.
Cliquer sur une partie de la partition en dehors de la fenêtre d'édition.

Raccourcis clavier

En mode édition de texte, les raccourcis clavier suivants sont disponibles :

Ctrl+B (Mac : Cmd+B) permet d'afficher en gras.
Ctrl+I (Mac : Cmd+I) active l'italique.
Ctrl+U (Mac : Cmd+U) bascule en souligné.
Home End ← → ↑ ↓ déplace le curseur.
Backspace (Mac : Effacer) supprime le caractère à gauche du curseur.
Supprimer (Mac : Supprimer ou Fn+Del) supprime le caractère à droite du curseur.
↵ commence une nouvelle ligne.
F2 (Mac : Fn+F2) Insère des caractères spéciaux (voir ci-dessous).

Symboles et caractères spéciaux

Vous pouvez utiliser la fenêtre Caractères spéciaux pour insérer des quarts de notes, des fractions et de nombreux
autres types de symboles ou caractères spéciaux dans votre texte. Quelques symboles sont également accessibles par
raccourci (voir ci-dessous).

inline:special_characters_en.png=La palette des caractères spéciaux contient des boutons permettant d'insérer des
symboles dans le texte (par exemple, une noire), ou des caractères spéciaux (par exemple, le symbole de copyright, ©)]

Pour ouvrir Caractères spéciaux, utilisez l'une des méthodes suivantes :

Cliquer sur l'icône  dans la barre d'outils texte (sous la fenêtre de partition).
Appuyer sur F2 (Mac : Fn+F2).

Note : (1) Cela ne fonctionne qu'en Mode d'édition de texte ; (2) Le dialogue des caractères spéciaux ne doit pas être
confondu avec l'élément de menu du même nom dans la version macOS de MuseScore.

Le dialogue est divisé en 3 onglets : Symboles communs, symboles musicaux et symboles unicode. Les onglets musicaux
et unicode sont ensuite subdivisés en catégories classées par ordre alphabétique.

Un double-clic sur un élément dans le dialogue des caractères spéciaux l'ajoute immédiatement au texte où se trouve le
curseur. Plusieurs éléments peuvent être appliqués sans fermer la boîte de dialogue, et l'utilisateur peut même continuer
à taper normalement, supprimer des caractères, entrer des codes de caractères numériques, etc.

Raccourcis pour les caractères spéciaux

En mode édition de texte, les raccourcis clavier suivants peuvent être utilisés pour accéder à certains caractères
spéciaux :

Ctrl+Shift+# (Mac : Cmd+Shift+#) : Dièse ♯. (Note : Cela peut ne pas fonctionner sur tous les claviers)
Ctrl+Shift+B (Mac : Cmd+Shift+B) : Bémol ♭__.
Ctrl+Shift+H (Mac : Cmd+Shift+H) : Bécarre ♮__.
Ctrl+Shift+P (Mac : Cmd+Shift+P) : Piano p.
Ctrl+Shift+F (Mac : Cmd+Shift+F) : Forte f___.
Ctrl+Shift+M (Mac : Cmd+Shift+M) : Mezzo _m.
Ctrl+Shift+R (Mac : Cmd+Shift+R) : Rinforzando r.
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Ctrl+Shift+S (Mac : Cmd+Shift+S) : Sforzando s.
Ctrl+Shift+N (Mac : Cmd+Shift+N) : Niente n___.
Ctrl+Shift+Z (Mac : Cmd+Shift+Z) : Z _z.
Ctrl+Alt+- (Mac : Cmd+Alt+-) : Élision ‿.

Voir aussi

Symbole d'accord
Paroles
Cadres
Mode édition

Styles de texte et propriétés

Styles de texte

Lorsque vous créez un objet texte, il place initialement les propriétés du Style de Texte applicable à sa classe. Les objets
__texte personnel_, par exemple, ont leur propre style, tout comme les indications de tempo, les paroles, les symboles
d'accord, etc.

Pour afficher et modifier un Style de Texte : sélectionner Format→Style...→Styles de Texte. Cela vous donne accès aux
propriétés suivantes :

Nom : Changer le nom d'un style créé par l'utilisateur si vous le souhaitez.
Police : Le nom de la police (par exemple Times New Roman, Arial etc.) et sa taille en points.
Taille de la police : Si la taille du texte change en proportion de mise à l'échelle.
Style de police : Le style de police à utiliser, par exemple Italique, Gras ou Souligné.
Aligner : Horizontal (gauche, centre, droite) et Vertical.
Couleur : Couleur du texte.
Décalage X/Y : Décalages horizontaux et verticaux en unités mm.
Cadre : Choisir d'avoir un cadre circulaire ou carré autour du texte.
Bordure : Couleur de la bordure du cadre.
Arrière-plan : Couleur de l'arrière-plan à l'intérieur du cadre.
Épaisseur : Épaisseur de la ligne du cadre en unités d'espace.
Marge : Marge intérieure du cadre en unités d'espace.
Arrondi de l'angle : Pour le cadre de la boîte, rayon du coin arrondi.
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Notes__ : (1) L'opacité est définie par le paramètre "Canal Alpha" dans le dialogue "Sélectionner une couleur" : une
valeur entre 0, transparent, et 255, opaque. (2) D'autres propriétés du texte, telles que la couleur de la police, peuvent
être définies dans l'Inspecteur.

Vous pouvez également modifier les propriétés d'un style de texte en sélectionnant un objet souhaité dans la partition, en
ajustant ses propriétés dans l'Inspecteur, et en cliquant sur les boutons Set as style au fur et à mesure. Cela mettra
automatiquement à jour le Style de Texte et tous les objets-texte pertinents de la partition.

Objets texte

Si vous souhaitez formater un objet texte particulier dans la partition différemment de son Style de texte, sélectionnez-le et
ajustez ses propriétés de texte dans l'Inspecteur :

Si vous avez apporté des modifications à une propriété de texte particulière dans l'Inspecteur, mais que vous souhaitez
revenir à la définition de Style de Texte, appuyez sur le bouton "Supprimer la mise en forme personnalisée".

Enregistrer et charger des styles de texte

Les styles de texte (ainsi que tous les autres styles d'un document) peuvent être enregistrés sous forme de fichier style et
chargés dans d'autres fichiers MuseScore. Voir Enregistrer et charger.

Voir aussi

Edition de texte
Entête/Pied de Page
Comportement du texte et des lignes appliqués

Textes de portée et de système

Les Textes de portée et les Textes de système sont importants en tant que texte à usage général. Les premiers ne
concernent que la seule portée où ils sont affectés, les seconds concernent la totalité des portées du système.

Pour ajouter ces Textes de Portée ou de Système, utiliser l'une des méthodes suivantes :

Sélectionner une note ou un silence puis, pour un Texte de Portée, utiliser les touches Ctrl+T et pour un Texte de
Système, utiliser les touches Maj+Ctrl+T.
Sélectionner une note ou un silence puis choisir Texte de Portée ou Texte de Système dans le menu Ajouter→Texte.
Sélectionner une note ou un silence puis cliquer sur Texte de portée ou sur Texte de Système dans la palette
Textes. (Double-click pour les versions de MuseScore antérieures à 3.4).
Faire glisser le texte voulu depuis la palette Textes sur la note ou sur le silence de destination.

Ces actions créent une boîte vide dans laquelle vous aurez à saisir le texte. Utiliser la touche Echap ou cliquer sur un
endroit vide de votre partition pour sortir de l'édition du texte.

En plus de leur utilisation comme texte indicatif, certaines propriétés des Textes de Portée et des Textes de Système
peuvent agir sur la lecture sonore : Paramètres du Swing, Paramètres du Capo, Changer de Canal, Action MIDI (voir plus
loin dans cette page de manuel).

Principales différences entre les Textes de Portée et les Textes de Système:

Style de texte Concerne Propriétés sonores (si
applicable)

Apparaît dans les parties
d'instrument

Texte de portée Une seule portée Une seule portée La partie d'un seul instrument
Texte de
système

Toutes les portées du
système Toutes les portées du système Toutes les parties de tous les

instruments

Texte de Portée

Un Texte de Portée ne concerne qu'une seule portée de la partition, il donne des indications valables uniquement pour
cette portée. Tout effet sonore appliqué à ce Texte est limité à cette portée uniquement. Le texte n'apparaîtra que dans la
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partie instrumentale correspondant cette portée.

Si vous choisissez de masquer les portées vides, les textes de portée seront également masqués.

Un Texte de Portée peut, par exemple, être utilisé pour indiquer des chose comme Solo ou Pizzicato sur l'une des portées
de la partition. En fonction des instructions fournies par le texte, le son produit lors de la lecture de la partition pourra être
modifier. Pour cela, click-droit sur le Texte de Portée, sélectionner Propriétés du texte de portée…. Voir Changer de son en
cours de portée.

Propriétés des Textes de Portée

Pour accéder aux propriétés Changer de canall, Paramètres du swing et Paramètres du Capo, utiliser l'une des méthodes
suivantes :

Sélectionner le Texte de Portée, cliquer sur "Propriétés" dans la section "Texte de portée" de l'Inspecteur.
Click-droit sur le Texte de Portée puis choisir "Propriétés du texte de portée...". Sélectionner l'onglet qui vous
intéresse.

Texte de Système

Un Texte de Système est lie à une portée d'un système, mais il concerne toutes les portées de ce système. Il s'affiche en
haut de la première portée du système. La plupart des propriétés agissant sur la lecture sonore sont applicables à
l'ensemble des portées d'un système. Un Texte de Système apparaît sur chacune des parties instrumentales.

Les Textes de Système ne sont jamais masqués par la fonction Masquer les portées vides dans les systèmes.

Propriétés des Textes de Système

Ajout ou modification du Swing:

Click-doit sur un Texte de Système, puis choisir Propriété du texte de système.... Sélectionner l'onglet
Paramètres du swing.

Note : dans la palette Textes, il existe un Texte de Système pré-réglé pour une exécution Swing de la partition.

Voir aussi

Changer le son en cours de partition

Liens externes

Comment changer le son d'un instrument (ex: pizzicato, trémolo) en cours de partition  (MuseScore HowTo)

Symboles d'accords

Les Symboles d'accords sont des formes abrégées (voir Chiffrage des accords ) (Wikipedia).

Par exemple :

Note: Pour remplir des mesures avec des slashs, voir Remplir avec des slashs ou Activer la notation rythmique avec des
slashs.

En plus de la notation conventionnelle des symboles d'accord, MuseScore à partir de la version 3.3 prend également en
charge le Nashville Number System (NNS), et le Roman Numeral Analysis (RNA).

Saisie d'un symbole d'accord

1. Sélectionnez une note de début ou un slash;
2. Tapez Ctrl+K (Mac: Cmd+K);
3. Le curseur est maintenant positionné au-dessus de la portée prêt pour la saisie. Entrez le symbole d'accord comme

un texte normal, comme suit :
Note: A, B, C, D, E, F, G.
Dièse: # .
Bémol: b (minuscule).
Double dièse: x (minuscule) or ## .
Double bémol: bb .
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Natural: natural. Remarque : Il ne doit pas y avoir d'espace avant le mot "natural", mais tout texte d'accord qui le
suit doit être séparé par un espace - ce dernier étant inséré à l'aide de la commande Ctrl+Space. Ainsi, pour
écrire B♮m: entrez "Bnatural", puis appuyez sur Ctrl+Space, puis tapez "m". Vous pouvez aussi utiliser
Ctrl+Shift+H. Notez qu'aucun de ces éléments ne transpose ou ne joue (autre que la note fondamentale), ni ne
s'exporte correctement vers MusicXML.
Pour les autres symboles, voir Syntaxe des symboles d'accord (plus bas).
4.Déplacez le curseur vers l'avant ou vers l'arrière pour continuer à saisir ou modifier des symboles d'accord
(voir Commandes au clavier plus bas);
5.Quittez le mode Saisie d'un symbole d'accord en appuyant sur Esc.

Lorsque vous quittez la saisie d'un symbole d'accord, les caractères saisis prendront automatiquement le bon format : par
défaut une fondamentale entrée en minuscule deviendra majuscule (pour des options alternatives, voir Majuscules
Automatiques); un "#", "b" ou "natural" se transforme en un bon dièse (♯), bémol (♭) ou bécarre (♮) et ainsi de suite.
N'utilisez pas les signes de dièse, bémol et bécarre habituels car MuseScore ne les interprèterait pas correctement.

Commandes au clavier

Les commandes suivantes sont disponibles lors de la saisie du symbole d'accord :

Espace déplace le curseur à la note, au silence ou au temps suivant
Maj+Espacedéplace le curseur à la note, au silence ou au temps précédent
Ctrl+Espace (Mac: Alt+Espace) ajoute un espace dans le nom de l'accord
; déplace le curseur au temps suivant
: déplace le curseur au temps précédent
Tab déplace le curseur à la mesure suivante
Maj+Tab déplace le curseur à la mesure précédente
Ctrl (Mac: Cmd) plus nombre (1 - 9) déplace le curseur de la durée correspondante au nombre (ex.; d'une blanche
pour le 6)
Échap sortie du mode Édition de texte.

Syntaxe des symboles d'accord

MuseScore interprète la majorité des abréviations utilisées dans les symboles :

Majeur: M, Ma, Maj, ma, maj, Δ (entrez t ou ˆ pour le triangle)
Mineur: m, mi, min, -
Diminué: dim, ° (lettre minuscule o, affiché comme ° si vous utilsez le style Jazz , comme o sinon)
Demi-diminué: ø (entrez 0, zero). Vous pouvez bien sûr utiliser les abréviations telles que mi7b5 etc.
Augmenté: aug, +
Également valides :
Les extensions et altérations comme b9 ou #5, sus, alt, et no3;
Les renversements et notes de basse, comme C7/E;
Les virgules;
Les parenthèses, pouvant inclure tout ou partie d'un symbole d'accord.

Édition d'un symbole d'accord

Les symboles d'accord s'éditent simplement comme des textes. Voir Édition de texte.

Transposition des symboles d'accord

La fenêtre de dialogue Transposer du menu Outils permet de choisir le type de transposition à appliquer à la sélection
(par mesure entière).
Par défaut, l'option Transposer les symboles d'accord en bas de la fenêtre, est cochée.

Symboles d'accord en mode texte

Pour ajuster l'apparence de tous les symboles d'accord en mode texte, utilisez une des méthodes suivantes:

Depuis le menu principal Format → Style... → Styles de Texte → Symboles d'accord. Éditez ensuite le style de texte selon
vos besoins.
Sélectionnez un symbole d'accord et apportez des modifications dans l' Inspecteur, en appuyant sur les boutons
"Définir comme style" au fur et à mesure.

Style de symboles d'accord

Pour accéder aux options de formatage des symboles d'accord:

Depuis le menu principal, selectionnez Format→Style…→Symboles d'accord. Les propriétés réglables sont répertoriées
sous les en-têtes suivants:
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Apparence

MuseScore supporte trois styles principaux de symboles d'accord : Standard, Jazz et Personnalisé, que vous pouvez
sélectionner grâce aux boutons radio.

Dans le style Standard , les accords sont interprétés simplement, avec la police déterminée pour votre style de texte
Symboles d'accord en mode texte.

Dans le style Jazz , la police MuseJazz est utilisée pour obtenir un effet manuscrit, avec des exposants distinctifs et
d'autres caractéristiques de mise en forme. Le style Jazz est sélectionné par défaut si vous utilisez l'un des modèles
Jazz.

L'option de style Personnalisé vous permet de personnaliser l'apparence des symboles d'accord (et assure
également la compatibilité avec les partitions plus anciennes). Sélectionnez un fichier de style de symboles
d'accord personnalisé dans le champ ci-contre: il peut être créé en copiant et en modifiant l'un des fichiers
préexistants dans le dossier "styles". La documentation se trouve dans le même dossier. Notez, cependant, que ceci
est réservé aux utilisateurs avancés et qu'il n'y a aucune garantie que ces fichiers seront pris en charge à l'avenir.

Noms des notes (Spelling)

Par défaut, MuseScore utilise les lettres pour le nom des symboles d'accord. Pour les utilisateurs de régions où d'autres
noms de notes sont utilisés, MuseScore supporte les possibilités suivantes:

Standard: A, B♭, B, C, C♯,...
Allemande: A, B♭, H, C, C♯,...
Allemande complète: A, B, H, C, Cis,...
Solfège: Do, Do♯, Re♭, Re,...
Française: Do, Do♯, Ré♭, Ré,...

Majuscules Automatiques

Par défaut, MuseScore affiche en majuscules tous les noms de notes comme montré ci-dessus, même si vous les avez
entrés en minuscules. Cependant, vous pouvez opter pour l'une des options de majuscules automatiques suivantes :

Accords mineurs en minuscule: c, cm, cm7,...
Casse en minuscule des notes de basse: C/e,...
Tous les noms de notes en majuscule: DO, RE, MI,...

Vous pouvez également désactiver complètement les majuscules automatiques, auquel cas les noms de notes seront
simplement rendus tels que vous les aurez saisis.

Position

Distance du diagramme d'accord de guitare: Si un diagramme d'accord de guitare est présent, cette valeur est la
hauteur à laquelle le symbole d'accord est positionné au-dessus du diagramme (des valeurs négatives peuvent être
utilisées).
Espace minimum entre les accords: L'espace à laisser entre les symboles d'accord.
Distance maximale de la barre de mesure: modifie la taille de l'écart entre le dernier symbole d'accord de la
mesure et la barre de mesure suivante. Vous ne devez ajuster cette valeur que s'il y a un problème continu dans la
partition avec un chevauchement entre le dernier symbole d'une mesure et le premier symbole de la suivante.
Décalage maximum au-dessus (n'existe pas dans la version anglaise au moment de la traduction)
Décalage maximum au-dessous (n'existe pas dans la version anglaise au moment de la traduction)

Remarque: Outre les paramètres décrits ici, la position par défaut des symboles d'accord appliqués est également
déterminée par les paramètres de la boîte de dialogue Styles de texte. L'effet est cumulatif.

Position du capodastre

Spécifie le réglage du capodastre ; les accords correspondants sont automatiquement affichés entre parenthèses.
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Système de numéro Nashville (NNS)

Le Système de numéro Nashville (Nashville Number System ou NNS), disponible dans MuseScore depuis la version 3.3,
est une manière abrégée de représenter des accords basés sur des degrés de la gamme plutôt que sur des lettres
d'accord. Cela permet à un accompagnement d'être joué dans n'importe quelle tonalité depuis les mêmes diagrammes
d'accord.

Pour commencer à saisir la notation Nashville:

1. Sélectionnez une note de départ;
2. Dans le menu, sélectionnez Ajouter→Texte→Numéro Nashville.

Tout comme avec les symboles d'accord standard, vous pouvez taper la notation de Nashville normalement et MuseScore
fera de son mieux pour reconnaître et formater les symboles de manière appropriée. Les mêmes raccourcis utilisés pour
la navigation lors de la saisie de symboles d'accord standard (e.g. Espace, voir au dessus) sont également disponibles pour
la notation Nashville.

Analyse avec des chiffres romains (RNA)

À partir de MuseScore 3.3, le système d'Analyse avec des chiffres romains est pris en charge - un type d'analyse
musicale où les accords sont représentés par des chiffres romains majuscules et minuscules (I, ii, III, iv etc.), des
exposants, des indices et d'autres symboles de modification. Il sert à noter et analyser l'harmonie d'une composition
indépendante de sa tonalité (voir les Liens externes pour plus de détails).

Remarque: Contrairement aux symboles d'accord standard et à la notation de Nashville, que MuseScore formate en
utilisant ses propres algorithmes, RNA utilise le logiciel libre et open source Campania font  pour formater les symboles.
Cela permet à MuseScore de formater les symboles au fur et à mesure que vous tapez, plutôt que d'appliquer le
formatage uniquement lorsque vous avez terminé. De plus, si vous installez normalement la police Campania sur votre
système, vous pouvez également l'utiliser dans d'autres programmes et bénéficier du même formatage.

Saisie RNA

1. Sélectionnez une note de départ;
2. Dans le menu, sélectionnez Ajouter→Texte→Chiffre Romain d'analyse. Vous pouvez également configurer un raccourci

clavier pour faire la même chose dans Préférences;
3. Saisissez les symboles RNA de l'accord comme un texte normal, comme suit;

Accord Majeur: Chiffres romains majuscules
Accord mineur: Chiffres romains minuscules
Accord diminué: o (minuscule)
Accord demi diminué: 0 (zéro)
Accord augmenté: +
Renversements d'accords: Entrez jusqu'à 3 numéros à un chiffre, note du haut en premier
Altérations: # (dièse), b (bémol)
Pour les autres symboles, voir les images ci-dessous, "Exemples de RNA".

4. Déplacez le curseur vers l'avant ou vers l'arrière pour continuer à saisir ou éditer des symboles pour d'autres
accords;

5. Lorsque le RNA est terminé, quittez en appuyant sur Échap, ou en cliquant sur une section vierge de la partition.

Tout comme avec les symboles d'accord standard, vous pouvez taper normalement l'analyse des chiffres romains et
MuseScore fera de son mieux pour reconnaître et formater les symboles de manière appropriée. Les mêmes raccourcis
utilisés pour la navigation lors de la saisie de symboles d'accord standard sont également disponibles pour l'analyse des
chiffres romains. (voir Commandes au clavier (au dessus)).

Exemples de RNA

Saisir ceci:

Pour obtenir ceci:
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Lecture (à partir de la version 3.5)

Voir Lecture: Symboles d'accords / Numéros Nashville.

Liens Externes

Système de numéro Nashville Nashville Number System  (Wikipedia)
Analyse avec des chiffres romains Roman Numeral Analysis  (Wikipedia)
Campania font
Voicings d'accords pour lecture (partiellement obsolète depuis version 3.5

Doigté

Les symboles de doigtés pour divers instruments se trouvent dans la palette de doigtés palette dans l'espace de travail
avancé.

La musique pour clavier utilise les chiffres 1-5 pour représenter les doigts de la main gauche ou droite. Il existe
également un fingering positioner  plugin pour vous aider à optimiser la disposition des doigtés de piano ou de
clavier.

La musique pour guitare utilise les chiffres 0-4 pour représenter le doigté de la main gauche (T est parfois utilisé
pour le pouce). Le doigté de la main droite est indiqué par les lettres p, i, m, a, c. Les chiffres encerclés représentent
les cordes de l'instrument.

Les cinq derniers symboles de la palette sont utilisés pour le doigté du luth dans la musique ancienne.

Note : Pour activer l'affichage du doigté dans la tablature, faites un clic droit sur la TAB, et sélectionnez Portée/Propriétés
de la partie...→Propriétés avancées de style ; puis cochez la case "Afficher les doigtés dans la tablature".

Ajouter un doigté à une seule note

Utiliser l'une des méthodes suivantes :

Sélectionner une note et cliquez sur l'un des symboles de doigté dans une palette (double-clic dans les versions
antérieures à 3.4).
Faire glisser et déposez un symbole de doigté d'une palette sur une note

Lorsque le doigté est ajouté à une note, l'attention se porte immédiatement sur le symbole, de sorte que vous pouvez
l'ajuster immédiatement.

Ajouter un doigté à plusieurs notes

1. Sélectionner les notes souhaitées ;
2. Cliquer sur un symbole de doigté dans une palette (double-clic dans les versions antérieures à 3.4).

Mode de saisie à doigté facile (version 3.1 et supérieure) {#facilité de doigté}

Cette fonction spéciale vous permet d'ajouter rapidement et facilement un doigté aux notes successives.

1. Choisir l'une des options suivantes :
Ajouter le premier symbole de doigté en utilisant l'une des méthodes indiquées ci-dessus : il peut s'agir d'un
"doigté de guitare de la main gauche", d'un "doigté" ou d'un "numéro de corde" ;
Pour un seul "doigté" uniquement, sélectionner une note et appuyer sur le raccourci clavier pour "Ajouter un
doigté" (défini dans Préférences : Raccourcis) ; puis taper le nombre souhaité ;

2. Choisir l'une des options suivantes :
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Pour déplacer le curseur sur la prochaine note : Appuyez sur Space, ou Alt+→ ;
Pour déplacer le curseur sur la note précédente : Shift+Space, ou Alt + ← ;

3. Taper le nombre souhaité ;
4. Répéter les étapes 2 et 3 selon les besoins ;
5. Appuyer sur Esc, ou cliquez sur un espace vide dans la fenêtre du document, pour sortir.

Ajuster la position du doigté

Doigté unique

Pour modifier la position d'un symbole utilisez l'une des méthodes suivantes

Pour les réglages fins (0,1 sp), utilisez les touches fléchées ; pour les réglages plus importants (1 sp), utiliser Ctrl+←
→ ↑ ↓.
Changer les décalages X et Y dans le Inspecteur .
Faire glisser le symbole à l'aide de votre souris.

Doigtés multiples

Pour modifier la position de plusieurs symboles :

1. Rechercher les symboles de doigté souhaités ;
2. Ajuster en utilisant les décalages X et Y dans l'Inspecteur .

Note__ : Vous pouvez également utiliser le plugin fingering positioner  mentionné ci-dessus pour optimiser la disposition
des doigtés de piano.

Pour restaurer un symbole à sa position par défaut, sélectionnez-le et appuyez sur Ctrl+R.

Editer le texte du doigté

Les symboles de doigté sont des objets de texte et peuvent être édité de la manière habituelle. Le texte propriétés et
l'ensemble style peuvent être ajustés dans l'inspecteur.

Paroles

Entrer une ligne de paroles

Première ligne

1. Entrer les notes de la ligne de mélodie;
2. Sélectionnez la note où vous voulez commencer votre saisie des paroles;
3. Pour entrer dans le mode paroles, tapez Ctrl+L (Mac: Cmd+L); ou dans la barre de menu, sélectionnez

Ajouter→Texte→Paroles;
4. Tapez une syllabe;
5. Utilisez les options suivantes pour continuer à entrer les paroles:

Passez à la syllabe suivante : Appuyez sur la touche Espace: Pressez Space (ou Ctrl+→ (Mac: Alt+→)) à la fin
d'une syllabe.
Tiret (pour relier les syllabes): Appuyez sur - à la fin d'une syllabe.
Passez à la syllabe précédente: Appuyez sur Shift+Space (ou Ctrl+← (Mac: Alt+→)).
Déplacez-vous vers la gauche: Appuyez sur ← (flèche gauche). Si le curseur se trouve au début d'une
syllabe, il passera à la précédente.
Déplacez-vous vers la droite: Appuyez sur → (flèche droite). Si le curseur se trouve à la fin d'une syllabe, il
passera à la suivante.
Passez à la syllabe suivante: Appuyez sur ↓ (flèche bas).
Passez à la syllabe supérieure: Appuyez sur ↑ (flèche haut).
Commencez une nouvelle ligne de paroles: Appuyez sur ↵ (Entrée) à la fin d'une syllabe de paroles
existante (_ Remarque_: N'utilisez pas la touche Entrée du clavier numérique !).

6. Pour quitter le mode paroles, appuyez Echap ou cliquez en dehors de la zone de texte.

Lignes suivantes

Si vous souhaitez ajouter une autre ligne de paroles à une ligne existante (par exemple un 2ème ou 3ème couplet, etc.) :

1. Choisissez l'une des options suivantes :
Sélectionnez la note où vous voulez commencer la nouvelle ligne de paroles. Entrez dans le mode paroles
comme indiqué à l'étape 3 ([ci-dessus](#Première ligne)). Le curseur se déplace sur une nouvelle ligne (vide).
Placez vous en Mode Edition de Texte sur une syllabe existante, allez à la fin de la syllabe et appuyez sur ↵
(Entrée). Le curseur passe à la ligne suivante.

2. Continuez à saisir les paroles à partir de l'étape 4 ([ci-dessus] ]{#Première ligne}
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Exemple:

Caractères spéciaux {#caractères spéciaux}

Dans la plupart des cas, les paroles peuvent être saisies comme un texte normal. Toutefois, des raccourcis clavier
spéciaux sont nécessaires pour saisir les caractères suivants :

Caractère Espace: Ctrl+Space (Mac: Alt+Space).

Trait d'union: Ctrl+- (Mac: Alt+-) ou AltGr+-.

Saut de ligne: Ctrl+↵ (Mac: Alt+Return) ou Entrée (depuis le clavier numérique).

Numéros de versets {#Numéro-de-versets}

Pour numéroter les versets, il suffit de taper le nombre (par exemple 1.) et un [Espace](##caractères spéciaux )avant la
première syllabe. MuseScore alignera automatiquement les chiffres et la première syllabe correctement.

Mélisme {#mélisme}

Un mélisme est une syllabe ou un mot qui s'étend sur deux ou plusieurs notes. Il est indiqué par un trait de soulignement
allant de la base d'une syllabe à la dernière note du mélisme. Le soulignement est créé en positionnant le curseur à la fin
d'une syllabe et en appuyant sur Shift+_: une fois pour chaque note du mélisme. Voir l'image ci-dessous :

Les paroles ci-dessus ont été créées de la manière suivante :

1. Tapez les lettres, soul,.
2. A la fin du mot, appuyez sur Shift+___.
3. Tapez les lettres To, puis appuyez sur Esc.

Pour étendre les autres syllabes, il suffit d'utiliser des tirets supplémentaires -, généralement un seul d'entre eux
apparaîtra (davantage lorsque la distance entre les syllabes est suffisamment grande), et la syllabe sera alignée à droite
sur la première note, comme les dernières syllabes qui ont été notées avec un mélisme, voir ci-dessus.

Elision (liaison lyrique) / Synalèphe

Deux syllabes sous une note peuvent être jointes par une élision, également appelée "Liaison lyrique" ou "Synalèphe".
Par exemple :

Pour créer l'exemple de texte lyrique, en commençant par le texte de la syllabe "te" :
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1. Tapez te;

2. Cliquez sur l'icône du clavier dans le coin inférieur gauche de l'écran, ou appuyez sur F2 pour ouvrir la palette
Caractères Spéciaux;

3. Utilisez l'une des options suivantes :

Double-cliquez sur l'un des trois types d'élision dans l'onglet "Common Symbols" tab: "Élision étroite",
"Élision", or "Élision large" ( (ces éléments se trouvent entre la "Clef d'Ut" et la "p" dynamique—voir l'image ci-
dessous)

Double-cliquez sur le coulé d'élision trouvé après la fraction 7/8 dans l'onglet "Common Symbols" tab (à côté
de l'avant-dernier caractère de l'image ci-dessus). Selon la police utilisée, ajoutez un ou plusieurs espaces
avant/après le trait d'union en utilisant Ctrl+Space (Mac: Alt+Space).

Note : Toutes les polices n'incluent pas le caractère "undertie" character (U+203F ‿ "undertie", présent dans "les
Caractères Spéciaux" principalement pour des raisons de compatibilité avec les partitions MuseScore 1.x). Pour
savoir quelles polices de votre ordinateur le prennent en charge, consultez "fontlist " (recherchez toute police qui
présente un lien entre "te" et "A" au lieu d'un rectangle blanc).

4. Tapez A.

A partir de la version 3.5 : Ctrl+Alt+- (Mac: Cmd+Alt+-).

Editer les paroles

1. Entrez dans le mode Edition de Texte sur une syllabe existante ;
2. Utilisez les commandes standard Edition de Texte pour effectuer des modifications ;;

3.Continuez à entrer les paroles (voir [ci-dessus] (#first-line)); ou quittez le mode paroles en appuyant sur Esc.

Ajuster les propriétés des paroles

Pour apporter des ajustements globaux aux propriétés de toutes les paroles de la partition :

1. Dans le menu, sélectionnez Format→Style...→Paroles;
2. Modifiez les propriétés Placement, Hauteur de ligne, Marges, Tiret et Melisme selon vos besoins.

Ajuster la position des lignes de paroles individuelles

Pour ajuster la position d'une ligne de paroles particulière :

1. Sélectionnez la ligne de paroles : c'est-à-dire faites un clic droit sur un mot de la ligne, et (dans le menu) choisissez
Selection→Plus... ; puis vérifiez les options correspondantes, qui doivent inclure "Mêmes Systèmes" ;

2. Ajustez les décalages X et Y dans l'inspecteur.

Copier les paroles dans le presse-papiers

Pour copier toutes les paroles dans le presse-papiers :

Dans la barre de menu, sélectionnez Tools→Copier les paroles dans le presse-papiers .

Coller les paroles du presse-papiers
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Pour copier et coller les paroles d'un fichier texte (disons) dans une partition :

1. Saisissez les notes de la partition auxquelles les paroles seront jointes.
2. Placez vos paroles dans un fichier texte, avec les espaces appropriés, les traits d'union, les sauts de ligne, etc.

3.. Copiez les paroles du fichier texte dans le presse-papiers.
3. Sélectionnez la note de début dans MuseScore, et appuyez sur Ctrl+L (Mac : Cmd+L).
4. En appliquant de manière répétée collez, les mots successifs des paroles seront entrés. Il se peut que vous deviez

entrer des mélismes et faire d'autres corrections au fur et à mesure.

Voir aussi{#see-also}

Text
Chord symbol

Liens externes

Comment entrer les paroles  (MuseScore HowTo)
Comment déplacer les paroles  (MuseScore HowTo)
Comment ajouter un paragraphe de texte à une partition  (MuseScore HowTo)
Comment copier des paroles avec/sans les rythmes  (MuseScore HowTo)
Comment ajouter des paroles dans les colonnes  (MuseScore HowTo)
Vidéo tutoriel : MuseScore en quelques minutes : Leçon 6 - Texte, Paroles et accordss

Repères

Les repères peuvent être utilisés de plusieurs façons :

Pour identifier des points spécifiques dans une partition, afin de faciliter les répétitions.
Comme signets dans la partition, vers lesquels vous pourrez naviguer instantanément en utilisant la commande
Edition/Rechercher.
Pour marquer les différentes sections de la partition.

En général, les repères consistent en une ou plusieurs lettres et/ou chiffres, et apparaissent en séquence dans la partition
- par exemple A, B, C..., ou 1, 2, 3... etc. Ils peuvent également comporter des numéros de mesure (généralement plus
grands que les numéros de mesure standard, en gras et/ou dans des cases). Les pauses multi-mesures sont
automatiquement interrompues avant et après les répétitions.

Les repères peuvent être ajoutés à la partition (i) automatiquement - ce qui garantit qu'ils sont nommés dans l'ordre - ou
(ii) manuellement, ce qui vous permet de les nommer comme vous le souhaitez.

Ajoutez un repère de répétition

Placement manuel

Pour créer manuellement un repère de répétition :

1. Cliquez sur une note (ou un silence) à l'endroit souhaité ;
2. Sélectionnez l'une des options suivantes :

Appuyez sur Ctrl+M (Mac : Cmd+M) ;
Dans le menu, choisissez Ajouter → Texte → Repères de répétition;

3. Saisissez le texte souhaité.

Placement automatique

Ajouter une marque de répétition alphanumérique

Utilisez l'une des options suivantes :

Cliquez sur une note (ou un silence) à l'endroit désiré, puis cliquez sur l'icône de la marque de répétition [B1] dans
le "Texte" palette (double-clic dans les versions antérieures à 3.4).
Glissez et déposez la marque de répétition de la palette "Texte" sur la partition.

Notes__ : (1) Par défaut, les marques sont ajoutées dans l'ordre, A, B, C etc. (2) Pour modifier le format des notes
ajoutées par la suite (en lettres minuscules ou en chiffres), modifiez la note de répétition précédente en conséquence. (3)
Les marques ajoutées entre des marques de répétition existantes ajoutent un chiffre ou une lettre à la marque précédente
: il est conseillé d'appliquer la commande Remettre les repères de répétition dans l'ordre par la suite (voir ci-dessous)

Ajouter une marque de répétition de mesure

1. Ajoutez la première marque de répétition de la série par ordre alphabétique ; puis edit pour lire le même comme le
numéro de la mesure à laquelle il est attaché ;
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2. Ajoutez les marques suivantes comme indiqué [ci-dessus] (#add-alphanumeric-mark). Elles adopteront
automatiquement le format du numéro de la mesure.

Répétition automatique des marques de répétition

MuseScore permet à l'utilisateur de réorganiser automatiquement une série de repères de répétition s'ils sont sortis de
l'ordre pour une raison quelconque. Utilisez la méthode suivante :

1. Avant de faire une sélection, vous pouvez, si vous le souhaitez, établir un nouveau format pour les repères de
répétition (minuscules/majuscules, nombre ou numéro de mesure) en modifiant manuellement le premier repère de
la série en conséquence.

2. Sélectionnez la plage de mesures à laquelle vous souhaitez appliquer la commande Remettre les repères de
répétition dans l'ordre (s'il n'y a pas de sélection, le programme suppose que vous souhaitez réordonner toutes les
mesures).

3. Dans le menu, sélectionnez Outils &rarr ; Remettre les marques de répétition dans l'ordre .

MuseScore détecte automatiquement la séquence en fonction de la première marque de répétition dans la sélection -
toutes les marques de répétition dans la sélection sont alors modifiées en conséquence. Les séquences suivantes sont
possibles :

A, B, C, etc.
a, b, c, etc.
Numérique : 1, 2, 3 etc.
Numérique : selon les numéros de mesure. Pour cela, le numéro de la première marque de la série doit être égal au
numéro de la mesure à laquelle elle est rattachée.

Style de texte

Les marques de répétition sont une variété de Texte de Système, apparaissant à la fois sur la partition et sur chaque
partie. Par défaut, ils sont en grande police de caractères gras et entourés de cadres aux coins arrondis. Tous les aspects
de leur apparence peuvent être modifiés globalement via la marque de répétition Style de Texte.

Rechercher une marque de répétition

Voir Modes d'affichage et navigation (Visualisation et navigation).

Voir aussi

Styles de texte

Liens externes

Lettre de répétition  (article Wikipedia)

Mise en forme

Mise en page et mise en forme

Les options de mise en page et de formatage pour la partition sont accessibles par le menu Format.

Mise en page

Ce chapitre liste les principales boîtes de dialogue et commandes intervenant dans la mise en page. D'autres options sont
abordées plus bas dans ce document (pour la mise en forme des Textes, voir Styles de texte et propriétés).

Paramètres de la page : Permet d'ajuster les dimensions générales de votre partition, comme la taille de la feuille
(A3, A4, etc.), les marges et l'échelle (Esp. : Espace de portée).

Étirement : Permet d'ajuster la largeur des mesures sélectionnées.

Style... : Permet de définir les détails de présentation de la partition globale, tels que la police de caractères de la
musique, l'affichage des silences à mesures multiples et la possibilité de cacher les portées vides.

Mesures : Permet de définit la taille des mesures, ce qui affecte le nombre de mesure par ligne.

Tailles des notes : Permet d'ajuster la taille des "petites" notes et des appoggiatures, des petites portées et des
petites clefs.

Autres commandes :
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Ajouter / Supprimer des sauts de système : Permet de fixer le nombre de mesures par système.

Sauts et espacements : Permet d'appliquer les sauts de système, de page ou de section. Vous pouvez également
ajouter un espace supplémentaire entre les systèmes ou des portées particulières si nécessaire.

Menu "Style..."

Le sous-menu Style... ouvre une boîte de dialogue permettant d'ajuster les paramètres du formatage global de tous les
éléments de la partition. Pour ouvrir le sous-menu Style... :

Dans le menu principal, sélectionner Format→Style...
Cliquer avec le bouton droit sur un espace de la fenêtre du document et sélectionner Style....
Utiliser un raccourci clavier (voir Raccourcis).

La boîte de dialogue Style propose les fenêtres suivantes :

Partition

Pour accéder aux propriétés de la Partiton, sélectionner Format→Style…→Partition.

Cette boîte de dialogue permet de définir des propriétés globales, telles que la police des symboles musicaux, l'affichage
des silences multi-mesures, le masquage ou non des portées vides, la lecture avec swing, etc.

Police des symboles musicaux : Choisir entre Leland (à partir de la version 3.6), Emmentaler, Bravura, Gonville,
MuseJazz et Petaluma. Cocher la case "Charger automatiquement le style selon la police".

Police de texte musical : Choisir entre Leland Text (à partir de la version 3.6), Emmentaler text, Bravura text,
Gonville text, MuseJazz text et Petaluma text.

Afficher en tonalité réelle : Cocher cette case pour afficher la partition en tonalité réelle. Si elle n'est pas cochée, la
partition est affiché à la hauteur écrite.

Créer des pauses multimesures : Cocher cette case pour autoriser les pauses multi-mesures.

Nombre minimum de mesures vides : valeur par défaut 2.

Largeur minimale de la mesure : valeur par défaut 4 sp.

Activer l'indentation du premier système : Cocher cette case pour décaler le premier système de la partition (à
partir de la version 3.6).

Indentation du premier système : valeur par défaut 5 sp (à partir de la version 3.6).

Masquer les portées vides dans les systèmes : Cette option permet de gagner de la place en cachant ces
portées dans un système qui ne comporte que des mesures vides. Utilisé pour les partitions condensées.

Ne pas masquer les portées vides du premier système : Toujours afficher les portées dans le premier système,
même si elles ne contiennent que des mesures vides.

Toujours afficher les crochets étendus à une portée unique : Une fonction utile pour noter la musique ancienne.
Voir Notation sans barre de mesure.

Afficher la valeur des notes dépassant la mesure : Une fonction EXPERIMENTALE utile pour noter la musique
ancienne. (à partir de la version 3.6)

Ne pas afficher le nom s'il n'y a qu'un seul instrument : Dans ce cas, il n'est généralement pas nécessaire
d'afficher le nom de l'instrument.

Paramètres de Swing : Permet de contrôler le degré de swing pour l'ensemble de la partition.

Swing : Choisir entre Sans (par défaut) / Croche / Double-croche.

Sélectionner le ratio du swing : valeur par défaut 60%.

Pour plus d'information concernant le Swing, voir le chapitre Swing.

Placement automatique
Étendue de l'alignement vertical : Choisir entre "Mesure", "Segment" et Système. (à partir de la version 3)
Distance verticale minimum : valeur pat défaut 0,5 sp.

Page

Pour accéder aux propriétés de la Page, sélectionner Format→Style…→Page.
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Cette boîte de dialogue vous permet d'ajuster la présentation générale de votre partition en modifiant l'espacement des
marges, des systèmes, des portées, des lignes de paroles et des cadres. Vous pouvez également contrôler l'affichage
des clés, des indications de mesure et des armures.

L'image ci-dessous présente les différents paramètres disponibles de mise en page :

Marge au dessus de la musique : Distance entre la première portée du premier système de la page et la Marge de
la page.
Marge au dessous de la portée : Distance entre la dernière ligne de la dernière portée du dernier système de la
page et la Marge de la page.

À partir de la version 3.6
Il existe un système automatique de justification des systèmes d'une partition. Voici les paramètres qui permettent d'en
contrôler le résultat :

Activer la justification verticale des portées :

Facteur de distance entre systèmes : ratio.
Facteur de distance au dessus/au dessous du crochet : ratio. Il s'agit de la distance entre les portées d'un
système.
Facteur de distance au dessus/au dessous de l'accolade : ratio. Il s'agit de la distance entre les portées
d'un même instrument (piano, clavier, ...).
Distance minimale entre deux systèmes : valeur par défaut 8,5 sp.
Distance max entre systèmes : valeur par défaut 32 sp.
Distance mini entre portées : valeur par défaut 3,5 sp.
Distance max entre portées : valeur par défaut 20 sp.
Distance max entre portées de claviers : valeur par défaut 6,5 sp.
Distance max du remplissage de la page : valeur par défaut 6 sp.

Désactiver la justification verticale des portées
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Distance entre les portées : Espace entre les portées qui ne sont pas des portées de clavier (voir ci-
dessous).
Distance entre portées de clavier dans l'accolade : Espace entre les portées que partagent un même
instrument, comme par exemple le piano, l'orgue, l'accordéon.

Note: Pour modifier l'espace au-dessus d'une portée particulière, voir Distance supplémentaire au-dessus de la portée
(propriétés de la portée).

Distance minimale entre deux systèmes : Distance minimale autorisée entre un système et le suivant.

Distance Max entre systèmes : Distance maximum autorisée entre un système et le suivant.

Marge supérieure du cadre vertical : Hauteur maximale au-dessus d'un cadre vertical.

Marge inférieure du cadre vertical : Hauteur maximale au-dessous d'un cadre vertical.

Seuil de remplissage du dernier système : Si le dernier système est plus long que ce pourcentage de la
largeur de la page, il s'étire pour remplir cette largeur.

Les cases à cocher suivantes vous permettent de contrôler l'affichage des clefs, des indications de mesure et des
armures, y compris les rappels de celles-ci.

Créer une clef pour tous les systèmes / Créer une armure pour tous les systèmes / Créer le rappel des clefs / Créer
le rappel des indications de mesure / Créer le rappel des armures.

Tailles

Pour accéder aux propriétés de Tailles, sélectionner Format→Style…→Tailles.

Permet de définir la taille proportionnelle des "petites" notes et des appoggiatures, ainsi que des petites portées et des
petites clés. Il serait inhabituel de modifier ce paramètre.

En-tête, Pied de Page

Pour accéder aux propriétés des En-têtes et Pieds de Page, sélectionner Format→Style…→En-tête et Pied de Page.

Ceci vous permet d'ajouter du texte en en-tête et en pied de page à l'aide de métabalises (voir Propriétés de la partition)
comme les numéros de page, les informations sur les droits d'auteur, etc. Par exemple, vous pouvez créer des en-têtes et
des pieds de page différents pour les pages paires et impaires, en plaçant par exemple les numéros de page à droite pour
les pages impaires et à gauche pour les pages paires.

Si vous survolez avec votre souris la région de texte de l'en-tête ou du pied de page, une liste de métabalises apparaîtra,
indiquant leur signification et leur contenu.

Pour créer un en-tête ou un pied de page pour une partie uniquement, cette partie doit être l'onglet actif. Pour créer un en-
tête ou un pied de page pour une partition avec des parties liées, assurez-vous que la partition principale se trouve dans
l'onglet actif.

Numéros de mesure

Pour accéder aux propriétés des Numéros de mesure, sélectionner Format→Style…→Numéros de mesure.

Cela vous permet de préciser si les numéros de mesure apparaîtront dans la partition et, si oui, à avec quelle fréquence.
Vous pouvez également définir les propriétés de la police d'écriture.

Vous pouvez également afficher la plage des numéros de mesure pour les pauses multi-mesures.

Système

Pour accéder aux propriétés des Systèmes, sélectionner Format→Style…→Système.

Ce dialogue vous permet d'ajuster les propriétés communes à tous les systèmes.

Crochets système :

Épaisseur du crochet : Par défaut 0,44 sp.
Épaisseur de l'accolade : Par défaut 1,6 sp.
Distance entre crochet et système : Fixe la distance entre le crochet et la première barre de mesure. Par défaut
0,1 sp.
Distance entre accolade et système: Fixe la distance entre l'accolade et la première barre de mesure. Par défaut
0,4 sp.

Voir aussi Crochets.
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Séparateurs de système :

Gauche / Droite: Précisez s'il faut afficher les séparateurs de système, de quels types, et appliquer les valeurs de
décalage de positionnement global.

Clefs de tablature

Pour accéder aux propriétés des Clefs de tablature, sélectionner Format→Style…→Clefs.

Choisir un style de clef de tablature par défaut pour la partition : Standard ou Serif.

Altérations/Armures

Pour accéder aux propriétés des Altérations pendant les changement d'armure, sélectionner Format→Style…→Altérations.

Permet de spécifier comment la partition affiche les armures lors des changements de clés. Voir Bécarres lors des
changement d'armure.

Mesure

Pour accéder aux propriétés des Mesures, sélectionner Format→Style…→Mesure.

Voir les détails au chapitre Mesure.

Barres de mesure

Pour accéder aux propriétés des Barres de mesure, sélectionner Format→Style…→Barres de mesure.

Afficher les pointes (ailes) des barres de reprise :
Barre de mesure au début d'une portée unique : Cocher cette case pour afficher une barre de mesure au début
des portées.
Barre de mesure au début de portées multiples: Cocher cette case pour afficher une barre de mesure au début
des portées.
Ajuster la taille des barres de mesure à la taille de la portée: Ne concerne que les "petites" portées.

D'autres propriétés vous permettent de définir l'épaisseur des barres "fines", "épaisses" et "doubles", la distance entre les
doubles barres et la distance entre les barres et les points de répétition.

Notes

Pour accéder aux propriétés des Notes, sélectionner Format→Style…→Notes.

Vous pouvez régler ici la distance et l'épaisseur des objets liés aux notes (hampe, points, lignes supplémentaires,
altérations). Il serait inhabituel de les modifier.

Ligatures

Pour accéder aux propriétés des Ligatures, sélectionner Format→Style…→Ligatures.

Cela vous permet de définir les propriétés globales des ligatures dans la partition :

Épaisseur de la ligature
Distance de la ligature : Distance verticale entre les lignes (en % de l'épaisseur).
Longueur minimum de la coupure de ligature : Concerne les ligatures secondaires lorsqu'elles ne s'étendent pas
entièrement de note en note.

Cocher la case Aplanir l'ensemble des ligatures signifie que toutes les ligatures de notes seront horizontales, et non
pas inclinés.

Divisions irrégulières

Pour accéder aux propriétés des Divisions irrégulières, sélectionner Format→Style…→Divisions irrégulières.

Distance verticale entre les notes :

Inclinaison maximum : Limite l'inclinaison des crochets des divisions irrégulières.
Distance verticale depuis la hampe : Se réfère au numéro et au crochet de la division irrégulière.
Distance verticale depuis la tête de note: réfère au numéro et au crochet de la division irrégulière.

Distance horizontale entre les notes :

Distance avant la hampe de la première note
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Distance avant la tête de la première note
Distance après la hampe de la première note
Distance après la hampe de la dernière note

Crochets :

Épaisseur du crochet
Hauteur du crochet : Définit la longueur par défaut des crochets verticaux aux extrémités des divisions irrégulières.

Propriétés :

Direction / Type de numéro / Type de crochet

Arpèges

Pour accéder aux propriétés des Arpèges, sélectionner Format→Style…→Arpèges.

Vous pouvez ici modifier la distance à la note, l'épaisseur de la ligne et la longueur du crochet des symboles d'arpèges et
de coups de médiator suivants :

Liaisons de phrasé, liaisons de prolongation

Pour accéder aux propriétés des Liaisons de phrasé et des Liaisons de prolongation , sélectionner
Format→Style…→Liaisons de phrasé / Prolongation .

Épaisseur du trait à la fin
Épaisseur du trait au milieu
Épaisseur du trait pointillé
Longueur minimum de la liaison de prolongation
Distance min. du placement automatique

Crescendo/Decrescendos

Pour accéder aux propriétés des Crescendos et des Decrescendos , sélectionner Format→Style…→Crescendos /
Decrescendos.

Ici, vous pouvez définir les propriétés par défaut des lignes de crescendo et decresendo :

Position: Placer la ligne placer au-dessus ou au-dessous de la portée.
Position au-dessus/au-dessous : Valeur numérique en sp.
Hauteur : Largeur de l'ouverture de la ligne.
Hauteur du prolongement sur la portée suivante
Placement automatique, distance des nuances
Épaisseur de la ligne

Alternatives de reprise

Pour accéder aux propriétés des Alternatives de reprise, sélectionner Format→Style…→Alternatives de reprise.

Vous pouvez fixer ici les propriétés par défaut des alternatives de reprise :

Position X/Y
Hauteur du crochet : La longueur des lignes descendantes aux extrémités des alternatives de reprise.
Épaisseur de la ligne
Style de ligne : La ligne continue est l'option par défaut, mais il est possible d'avoir une ligne en pointillés ou en
tirets.

Octave

Pour accéder aux propriétés des Lignes d'octave, sélectionner Format→Style…→Octaves.

Voici les principales propriétés des lignes d'octave :

Nombres seulement : Si cette case n'est pas cochée, les lignes d'octave affichent également "va" ou "vb" après le
nombre.
Position au-dessus/au-dessous : Offsets de position en X et en Y.
Hauteur du crochet au-dessus/au-dessous : Longueur de la petite ligne montante ou descendante à la fin de la
ligne d'octave.
Épaisseur de la lignes : Valeur par défaut 0,11 sp.
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Style de ligne : Par défaut, la ligne est en tireté, mais elle peut être dessinée en continu, avec des tirets et des
points, avec des tirets et des doubles points.

Pédale

Pour accéder aux propriétés des Lignes de pédale, sélectionner Format→Style…→Pédale.

Voici les principales propriétés des lignes de pédale :

Position : Au-dessous ou au-dessus de la portée.
Position au-dessous/au-dessus : Offsets de position en X et en Y.
Épaisseur de la ligne : Valeur par défaut 0,11 sp.
Style de ligne : Par défaut, la ligne est continue, mais elle peut être dessinée en tireté, avec des tirets et des points,
avec des tirets et des doubles points.

Trille

Pour accéder aux propriétés des Lignes de trille, sélectionner Format→Style…→Trille.

Voici les principales propriétés des lignes de Trille :

Position: Au-dessus ou au-dessous de la portée.
Position au-dessous/au-dessus : Offsets de position en X et en Y.

Vibrato

Pour accéder aux propriétés des Lignes vibrato, sélectionner Format→Style…→Vibrato.

Voici les principales propriétés des lignes de Vibrato :

Position: Au-dessus ou au-dessous de la portée.
Position au-dessous/au-dessus : Offsets de position en X et en Y.

Bend

Pour accéder aux propriétés des Bends, sélectionner Format→Style…→Bend.

Voici les principales propriétés des Bends.

Épaisseur de la ligne : Valeur par défaut 0,15 sp.
Largeur de la flèche : Valeur par défaut 0,50 sp.

Ligne de texte

Pour accéder aux propriétés des Lignes de texte, sélectionner Format→Style…→Ligne de texte.

Voici les principales propriétés des Lignes de texte :

Position : Au-dessous ou au-dessus de la portée.
Position au-dessous/au-dessus : Offsets de position en X et en Y.

Ligne de texte de système

Pour accéder aux propriétés des Lignes de texte de système, sélectionner Format→Style…→Ligne de texte de système.

Voici les principales propriétés des Lignes de texte de système :

Position : Au-dessous ou au-dessus de la portée.
Position au-dessous/au-dessus : Offsets de position en X et en Y.

Articulations, Ornements

Pour accéder aux propriétés des Articulations et des Ornements, sélectionner Format→Style…→Articulations, Ornements.

Cette boîte de dialogue vous permet de définir les distances de placement par défaut et la taille (en pourcentage) des
articulations et ornaments.

Points d'orgue

Pour accéder aux propriétés des Points d'orgue, sélectionner Format→Style…→Points d'orgue.

Voici les principales propriétés des Points d'orgue :
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Position au-dessous/au-dessus : Offsets de position en X et en Y.
Distance minimum du placement automatique : (à partir de la version 3) valeur par défaut 0,4 sp.

Texte de portée

Pour accéder aux propriétés des Textes de portée, sélectionner Format→Style…→Texte de portée.

Propriétés de placement par défaut et automatique des Textes de portée.

Tempo

Pour accéder aux propriétés des Tempo, sélectionner Format→Style…→Texte de tempo.

Propriétés de placement par défaut et automatique des Textes de tempo.

Paroles

Pour accéder aux propriétés des Paroles, sélectionner Format→Style…→Paroles.

Position, Position au-dessous/au-dessus : Position de la ligne de paroles la plus près de la portée.
Hauteur de la ligne : Distance par défaut entre les lignes de parole.
Tiret de paroles : Longueur des tirets inter-syllabe et espace entre eux.
Mélisme des paroles : Principales propriétés pour le mélisme.

Note : Le mélisme est une figure mélodique de plusieurs notes portant une syllabe, par opposition au syllabisme, dans
lequel chaque syllabe du texte est chantée sur une seule note.

Nuances

Pour accéder aux propriétés des Nuances, sélectionner Format→Style…→Nuances.

Voici les principales propriétés des Nuances :

Position au-dessous/au-dessus : Offsets de position en X et en Y.
Distance minimum du placement automatique : (à partir de la version 3) valeur par défaut 0,5 sp.

Repères de répétition

Pour accéder aux propriétés des Repères de répétition, sélectionner Format→Style…→Repères de répétition.

Voici les principales propriétés des Repères de répétition :

Position au-dessous/au-dessus : Offsets de position en X et en Y.
Distance minimum du placement automatique : (à partir de la version 3) valeur par défaut 0,5 sp.

Basses chiffrées

Pour accéder aux propriétés des Basses chiffrées, sélectionner Format→Style…→Basse chiffrée.

Style, alignement et position des Basses chiffrées.

Symboles d'accord
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Pour accéder aux propriétés des Symboles d'accord, sélectionner Format→Style…→Symboles d'accord.

Style, alignement et position des Symboles d'accord:

Apparence :

Choisir le style des symboles d'accord : Standard, Jazz ou Personnalisé.

Notation (nom des notes) :

Choisir comment le nom des notes sera affiché : Standard, Allemande, Allemande complète Française.

Position :

Distance du diagramme d'accord de guitare : Distance (en sp.) d'un symbole d'accord à un diagramme d'accord
de guitare lorsque les deux sont appliqués au même endroit sur une portée. L'utilisateur peut choisir de placer un
symbole d'accord sous un diagramme d'accord de guitare en entrant une valeur négative.
Minimum chord spacing: The minimum space to allow between chord symbols.
Maximum barline distance: Increases the distance between the final chord symbol in a measure and the following
barline. You may wish to adjust this value if there is a recurring problem in the score with overlap between the final
chord symbol in one measure and the following chord symbol.

Capo :

Position du capodastre: Entrez le numéro de la position de capodastre à laquelle vous souhaitez afficher des
accords de substitution, entre parenthèses, pour tous les symboles d'accords de la partition.

Diagrammes d'accord de guitare

Pour accéder aux propriétés des Diagrammes d'accord de guitare, sélectionner Format→Style…→Diagrammes d'accord de
guitare.

Voici les principales propriétés des Repères de répétition : Diagrammes d'accord de guitare.

Position verticale par défaut : Distance (en sp.) entre le diagramme d'accord de guitare nouvellement créé et la
portée. Une valeur négative peut être utilisée.
Échelle : Augmente ou diminue la taille des diagrammes d'accord de guitare.
Taille de la police du numéro de frette : Augmente ou diminue la taille des caractères utilisée pour les numéro de
frette.
Position du numéro de frette : Droite ou gauche.
Épaisseur de la ligne de barré: en sp.
Espacement des cordes : en sp.
Espacement des frettes : en sp.
Décalage maximum au-dessus/au-dessous : en sp.

Styles de Texte

Pour accéder aux Styles de Texte, sélectionner Format→Style…→Styles de Texte.

C'est ici l'endroit où régler vos préférences pour tous les styles de texte. Ces éléments sont tous également présents dans
l'Inspecteur.

Boutons OK / Annuler

Toute modification apportée dans la boîte de dialogue Style est immédiatement appliquée à la partition, mais peut être
annulée à tout moment en appuyant sur Annuler ce qui permet également de fermer cette fenêtre. Appuyez sur OK pour
enregistrer vos modifications de la partition et fermer la fenêtre.

Si vous effectuez des modifications de formatage dans une partie instrumentale, utilisez le bouton Appliquer à l'ensemble les
parties pour répercuter les changements à toutes les parties de la partition.

Paramètres de la page...

Voir Paramètres de la page.

Ajouter / Supprimer des sauts de système

Cet outil ajoute ou supprime des Sauts de système sur toute la partition ou sur une partie seulement :

1. Sélectionner un ensemble de mesures : s'il n'y a pas de sélection, l'outil agit sur la totalité de la partition.

2. Choisir Format→Ajouter/Supprimer des sauts de système…. La boîte de dialogue suivante s'affiche :
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3. Choisir l'une des options suivantes :

Saut de système toute les X (donner le nombre) mesure.
Ajouter un saut de système à la fin de chaque système.
Supprimer les sauts de systèmes actuels.

4. Utiliser le bouton OK.

Étirement

Ajustement de la taille des mesures

Étirement / Rétrécir

1. Sélectionner un ensemble de mesures, ou utiliser Ctrl+A pour sélectionner la totalité des la partition.
2. Utiliser l'une de ces deux options :

Pour Étirer les mesures :
Utiliser le raccourci clavier } (accolade droite) (Mac : Command+Option+9).
Ou, dans la barre des menu, sélectionner Format→Étirement→Étirer.

Pour Rétrécir les mesures :
Utiliser le raccourci clavier { (accolade gauche) (Mac : Command+Option+8).
Ou, dans la barre des menu, sélectionner Format→Étirement→Rétrécir.

Réinitialiser l'étirement des mesures

Pour réinitialiser l'étirement des mesures avec l'espace par défaut de 1 :

Sélectionner un ensemble de mesures, ou utiliser Ctrl+A pour sélectionner la totalité des la partition.
2. Dans le menu, sélectionner Format→Étirement→Réinitialiser l'étirement des mesures.

Voir aussi Propriété des mesures : Étirement. Ceci vous permettra d'ajuster l'étirement des mesures avec plus de
précision.

Réinitialiser les personnalisations de style de texte

Pour réinitialiser les styles de texte aux valeurs par défaut :

Dans le menu, sélectionner Format→Réinitialiser les personnalisations de style de texte .

Réinitialiser les ligatures

Pour réinitialiser les ligatures et revenir au mode décrit par défaut pour l'indication de mesure :

1. Sélectionner les mesures à réinitialiser. Si rien n'est sélectionné, l'ensemble de la partition sera réinitialisée.
2. Sélectionner Format→Réinitialiser les ligatures.

Voir aussi Ligatures.

Réinitialiser les formes et les positions

La commande Réinitialiser les formes et les positions remets les valeurs par défaut de la direction des hampes, de la
position des lignes de liaisons de phrasé et des lignes de liaison de prolongation :

1. Sélectionner les mesures à réinitialiser. Si rien n'est sélectionné, l'ensemble de la partition sera réinitialisée.
2. Utiliser Ctrl+R ou, dans le menu, sélectionner Format→Réinitialiser les formes et les positions .

Charger un style / Enregistrer le style

Il est facile de transférer la totalité des styles (tous les paramètres de style général, tous les styles de texte et tous les
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paramètres de la page) d'une partition à l'autre en utilisant la fonction Charger un style / Enregistrer le style.

Pour charger un style personnalisé :

1. Sélectionner le menu Format→Charger un style....
2. Sélectionner le fichier style voulu (.mss) et cliquer sur le bouton Ouvrir (ou double-cliquer sur le fichier).

Tous les styles existants dans la partition se mettent à jour automatiquement.

Pour Enregistrer un style personnalisé :

1. Sélectionner le menu Format→Enregistrer le style... .
2. Donner un nom et enregistrer le fichier style (le dossier par défaut est défini dans les Préférences). Les styles sont

enregistré dans des fichiers *.mss.

Remarque : Vous pouvez également définir un style préféré pour les partitions et les parties dans la section Partition des
préférences de MuseScore.

Voir aussi

Décaler les notes
Upgrading from MuseScore 1.x, local relayout (en anglais)

Liens externes (en anglais)

Tutorial – How to create large-print stave notation (MSN)
MuseScore in 10 Easy Steps: Part 10A Layout and Formatting (a video tutorial)
MuseScore in 10 Easy Steps: Part 10B Layout and Formatting (a video tutorial) .

Mesure

Pour ouvrir le dialogue Mesure, sélectionnez Format→Style...→Mesure.

Ce dialogue vous permettra d'ajuster la distance entre différents éléments de mesures.

Introduction

Si vous modifiez une propriété de style de mesure, MuseScore ajuste automatiquement la partition pour maintenir
l'espacement correct entre les notes et les silences selon les meilleures pratiques de l'édition musicale. Il repositionnera
également correctement tous les éléments attachés aux notes ou aux silences, tels que les doigtés, les nuances, les
lignes, etc.

Tous les paramètres relatifs à la largeur de la mesure et à l'espacement des notes sont des valeurs minimum. Les
mesures sont automatiquement étirées, si nécessaire, pour maintenir les marges de la page existantes.

Toutes les propriétés énumérées ci-dessous utilisent l'espace de portée (abrégé en "sp") comme unité de mesure de
base. Voir Paramètres de la page : Echelle pour plus de détails.

Options

Largeur minimale de la mesure : Définit la longueur horizontale minimale des mesures. Dans les mesures
contenant très peu de contenu (par exemple, une seule note entière ou un seul silence ), la mesure ne se rétrécit
que jusqu'à ce minimum.

Espacement (1=étroit) : Condense ou élargit l'espace après les notes ou les silences. Ce réglage affecte donc non
seulement l'espace entre les notes, mais aussi entre la dernière note et la barre de fin. Pour l'espace entre le début
de la mesure et la première note ou le silence, voir Marge gauche de la note (ci-dessous).

Marge gauche de la note : Définit la distance entre la barre de mesure de début et la première note.

Distance entre la fioriture et la barre de mesure : Définit la distance entre une barre de mesure et une fiorituret
qui se produit avant la première note réelle dans une mesure (indépendamment du réglage "Note marge gauche").

Distance entre la barre de mesure et l'altération : Définit la distance entre une barre de mesure et une altération
placée avant la première note d'une mesure (indépendamment du réglage "Marge gauche de la note").

Distance entre la note et la barre de mesure : Définit la distance entre la dernière note et la barre de mesure
suivante.

Distance minimum entre les notes : Spécifie la plus petite distance que MuseScore autorisera après chaque note
(en fonction d'autres facteurs, plus d'espace peut être autorisé).
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Marge gauche de la clef : Définit la distance entre le tout début de chaque ligne et la clef. (Cette option est
rarement nécessaire).

Marge gauche de l'armure : Définit la distance entre le début de la mesure et une indication de clé.

Marge gauche de l'indication de mesure : Définit la distance entre le début de la mesure et une indication de
mesure (s'il n'y a pas d'indication de clé entre les deux).

Distance entre l'indication de mesure et la barre de mesure : À ajouter

Marge à droite de la clef ou de l'armure : Définit la distance entre une clef de milieu de page ou une indication de
clé ,et la note ou le silence suivant.

Distance entre la clef et la barre de mesure : Définit la distance entre une barre de mesure et un changement de
clef qui la précède.

Distance entre la clé et l'armure : Définit la distance entre la clé et l'armure qui la suit.

Distance entre la clef et l'indication de mesure : Définit la distance entre la clé et l'indication de mesure qui la suit
(s'il n'y a pas d'indication de mesure entre les deux).

Distance entre l'armure et l'indication de mesure : Définit la distance entre une armure et la signature temporelle
qui la suit.

Distance entre l'armure et la barre de mesure : A ajouter..

Distance de l'en-tête du système : Définit la distance entre une clé (ou l'armure au début d'un système) et la
première note ou le silence.

DIstance de l'en-tête système et l'indication de mesure : Définit la distance entre une indication de mesure au
début d'un système et la première note ou le premier silence.

Marge de pauses multimesures : Définit la distance entre un les pauses multimesures et les barres de mesure de
chaque côté.

Épaisseur des lignes de portée : Définit l'épaisseur des lignes de la portée, ce qui vous permet de rendre la portée
plus épaisse et plus sombre, si vous avez besoin d'une plus grande visibilité sur vos impressions.

Note : Les modifications apportées à l' Etirement d'une mesure individuelle (en utilisant Format→Étirement →
Étirer/Retrécir) sont calculées après, et proportionnellement au réglage global de l'espacement de la partition.

Paramètres des pages

Les paramètres de page vous permettent d'ajuster les dimensions générales de votre partition, telles que [taille de la
page] (#page size), [marges de la page] (#page-margins) et [Échelle] (#scaling). C'est l'un des principaux outils de mise
en page de MuseScore, avec les options disponibles depuis Format→Style...

Pour ouvrir le dialogue Paramètres de la page : dans le menu, sélectionnez Format → Paramètres de la page....
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Taille de la page

Ici, vous pouvez sélectionner le format du papier, soit par nom standard (par exemple, Lettre ou A4), soit en spécifiant la
hauteur et la largeur en mm ou en pouces (utilisez les boutons radio pour choisir l'unité de mesure à utiliser). Le format
initial par défaut de la page dépend de votre localisation - en France, le papier de format A4 est standard.

Vous pouvez également choisir pour votre musique une impression de type Paysage ou Portrait en utilisant les boutons
radio. Vous pouvez également utiliser la mise en page Deux faces (c'est-à-dire le format livre, avec des marges gauches
et droites en miroir pour les pages paires et impaires - voir [ci-dessous](#margines de page)).

Marges des pages paires/impaires

Les paramètres Marges des pages paires et Marges des pages impaires vous permettent de définir la zone
imprimable de vos pages. Outre la modification des marges autour de la musique de la page, d'autres paramètres, tels
que la position des en-têtes et des pieds de page, sont calculés par rapport aux marges définies ici.

Si la case "Recto/Verso" sous "Taille de la page" est cochée, vous pouvez définir les marges différemment pour refléter
les pages paires et impaires. Sinon, un seul jeu de marges peut être modifié, mais il s'appliquera à toutes les pages.

Pour afficher les marges des pages de votre partition à l'écran (mais pas à l'impression), allez à Affichage→Afficher les marges.

Échelle

La propriété Échelle vous permet d'augmenter ou de diminuer la taille de votre partition.

Dans MuseScore, la taille des éléments de la partition, tels que les têtes de note, les tiges de note, les altérations, les
clés, etc., est définie en termes d'unité de mesure appelée espace de portée - abrégée en sp. (voir Glossaire). Lorsque
vous modifiez le paramètre "Espace de la portée", tous les éléments de la partition suivent le même chemin et les
proportions correctes sont donc maintenues. L'exception est Texte, dans lequel vous pouvez définir une valeur absolue,
indépendamment de la "Mise à l'échelle".

Note__ : La modification de "Échelle" ne modifie pas toujours le nombre de systèmes par page, car la distance du
système peut varier entre les limites fixées sous "Distance minimale entre deux systèmes" et "DIstance max. entre
systèmes" (voir Format→Style...→Page).

Unité {#unité}
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Ici, vous pouvez choisir d'afficher les valeurs en pouces ou en millimètres.

Numéro de la première page

Fixe le numéro de la première page de la partition. Les numéros de page inférieurs à 1 ne seront pas imprimés - par
exemple, si le numéro de la première page est -1, la première et la deuxième page n'auront pas de numéro de page et la
page 1 apparaîtra sur la troisième page.

Appliquer à l'ensemble des parties

Le bouton Appliquer à l'ensemble des parties  est disponible lors de la modification d'une partie, plutôt que de la partition
principale (voir Extraction de partie). Si vous modifiez les paramètres de page d'une partie et que vous souhaitez que les
autres parties aient les mêmes paramètres, ce bouton appliquera la modification à toutes les parties en une seule fois.

Sauts et espacements

La palette Sauts et espacements contient les symboles (non imprimable) suivants :

Les trois premiers symboles sont appelés Sauts. Les lignes verticales sont des espacements.

Sauts

Un Saut peut être appliqué sur une mesure ou sur un cadre. Il en existe trois sortes :

Saut de système : Force la suite de la partition à commencer sur un nouveau système.
Saut de page : Force la suite de la partition à commencer sur une nouvelle page.
Saut de section: Force la suite de la partition à commencer sur un nouveau système et de démarrer une nouvelle
section (voir ci-dessous). Il peut être combiné avec un saut de page si nécessaire.

Remarques :
- (1) Les symboles de saut sont visibles à l'écran, mais n'apparaissent pas sur les impressions.
- (2) Pour ajouter (ou supprimer) des sauts de système sur totalité ou sur une partie de la partition, voir Ajouter/Supprimer
des sauts de système.
- (3) Pour scinder une mesure en deux, voir Opérations de mesure : Scinder et Joindre.

Ajouter un saut à une mesure

Les sauts peuvent être ajoutés soit en utilisant un raccourci clavier, soit en utilisant un symbole de la palette Sauts et
espacements.

Utilisation d'un raccourci clavier

Pour ajouter un saut de système ou un saut de page :

1. Sélectionner l'une des chose suivantes :
une barre de mesure
une mesure
la tête d'une note
un élément texte associé à la portée (e.g. syllabe de parole, symbole d'accord, texte de portée etc.)
un ensemble de mesures (si vous choisissez cette option, une pause sera appliquée avant et après la
sélection)

2. Choisir l'une des options suivantes :
Saut de système : Utiliser ↵ (bascule).
Saut de page : Utiliser Ctrl+↵ (Mac: Commande+↵) (bascule).

Utilisation des symboles de la palette

Tous les sauts peuvent être ajoutés à partir de la palette Sauts et espacements :

1. Sélectionner l'une des chose suivantes :
une barre de mesure
une mesure
la tête d'une note
un élément texte associé à la portée (e.g. syllabe de parole, symbole d'accord, texte de portée etc.)
un ensemble de mesures (si vous choisissez cette option, une pause sera appliquée avant et après la
sélection)
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2. Cliquer sur le symbole de saut dans la palette (double-click dans les versions antérieures à 3.4). (bascule).

Il est également possible de faire glisser le symbole depuis la palette et de le déposer sur une mesure.

Ajouter un saut à un cadre

Pour ajouter un saut à un cadre, utiliser l'une des options suivantes :

Faire glisser et déposer un saut depuis la palette sur un cadre.
Sélectionner un cadre puis cliquer sur un symbole de saut dans la palette (double-click dans les versions
antérieures à 3.4).

Supprimer les sauts

Pour supprimer un saut, utiliser l'une des options suivantes :

Sélectionner un ou plusieurs sauts et presser la touche Suppr.

Voir aussi : Ajouter / Supprimer des sauts de système.

Déplacer un saut

Bien que les sauts ne soient pas visibles sur la sortie imprimée, vous pouvez les repositionner, si nécessaire, en entrant
dans le mode édition et en utilisant les touches fléchées du clavier (voir Ajuster la position des objets texte).

Saut de section

Un Saut de section, comme son nom l'indique, est utilisé pour créer des sections séparées au sein d'une partition.
Comme un saut de système, il force la mesure ou la trame suivante à commencer un nouveau système, et peut
également être utilisé en association avec un saut de page si nécessaire. Un saut de section peut être utilisé, par
exemple, pour diviser une pièce en plusieurs mouvements.

Chaque section peut avoir sa propre numérotation de mesure indépendante du reste de la partition. Par défaut, la
première mesure d'une section est numérotée "1" (voir image ci-dessous), bien que comme la première mesure de la
partition elle-même, le nombre ne soit pas affiché à moins d'être configuré dans le dialogue Propriétés de mesure. La
même boîte de dialogue peut être utilisée pour modifier la numérotation à votre convenance.

Si vous changez l'indication de mesure ou l'armure au début de la nouvelle section, il n'y aura pas rappel à la fin de la
section précédente. Voir l'exemple ci-dessous :

Lorsque vous faite la lecture sonore de la partition, le programme ajoute une courte pause entre chaque section. En outre,
la première barre de fin de répétition d'une section envoie toujours le curseur de lecture au début de la section, une barre
de début de répétition est donc facultative.

Les propriétés suivantes peuvent être ajustées dans l'Inspecteur après avoir sélectionné le saut de section :

Pause: Temps d'attente à la fin de la section.
Démarrer avec les noms longs d'instrument : (case à cocher).
Démarrer la numérotation des mesures à 1 : (case à cocher).
Démarrer avec l'indentation du premier système : case à cocher (à partir de la version 3.6).

Dans les versions antérieures à 3.4, les mêmes propriétés sont accessibles en cliquant avec le bouton droit de la souris
sur le saut et en sélectionnant Propriétés du saut de section.

Espacements

Il existe trois types d'espacement :

Espacement vers le haut entre portées : Flèche pointant vers le haut. Ajoute de l'espace au-dessus de la portée.
Espacement vers le haut entre portées : Flèche pointant vers le bas. Ajoute de l'espace au-dessous de la portée.
Espacement fixe entre portées : Ressemble à la lettre "I" majuscule. Fixe la distance entre deux portées. (utile
pour passer outre les paramètres de style ou de placement automatique à un seul endroit). Des valeurs négatives
sont possibles.
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Remarque : Les espacements ne peuvent pas être appliqués aux cadres.

Ajouter un espacement

Utiliser l'une des options suivantes :

Sélectionner une mesure, puis cliquer sur l'un des symboles d'espacement dans la palette (double-click dans les
versions antérieures à 3.4).
Faire glisser et déposer un symbole d'espacement depuis la palette sur une mesure.

Les symboles d'espacement sont visibles à l'écran, mais n'apparaissent pas sur les impressions.

Remarque : Les espacement sont destinés à réaliser des ajustements locaux uniquement. Si vous avoulez agir sur la
partition entière, utilisez plutôt les paramètres disponibles dans la fenêtre Format → Style... → Page.

Ajuster un espacement

Pour ajuster la hauteur d'un espacement, utiliser l'une des options suivantes :

Cliquer sur l'espacement et faire glisser la poignée bleue vers le haut ou vers le bas (double-clic dans les versions
antérieures à 3.4).
Cliquer sur la ligne et utilisez les touches ↑↓ et/ou Ctrl+↑↓ pour déplacer la poignée d'extrémité vers le haut et le bas
(double-clic dans les versions antérieures à 3.4).
Cliquer sur l'espacement et ajuster la propriété de hauteur dans l'Inspecteur.

Supprimer un espacement

Cliquer sur l'espacement et utiliser la touche Suppr key.

Voir aussi

Ajouter/Supprimer des sauts systèmes

Cadres

Un cadre est un élément rectangulaire permettant de créer dans la partition des espaces vides, de contenir du texte ou
des images. Il peut être de trois types :

Horizontal : Utilisé pour créer un espace au sein d'un système. Peut contenir un ou plusieurs objets texte et/ou
images.
Vertical : Inséré au-dessus d'un système ou annexé au dernier système. Peut contenir un ou plusieurs objets texte
et/ou images.
Texte : Inséré au-dessus d'un système ou annexé au dernier système. Ne peut contenir qu'un seul objet texte.

Cadre Horizontal

Un cadre horizontal est utilisé pour créer une rupture dans un système. Vous pouvez par exemple :

Créer une coda, avec un écart réglable la séparant du reste de la partition (comme dans l'exemple ci-dessous).

Créer un décalage au début de la partition (À partir de la version 3.6, il existe la possibilité d'indenté le premier
système).
Créer une marge droite ajustable à la fin d'un système.
Créer un espace pour du texte ou des images.
Créer un espace entre un "incipit historique" et le début de l'édition moderne.

Insérer/Ajouter un cadre horizontal

Voir Créer un cadre (plus loin dans ce chapitre).

Ajuster la largeur d'un cadre horizontal

Utiliser l'une des méthodes suivantes :
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Cliquer sur le cadre (double-clic dans les versions antérieures à 3.4) et faire glisser la poignée de manipulation vers
la droite ou vers la gauche.
Sélectionner le cadre puis ajuster la largeur dans l'Inspector.

Ajouter du texte ou une image à un cadre horizontal

Ajouter du texte : Faire un clic droit sur le cadre et sélectionner Ajouter &rarr ; Texte.

Ajouter une image: Faire un clic droit sur le cadre et sélectionner Ajouter &rarr ; Image.

Cadre Vertical

Un cadre vertical peut être inséré au-dessus d'un système ou annexé au dernier système. Il peut contenir un ou plusieurs
objets de texte et/ou des images. La hauteur est réglable et la largeur est égale à la largeur du système.

Il peut être utilisé, par exemple, pour :

Créer une zone en tête de partition pour le titre/sous-titre/texte du compositeur/parolier, etc. (voir ci-dessous).
Créer une page de titre (voir ci-dessous).
Ajouter les paroles d'une chanson sur une ou plusieurs colonnes (à la fin d'une partition).
Créer des sous-titres et d'autres annotations entre les systèmes.

Insérer/Ajouter un cadre vertical

Voir Créer un cadre (plus loin dans ce chapitre).

Ajuster la hauteur d'un cadre vertical

Utiliser l'une des méthodes suivantes :

Cliquer sur le cadre (double-clic pour les versions antérieures à 3.4) et faites glisser la poignée vers le haut ou vers
le bas.
Sélectionnez le cadre et ajustez la "Hauteur" dans l'Inspecteur.

Modifier les propriétés d'un cadre vertical

La sélection du cadre vous permet de régler divers paramètres dans l'inspecteur :

Écart supérieur : Ajuste la distance entre le cadre et l'élément du dessus.
Écart inférieur : Ajuste la distance entre le cadre et l'élément du dessous.
Hauteur : Ajuste la hauteur du cadre.
Marge gauche : Ajuste la marge des objets alignés à gauche contenus à l'intérieur du cadre.
Marge droite : Ajuste la marge des objets alignés à droite contenus à l'intérieur du cadre.
Marge haute : Ajuste la marge des objets alignés en haut contenus à l'intérieur du cadre (voir aussi Format → Style... →
Page).
Marge basse : Ajuste la marge des objets alignés en bas contenus à l'intérieur du cadre (Voir aussi Format → Style... →
Page).

Ajouter du texte ou des images à un cadre vertical

Pour ajouter du texte : Clic droit sur le cadre, sélectionner Ajouter, puis choisissez l'une des options de texte.

Pour ajouter une image : Clic droit sur le cadre, sélectionner Ajouter, puis choisissez "Image".

Vous pouvez créer autant d'objets que vous le souhaitez dans un cadre. Leurs positions peuvent être ajustées
indépendamment en faisant glisser ou, pour plus de précision, en modifiant les valeurs de décalage X et Y dans
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l'inspecteur. Pour formater les objets texte, voir Édition de texte et Styles et propriétés du texte.

Insérer un cadre horizontal à l'intérieur d'un cadre vertical

Faire un clic droit sur le cadre et sélectionnez Ajouter &rarr ; Insérer un cadre horizontal.

Le cadre horizontal est automatiquement aligné à gauche et remplit tout le cadre vertical. Pour l'aligner à droite :

1. Réduire la largeur du cadre horizontal.
2. Désélectionnez le cadre puis faites-le glisser vers la droite. Pour rétablir l'alignement à gauche, faites glisser le

cadre vers la gauche.

Cadre "Titre"

Un cadre vertical est automatiquement créé au début d'une partition, indiquant le titre, le sous-titre, le compositeur, le
parolier etc., lorsque vous remplissez les champs d'information fournis à la page 1 du Assistant Nouvelle Partition.

Si la partition ne possède pas de cadre de Titre au début, vous pouvez le créer ainsi :

1. Dans le menu, sélectionner Ajouter &rarr ; Texte &rarr ; Titre/Sous-titre/Compositeur/Parolier ;
2. Saisir le texte souhaité
3. Appuyer sur Echap ou cliquez sur un espace vide pour quitter.

Cadre Texte

Un Cadre de Texte ressemble à un [cadre vertical] (#vertical), mais est spécialisé dans la saisie de texte : un objet texte
est autorisé par cadre. La hauteur s'étend automatiquement pour s'adapter au contenu et il n'y a pas de poignée de
réglage de la hauteur.

Un cadre de texte peut être utilisé, par exemple, pour :

Écrire les paroles d'une chanson à la fin de la partition.
Créer des sous-titres et autres annotations entre les systèmes.
Créer et insérer une page blanche]n'importe où dans la partition, y compris au début.

Insérer/Ajouter un cadre Texte

Voir Créer un cadre (ci-dessus).

Modifier les propriétés d'un cadre

La sélection du cadre vous permet de régler divers paramètres dans l'inspecteur :

Écart supérieur : Ajuste la distance entre le cadre et l'élément du dessus.
Écart inférieur : Ajuste la distance entre le cadre et l'élément du dessous.
Hauteur : Ajuste la hauteur du cadre.
Marge gauche : Ajuste la marge des objets alignés à gauche contenus à l'intérieur du cadre.
Marge droite : Ajuste la marge des objets alignés à droite contenus à l'intérieur du cadre.
Marge haute : Ajuste la marge des objets alignés en haut contenus à l'intérieur du cadre (voir aussi Format → Style... →
Page).
Marge basse : Ajuste la marge des objets alignés en bas contenus à l'intérieur du cadre (Voir aussi Format → Style... →
Page).

Créer un cadre

Insertion d'un cadre dans une partition

Depuis le menu :

1. Sélectionner une mesure ;
2. Dans le menu, sélectionner Ajouter &rarr ; Cadres &rarr ; Insérer un cadre horizontal/vertical/de texte.

Depuis une mesure :

1. Clic-droit sur la mesure.
2. Sélectionenr Ajouter → Insérer un cadre horizontal/vertical/de texte.

Depuis la palette :

Voir Ajout de symboles depuis une palette.

Ajouter un cadre à une partition
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Dans le menu, sélectionner Ajouter &rarr ; Cadres &rarr ; Ajouter un cadre horizontal/vertical/de texte.

Supprimer un cadre

Utiliser l'une des méthodes suivantes :

Sélectionner la limite du cadre et appuyez sur Suppr.
Sélectionner la limite du cadre, puis faites un clic droit sur le cadre et sélectionnez Supprimer.

Ajouter un saut

Les sauts de système, de page et de section peuvent être appliquer aussi bien aux cadres qu'aux mesures. Utiliser l'une
des deux méthodes suivantes :

Sélectionner un cadre et cliquer (double-clic avant la version 3.4) sur un symbole saut dans la palette "Sauts et
espacements").
Faites glisser un symbole de saut d'une palette sur un cadre.

Voir aussi

Propriété des textes : pour mettre une bordure autour du texte.
Insérer des mesures : pour insérer des mesure avant un cadre.

Liens externes

How to add a block of text to a score  (MuseScore HowTo)
Comment créer une page blanche ou une page de titre au début d'une partition
Page Formatting in MuseScore 1.1 - 1. Frames, Text & Line Breaks  [video]

Images

Il est possible d'utiliser des Images pour illustrer les partitions ou pour ajouter des symboles qui ne sont pas présents
dans les palettes standards.

MuseScore accepte les formats suivants :

PNG (*.png)
JPEG (*.jpg and *.jpeg)
SVG (*.svg) (MuseScore ne supporte pas actuellement l'ombrage, le floutage, le découpage ou le masquage SVG.)

Ajouter une image

Il est possible d'utiliser l'une des méthodes suivantes :

Glisser-Déposer (Drag-and-drop) une image (en provenance d'ailleurs que de MuseScore) à l'intérieur d'un cadre
vertical ou horizontal, ou sur une note ou un silence dans la partition.
Après un clic-droit sur un cadre, sélectionner Ajouter→Image, puis choisir une image dans la fenêtre d'ouverture de
fichier.

Une fois ajoutée à une partition, une image peut être placée dans une Palette afin de pouvoir être réutilisée. (voir Ajouter
à une palette pour plus d'information)

Couper/Copier, Coller une image

1. Cliquer sur une image dans la partition.
2. Utiliser Copier/Coller de façon habituelle (Voir Commandes pour plus d'informations).
3. Cliquer sur une note, un silence ou un cadre.
4. Utiliser la commande Coller de façon habituelle (Voir Commandes pour plus d'informations).

Modifier une image

Pour modifier la hauteur ou la largeur d'une image, faire un double-clic sur l'image et utiliser les poignées d'édition. Il est
également possible d'utiliser l'inspecteur pour ajuster ces valeurs : dé-valider "Conserver le rapport hauteur/largeur" dans
l' inspecteur.

Il est possible de déplacer une image en la faisant glisser à l'aide de la souris.

Voir aussi

Capteur d'Image
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Palettes personnalisées

Liens externes

Comment créer une variation avec une capture d'image  (MuseScore HowTo)
Comment créer une variation dans une autre portée  (MuseScore HowTo)

Capture d'image

La fonction Capture d'image de MuseScore vous permet de sauvegarder un instantané de n'importe quelle partie de la
fenêtre de la partition. Les formats PNG, PDF et SVG sont pris en charge.

Sauvegarder un instantané

1. Cliquez sur le bouton de Capture d'image, .
2. Appuyez sur Maj + glisser, pour créer un nouveau rectangle de sélection.
3. Ajustez la position du rectangle, si nécessaire, en le faisant glisser et/ou en modifiant les valeurs de "Position" dans

l'Inspecteur.
4. Ajustez la zone du rectangle, si nécessaire, en faisant glisser les poignées, et/ou en changeant les valeurs de

"Taille" dans l'inspecteur.

5. Cliquez avec le bouton droit sur le rectangle de sélection pour ouvrir le menu Capture d'Image. Sélectionnez
l'option souhaitée :

Enregistrer sous (mode impression)…. Cela permet d'enregistrer une image de la zone de sélection telle
qu'elle apparaîtrait si elle était imprimée, par exemple

Enregistrer sous (mode capture d'écran)…. Cette fonction permet d'enregistrer une sélection de l'écran
réel, y compris les symboles de saut de ligne, les éléments invisibles, etc.

Vous pouvez enregistrer l'image au format PNG (par défaut), SVG ou PDF.

Le Menu Capture d'image

Un clic droit sur le rectangle de sélection ouvre le menu Capture d'image (Mac : Ctrl + clic, ou tap à 2 doigts) :
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Copier : Choisissez cette option pour copier une image avant de la coller dans le même fichier MuseScore ou dans
un autre logiciel.
Copier avec le lien vers la partition : Choisissez cette option pour copier une image comprenant un lien vers le
fichier MuseScore. Lorsque vous collez cette image dans un programme qui la prend en charge, vous pourrez
cliquer sur l'image pour ouvrir le fichier MuseScore.
Résolution (350 DPI) : Permet de définir la résolution, et donc la taille de l'image sauvegardée ou copiée. Essayez
de commencer avec 100 dpi, si vous n'êtes pas sûr.
Arrière-plan transparent : Activez ou désactivez la transparence de l'image.
Redimensionnement automatique à la page : Ajuste le rectangle de sélection pour qu'il s'adapte à la page.
Redimensionnement à A/B/C/D : Choisissez un rectangle de sélection personnalisé (comme défini ci-dessous).
Définir la taille par défaut : Redimensionnez le rectangle de sélection, puis choisissez "Définir la taille A/B/C/D"
pour le stocker.

Voir aussi

Image

Liens externes

Créer un ossia avec capture d'image  (MuseScore HowTo)
Comment créer un ossia avec une autre portée  (MuseScore HowTo)

Alignement des éléments

En faisant glisser un élément:

Pour contraindre un mouvement horizontal uniquement: Cliquez et maintenez sur l'élément, appuyez sur Ctrl, puis
faites glisser l'élément vers la gauche ou vers la droite.
Pour contraindre un mouvement vertical uniquement: Cliquez et maintenez sur l'élément, appuyez sur Shift, puis
faites glisser l'élément vers le haut ou vers le bas.

Aligner sur la grille

Aligner sur la grille est une fonction qui vous permet de faire glisser un élément par étapes précises - utile pour un
positionnement exact.

Pour activer l'alignement sur la grille, sélectionnez un élément et cliquez sur un bouton (ou les deux) d'alignement sur la
grille, situés à droite des champs de décalage X (horizontal) et Y (vertical) dans l'Inspecteur. Vous pouvez ensuite faire
glisser l'élément par étapes égales à l'espacement de la grille. La valeur par défaut est 0,5 espace (spatium en anglais).

Pour modifier l'espacement de la grille:

1. Cliquez avec le bouton droit de la souris sur l'un des boutons d'alignement sur la grille dans l'inspecteur et
sélectionnez Configurer la grille.

2. Définissez les valeurs d'espacement horizontal et vertical de la grille selon vos besoins. Notez qu'il s'agit d'un
paramètre fractionnaire.

Fonctionnalités avancées

Accessibilité

Introduction

Ce document est destiné aux utilisateurs aveugles et malvoyants de MuseScore 3. Il ne vise pas à fournir une description
complète de toutes les fonctionnalités de MuseScore; vous devriez lire ceci en conjonction avec la documentation
régulière de MuseScore.

MuseScore prend en charge le lecteur d'écran NVDA  gratuit et open source pour Windows. Vous pouvez également
installer un script  pour activer la prise en charge de JAWS , ou installer un script  Pour Orca  sur Linux.

À terme, nous espérons supporter d'autres lecteurs d'écran tels que VoiceOver  et Narrateur . Actuellement, les
lecteurs d'écran non pris en charge liront généralement les menus et les boîtes de dialogue, mais la lecture de la partition
note par note nécessite actuellement l'un des lecteurs d'écran pris en charge.

À partir de MuseScore 3.3, la plupart des fonctionnalités de MuseScore sont entièrement accessibles, il est viable à la fois
en tant que lecteur de partition et éditeur. Les versions précédentes étaient plus limitées en ce qui concerne l'édition.
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La configuration initiale

Lorsque vous exécutez MuseScore pour la première fois, des questions vous seront posées au démarrage. Nous vous
recommandons d'accepter les valeurs par défaut, mais de répondre "non" à la question sur l'affichage des visites gudées,
car celles-ci ne sont malheureusement pas encore accessibles.

Lorsque MuseScore démarre, la première chose que vous voyez normalement est la fenêtre Centre de démarrage. Cela
vous montre une liste de scores récents auxquels vous pouvez accéder via Maj + Tab, puis en utilisant les touches
fléchées gauche et droite. Vous trouverez peut-être plus facile d'ouvrir les partitions directement à partir du menu Fichier,
mais vous pouvez appuyer sur Esc pour fermer le Centre de démarrage si vous préférez. En fait, vous voudrez peut-être le
désactiver définitivement. Après avoir fermé le Centre de démarrage, ouvrez le menu Edition (Alt+E), choisissez
Préférences, et dans l'onglet Général, décochez Afficher le centre de démarrage, puis fermez la fenêtre Préférences.

MuseScore inclut des raccourcis clavier pour plusieurs de ses commandes, et les autres qui n'ont pas de raccourcis
définis par défaut peuvent être personnalisés plus tard, dans Edition, Préférences, Raccourcis.

Se repérer dans l'interface de MuseScore

L'interface utilisateur de MuseScore fonctionne un peu comme d'autres programmes de notation ou d'autres programmes
orientés document en général. Il possède une seule fenêtre de document principale dans laquelle vous pouvez travailler
avec une partition. MuseScore prend en charge plusieurs onglets de document dans cette fenêtre. Il prend également en
charge une vue en écran partagé pour vous permettre de travailler avec deux documents à la fois, et vous pouvez avoir
plusieurs onglets dans chaque fenêtre.

En plus de la fenêtre de partition, MuseScore dispose d'une barre de menus à laquelle vous pouvez accéder via les
raccourcis des menus individuels:

Fichier: Alt+F
Edition: Alt+E
Affichage: Alt+A
Ajouter: Alt+A
Plugins: Alt+P
Aide: Alt+D

Astuce: une fois que vous avez ouvert un menu, plusieurs pressions sur les touches Haut ou Bas peuvent être nécessaires
avant que tout soit lu correctement. De plus, si à un moment donné le lecteur d'écran cesse de répondre, une astuce utile
pour le redémarrer est d'appuyer sur Alt pour déplacer le focus vers la barre de menu, puis Echap pour revenir à la
partition. Parfois, passer à une autre application puis revenir en arrière peut également aider.

En plus de la barre de menus, il existe également un certain nombre de barres d'outils, de palettes et de sous-fenêtres
dans MuseScore, et vous pouvez parcourir les commandes de celles-ci en utilisant Tab (ou Maj+Tab pour revenir en arrière
dans ce même cycle). Lorsque vous démarrez MuseScore pour la première fois ou que vous chargez une partition, le
focus doit être dans la fenêtre de partition principale.

Si rien n'est sélectionné (appuyez sur Echap pour effacer une sélection), appuyez sur Tab pour accéder à une barre
d'outils contenant une série de boutons pour des opérations telles que Nouveau, Ouvrir, Lire, etc. Tab ignorera tous les
boutons qui ne sont pas actuellement actifs. Les noms et raccourcis (le cas échéant) de ces boutons doivent être lus par
votre lecteur d'écran.

Une fois que vous avez parcouru les boutons de la barre d'outils, la prochaine fenêtre que l'onglet va visiter est les
palettes. Ceci est utilisé pour ajouter divers éléments à une partition (dynamique, articulations, etc.).

Si un élément est sélectionné dans la partition, la première fenêtre visitée par Tab est l'Inspecteur, qui est utilisé pour
effectuer divers ajustements manuels dans votre partition. Beaucoup de ces fonctionnalités sont basées sur l'apparence
visuelle de la partition (bien que quelques-unes concernent la lecture).
Si vous avez ouvert l'une des fenêtres optionnelles supplémentaires, telles que le filtre de sélection, la touche Tab les
visitera également. Vous pouvez fermer les fenêtres dont vous n'avez pas besoin en allant dans le menu Affichage et en
vous assurant qu'aucune des premières cases à cocher n'est cochée (les fenêtres qui apparaissent avant les paramètres
de zoom). Par défaut, seuls les palettes et l'inspecteur doivent être sélectionnés. Voir La configuration initiale pour obtenir
des instructions sur la désactivation du centre de démarrage. F9 peut être utilisé pour basculer les palettes tandis que F8
basculera l'Inspecteur.

Pour remettre le focus sur la fenêtre de partition après avoir visité la barre d'outils ou une sous-fenêtre, appuyez sur
Echap. Si quelque chose a été sélectionné avant de visiter l'autre fenêtre, la sélection est laissée intacte, mais appuyer
sur Echap une fois que le focus est dans la fenêtre de partition efface la sélection. La sélection est automatiquement
restaurée lorsque vous commencez la navigation à l'aide des commandes d'accessibilité décrites ci-dessous.

La fenêtre de partition

Lorsque vous démarrez MuseScore 3 pour la première fois, un exemple de partition vide est chargé par défaut. Si vous
souhaitez expérimenter les fonctionnalités d'édition, c'est le bon endroit pour commencer. Sinon, vous voudrez
probablement commencer par charger une partition. MuseScore utilise les raccourcis standard pour accéder aux
commandes système telles que Ctrl+O (Mac: Cmd+O) pour ouvrir un fichier, Ctrl+S (Mac: Cmd+S) pour enregistrer, Ctrl+W
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(Mac: Cmd+W) pour fermer, etc.

Si vous appuyez sur Ctrl+O (Mac: Cmd+O) pour charger une partition, une boîte de dialogue de fichier assez standard vous
est présentée. MuseScore peut ouvrir des partitions dans son propre format (MSCZ ou MSCX) ainsi qu'importer des
partitions au format standard MusicXML, au format MIDI ou à partir de quelques autres programmes tels que Guitar Pro,
Capella et Band-in-a-Box. Une fois que vous avez chargé une partition, elle s'affiche dans un nouvel onglet de la fenêtre
de partition. Vous pouvez vous déplacer entre les onglets de la fenêtre de partition en utilisant Ctrl+Tab (ne s'applique pas
pour Mac). Astuce: si le nom de la partition dans l'onglet courant n'est pas lu, demandez à votre lecteur d'écran de lire la
barre de titre.

Pour lire la partition note par note, voir ci-dessous, mais il existe quelques autres choses intéressantes que vous pouvez
faire avec une partition chargée. Vous pouvez appuyer sur Espace pour que MuseScore joue la partition pour vous. Vous
pouvez utiliser File / Export pour convertir vers un autre format, y compris PDF, PNG, WAV, MP3, MIDI, MusicXML, etc.
Et bien sûr, vous pouvez l'imprimer via Fichier / Imprimer ou Ctrl+P (Mac: Cmd+P).

Si une partition contient plusieurs instruments, elle peut déjà avoir des parties liées générées. Les parties liées sont
présentées sous forme d'onglets de partie dans les onglets de partition, mais actuellement, il n'existe aucun moyen de
naviguer dans ces onglets de partie à l'aide du clavier. Les parties ne contiendraient normalement pas d'informations
différentes de la partition; ils seraient simplement affichés différemment (chaque partie sur sa propre page). Si une
partition n'a pas encore de parties générées, vous pouvez le faire via Fichier / Parties, et cette boîte de dialogue est
accessible. Si vous souhaitez imprimer les pièces, vous pouvez contourner l’impossibilité d’accéder individuellement aux
onglets de pièces en utilisant la boîte de dialogue Fichier / Exporter des pièces, qui exporte automatiquement les PDF (ou
d’autres formats) pour toutes les pièces en une seule étape.

Lecture visuelle de la partition

Lorsque vous chargez une partition pour la première fois, la fenêtre de partition a le focus clavier, mais il n'y aura rien de
sélectionné. La première étape de la lecture d'une partition est de sélectionner quelque chose, et le point de départ le plus
naturel est le premier élément de la partition. Après le chargement d'une partition, Alt+Droite (Mac: Alt+Droite) sélectionnera
le premier élément littéral, qui est probablement le titre; Ctrl+Home (Mac: Cmd+Home) sélectionnera le premier élément
"musical" (généralement une clé ou une barre de mesure initiale).

Lorsque vous naviguez entre les éléments, votre lecteur d'écran doit donner le nom de l'élément sélectionné. Vous
l'entendrez lire le nom de l'élément (par exemple, "Clé de sol") et également donner des informations de position (par
exemple, "Mesure 1; Battement 1; Portée 1; Violon"). La quantité d'informations lues est optimisée pour ne pas répéter les
informations qui n'ont pas changé. Appuyer sur Maj interrompt actuellement la lecture, ce qui peut également être utile.

La plupart de la navigation dans MuseScore est centrée sur les notes et les silences uniquement - elle sautera les clés,
les armures, les indications de mesure, les barres de mesure et d'autres éléments. Donc, si vous utilisez simplement les
touches standard Droite et Gauche pour vous déplacer dans votre partition, vous n'entendrez que les notes et les silences
(et les éléments qui y sont attachés). Cependant, il existe deux commandes d'accessibilité spéciales que vous trouverez
utiles pour obtenir un résumé plus complet de la partition:

Élément suivant: Alt+Droite (Mac: Alt+Droite)
Élément précédent: Alt+Gauche (Mac: Alt+Gauche

Ces commandes incluent des clés et d'autres éléments que les autres commandes de navigation ignorent, et permettent
également de parcourir toutes les voix de la portée actuelle, tandis que d'autres commandes de navigation telles que
Droite and Gauche ne naviguent que dans la voix actuellement sélectionnée jusqu'à ce que vous changiez explicitement de
voix. Par exemple, si vous êtes sur une noire sur le temps 1 de la mesure 1 et qu'il y a deux voix dans cette mesure,
appuyez sur la touche Droite pour passer à la note suivante de la voix 1 - qui sera sur le temps 2 - tout en appuyant sur
Alt+Droite (Mac: Alt+Droite) restera sur le temps 1 mais passera à la note de la voix 2. Ce n'est que lorsque vous avez
parcouru toutes les notes du temps actuel sur la portée actuelle que le raccourci vous fera passer au temps suivant.
L'intention est que ce raccourci devrait être utile pour naviguer dans une partition si vous ne savez pas déjà quel est le
contenu.

Lorsque vous accédez à un élément, votre lecteur d'écran doit lire les informations à son sujet. Pour les notes et les
silences, il lira également les informations sur les éléments qui leur sont attachés, tels que les paroles, les articulations,
les symboles d'accord, etc. Les commandes d'accessibilité navigueront également dans ces éléments individuellement.

Une note importante: Haut and Bas par eux-mêmes, avec Maj, ou avec Ctrl / Cmd ne sont pas des raccourcis utiles pour la
navigation! Au lieu de cela, ils modifient la hauteur de la ou des notes actuellement sélectionnées. Faites attention de ne
pas modifier par inadvertance une partition que vous essayez de lire. Haut et Bas ne doivent être utilisés avec Alt que si
votre intention est uniquement la navigation. Consultez la liste des raccourcis de navigation ci-dessous.

Si vous perdez la trace de votre place dans la partition - ou si vous perdez complètement la sélection - appuyez sur Maj+L
("Indiquer la position") pour obtenir l'emplacement actuel.

Se déplacer en avant ou en arrière dans le temps

Les raccourcis suivants sont utiles pour se déplacer "horizontalement" dans une partition:

Élément suivant: Alt+Droite
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Élément précédent: Alt+Gauche
Accord ou silence suivant: Droite
Accord ou silence précédent: Gauche
Mesure suivante: Ctrl+Droite
Mesure précédente: Ctrl+Gauche
Aller à la mesure: Ctrl+F
Premier élément: Ctrl+Home
Dernier élément: Ctrl+Fin

Se déplacer entre les notes à un moment donné

Les raccourcis suivants sont utiles pour se déplacer "verticalement" dans une partition:

Élément suivant: Alt+Droite
Élément précédent: Alt+Gauche
Note supérieure suivante dans la voix, la voix précédente ou la portée ci-dessus: Alt+Haut
Note inférieure suivante dans la voix, la voix suivante ou la portée ci-dessous: Alt+Bas
Note la plus haute de l'accord: Ctrl+Alt+Haut
Note la plus basse de l'accord: Ctrl+Alt+Bas

Les commandes Alt+Haut et Alt+Bas sont similaires aux commandes Alt+Droite et Alt+Gauche en ce qu'elles sont conçues pour
vous aider à découvrir le contenu d'une partition. Vous n'avez pas besoin de connaître le nombre de notes d'un accord, le
nombre de voix dans une portée ou le nombre de portées d'une partition pour vous déplacer verticalement dans la
partition à l'aide de ces commandes.

Filtrage de la lecture des partitions

Exclure certains éléments comme les paroles ou les noms d'accords lors de la lecture de la partition est possible en
utilisant le filtre de sélection (F6). Décochez les éléments que vous ne souhaitez pas lire. Cependant, cette fonctionnalité
n'est peut-être pas actuellement implémentée.

Lecture audio de la partition

La touche Espace sert à la fois à démarrer et à arrêter la lecture. La lecture commencera avec la note actuellement
sélectionnée si une note est sélectionnée; ou à l'endroit où la lecture a été arrêtée pour la dernière fois si aucune note
n'est sélectionnée; ou au début de la partition lors de la première lecture.

MuseScore prend en charge la lecture en boucle afin que vous puissiez répéter une section d'un morceau à des fins de
pratique. Pour définir les points "début" et "fin" pour la lecture en boucle via le panneau de lecture (F11):

1. Sélectionnez d'abord la note, dans la fenêtre de la partition, où la boucle doit commencer;
2. Accédez au panneau de lecture et appuyez sur le bouton à bascule "Définir la position initiale de la boucle";
3. De retour à la fenêtre de partition, accédez à la note où vous voulez que la boucle se termine;
4. Revenez au panneau de lecture et appuyez sur le bouton à bascule "Définir la position finale de la boucle";
5. Pour activer ou désactiver la boucle, appuyez sur le bouton bascule "Activer / Désactiver la lecture en boucle".

Vous pouvez également contrôler la lecture en boucle et contrôler d'autres paramètres de lecture, tels que le
remplacement du tempo de base d'une partition, à l'aide du panneau Fenêtre de Lecture. (F11).

Création et édition de partitions

Alors que certaines techniques avancées d'édition de partition nécessitent une inspection visuelle de la partition, et qu'un
petit nombre de commandes peuvent nécessiter la souris, depuis MuseScore 3.3, la plupart des fonctionnalités d'édition
de partition sont entièrement accessibles.

Vous pouvez entrer de la musique dans la partition vide par défaut (une partition avec une portée, en utilisant un son de
piano), ou éditer une partition existante que vous avez déjà ouverte, ou vous pouvez créer une nouvelle partition avec
l'ensemble d'instruments de votre choix.

Créer une nouvelle partition

Pour créer une nouvelle partition, utilisez Fichier, Nouveau ou Ctrl+N. Un assistant vous guide ensuite tout au long du
processus de création de partition.

Le premier écran de l'assistant comporte des champs pour saisir le titre, le compositeur et d'autres informations. Le
second permet de sélectionner un modèle (partitions prédéfinies pour des ensembles communs comme le choral SATB
ou le jazz big band) ou de choisir les instruments. L'écran suivant vous permet de sélectionner une armure. Pour
sélectionner une armure, utilisez Haut et Bas. Le contrôle de l'armure ne fonctionne pas bien avec certains lecteurs d'écran,
mais si vous donnez la commande "lire la ligne actuelle" (par exemple, NVDA + L), il peut lire l'armure actuellement
sélectionnée. L'écran suivant vous permet de sélectionner une indication de mesure, une anacrouse, un nombre de
mesures et un tempo initiaux. Parfois, cet écran est ignoré, donc si cela se produit, appuyez sur le bouton Retour pour
revenir en arrière.
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Une fois que vous avez une partition, vous pouvez commencer à la modifier.

Saisie des Notes

Pour saisir des notes, vous devez être en mode de saisie de notes. Tout d'abord, accédez à la mesure dans laquelle vous
souhaitez saisir des notes, puis appuyez sur N. Presque tout ce qui concerne la saisie de notes est conçu pour être
accessible au clavier, et la documentation standard devrait être utile pour vous aider tout au long du processus. Gardez à
l’esprit que MuseScore peut être soit en saisie de notes, soit en mode normal, et il ne sera pas toujours clair dans quel
mode vous vous trouvez. En cas de doute, appuyez sur Echap. Si vous étiez en mode de saisie de notes, cela vous fera
sortir. Si vous étiez en mode normal, vous y resterez, même si vous perdrez également votre sélection.

Le processus de base de la saisie d'une note consiste à sélectionner d'abord une durée (par exemple, à l'aide des
raccourcis 4-5-6 pour croche, noire, blanche), puis saisir une note en tapant sa première lettre de A à G, (de La à Sol).
Une fois qu'une durée est sélectionnée, vous pouvez saisir plusieurs notes de la même durée. appuyez sur 0 pour saisir
un silence.

Les touches Haut et Bas augmentent ou réduisent la hauteur d'un demi-ton, en ajoutant ou en supprimant les altérations si
nécessaire. Pour changer l'enharmonie d'une note, appuyez sur J.

Pour entrer une liaison de prolongation, sélectionnez la durée de la note liée puis appuyez sur +. Pour créer des triolets,
sélectionnez la durée totale du triolet, puis appuyez surCtrl+3 (de même pour les quartolets et autres nolets). Pour entrer
de la musique en plusieurs voix sur une seule portée, appuyez sur Ctrl+Alt plus un nombre de 1 à 4 cela passera à la voix
correspondante (gardez à l'esprit que la première voix de chaque portée est toujours la voix 1).

Il y en a beaucoup plus sur la saisie de notes dans MuseScore. Voir la section la saisie des notes dans le Manuel .

Sélection

MuseScore prend en charge les raccourcis clavier habituels pour la sélection. La navigation revient à sélectionner des
éléments uniques. Pour sélectionner une plage d'éléments, accédez au premier, maintenez la touche Maj enfoncée, puis
accédez au second. Ctrl+A sélectionnera la partition entière.

Palettes

Comme mentionné précédemment, de nombreux symboles autres que les notes sont saisis à partir de la fenêtre des
palettes. Le modèle d'utilisation de base consiste à sélectionner d'abord le ou les éléments de la partition auxquels vous
souhaitez appliquer l'élément de la palette, puis d'appliquer l'élément de la palette. Il existe plusieurs façons de
sélectionner l'élément de la palette.

La méthode la plus simple à utiliser dans un premier temps est de parcourir simplement la fenêtre des palettes à l'aide du
clavier. Pour accéder à la fenêtre des palettes, appuyez sur Maj + Tab. Le lecteur d'écran peut ne pas vous dire
spécifiquement que vous êtes dans la fenêtre des palettes, mais vous découvrirez que vous êtes au fur et à mesure que
vous naviguez. Selon que vous avez utilisé les palettes auparavant, la mise au point peut être là où vous vous étiez arrêté
ou en haut. Appuyez sur Tab plusieurs fois pour accéder à la première palette de la fenêtre (Clefs). Vous pouvez parcourir
la liste des palettes à l'aide des touches fléchées Haut et Bas. La touche de curseur droite ouvre une palette, puis les
quatre touches de curseur peuvent être utilisées pour naviguer à travers les éléments (ils sont organisés dans un tableau).
Vous pouvez également utiliser Tab pour parcourir les noms et le contenu de la palette.

Une fois que vous avez trouvé un élément de palette que vous souhaitez appliquer, appuyez sur Entrée pour l'appliquer
aux éléments de partition actuellement sélectionnés et remettre le focus sur la partition. La prochaine fois que vous
appuyez sur Maj + Tab pour revenir aux palettes, le dernier élément de palette utilisé sera toujours sélectionné, donc
Entrée l'appliquera à nouveau. Le lecteur d'écran peut cesser de répondre après avoir appliqué un élément de palette,
même si le focus est revenu sur la partition, mais l'astuce consistant à appuyer sur Alt suivi d'Echap devrait le faire
fonctionner à nouveau.

Vous pouvez également utiliser la fonction de recherche de palette pour trouver rapidement un élément de palette. Le
champ de recherche est l'un des premiers éléments en haut de la palette, vous pouvez donc y accéder, ou vous pouvez
définir un raccourci (Edition, Préférences, Raccourcis) pour la commande "Recherche de palette", qui vous mènera
ensuite directement dans le champ de recherche. Une fois que vous êtes dans la zone, tapez les premiers caractères
d'un terme de recherche, et seuls les éléments de palette correspondant à cette recherche seront affichés. Vous pouvez
ensuite accéder aux résultats de la recherche et trouver l'élément souhaité. Le curseur Bas vous amènera directement au
premier résultat de la recherche, puis vous pourrez utiliser Droite après. Cependant, sur certains systèmes, MuseScore
peut planter lors de l'utilisation de la fonction de recherche de palette avec un lecteur d'écran activé.

Une autre façon d'atteindre la fenêtre des palettes est d'utiliser le raccourci F9, qui active et désactive la fenêtre des
palettes. Par défaut, la fenêtre des palettes est ouverte, donc appuyer sur F9 la fermera, mais appuyer à nouveau dessus
ouvre la fenêtre et place le curseur dans la zone de recherche.

Il existe une autre technique utile pour l'accessibilité de la palette, à savoir la commande "Appliquer l'élément de la palette
actuelle" (pour laquelle vous pouvez définir un raccourci). Si vous êtes dans la partition, cela appliquera automatiquement
le dernier élément de palette utilisé (l'équivalent de Maj + Tab suivi de Entrée).
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Menus et raccourcis

Certains éléments peuvent être ajoutés ou modifiés via des commandes de menu ou des raccourcis clavier. Le menu
Édition a des commandes standard de copier-coller (et les raccourcis habituels fonctionnent aussi). Le menu Ajouter
contient des commandes pour ajouter des notes, des n-olets, des mesures, des cadres, du texte et quelques lignes. Le
menu Format contient des commandes liées principalement à l'apparence visuelle de la partition (par exemple, la taille de
la page et de la portée, la position et la taille des symboles, les polices utilisées pour le texte), qui peuvent être
extrêmement utiles pour produire des partitions en gros caractères aussi connue comme "Modified Stave Notation" (voir
ci-dessous). Le menu Outils contient un certain nombre d'autres commandes utiles, notamment des commandes
permettant de supprimer des mesures ou d'autres plages sélectionnées, de transposer une sélection, de joindre et de
fractionner des mesures, etc. chacune de ces commandes a des raccourcis définis par défaut qui doivent être lus par un
lecteur d'écran. Vous pouvez définir des raccourcis personnalisés pour la plupart des autres dans Edition, Préférences,
Raccourcis.

Il existe également des raccourcis pour un certain nombre d'éléments de la palette et la possibilité d'en définir d'autres
(bien que de nombreux éléments de la palette ne le prennent actuellement pas en charge). Voici quelques raccourcis
utiles à retenir:

Ctrl+T: texte de portée
Alt+Shift+T: tempo
Ctrl+L: paroles
Ctrl+K: symbole d'accord
Ctrl+M: repère de répétition

S: liaison
Shift+S: staccato
Shift+V: accent
Shift+N: tenuto
Shift+O: marcato
slash: acciaccatura
less than: crescendo
greater than: decrescendo

Personnalisation

Vous pouvez personnaliser les raccourcis clavier en ouvrant le menu Édition, en sélectionnant Préférences, puis en
accédant à l'onglet Raccourcis. Une fois là-bas, Tab vous amènera à la liste des raccourcis, et vous pourrez naviguer
dans la liste directement avec les touches de curseur Haut et Bas, mais c'est une très longue liste. Vous pouvez à la place
appuyer sur Tab plusieurs fois pour atteindre la zone de recherche, puis taper les premiers caractères de la commande
pour filtrer la liste, puis revenir à la liste.

Une fois que vous avez trouvé la commande que vous souhaitez personnaliser, appuyez sur Entrée. Vous pouvez ensuite
appuyer sur la combinaison de touches que vous souhaitez utiliser comme raccourci. Il peut s'agir d'une seule touche,
d'une touche avec Shift, Ctrl et / ou d'autres modificateurs, ou même d'une séquence ou de deux touches ou plus
enfoncées successivement. Après avoir entré le raccourci souhaité, appuyez sur Tab pour accéder au bouton Ajouter ou
Remplacer (Tab est la seule touche qui ne sera pas interprétée comme faisant partie d'une séquence de raccourcis). Si
vous atteignez Annuler sans jamais voir Ajouter ou Remplacer, cela signifie que le raccourci que vous choisissez est en
conflit avec un autre. Revenez à l'endroit où vous avez tapé le raccourci et il vous indiquera le nom de la commande avec
laquelle il est en conflit. Appuyez sur Tab pour accéder au bouton Effacer pour l'effacer, puis réessayez avec un autre
raccourci.

À un moment donné, nous pouvons fournir un ensemble de raccourcis spéciaux optimisés pour l'accessibilité. Il existe
déjà une fonction dans la boîte de dialogue des raccourcis pour enregistrer et charger les définitions de raccourcis, il est
donc possible de partager des définitions de raccourcis avec d'autres utilisateurs.

Liens externes

MuseScore Accessibility Demo (YouTube)
Creating a New Score in MuseScore with NVDA  (MuseScore Tutorial en anglais)
Inputting notes in MuseScore with NVDA  (MuseScore Tutorial en anglais)
Creating Modified Stave Notation in MuseScore  (MuseScore Tutorial en anglais)

Albums

The Album feature has been disabled for 3.x. It will come back in 4.0.

The Album Manager allows you to prepare a list of multiple scores and save the list as an album file ("*.album"), print all
the scores as one long print job with consistent page numbers, or even join the scores into a single new MSCZ score.
This is ideal for preparing an exercise book or combining multiple movements of an orchestration.

To open the Album Manager, go to File → Album...
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Create album

1. To create a new album, click the New button. Fill in a title in the "Album Name:" box at the top.
2. To add scores to the album, click Add Score. A file selection dialog will appear and let you choose one or multiple

scores from your file system. Click OK.
3. The scores you add will appear in a list in the Album Manager. You can rearrange their order by selecting a score

and clicking the Up or Down button.

Load album

If you have previously created an album, you can open it through the Album Manager by clicking the Load button. A file
selection dialog will appear to let you load the .album file from your file system.

Print album

To print an album as if it were a single document, click Print Album. The scores loaded into the Album Manager are printed
in the order they are listed in with the correct page numbers, ignoring the page number offset values in Layout → Page
Settings... → First page number for all but the first score. As the album is printed in one print job, double-sided printing (duplex
printing) also works as expected.

Join scores

To combine multiple scores into a single .mscz file, click Join Scores. The scores are combined in the selected order into
one single score. If not already present, line- and section breaks are added to the last measure or frame of each score in
the combined file.
All style settings are taken from the first score, different style settings from subsequent score are ignored.

All the scores should have the same number of parts and staves for this to work correctly, ideally with the same
instruments in the same order. If the scores have the same total number of instruments but not the same ones, or not in
the same order, then the instrument names from the first score will overwrite ones from subsequent scores. If some of the
scores have fewer instruments than the first score, then empty staves will be created for those sections. Any part or staff
that is not present in the first score will be lost in the joined score.

Save album

Upon clicking the Close button, you will be prompted to save your album as a .album file. This file is not the same as a
joined score; it simply consists of the list of scores. Album files can be loaded into the Album Manager as described
above.

Basses chiffrées

Ajouter des indications de basses chiffrées

1. Sélectionner la note à laquelle s'applique la basse chiffrée.
2. Utiliser le raccourci clavier Basse chiffrée. Par défaut, il s'agit de la combinaison Ctrl+G (Mac: Command+G) : cela peut

être modifié dans Préférences : Raccourcis si nécessaire.
3. Saisir la basse chiffrée dans la boîte de saisie qui s'affiche (voir ci-dessous).

4. Utiliser l'une des techniques suivantes :

Utiliser la touche Espace pour se déplacer à la note suivante pour saisir la prochaine basse chiffrée (ou cliquer
en dehors de la boîte de saisie pour en sortir). La boîte de saisie passe à la note suivante. Pour passer à un
point intermédiaire, ou pour prolonger la durée d'une indication de basse chiffrée, voir Durée (ci-dessous).
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Maj+Espace déplace la boîte d'édition à la note ou au silence précédent.
Tab avance la boîte d'édition au début de la mesure suivante.
Maj+Tab recule la boîte d'édition au début de la mesure précédente

Format du texte

Chiffres

Les chiffres sont à saisir directement. Une indication de basse chiffrée avec plusieurs chiffres placés les uns sur les
autres est obtenu en empilant les chiffres avec la touche Entrée :

Altérations

Les altérations peuvent être saisies avec des touches de clavier suivantes :

Pour afficher un
:

Taper
:

double bémol bb
bémol b
bécarre h
dièse #
double dièse ##

Ces caractères se transformeront automatiquement en symboles appropriés lorsque l'on sortira de la boîte de saisie. Les
altérations peuvent être saisies avant, après ou à la place d'un chiffre (pour les tierces modifiées). Les chiffres seront
correctement alignés, l'altération se trouvant décalée sur la gauche ou sur la droite.

Chiffres barrés et chiffres avec une croix

Les chiffres barrés et les chiffres avec une croix sont à saisir en ajoutant \, / ou + après le chiffre. Le chiffre barré ou avec
croix correct sera affiché après être sorti de la boîte de saisie :
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La police de caractères intégrée peut afficher les chiffres barrés ou les chiffres avec une croix, en favorisant la substitution
la plus courante :

1+, 2+, 3+, 4+ donnent  (notation Moderne) ou ) (notation Historique)

5/, 6/, 7/, 8/, 9/ donnent  (notation Moderne) ou ) (notation Historique)

Il faut se souvenir que / ne peut être combiné qu'avec 5. Toute autre chiffre combiné avec / s'affichera sous la forme d'un
point d'interrogation.

+ peut également être utilisé avant un chiffre. Dans ce cas, il ne sera pas combiné mais affiché correctement aligné avec
un '+' sur le coté gauche.

Parenthèses

Les parenthèses ouvertes et fermées, aussi bien rondes : '(', ')' que carrées : '[', ']', peuvent être insérées avant et après
les altérations, avant et après les chiffres, avant et après une ligne de continuation. L'ajout de parenthèses ne perturbera
pas le bon alignement du résultat.

Remarques :
(1) L'éditeur ne vérifie pas que les parenthèses, ouvertes et fermées, rondes ou carrées, sont correctement équilibrées.
(2) Plusieurs parenthèses dans une rangée ne sont pas une saisie correcte et empêchent la reconnaissance du texte
saisi.
(3) Une parenthèse entre un chiffre et un suffixe de combinaison ("+", "\", "/") est acceptée, mais empêche la
combinaison.

Lignes de continuation

Les lignes de continuation sont saisies en ajoutant un "_" (soulignement) à la fin de la ligne. Chaque chiffre d'une
indication de basse chiffrée peut avoir sa propre ligne de continuation :

Des lignes de continuation sont tracées pour toute la durée de l'indication de basse chiffrée.

Lignes de continuation 'Étendues'

Parfois, une ligne de continuation doit être reliée à la ligne de continuation d'une indication suivante lorsqu'un degré
d'accord doit être maintenu entre deux indications de basse chiffrées. Des exemples (tous deux de J. Boismortier, Pièces
de viole, op. 31, Paris 1730) :

Dans le premier cas, chaque indication de basse chiffrée a sa propre ligne de continuation ; dans le second, la ligne de
continuation de la première indication est reportée "dans" la seconde.

Pour obtenir cela, saisir plusieurs (deux ou plus) caractères de soulignement "__" à la fin de la ligne de texte de la
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première indication de basse chiffrée.

Durée

Chaque indication de basse chiffrée a une durée indiquée par une ligne dessinée gris clair au-dessus. Cette ligne n'est
visible qu'à l'écran et ne sera pas imprimée ni exportée en PDF.

Au départ, une indication de basse chiffrée a la même durée que la note à laquelle elle est attachée. Une durée différente
peut être nécessaire pour faire tenir plusieurs indications sous une seule note ou pour étendre une indication sur plusieurs
notes.

Pour ce faire, chaque combinaison de touches du tableau ci-dessous peut être utilisée pour (1) avancer la boîte de saisie
de la durée indiquée, et (2) régler la durée de l'indication précédente à la nouvelle position de la boîte de saisie.

En appuyant consécutivement sur plusieurs d'entre elles en séquence sans saisie de chiffre, on prolonge l'indication
précédente de manière cumulée.

Saisir
: Pour obtenir :

Ctrl+1 quadruple croche
Ctrl+2 triple croche
Ctrl+3 double croche
Ctrl+4 croche
Ctrl+5 noire
Ctrl+6 blanche
Ctrl+7 ronde
Ctrl+8 2 rondes

(Les chiffres utilisés sont les mêmes que ceux utilisés pour fixer la durée des notes)

Le réglage de la durée exacte de l'indication de basse chiffrée n'est obligatoire que dans deux cas :

1. Lorsque plusieurs indications sont réunis sous une seule note de la portée (il n'y a pas d'autre moyen).
2. Lorsque des lignes de continuation sont utilisées, car la longueur de la ligne dépend de la durée de l'indication.

Cependant, il est bon de toujours fixer la durée à la valeur prévue pour les besoins des plugins et de MusicXML.

Modification de basses chiffrées existantes

Pour modifier une indication de basse chiffrée existante, utilisez l'une des options suivantes :

La sélectionner, ou la note à laquelle elle appartient et appuyer sur le même raccourci Basse chiffrée que celui
utilisé pour en créer une nouvelle.
Double-cliquer sur l'indication de nasse chiffrée.

La boîte de saisie s'ouvrira et le texte sera reconverti en caractères simples ("b", "#" et "h" pour les altérations, les suffixes
de combinaison séparés, les soulignements, etc.

Une fois la saisie terminée, appuyer sur Space pour passer à une note suivante, ou cliquer en dehors de la boîte de
l'éditeur pour la quitter.

Style

Pour configurer le rendu des indications de basse chiffrée : dans le menu, sélectionner Format &rarr ; Style... &rarr ; Basse
chiffrée.
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Police : La liste déroulante contient toutes les polices disponibles pour les indications de basse chiffrée. Une
installation standard ne contient qu'une seule police, "MuseScore Figured Bass". C'est la police par défaut.
Taille : Sélectionner une taille de police en points. Note : Cette valeur sera modifiée par tout changement apporté ici
: Échelle (Format &rarr ; Paramètres de la page...), ou là : Échelle ("Propriétés de la portée").
Position verticale : La distance (en sp) entre le haut de la portée et la marge supérieure du texte de la basse
chiffrée. Les valeurs négatives montent (basse chiffrée au-dessus de la portée) et les valeurs positives descendent
(basse chiffrée en dessous de la portée : une valeur supérieure à 4 est nécessaire pour enjamber la portée elle-
même).

Hauteur de la ligne : La distance entre la ligne de base de chaque ligne de basse chiffrée, en pourcentage de la
taille de la police.

L'image suivante visualise chaque paramètre numérique :

Alignement : Sélectionner l'alignement vertical : avec Haut, la ligne supérieure de chaque indication est alignée
avec la position verticale principale et l'indication "pend" de celle-ci (ceci est normalement utilisé avec la notation
des basses chiffrées et est la valeur par défaut) ; avec Bas, la ligne inférieure est alignée avec la position verticale
principale et l'indication "reste" dessus (ceci est parfois utilisé dans certains types de notations d'analyse
harmonique) :

Style : Choisir entre "Moderne" or "Historique". La différence entre les deux styles est montrée ci-dessous :

Syntaxe correcte

Pour que les substitutions et les combinaisons de formes pertinentes prennent effet et pour un alignement correct, le
mécanisme de la basse chiffrée s'attend à ce que les textes d'entrée suivent certaines règles (qui sont, en tout cas, les
règles pour une indication syntaxique de la basse chiffrée) :

Il ne peut y avoir qu'une seule altération (avant ou après), ou un seul suffixe de combinaison par figure ;
Il ne peut y avoir à la fois une altération et un suffixe combinatoire ;
Il peut y avoir une altération sans chiffre (tierce altérée), mais pas de suffixe combinatoire sans chiffre.
Tout autre caractère non mentionné ci-dessus ne sera pas analysé.
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Si un texte saisi ne respecte pas ces règles, il ne sera pas traité : il sera stocké et affiché tel quel, sans aucune mise en
page.

Résumé des touches

Type: to get:
Ctrl+G Ajoute une nouvelle indication de basse chiffrée à la note sélectionnée.
Espace Avance la boîte de saisie à la note suivante.
Maj+Espace Recule la boîte de saisie vers la note précédente.
Tab Avance la boîte de saisie à la mesure suivante.
Maj+Tab Recule la boîte de saisie vers la mesure précédente.
Ctrl+1 Avance la boîte de saisie d'une quadruple croche, et fixe la durée de l'indication précédente.
Ctrl+2 Avance la boîte de saisie d'une triple croche, et fixe la durée de l'indication précédente.
Ctrl+3 Avance la boîte de saisie d'une double croche, et fixe la durée de l'indication précédente.
Ctrl+4 Avance la boîte de saisie d'une croche, et fixe la durée de l'indication précédente.
Ctrl+5 Avance la boîte de saisie d'une noire, et fixe la durée de l'indication précédente.
Ctrl+6 Avance la boîte de saisie d'une blanche, et fixe la durée de l'indication précédente.
Ctrl+7 Avance la boîte de saisie d'une ronde, et fixe la durée de l'indication précédente.
Ctrl+8 Avance la boîte de saisie d'une ronde carrée, et fixe la durée de l'indication précédente.

Ctrl+Espace
Entre un espace réel ; utile lorsque le chiffre apparaît "sur la deuxième ligne" (par exemple, 5 4 ->
3).

BB Entrée d'un double bémol.
B Entrée d'un bémol.
H Entrée d'un bécarre.
# Entrée d'un dièse.
## Entrée d'un double dièse.
_ Entrée d'un ligne de continuation.
__ Entrée d'un ligne de continuation étandue.

Note: Pour Mac, la touche Ctrl est à remplacer par la touche Command.

Changement de type de portée

Vous pouvez changer l'apparence d'une portée en ajoutant un élément changement de type de portée à une mesure, et
en ajustant ses propriétés dans l'Inspecteur.

Ajouter un changement de type de portée

1. Sélectionnez une mesure dans la partition et, dans la palette Texte, cliquez (double-clic avant la version 3.4) sur

l'icône "Changement de type de portée",  (ici celle de la version 3.5.2) ; ou bien, faites glisser cette icône
"Changement de type de portée" sur une mesure ;

2. Sélectionnez l'icône ainsi positionnée sur la portée, et ajustez selon vos besoins ses propriétés (voir ci-dessous)
grâce à l'Inspecteur

Propriétés de changement de type de portée

Lorsque vous modifiez une propriété de changement de type de portée dans l'inspecteur, la nouvelle valeur a priorité
sur la valeur affichée dans la boîte de dialogue globale Propriétés de portée/partie. Seules les valeurs de propriété dans
"Propriétés de portée/partie" qui ne peuvent pas être modifiées dans le dialogue "changement de type de portée" seront
valables pour l'ensemble de la partition.

Les propriétés qui peuvent être modifiées dans le dialogue Changement de type de portéel dans l'Inspecteur sont :

Décalage
La distance à laquelle la portée modifiée doit être déplacée vers le haut ou vers le bas : mesurée en espaces (abbr. : sp) .

Taille réduite
Cochez la case pour créer une portée réduite.

Échelle
Modifie la taille de la portée et de tous les éléments qui lui sont associés, le tout exprimé en pourcentage.

Lignes
Détermine le nombre de lignes composant la portée.

interlignes
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La distance des interligne mesurée en espaces (abbr. : sp)_.

Décalage de pas
Combien de pas vers le haut ou vers le bas pour les notes dans la portée.

Afficher les barres de mesure
Indique si les barres de portée seront affichées ou non.

Afficher les lignes supplémentaires
Indique si les lignes supplémentaire seront affichées pour les notes au-dessus/en dessous des lignes de portée.

Sans hampe
Si les notes doivent être affichées en style standard ou en barre oblique.

Type de tête de note
Permet de sélectionner le mode d'affichage des têtes de notes.

Générer les clefs
Si la clé de portée est affichée ou non.

Générer les indications de mesure
si la ou les indications de mesures de la portée seront ou non affichées.

Générer les armures
Si les armures des clés de la portée seront affichées ou non.

Exemple

Pour illustrer l'utilisation du changement de type de portée __, la portée illustrée ci-dessous a été créée en suivant les
étapes suivantes :

1. Ajouter un changement de type de portée à la mesure 2.
2. 2. Définir la taille sur "Taille réduite".
3. Mettre "Lignes" sur 4.
4. Ajouter un deuxième changement de type de portée à la mesure 3.

5. Indiquer 7 dans "Lignes",

Ensuite, les propriétés globales de la portée sont modifiées en utilisant Propriété de portée/partie :

1 Mettez "Lignes" sur 2.
2. Changez la "Couleur des lignes de la portée".

Comme on peut le voir, le changement de "Lignes" n'est effectif que jusqu'au premier changement de type de portée,
alors que le changement de "Couleur des lignes de port&e" est mis en place sur toute la partition.

Comparaison de partitions

L'outil de comparaison de partitions vous permet de comparer deux versions d'une partition pour trouver les différences
entre elles.

Introduction

Pour ouvrir l'outil de comparaison des partitions :

Dans le menu, sélectionnez Affichage→Outil de comparaison des partitions .
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Le dialogue s'ouvre sous la fenêtre du document et se compose de trois sections (de gauche à droite) :

Choisissez les partitions à comparer : Sélectionnez les partitions que vous voulez comparer.
Mode Diff : Sélectionnez la façon dont vous souhaitez afficher la comparaison.
Comparaison de : Une comparaison ligne par ligne des partitions est affichée.

Sélectionner la partition {#score}.

La première étape consiste à sélectionner la parttion. Utiliser la liste déroulante à côté de "Partition 1" pour choisir entre
les partitiond actuellement ouverts, ou cliquer sur le bouton Parcourir pour ouvrir l'explorateur de fichiers et sélectionner une
partition sur votre disque dur. Ensuite, utiliser la liste déroulante sur la droite pour choisir si la première partition doit être
la version actuelle ou la dernière version enregistrée. La partition 2 est le même que celui que vous avez sélectionné pour
le score 1, mais vous pouvez choisir une autre des partitions ouvertes.

Lorsque vous avez sélectionné les partitions et les versions, appuyer sur Comparer pour effectuer la comparaison.

Choisir la vue

"Comparaison intelligente" est l'option par défaut en mode Diff : elle affiche les différences entre les patitions dans un
format lisible par l'homme (par exemple "Mesure 2 : Accord : élément effacée Note"). Modifier la sélection de Diff Mode
en "Raw" si vous préférez voir les résultats affichés en code XML.

Voir la comparaison

Lorsque vous appuyez sur Comparer, une liste de différences s'affiche à droite, et la vue des partitions passe
automatiquement en 'documents côte à côte'. Dans la section Comparaison, double-cliquez sur une différence de la liste
et les deux vues de la partition se déplaceront automatiquement pour vous montrer l'élément modifié, qui sera également
mis en évidence.

Quitter la comparaison

Pour quitter l'outil de comparaison des scores, désactivez les deux options "Outil de comparaison des scores" et
"Documents côte à côte" dans le menu Affichage.

Exemple

Vous trouverez ci-dessous deux petites partitions avec quelques différences entre elles.

Dernière sauvegarde :

Courant :
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Le résultat de la comparaison ressemblera à ceci :

Diagrammes d'accord

Note : Cette page s'applique uniquement pour les versions de MuseScore à partir de la 3.1. Les utilisateurs des versions
antérieures doivent se rendre à Diagrammes d'accord (versions antérieures à 3.1)._

Aperçu des diagrammes d'accords

MuseScore permet l'utilisation et la création de diagrammes d'accord. Ils apparaissent généralement au-dessus de la
portée sur les "lead sheets" (mélodie/accords) et les partitions de piano. Ils sont couramment utilisés pour les accords de
guitare, mais MuseScore permet la création de diagrammes pour n'importe quel instrument.

Vous trouverez ci-dessous un exemple simple d'utilisation des diagrammes d'accord.

(Remarque : le diagramme d'accord est une alternative, (il est très différent de la notion de tablature, qui est une forme de
notation spécialisée qu'apprécient certains joueurs d'instruments à cordes).

Le mécanisme des diagrammes d'accord peut être utilisé de plusieurs façons différentes.

1. Accords standards. Un ensemble de 21 diagrammes d'accords courants pour la guitare se trouve dans les
diagrammes d'accords palette dans l'espace de travail avancé. Ces diagrammes consistent en un seul exemple
d'accord majeur, mineur et septième pour chaque ton de la gamme diatonique (CDEFGAB). Ces 21 accords
conviennent à de nombreuses partitions de musique pop ou folk. Voir la [vue d'ensemble de cette palette]
(#overview-of-standard-chords) ci-dessous.
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2. Accords personnalisés. Dans de nombreux cas, les accords standards de la palette 'Diagramme d'accord' sont
utilisés comme point de départ pour créer des diagrammes d'accords modifiés, via l'Inspecteur. Cette technique
permet d'appliquer aux 21 diagrammes standard des extensions d'accords, des modifications, des hauteurs
différentes, des positions différentes, etc. Il existe littéralement des milliers d'accords de guitare d'usage général, ce
qui rend une palette complète ou un dictionnaire peu pratique. Voir Comment utiliser les diagrammes d'accord pour
les accords personnalisés/complexes .

3. Accords "à main levée". Les guitaristes plus avancés préfèrent souvent partir d'une grille d'accords vierge, puis
dessiner les tonalités d'accords spécifiques souhaitées. Voir Comment utiliser les diagrammes d'accord pour les
accords personnalisés/complexes .

Note : De nombreux aspects de la notation musicale suivent des normes d'édition bien établies. Les diagrammes
d'accords de guitare sont une exception. L'utilisation a beaucoup varié d'une année à l'autre, d'un éditeur à l'autre, d'un
professeur à l'autre et d'un arrangeur à l'autre. De nombreuses pratiques incohérentes persistent aujourd'hui, et des styles
distincts de notation d'accords sont préférés dans différents genres musicaux et régions. Pour cette raison, l'interface
MuseScore 'Diagramme d'accord' prend en charge des diagrammes de différents types. Les utilisateurs sont libres de
choisir leurs préférences.

Aperçu de la palette d'accords standard de guitare

La palette 'Diagramme d'accord' dans l'espace de travail avancé fournit 21 diagrammes, comprenant un seul accord
majeur, mineur et septième pour chaque ton de la gamme diatonique (CDEFGAB). Le nom de chaque diagramme
apparaît lorsque le curseur survole le pictogramme.

Note : Cette gamme de diagrammes d'accords, ou même une sélection de 21 accords, ne serait pas suffisante pour la
publication. Les arrangeurs doivent tenir compte de nombreuses autres voix, positions et qualités d'accords. Cette palette
est également un exemple des divers formats de diagrammes utilisés, comme nous l'avons vu plus haut. Ces 21 accords
intègrent par hasard des indicateurs de __cordes à vide/non jouées (les symboles O et X au-dessus des diagrammes)_.
Bien que ces symboles peuvent apparaître souvent dans les partitions publiées, leur utilisation varie selon le contexte. Par
exemple, les arrangements de jazz omettent généralement les indicateurs de cordes muettes, sauf si le contexte est
important, et utilisent rarement des cordes à vide.

D'autres palettes contenant un plus grand nombre d'accords standard devraient être disponibles à l'avenir. Ces palettes
pourraient répondre aux besoins de genres musicaux et de situations spécifiques.

Aperçu de la création d'accords modifiés ou personnalisés

Les Diagrammes d'accord modifiés sont créés en ajoutant puis en modifiant un diagramme existant de la palette. En
modifiant les accords standard, il est possible de créer des diagrammes d'accord pour n'importe quel accord jouable, et de
refléter le doigté de n'importe quel instrument à cordes frettées occidental, indépendamment de l'accord, du nombre de
cordes ou du nombre de frettes. La plupart des informations ci-dessous concernent le processus de modification des
diagrammes et de création de nouveaux diagrammes.

Les diagrammes modifiées peuvent être enregistrés dans une palette personnalisée si vous le souhaitez pour une
utilisation ultérieure. Bien entendu, les diagrammes modifiés peuvent être copiés/collés dans une partition de la manière
habituelle.

Création d'un diagramme d'accord

Pour ajouter un diagramme d'accord à la partition, il convient d'utiliser l'une des méthodes suivantes :

Sélectionner une note dans la voix 1 et double-cliquer sur un diagramme d'accord grâce à la palette.
ou
Faire glisser un diagramme d'accord depuis la palette jusqu'à la position souhaitée dans la partition.

199

https://musescore.org/fr/node/289836
https://musescore.org/fr/node/289836


Lorsque le curseur survole le diagramme d'accord choisi dans la palette, son nom apparaîtra dans une bulle d'aide (voir
l'exemple dans la vue d'ensemble).

Symboles d'accords liés aux diagrammes d'accord

Lorsque l'on ajoute un diagramme d'accord sur une partition, un symbole d'accord est également créé automatiquement.
Le symbole d'accord est normalement placé au-dessus du diagramme, et utilise le nom de l'accord dans la cellule de la
palette d'accords. Le placement et la mise en forme automatiques du symbole d'accord d'un diagramme sont contrôlés
par les paramètres de style (voir [paramètres de style] (#fretboard-diagram-style), ci-dessous).

Le symbole d'accord généré par un diagramme d'accord peut être sélectionné, déplacé et modifié comme n'importe quel
autre élément de texte. Il se comporte généralement comme les symboles d'accord standard __ qui sont ajoutés en
utilisant Ajouter→Texte→Symboles d'accord ou le raccourci Ctrl+K.

Note 1 : Un champ sur la page de style Symboles d'accord (Style submenu : select Format→Style...→[node :
278570,fragment="style-chord-symbols",title="Symbole d'accord"]) &ndash ; plutôt que la page de style du Diagramme d'accord
&ndash ; controle la "Distance au diagramme d'accord" du symbole d'accord.

Cette valeur interagit avec le champ de l'élément "Distance minimum", de l'inspecteur, pour contrôler le placement
automatique du symbole d'accord par rapport au diagramme. Notez également que la "partie supérieure" du diagramme
comprend un espace où peuvent apparaître des indicateurs de corde à vide/non jouée, même si cette zone est vide. Cela
peut donc laisser un espace plus grand que ce qui est souhaité. Comme d'habitude, le placement manuel peut être utilisé
pour passer outre ces réglages automatiques.

Note 2 : Les symboles d'accords automatiquement générés pour les diagrammes d'accord ne sont pas complètement
intégrés aux symboles d'accords normaux qui peuvent être directement associés aux notes de la portée. Plus
précisément, le focus ne se fait pas sur le symbole d'accord d'un diagramme d'accord pour revenir à la séquence des
autres symboles de la page lorsque l'on utilise Espace pour se déplacer dans les symboles d'accord. Ce problème mineur
sera traité dans une prochaine mise à jour).

Utilisation des symboles d'accords avec les diagrammes d'accord

Ajouter un symbole d'accord sur un diagramme, c'est simplement suivre la description ci-dessus.
Supprimer le symbole d'accord d'un diagramme en le sélectionnant puis en le supprimant, comme pour tout élément
de texte.
Ajouter un nouveau symbole d'accord à un diagramme qui n'en possède pas, nécessite de le sélectionner et
d'utiliser Ajouter→Texte→[node : 278623,title="Symbole d'accord"]  ou le raccourci Ctrl+K.

Ajuster les propriétés des éléments d'un diagramme d'accord (position, taille, couleur etc.)
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La position peut être ajustée à l'aide des flèches du clavier dans le mode Édition ; ou avec les décalages X et Y dans la
section "Élement" en haut de l'Inspecteur.

La visibilité, la couleur et la position peuvent également être ajustés dans la section "Élément" : voir le diagramme sous
édition.

Ajuster les propriétés de style d'un diagramme

Certaines propriétés par défaut et globales (voir le diagramme ci-dessous) peuvent être ajustées à partir du sous-menu
Style : select Format→Style...→Diagramme d'accords. Certaines de ces propriétés peuvent être modifiées par l'intermédiaire de
l'Inspecteur ; mais la plupart affectent tous les diagrammes de la partition.

Position verticale par défaut spécifie le placement par défaut du diagramme par rapport à la portée. (jusqu'à la
limite acceptée par l'inspecteur).
Échelle spécifie l'échelle par défaut (c'est-à-dire la taille du diagramme). (Peut être modifié par l'inspecteur).
Taille de la police du numéro de frette et ...position contrôlent le placement des numéros de frette sur tous les
diagrammes. (Global).
_Épaisseur de la ligne du barré__ contrôle la taille de la ligne utilisée pour représenter un barré sur tous les
diagrammes. Par défaut, il s'agit de la même épaisseur que les points pleins. Une ligne plus petite permettra aux
points d'être visibles sous le barré, pour les situations où cela est souhaitable. (Global).
La taille relative du point contrôle la taille des points sur tous les diagrammes, par rapport à la taille de la grille
mise à l'échelle. (Global).
Espacement des cordes contrôle l'espacement entre les cordes, et donc la largeur totale de tous les diagrammes.
(Global).
Espacement des frettes contrôle l'espacement entre les frettes, et donc la hauteur totale de tous les diagrammes
par rapport au nombre de frettes qu'ils affichent. (Global).

Certaines propriétés indiquées par l'Inspecteur offrent des boutons "réinitialiser au style par défaut" et "Définir comme
style par défaut". Ces valeurs n'apparaissent généralement pas sur la page de style, mais sont utilisables dans
l'inspecteur.

Éditer un diagramme d'accord

Lorsqu'un diagramme est sélectionné, il peut être édité grâce à l'Inspecteur comme suit :

L'Inspecteur affiche trois sections relatives au diagramme :

Une section Élément qui contrôle la visibilité, le placement, la couleur et d'autres aspects du diagramme utilisés en
commun avec d'autres éléments MuseScore ; voir [ajuster les propriétés de l'élément] (#ajust-position-color) et
l'Inspecteur pour plus de détails.
Une section Diagramme d'accord, avec des champs de contrôle et des boutons qui définissent l'apparence de ce
diagramme.
Une version agrandie du diagramme, montrant ses détails et permettant son édition.

Vous trouverez ci-dessous un exemple d'Inspecteur avec un diagramme d'accord sélectionné.
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Editer les propriétés d'un diagramme d'accord

(Voir les propriétés de l'inspecteur ci-dessus dans l'exemple édition).

Pour ajuster l'échelle __ (taille)__ du diagramme : utilisez _Échelle __.
Pour ajuster la position du diagramme par rapport à la portée : utilisez Position.
Pour ajuster le nombre de cordes de l'instrument : Utilisez __Cordes. Les cordes sont ajoutées/supprimées dans
la partie gauche du diagramme.
Pour ajuster le nombre de frettes à afficher (c'est-à-dire la hauteur du diagramme) : Utilisez Frettes. Les frettes
sont ajoutées/supprimées en bas du diagramme.
Pour ajuster la première position des frettes : Utiliser le Numéro de frette. Un chiffre est affiché à côté de la
première frette visible.
Pour spécifier l'épaississement du 'sillet de tête' (une ligne épaisse au-dessus de la première frette) : Utilisez
Afficher le sillet.
Placez les positions de doigts comme décrit ci-dessous.

Éditer les points de doigt (utilisation de base)

(Voir les propriétés de l'inspecteur ci-dessus dans l'exemple édition).

Pour supprimer tous les points courantes, utiliser le bouton "Effacer" au-dessus du diagramme. (Remarque :
vous pouvez enregistrer une grille vierge dans une palette personnalisée, comme point de départ pour les
diagrammes personnalisés).
Pour créer un point, cliquer sur une frette dans le diagramme en bas de l'inspecteur puis cliquez à nouveau
Pour déplacer un point, effacer sa position actuelle en cliquant dessus ; puis créer le point souhaité.
Pour créer un barré ou un petit barré : Cliquer sur le bouton "Barré" au-dessus du diagramme ; puis cliquer à la
position la plus à gauche souhaitée pour le barré. Le barré s'étendra jusqu'au bord droit du manche. Raccourci
clavier: En maintenant la touche Maj, cliquer sur la corde où vous voulez qu'un barré commence.
Pour terminer un barré avant la corde la plus à droite, cliquer sur la corde où vous voulez qu'un barré commence :
Cliquer sur le bouton "Barré" au-dessus du diagramme ; puis cliquer sur la position la plus à droite souhaitée sur un
barré existant. Le barré se terminera à cette note. Raccourci clavier : en maintenant la touche Maj, cliquer sur la
corde où vous voulez que le barré se termine.
Pour supprimer un barré : Cliquer sur le bouton "Barré" au-dessus du diagramme ; puis cliquer à la position la
plus à gauche du barré. Elle sera supprimée. Raccourci clavier : en maintenant la touche Maj, cliquer sur la position
la plus à gauche du barré.
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Pour créer plusieurs barrés : Utiliser les étapes ci-dessus pour créer un seul barré, par exemple pour montrer le
troisième doigt couvrant deux cordes.
Pour régler l'épaisseur du barré : Utiliser les options de style (Format->Style->Diagramme d'accord) pour ajuster
l'épaisseur des lignes de la barre par rapport aux points. Cela permettra aux points d'être visibles sur le barré, dans
le cas où cela est souhaité.
Pour Indiquer les cordes à vide et non jouées (facultatif). Cliquer juste au-dessus du diagramme pour faire
basculer une chaîne entre les deux :

À vide (o)
Muette/non jouée (x)
Pas d'indication

Édition de points multiples de doigt (utilisation avancée)

Certains arrangeurs et professeurs de musique utilisent une forme plus avancée de diagramme d'accord qui a) incorpore
plusieurs types de "points", et qui b) permet plusieurs points par corde.

Cette technique est particulièrement associée aux nombreux livres et arrangements publiés par Ted Greene et ses
successeurs. (Remarque : aucun autre logiciel de notation ne prend actuellement en charge ce style de diagramme).

Type de notation à points multiples. Avec cette approche, les points ronds sont joués en premier. Puis, sur des
temps successifs, les notes représentées par les autres points sont ensuite jouées dans l'ordre. Cela permet à un
seul diagramme de représenter plusieurs temps de musique. (La séquence habituelle est la suivante :
point→X→carré→triangle. L'utilisation varie cependant). Voici deux exemples de diagrammes à points multiples.

Notation optionnelle. Une autre utilisation de plusieurs points par corde permet à d'autres symboles d'afficher des notes
facultatives, plutôt que des notes différées. En général, une voix d'accord connexe est affichée, comme une extension
optionnelle ou une autre version d'accord. Voici un exemple d'extension optionnelle.

Les Diagrammes d'accord dans MuseScore permettent la création de ces diagrammes et d'autres types de diagrammes
multi-symboles. Un accord est d'abord créé et édité en utilisant les [étapes de base décrites ci-dessus] (#edit-fretboardd-
diagram). Ensuite, les boutons _Plusieurs points__ au-dessus du diagramme sont utilisés pour ajouter des notes
secondaires.

1. Pour commencer à ajouter des points multiples (c'est-à-dire des symboles) à un diagramme, cliquer sur
"Plusieurs points".
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2. Pour ajouter un autre point à une corde, cliquer au-dessus ou au-dessous d'un symbole existant. Le symbole
suivant dans la séquence sera placé à cette position, par exemple s'il y a déjà un point, un X apparaîtra ensuite.

3. Pour supprimer un symbole d'un diagramme, cliquer dessus.
4. Pour __ entrer un symbole particulier hors séquence__, cliquer sur le bouton avec ce symbole avant d'ajouter le

point ; par exemple, pour entrer un X sur une corde sans point courant, parce que cette note doit être jouée après le
reste de l'accord, cliquer sur le X et le placer à la position désirée.

(Note : Les utilisateurs expérimentés des diagrammes de style Ted Greene constateront que plusieurs caractéristiques
secondaires des diagrammes de Ted ne sont pas encore prises en charge dans MuseScore. Il s'agit notamment de : a.
Afficher le numéro de frette sur une frette plus haute que la première frette visible. b. Permettre aux symboles des notes
d'inclure des chiffres, et non pas seulement les quatre styles de points actuellement pris en charge. c. Permettre la
création d'annotations sur et entre les diagrammes, comme par exemple encercler une note particulière, ou tracer des
lignes reliant les notes dans les diagrammes adjacents. Toutefois, MuseScore fournit de nombreux outils de dessin et
d'annotation qui peuvent servir pour ces techniques).

(Remarque : étant donné que les symboles multi-note ne sont pas normalisés, même au sein de la communauté Ted
Greene, les utilisateurs doivent veiller à indiquer comment ils sont utilisés pour une note donnée).

Liens externes

Comment utiliser les Diagrammes de notes pour les accords personnalisés/complexes  (MuseScore HowTo)
Palette avec diagrammes de notes pour mandoline  (Article du forum)
Palette avec diagrammes de notes pour Ukulele  (Article du forum)

Fretboard diagrams (prior to version 3.1)

Note: This page applies to versions of MuseScore prior to 3.1 only. Users of MuseScore 3.1 and above should go to
Fretboard diagrams.

A range of fretboard (or chord) diagrams for the guitar are provided in the Fretboard Diagrams palette in the Advanced
Workspace.

You can create a chord diagram for any fretted, stringed instrument by editing an existing one. It can be saved to a custom
palette for future use if required.

Add a fretboard diagram

To add a fretboard diagram to the score, use one of the following methods:

Select a note in voice 1 and double-click a fretboard diagram from a palette.
Drag and drop a fretboard diagram from a palette to the desired position in the score.

As the cursor hovers over the chosen diagram within the palette, its name will appear as a pop-up hint.

Edit a fretboard diagram

When a fretboard diagram is selected, it can be edited in the Inspector as follows:

To adjust the number of instrument strings: Use Strings.
To adjust the fret position number: Use Offset.
To adjust how many frets to display (height-wise): Use Frets.
To place the finger dots: Click on a fret to establish a dot; click again to remove the dot.
To create a barre or partial barre: First make sure that the desired fret position is clear of black dots (click on a dot
to remove it). Then, holding the Shift key, click on the string where you want the barre to begin. (Note: Only one barre
can be applied per diagram; a partial barre must end on the first string).
To delete a barre: Click on the black dot where the barre begins.
To Indicate open and mute strings (if applicable): Click just above the diagram to toggle a string between:

Open (o)
Mute/unplayed (x)
No indication.

To adjust the size: Use the Scale property.
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To adjust a diagram's element properties

The position of a Fretboard Diagram can be adjusted using the keyboard arrows in Edit mode; or with the X- and Y-
offsets in the "Element" section at the top of the Inspector.

Visibility, Color and Stacking order can also be adjusted from the "Element" section.

To adjust a diagram's style properties

Certain default and global properties of Fretboard Diagrams (e.g. barre thickness, vertical position, scale, fret-number
font-size and position) can be adjusted from the Style submenu: select Format→Style…→Fretboard Diagrams. Some of these
properties are subject to override via the Inspector; but most affect all Fretboard Diagrams in the score.

Fichiers récupérés

En cas de coupure inopinée de MuseScore ou de votre ordinateur, un message contextuel vous demandera, au
redémarrage de MuseScore, si vous souhaitez restaurer la session précédente :

Cliquez sur Oui, pour lancer la tentative de récupération des fichiers de la session interrompue. Ou cliquez sur Non
pour ignorer le message.

Sauvegarde après récupération de session

Lorsque MuseScore récupère des fichiers après un plantage, il les renomme en ajoutant le nom du chemin complet
devant le nom du fichier d'origine. Ce nom très long apparaîtra dans le(s) onglet(s) au-dessus de la fenêtre de partition
active.

Pour s'assurer que le fichier est enregistré à son emplacement d'origine_. Vous devez immédiatement enregistrer le
fichier restauré en utilisant l'option "Enregistrer sous..." : cela ouvrira une fenêtre pour vous permettre de naviguer vers le
bon dossier et le bon répertoire. Si vous utilisez la commande "Enregistrer" à la place, le fichier sera enregistré à son
emplacement actuel qui ne sera probablement pas celui d'origine.

Trouver des fichiers récupérés

Dans le cas où "Enregistrer" est utilisé au lieu de "Enregistrer sous..." avec un fichier récupéré, vous devrez trouver les fichiers
dans votre ordinateur. L'emplacement réel de ces fichiers variera en fonction de votre système d'exploitation et du
répertoire dans lequel MuseScore est installé.

Pour Windows 7, avec une installation par défaut de MuseScore dans le répertoire program files, les fichiers récupérés
sont automatiquement enregistrés dans C:\Program Files\MuseScore 3\bin (en fait %ProgramFiles%\MuseScore 3\bin).

Pour Windows 10, regardez dans C:\Users\[Nom d'utilisateur]\AppData\Local\MuseScore\MuseScore3 (en fait
%LOCALAPPDATA%\MuseScore\MuseScore3).

Vous devrez peut-être lancer une recherche à l'échelle du système afin de trouver les fichiers enregistrés directement
après une récupération de session. Utilisez des mots clés du nom de fichier original ainsi que des jokers, et indiquez la
date de modification.

Voir aussi

Ouvrir / Enregistrer / Exporter / Imprimer

Liens externes

Comment récupérer une copie de sauvegarde d'une partition  (How To MuseScore en Français)

Fonctionnalités pour musique ancienne

MuseScore offers several specialized functions to create engravings of early music (particularly medieval and
renaissance) akin to commercial editions from the 20th century onwards.

Unbarred (or unmetered) notation
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In MuseScore, notes lasting longer than the duration of a measure are normally tied across barlines. However MuseScore
has a special feature which allows it to display the note values intact, without splitting and tying them in this way. This
enables you to notate music which is unbarred (i.e. not divided into measures), such as that of the renaissance:

1. From the menu bar, select Format→Style...→Score.
2. Tick the box labelled "Display note values across measure boundaries … ."

3. Click "OK" or "Apply." The existing score is immediately updated.

Example

1. The example below shows an excerpt from the original score of "De Profundis Clamavi" for 4 voices by Nicolas
Champion:

2. The same excerpt displayed in MuseScore:

3. And after activating "Display note values across measure boundaries … ."

4. To get rid of the barlines, just untick the “Show barlines” box in the Staff / Part properties dialog. See also
Mensurstrich (below).

Note: The feature is still in development and may contain bugs. The longest supported note value is the longa (a dotted
longa is still broken up and tied over).

Mensurstrich

Since a complete lack of barlines could make performing the music more difficult for current musicians, many modern
engravers settled on a compromise called Mensurstrich, where barlines are drawn between, but not across, staves.

To place barlines between staves:

1. In the lowest staff (usually the bottom staff of a system) where the proposed Mensurstriche is required, uncheck
"Show barlines" in the Staff / Part Properties dialog;

2. In the staff above where you want the Mensurstriche, right-click on one barline and choose Select→All Similar Elements
(or select a set of barlines, one above the other, with Select→All Similar Elements in Range);

3. In the Barline section of the Inspector, tick the "Span to next staff" option;
4. In the Barline section of the Inspector, adjust the "Span from" value so that the top of the barlines meet the bottom

line of the staff;

Note: It is important to work from the lowest staff upwards.

Ambitus
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Before there was the concept of an absolute pitch, performers were required to transpose vocal music to a singable range
for their ensemble "on the fly." To aid them, an ambitus was sometimes included, marking the entire range of a voice at
the beginning of the piece.

To apply an ambitus, use one of the following methods:

Drag the ambitus symbol (from the Lines palette of the Advanced workspace) onto a clef.
Select one or more clefs, then click (double-click prior to version 3.4) the ambitus symbol (in the Lines palette of the
Advanced workspace).

When applied, the ambitus automatically displays the note range of the score: if there is a section break then only the note
range of the section is displayed. Beyond the section break a new ambitus may be applied.

The note range of the ambitus can be adjusted manually by selecting it and changing the "Top note" and "Bottom note"
values in the Inspector. For automatic adjustment click the Update Range button in the inspector.

Mensural time signatures

In the mensural notation system, time signatures did not define the length of a measure, but the length of breves and
semibreves. MuseScore supports mensural time symbols as a display method in the Time signature properties dialog
rather than as symbols, but they are just for show, as the proportion of e.g. half notes per whole notes cannot be modified.

One way to make use of these symbols is to replicate when composers of the renaissance had multiple voices in different
time signatures simultaneously without using tuplets. Edit the time signature on a per-staff basis, as long as the beginning
and end of a measure in all staves match up. If they do not, then consider increasing the size of the measures to the
lowest common denominator.

De Profundis Clamavi for 5 voices by Josquin Des Prez

See also

Measure Operations: Split and join

Formats de fichier

MuseScore peut importer et exporter une grande variété de formats de fichiers, ce qui vous permet de partager et de
publier des partitions dans le format qui répond le mieux à vos besoins.

MuseScore format natif

MuseScore sauvegarde les fichiers dans les formats natifs suivants :

*.mscz : Le format de fichier MuseScore par défaut. Il est compressé et prend relativement peu d'espace disque.
*.mscx : Un format de fichier MuseScore non compressé, principalement utilisé pour le débogage ou le stockage
dans un système de gestion de versions
.*.mscz, / .*.mscx, : Ce sont des fichiers de sauvegarde. Remarquez le point (point) ajouté avant le nom du fichier,
et la virgule ajoutée à l'extension du fichier.

Note sur les polices de caractères : MuseScore n'intègre pas de polices de texte dans les fichiers au format natif
enregistrés ou exportés. Si vous souhaitez que votre fichier MuseScore soit consulté par d'autres utilisateurs de
MuseScore, assurez-vous que vous utilisez les familles de polices FreeSerif ou FreeSans intégrées pour votre texte, ou
une police que les autres parties ont également installée. Si un système ne dispose pas des polices spécifiées dans votre
fichier d'origine, MuseScore utilisera une option de repli, ce qui pourrait faire apparaître votre score différemment.
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Format MuseScore (*.mscz)

MSCZ est le format de fichier standard de MuseScore, il est recommandé pour la plupart des utilisations. Une partition
enregistrée dans ce format prend très peu d'espace disque, mais conserve toutes les informations nécessaires. Ce format
est une version compressée au format ZIP des fichiers .mscx et comprend toutes les images que la partition peut contenir
ainsi qu'une vignette.

Format MuseScore non compressé ( *.mscx)

MSCX est la version non compressée du format de fichier MuseScore. Une partition enregistrée dans ce format
conservera toutes les informations, à l'exception des images. Il peut être ouvert avec un éditeur de texte, permettant à
l'utilisateur d'accéder au code source du fichier.

Fichier de sauvegarde MuseScore ( .*.mscz,) ou (.*.mscx,)

Les fichiers de sauvegarde sont créés automatiquement et enregistrés dans le même dossier que votre fichier MuseScore
normal. La copie de sauvegarde contient la version précédemment sauvegardée du fichier MuseScore et peut être
importante si votre copie normale devient corrompue, ou pour consulter une version plus ancienne du score.

Le fichier de sauvegarde ajoute un point au début du nom du fichier (.) et une virgule (,) à la fin (par exemple si votre
fichier normal s'appelle "untitled.mscz", la copie de sauvegarde sera ".untitled.mscz,"), et le point et la virgule doivent être
supprimés du nom afin d'ouvrir le fichier de sauvegarde dans MuseScore. Comme il est stocké dans le même dossier que
votre fichier MuseScore normal, vous devrez peut-être aussi lui donner un nom unique (par exemple, changer
".untitled.mscz," en "untitled-backup1.mscz").

Note : Pour voir les fichiers de sauvegarde de MuseScore, vous devrez peut-être modifier les paramètres de votre
système pour "Afficher les fichiers cachés". Voir aussi Comment récupérer une copie de sauvegarde d'une partition .

Fichiers graphiques (exportation uniquement)

MuseScore peut exporter exporter une partition sous forme de fichier graphique au format PDF, PNG ou SVG.

PDF (*.pdf)

Les fichiers PDF (Portable Document Format) sont les plus pratiques pour partager vos partitions avec d'autres personnes
qui n'ont pas besoin d'en modifier le contenu. C'est un format très répandu et la plupart des utilisateurs disposent d'une
sorte de visionneuse de PDF sur leur ordinateur : Importation de PDF-->

Pour régler la résolution des PDF exportés :

1. Dans la barre de menu, choisissez Édition→Préférences... (Mac : MuseScore→Préférences...), et sélectionnez l'onglet
"Exporter" ;

2. Définissez la résolution dans la section "PDF".

PNG (*.png)

Les fichiers PNG (Portable Network Graphics) sont basés sur un format d'image bitmap, largement pris en charge par les
logiciels sous Windows, Mac OS et Linux, et très populaire sur le web. MuseScore crée des images PNG telles qu'elles
apparaîtraient si elles étaient imprimées, une image par page.

Pour définir la résolution des images PNG exportées :

1. Dans la barre de menu, choisissez Édition→Préférences... (Mac : MuseScore→Préférences...), et sélectionnez l'onglet
"Exporter" ;

2. Réglez la résolution et la transparence dans la section PNG/SVG.

Si vous voulez créer des images qui ne montrent que des parties de la partition (avec ou sans les éléments à l'écran tels
que les cadres, les notes invisibles et les couleurs de notes hors limites), utilisez plutôt Capture d'image.

SVG (*.svg)

Les fichiers SVG  (Scalable Vector Graphics) peuvent être ouverts par la plupart des navigateurs web (sauf Internet
Explorer avant la version 9) et la plupart des logiciels de graphisme vectoriel. Cependant, la plupart des logiciels SVG ne
prennent pas en charge les polices intégrées, de sorte que les polices MuseScore appropriées doivent être installées pour
visualiser ces fichiers correctement. SVG est le format actuel de toutes les partitions sauvegardées sur MuseScore.com.

Pour définir la résolution et la transparence des fichiers SVG exportés, voir les instructions sous PNG (ci-dessus). Notez
que MuseScore ne supporte pas (encore) les gradients à l'exportation (bien qu'il le fasse pour les images dans une
partition).

Fichiers audio (exportation uniquement)
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MuseScore peut créer un son stéréo normalisé de la partition dans l'un des formats suivants : WAV, MP3, OGG VORBIS,
FLAC. Pour exporter un fichier audio :

1. Dans le menu, sélectionnez Fichier &rarr ; Exporter... ;
2. Choisissez le format souhaité dans le menu déroulant, puis appuyez sur Enregistrer.

Vous pouvez régler le taux d'échantillonnage de tous les formats audio comme suit :

1. Dans la barre de menu, sélectionnez Édition→Préférences... (Mac : MuseScore→Préférences...), et cliquez sur l'onglet
Exporter ;

2. Définissez le "Taux d'échantillonnage" dans la section "Audio".

WAV audio (*.wav)

WAV (Waveform Audio Format) est un format sonore non compressé. Il a été développé par Microsoft et IBM, et est
largement supporté par les logiciels pour Windows, OS X et Linux. C'est un format idéal pour la création de CD, car la
qualité sonore est préservée. Pour le partage par courrier électronique ou sur Internet, utilisez une alternative
compressée telle que MP3.

MP3 (*.mp3)

MP3 est un format audio compressé très répandu. Les fichiers MP3 sont pratiques pour le partage et le téléchargement
sur Internet en raison de leur taille relativement petite.

Pour régler le bitrate MP3 :

1. Dans la barre de menu, choisissez Édition→Préférences... (Mac : MuseScore→Préférences...), et sélectionnez l'onglet
"Exporter" ;

2. Réglez le bitrate du MP3 dans la section "Audio".

FLAC audio (*.flac)

Free Lossless Audio Codec  (FLAC) est un format audio compressé. Les fichiers FLAC sont environ deux fois moins
volumineux que les fichiers audio non compressés et sont d'une qualité tout aussi bonne. Windows et OS X n'ont pas de
support intégré pour le FLAC, mais des logiciels tels que le VLC media player , gratuit et open source, peuvent lire les
fichiers FLAC sur n'importe quel système d'exploitation.

Ogg Vorbis (*.ogg)

Ogg Vorbis  est destiné à remplacer, sans brevet, le format audio MP3 très répandu (que MuseScore prend également
en charge - voir ci-dessus). Comme le MP3, les fichiers Ogg Vorbis sont relativement petits (souvent un dixième de
l'audio non compressé), mais une certaine qualité sonore est perdue. Windows et OS X n'ont pas de support intégré pour
Ogg Vorbis. Cependant, des logiciels tels que [VLC media player] (http://videolan.org/vlc ) et [Firefox]
(http://www.mozilla.org/firefox ) peuvent lire les fichiers Ogg sur n'importe quel système d'exploitation.

Partage avec d'autres logiciels de musique

MuseScore peut importer et exporter MusicXML et MIDI ; il est également capable d'importer une variété de fichiers au
format natif d'autres programmes de notation musicale.

MusicXML (*.xml, *.musicxml)

MusicXML  est la norme universelle pour les partitions. C'est le format recommandé pour le partage de partitions entre
différents auteurs, dont MuseScore, Sibelius, Finale, et plus de 100 autres. MuseScore importe les fichiers *.xml et
*.musicxml, mais n'exporte que le fichier *.musicxml. Si vous avez besoin de *.xml (parce que le programme que vous voulez
importer en a besoin), vous devez le renommer vous-même après l'exportation.

MusicXML compressé (*.mxl)

Le format MusicXML compressé crée des fichiers plus petits que le format MusicXML normal. Il s'agit d'une norme plus
récente qui n'est pas aussi largement soutenue par les anciens auteurs de partitions, mais MuseScore offre une prise en
charge complète de l'importation et de l'exportation.

MIDI (*.mid, *.midi, *.kar)

MIDI (Musical Instrument Digital Interface) est un format largement pris en charge par les séquenceurs et les logiciels de
notation musicale. Pour plus de détails sur le protocole, voir le site web de l'[Association MIDI] (https://midi.org ).

Les fichiers MIDI sont très utiles pour la lecture mais contiennent peu d'informations sur la disposition de la partition
(formatage, orthographe de la hauteur, voix, ornements, articulations, répétitions, signatures des tonalités, etc.) ). Pour
partager des fichiers entre différents logiciels de notation musicale, il est recommandé d'utiliser MusicXML.
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Pour plus de détails sur l'importation de fichiers MIDI, voir Importation MIDI.

MuseData (*.md) (importation uniquement)

MuseData  est un format développé par Walter B. Hewlett à partir de 1983 comme un des premiers moyens de partage
de la notation musicale entre logiciels. Il a depuis été éclipsé par MusicXML, mais plusieurs milliers de partitions dans ce
format sont toujours disponibles en ligne.

Capella (*.cap, *.capx) (importation uniquement)

Les fichiers CAP et CAPX sont créés par le logiciel de création de partitions Capella . MuseScore importe la version
2000 (3.0) ou ultérieure avec une certaine précision.

Bagpipe Music Writer ( *.bww) (import uniquement)

Les fichiers BWW sont créés par le logiciel de création de partitions de niche [Bagpipe Music Writer]
(http://robertmacneilmusicworks.com ).

BB (*.mgu, *.sgu) (import uniquement)

Les fichiers BB sont créés par le logiciel d'arrangement musical [Band-in-a-Box] (http://pgmusic.com ). Le soutien de
MuseScore est actuellement expérimental.

Overture (*.ove) (import uniquement)

Les fichiers OVE sont créés par le logiciel de création de partitions [Overture] (https://sonicscores.com/overture/ ). Ce
format est principalement populaire dans les environnements de langue chinoise, comme la Chine continentale, Hong
Kong et Taïwan. Le soutien de MuseScore est actuellement expérimental.

Guitar Pro (various-import uniquement)

MuseScore peut ouvrir les fichiers Guitar Pro  avec les extensions suivantes : *.gtp, *.gp3, *.gp4, *.gp5, *.gpx, et, à partir
de la version 3.5, *.gp.

Power Tab Editor ( *.ptb) (importation uniquement)

Les fichiers PTB sont créés par le logiciel [Power Tab Editor] (http://www.power-tab.net/ ). Le support de MuseScore est
actuellement expérimental.

Voir aussi

Ouvrir/Enregistrer/Exporter/Imprimer
Fichiers récupérés

Liens externes

Comment récupérer une copie de sauvegarde d'une partition  (MuseScore HowTo)

Formes de têtes de notes

Pour une portée standard, vous pouvez choisir parmi 9 formes de têtes de notes.
Clic droit sur une portée, sélectionnez Propriétés de la portée et partie…, puis clic sur Propriétés avancées de style…  et
choisissez dans le menu déroulant la forme des têtes de notes :

Normale : C’est le schéma par défaut et celui que la grande majorité des gens utiliseront : c’est aussi le seul
schéma dans Musescore 1 et 2. Il utilise des têtes de notes normales qui peuvent être changées via la palette des
têtes de note ou l'inspecteur.

Noms des notes : A B C D E F G

Noms allemands des notes : A H C D E F G (presque comme au-dessus) sauf le H qui remplace le B, car le B
devient Sib.
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Solmisation relative, Movable Do ou Tonic Solfa : Les têtes de notes contiennent leurs noms selon le degré dans
l’échelle. Il utilise Ti et non Si

Solmisation absolue, Fixed Do : Notation utilisée en France, Italie, Espagne, etc... Si et pas Ti.

4 formes (Walker) : Les têtes de notes suivent le système des quatre formes utilisées dans des livres tels que
Southern Harmony (1835) de William Walker.

7 formes (Aikin) : Les têtes de notes suivent le système des sept formes utilisé dans des livres tels que The
Christian Minstrel (1846) de Jesse B. Aikin ,et les livres de la Ruebush & Kieffer Publishing Company. C’est le
système à 7 formes le plus utilisé.

7 formes (Funk) : Les têtes de notes suivent le système des sept formes utilisé dans des livres tels que Harmonia
Sacra (1851) de Joseph Funk.

7 formes Walker: Les têtes de notes suivent le système des sept formes utilisées dans les livres tels que Christian
Harmony de William Walker (1867).

(Pour plus d’informations sur les différentes variantes de forme de notes, voir : SMuFL specification )

Le paramétrage s'applique à toute la portée, y compris pour les notes éditées et entrées ultérieurement :
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Liens externes

En français : Solmisation
En anglais : Solfège Movable Do
En anglais : Solfège Fixed Do

Têtes de notes

Une gamme de têtes de notes alternatives est accessible via la palette Têtes de note l'espace de travail avancé, ou de
l'Inspecteur (voir Changer de groupe de tête de note, ci-dessous).

Remarque: Le style de tête de note peut varier en fonction de la police musicale sélectionnée (Emmentaler, Gonville ou
Bravura). Ceux de la palette sont affichés sous forme de demi-notes en police Bravura.

Groupes de tête de note

MuseScore prend en charge une gamme de styles de têtes de notes:

Normal: Une tête de note standard.
Croix (Ghost note): Utilisée en notation de percussion pour représenter les cymbales. Il indique également les effets
muets et / ou percussifs dans les instruments à cordes tels que la guitare.
Diamant: Utilisé pour indiquer les notes harmoniques d'instruments tels que la guitare, le violon, etc.
Slash: Utilisé pour noter les rythmes (par exemple gratter, brosser les cordes de guitare).
Triangle vers le haut/vers le bas: Utilisé en notation de percussion.
Notes de formes géométriques: Do, Ré, Mi, Fa, Sol, La, Si.
Croix cerclée: Utilisé en notation de percussion.
Circulaire: Tête de note entourée d'un cercle.
Penchée (en avant), Penchée (en arrière): Une tête de note traversée par une ligne oblique.
Plus: Tête de note en forme de plus (+).
Alt. Brevis: Utilisé dans la notation musicale ancienne.
Parenthèses: appliquées autour d'une note existante (ou d'une altération).

Changer de groupe de tête de note

Pour modifier la forme d'une ou de plusieurs têtes de note dans la partition, utilisez l'une des méthodes suivantes:

Sélectionnez une ou plusieurs notes et cliquez sur une tête de note dans la palette (double-cliquez dans les
versions antérieures à 3.4).
Faites glisser une tête de note de la palette sur une note de la partition.
Sélectionnez une ou plusieurs notes et modifiez la tête de note dans l'Inspecteur, en utilisant la liste déroulante sous
Note → Groupe de tête (non pris en charge pour les portées de batterie).

Changer le type de tête de note

Parfois, vous devrez peut-être modifier la durée apparente d'une tête de note, —c'est-à-dire le type de tête de note— sans
modifier sa durée actuelle, sous-jacente:

1. Sélectionner une ou plusieurs notes.
2. Choisissez l'une des options suivantes de l'Inspecteur sous Note → Type de tête:

Auto: Automatique, c'est-à-dire durée apparente = durée réelle.
Ronde: Tête de note ronde, quelle que soit la durée réelle.
Blanche: Tête de note blanche, quelle que soit la durée réelle.
Noire: Tête de note noire, quelle que soit la durée réelle.
Carrée: Tête de note carrée, quelle que soit la durée réelle.

Têtes de notes partagées

Quand deux notes dans différentes voix, mais de la même hauteur écrite, tombent sur le même temps, une des deux
choses peut se produire:
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Les notes peuvent partager la même tête de note.
Les notes peuvent être décalées: c'est-à-dire disposées côte à côte.

MuseScore utilise les règles suivantes:

Les notes dont les hampes sont dans le même sens ne partagent pas les têtes de note.
Les notes pointées ne partagent pas les têtes de notes avec des notes non pointées.
Les notes noires ne partagent pas les têtes de note avec les notes blanches.
Les rondes ne partagent jamais les têtes de notes.

Remarque:Si deux notes à l'unisson se trouvent dans la même voix, elles sont toujours décalées.

Changer les têtes de note décalées en partagées

Les têtes de note décalées peuvent être transformées en têtes de note partagées de deux manières:

Rendre la tête de note de plus petite valeur invisible en la sélectionnant et en utilisant le raccourci clavier V (ou
décocher l'option "Visible" dans l'Inspecteur).
Modifiez le type de tête de note de la note la plus courte pour qu'il corresponde à la plus longue en changeant
«Type de tête» dans la section «Note» de l'inspecteur: changez le type de tête de la valeur par défaut «Auto» à une
durée spécifique.

Exemples de partage de têtes de notes

1. Dans le premier exemple ci-dessous, les notes des voix 1 et 2 partagent des têtes de note par défaut, car ce sont
toutes des notes noires non pointées:

2. En revanche, dans l'exemple suivant, les notes blanches ne peuvent pas partager les têtes de note avec les notes
noires, elles sont donc décalées vers la droite:

Pour créer une tête de note partagée, rendez la croche noire invisible ou modifiez son type de tête pour
correspondre à celui de la note blanche (comme expliqué ci-dessus):

Supprimer les numéros de frettes en double

Dans certains cas, une tête de note partagée, lorsqu'elle est collée sur une portée tablature peut entraîner deux numéros
de frette distincts sur les cordes adjacentes. Pour corriger cela, rendez toutes les notes de tablature superflues invisibles
en les sélectionnant et en utilisant le raccourci clavier V (ou en décochant l'option "visible" dans l'inspecteur).

Liens externes

Shape notes  (notes à formes géométriques) source Wikipedia en anglais.
Ghost notes  (notes muettes ou étouffées) source Wikipedia en anglais.
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Importation MIDI

MuseScore peut importer des fichiers MIDI (.mid/.midi/.kar) et les convertir en notation musicale.

Pour importer un fichier MIDI, utilisez la commande standard Ouvrir…. Cela convertit le fichier MIDI en un fichier
MuseScore en utilisant les paramètres par défaut.

Le Panneau d'Importation MIDI apparaît en bas de l'écran : vous pouvez le développer en faisant glisser l'interface avec
la fenêtre du document vers le haut. Le panneau affiche toutes les pistes du fichier (seules celles avec des événements
de note sont affichées) et vous permet de régler les paramètres affectant le processus de conversion. S'il y a plusieurs
pistes, une piste supplémentaire est ajoutée en haut de la liste pour sélectionner toutes les pistes en même temps.

__ Accepter la conversion par défaut__ : Il suffit d'appuyer sur le symbole "X" en haut à gauche du panneau
d'importation pour le fermer. Le panneau peut être réouvert à tout moment pendant la session en appuyant sur
"Afficher le panneau d'importation MIDI" en bas de la fenêtre du document.

Pour réimporter le fichier : Ajustez les paramètres souhaités dans le panneau d'importation (voir ci-dessous) et
appuyez sur Appliquer. Si vous avez effectué des modifications dans le panneau d'importation mais que vous
souhaitez les ANNULER, appuyez sur Annuler. Pour fermer le panneau d'importation, appuyez sur le symbole "X" en
haut à gauche du panneau.

Défilement de la molette de la souris (Panneau d'importation MIDI) : Le défilement vertical est le défilement par défaut.
Pour un défilement horizontal, appuyez sur Maj ou Ctrl tout en utilisant la molette.

Opérations disponibles

L'instrument MuseScore
Attribuer un instrument MuseScore (listé dans instruments.xml ou dans un fichier xml personnalisé spécifié dans les
Préférences) qui définit le nom de la portée, la clé, la transposition, les articulations, etc.

Quantification

Quantifier les notes MIDI par une grille régulière. La résolution MAX de la grille peut être réglée via le menu
déroulant :

Valeur des préférences (par défaut) - la valeur de quantification est tirée du dialogue principal des préférences
de MuseScore (dans l'onglet "Importer")
Noire, croche, double-croche, triple-croche, quadruple-croche, quintuple-croche - valeurs définies par
l'utilisateur

Cependant, la taille réelle de la grille de quantification est adaptative et se réduit lorsque la longueur de la note est
petite, donc pour chaque note la valeur de quantification est différente. Mais il y a une limite supérieure pour la
valeur de quantification, et cette valeur peut être fixée par l'utilisateur comme "quantification max.".
Par exemple, si une note est longue - disons, une blanche, et que la quantification maximale est réglée sur une
croche, alors la note sera quantifiée avec la grille de croches, et non avec la grille de blanches ou de noires comme
elle est supposée l'être par l'algorithme.
Un tel schéma de quantification permet de quantifier toutes les notes de la partition (avec des longueurs différentes
!) de manière adéquate.

Nombre de voix max.
Définit le nombre maximum de voix musicales autorisées.

Recherche de Divisions Irrégulières
Lorsqu'elle est activée, cette option tente de détecter les divisions irrégulières et applique la grille de quantification
correspondante aux accords des divisions irrégulières.

Est joué par un humain
Si elle est activée, cette option réduit la précision de la conversion MIDI de la partition, au profit de la lisibilité. Elle
est utile pour les fichiers MIDI non alignés, lorsqu'aucune grille de quantification régulière n'est fournie. Pour de tels
fichiers, l'algorithme de suivi automatique des temps est utilisé, lequel tente de détecter les positions des mesures
dans l'ensemble du morceau.

Réduire de moitié le nombre de mesures
L'option est active pour les fichiers MIDI non alignés (lorsque "Est joué par un humain" est coché par défaut). Elle
divise par deux le nombre de mesures obtenues lors de l'opération de suivi des battements internes. Cela peut être
pratique lorsque le suivi des battements donne une subdivision des mesures 2x plus fréquente que nécessaire.

Indication de mesure
L'option est active pour les fichiers MIDI non alignés. L'utilisateur peut choisir une signature temporelle appropriée
pour l'ensemble du morceau si la valeur détectée par défaut est erronée. L'option est utile car elle gère
correctement les divisions irrégulières (n-olets) importés, contrairement au réglage direct de la signature temporelle
à partir de la palette.
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Scinder la portée
Cette option convient principalement aux morceaux de piano - pour attribuer des notes à la main gauche ou droite
de l'interprète. Elle utilise une séparation de hauteur constante (l'utilisateur peut choisir la hauteur via des sous-
options) ou une séparation de hauteur flottante (en fonction de la largeur de la main - une sorte de supposition du
point de vue du programme).
Pour les pistes de batterie (son "Percussion" dans la liste des pistes), il divise la portée en plusieurs portées, dont
chacune n'a qu'une seule hauteur de batterie (c'est-à-dire un son de batterie). Il existe également une sous-option
permettant d'autoriser ou d'interdire l'application des crochets pour le nouvel ensemble de pistes de batterie.

Changements de clef
Des petites clefs peuvent être insérées dans une portée pour garder les accords plus proches des 5 lignes de la
portée. Les changements de clefs dépendent de la hauteur moyenne de l'accord. Les groupes de notes liées ne sont
pas brisées par l'insertion de la clef (si cela se produit, on peut signaler un bug pour l'algorithme dans
importmidi_clef.cpp). Cette option n'est disponible que pour les pistes qui ne sont pas de la batterie.

Simplifier les durées
Réduit le nombre de repos pour former des durées de notes plus "simples". Pour les pistes de batterie, cette option
permet de supprimer les silences et d'allonger les notes.

Afficher les staccatos
Possibilité d'afficher/cacher les marquages staccato dans la partition.

Notes pointées
Contrôle si MuseScore utilisera des notes pointées ou liées.

Afficher l'indication de tempo
Affiche/masque les marques de texte du tempo dans la partition.

Montrer le nom des accords
Affiche/masque les noms d'accords dans la partition, le cas échéant, pour le format de fichier XF MIDI.

Reconnaître l'anacrouse
Lorsqu'elle est activée cette option permet de faire comprendre à MuseScore que si la première mesure est plus
courte, elle a tout de même la même indication de mesure que le reste de la partition. Cette option n'est valable que
pour l'ensemble des portées..

Détecter le swing
MuseScore essaye de détecter le swing pour remplacer le triolet [noire croche] par deux croches simples pour le
swing simple et [croche pointée - double croche ] par deux croches simples également pour le swing shuffle.
L'indication "Swing" ou "Shuffle" est alors indiquée au début de la portée modifiée.

Layer (experimental)

This feature is still experimental and only visible if MuseScore is started using the '-e' option, see Options de la ligne de
commande

For the Open-Goldberg project, the ability to create different versions of the score was needed. One version is the
"Urtext", a score which is close to the original version of Bach. A second version could be a Czerny variation, which in
addition to the Urtext, contains fingerings.

The layer feature allows creating different versions out of one score file. If you want to add fingerings, you have to create a
layer and tag the fingering elements with the layer name.

First, create layers:

Second, create a score variant:
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Add the visible layer to the score variant, then select all fingerings and tag them with the name of the score variant:

Default layer:

Czerny layer:
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See also

Options de la ligne de commande

Ligatures entre deux portées

Dans les partitions de piano, il est courant d'écrire une phrase musicale qui s'étend à la fois sur une portée du haut et une
du bas. Une telle phrase peut être saisie dans MuseScore comme suit :

1. Saisir la notation dans une portée pour commencer, par exemple

2. Sélectionner une note et appuyer sur Ctrl+Shift + ↓/↑ (Mac: Cmd+Shift + ↓/↑). Cela déplace toutes les notes de cette
voix vers le bas/haut sur l'autre portée.

Note : Si vous voulez seulement déplacer certaines notes dans un accord, vous devez vous assurer qu'elles sont
dans une voix séparée.

3. Pour régler la ligature, cliquez simplement dessus (double-clic dans les versions de MuseScore antérieures à 3.4)
pour faire apparaître les poignées. Utilisez les Raccourcis clavier ou faites glisser les poignées pour modifier l'angle
et la hauteur de la hampe :
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Voir aussi

Barres de Mesure : Comment étendre les barres de mesure sur plusieurs portées.
Ligatures : Comment ajuster l'angle et la hauteur du faisceau.

Liens externes

Comment étendre un accord ou une hampe sur deux portées  (MuseScore HowTo)

Modes de saisie des notes

MuseScore vous permet de choisir parmi plusieurs modes de saisie de notes. Une à une (voir ci-dessous) est la valeur
par défaut, mais d'autres sont accessibles en cliquant sur la petite flèche déroulante à côté du bouton de saisie de note
sur la Barre d'outils Saisie des notes.

Une à une

Il s'agit de la méthode par défaut de saisie de notes et consiste à saisir les notes une par une: d'abord en sélectionnant
une durée de note à l'aide de la souris ou du clavier, puis en choisissant une hauteur à l'aide de la souris, du clavier, du
clavier MIDI ou du piano virtuel.

Pour plus de détails, voir Saisie des notes, notions de base.

Hauteur

Le mode Hauteur vous permet de corriger les hauteurs d'une séquence de notes tout en laissant leurs durées inchangées
(à ne pas confondre avec Recalculer les altérations).

1. Sélectionnez une note comme point de départ;
2. Sélectionnez l'option Hauteur dans le menu déroulant Saisie des notes; ou utilisez le raccourci clavier, Ctrl+Maj+I

(Mac: Cmd+Maj+I).
3. Entrez maintenant les hauteurs à l'aide du clavier, du clavier MIDI ou Saisie avec le clavier de piano virtuel.

Vous pouvez également utiliser la fonction Hauteur pour créer un nouveau passage à partir d'un passage existant de la
même séquence de durées - en copiant et collant ce dernier, puis en appliquant Hauteur.

Rythme

Le mode Rythme vous permet de saisir des durées en appuyant sur une seule touche. La combinaison des modes
Rythme et Hauteur constitue une méthode très efficace de saisie de notes.

1. Sélectionnez votre point de départ dans la partition et passez en mode Rythme.
2. Sélectionnez une durée dans la barre d'outils de saisie de notes ou appuyez sur un raccourci de durée (numéros 1 à

9) sur le clavier de votre ordinateur. Une note sera ajoutée à la partition avec la durée sélectionnée. Contrairement à
Saisie des notes de base, appuyer sur la touche . fera basculer en note pointée ou en note non pointée toutes les
durées suivantes. Tous les rythmes suivants seront pointés jusqu'à ce que la touche . soit à nouveau enfoncée.
Contrairement à Saisie des notes de base, le point doit être pressé avant d'entrer le rythme.

3. La saisie de silences est similaire à l'ajout de notes pointées. Appuyez sur la touche 0 pour basculer entre les
silences. Tous les rythmes saisis seront des silences jusqu'à ce que la touche 0 est à nouveau enfoncée. Cela peut
être utilisé simultanément avec des notes pointées.

218

https://musescore.org/fr/node/8717


4. Continuez à appuyer sur les touches de durée pour entrer des notes avec les durées choisies.
5. Maintenant, utilisez le mode Hauteur pour définir la hauteur des notes que vous venez d'ajouter.

Temps réel (Automatique)

Les modes temps réel vous permettent essentiellement de jouer le morceau sur un clavier MIDI (ou sur MuseScore Saisie
avec le clavier de piano virtuel) pour ajouter les notes à votre place. Cependant, vous devez être conscient des limitations
suivantes qui s'appliquent actuellement:

Il n'est pas possible d'utiliser un clavier d'ordinateur pour la saisie en temps réel
Vous ne pouvez pas saisir de n-olets ou de notes plus courtes que la durée sélectionnée
Vous ne pouvez pas saisir de notes dans plus d'une voix à la fois

Cependant, ces restrictions signifient que MuseScore n'a que très peu de choses à deviner pour déterminer comment
votre entrée doit être notée, ce qui permet de garder les modes en temps réel précis.

Dans la version automatique de l'entrée en temps réel, vous jouez à un tempo fixe indiqué par un clic de métronome.
Vous pouvez ajuster le tempo en modifiant le délai entre les clics dans le menu: Édition → Préférences... → Saisie des notes
(Mac: MuseScore → Préférences... → Saisie des notes).

1. Sélectionnez votre position de départ dans la partition et passez en mode temps réel (automatique).
2. Sélectionnez une durée dans la barre d'outils de saisie de notes.
3. Maintenez enfoncée une touche MIDI ou une touche de piano virtuel (une note sera ajoutée à la partition).
4. Écoutez les clics du métronome. À chaque clic, la note augmente de la durée sélectionnée.
5. Relâchez la touche lorsque la note a atteint la longueur souhaitée.

La partition cesse d'avancer dès que vous relâchez la touche. Si vous voulez que la partition continue d'avancer (par
exemple pour vous permettre d'entrer des silences), vous pouvez utiliser le Raccourci Avance en temps réel pour
démarrer le métronome.

Temps réel (Manuel)

Dans la version manuelle de l'entrée en temps réel, vous devez indiquer votre tempo d'entrée en appuyant sur une touche
ou une pédale, mais vous pouvez jouer à n'importe quelle vitesse que vous souhaitez et elle n'a pas besoin d'être
constante. La touche par défaut pour régler le tempo (appelé "Avance en temps réel") est Entrée sur le pavé numérique
(Mac: Fn+Entrée), mais il est fortement recommandé de changer cela en une touche MIDI ou une pédale MIDI (voir ci-
dessous).

1. Sélectionnez votre position de départ dans la partition et passez en mode Temps réel (manuel).
2. Sélectionnez une durée dans la barre d'outils de saisie de notes.
3. Appuyez et maintenez une touche MIDI ou une touche de piano virtuel (une note sera ajoutée à la partition).
4. Appuyez sur la touche Avance en temps réel. À chaque pression, la note augmente de la durée sélectionnée.
5. Relâchez la note lorsqu'elle a atteint la longueur souhaitée.

Raccourci Avance en temps réel

Le raccourci Avance en temps réel est utilisé pour battre le tempo en mode manuel en temps réel ou pour démarrer les
clics du métronome en mode temps réel automatique. Il est appelé "Avance en temps réel" car il fait avancer la position
d'entrée, ou "avance", dans la partition.

La touche par défaut pour l'avance en temps réel est Entrée sur le pavé numérique (Mac: Fn+Entrée), mais il est fortement
recommandé de l'affecter à une touche MIDI ou à une pédale MIDI via la télécommande MIDI de MuseScore. La
télécommande MIDI est disponible depuis le menu: Édition → Préférences... → Saisie des notes (Mac: MuseScore → Préférences...
→ Saisie des notes).

Alternativement, si vous avez une pédale USB ou une pédale d'ordinateur qui peut simuler les touches du clavier, vous
pouvez le régler pour simuler Entrée sur le pavé numérique.

Lorsque les notes sont entrées, elles seront placées juste avant l'élément de départ sélectionné, qui sera mis en évidence
avec un marqueur carré bleu. L'élément de départ et toutes les notes ou silences subséquents dans la même mesure
seront décalés vers l'avant. Vous pouvez déplacer le point d'insertion vers l'avant et vers l'arrière à l'aide des touches
fléchées → ou ←, et le nouveau point d'insertion sera alors mis en évidence.

Insérer

Le mode d'entrée Insérer (appelé Dans le temps(non garanti) dans les versions antérieures à 3.0.2) vous permet
d'insérer et de supprimer des notes et des silences dans les mesures, en décalant automatiquement la musique suivante
vers l'avant ou vers l'arrière. Durée de la mesure est automatiquement mis à jour au fur et à mesure.

1. Assurez-vous que vous êtes en mode de Saisie des notes, et que vous avez sélectionné l'élément à l'endroit où
vous voulez commencer à insérer des notes/silences;

2. Cliquez sur la flèche à côté de l'icône de saisie de note et sélectionnez Insérer (ou si Insérer est la valeur par défaut
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actuelle, appuyez simplement sur N);
3. Entrez une note ou un silence comme vous le feriez dans le mode Une à une. Chaque note est insérée avant la

position actuelle du curseur;
4. Déplacez le curseur vers l'avant et vers l'arrière si nécessaire (à l'aide des touches fléchées), pour changer le point

d'insertion.

Sinon, si vous n'avez qu'une ou deux notes à insérer, vous préférerez peut-être utiliser un raccourci:

Appuyez sur Ctrl+Maj (Mac: Cmd+Maj) tout en ajoutant la note par un clic de souris ou un raccourci clavier (A-G).

Si, à tout moment, la durée totale des notes et des silences dans la mesure ne correspond pas à l'indication de mesure,
un petit signe + ou - sera affiché au-dessus de la mesure.

Voir aussi: supprimer un ensemble de mesures sélectionnées (Outils).

Mode Normal

Pour quitter le mode de saisie de note, cliquez sur le bouton de l'outil de saisie de note, appuyez sur N, ou appuyez sur
Échap. Cela vous met en mode Normal, dans lequel vous pouvez modifier les durées et supprimer des notes ou des
silences comme suit:

Si vous sélectionnez une note et appuyez sur Suppr la note sera remplacée par un silence de même durée.
Si vous sélectionnez une note ou un silence et appuyez sur Ctrl+Suppr la note/silence sera supprimée et les notes
suivantes déplacées vers l'arrière (voir Supprimer un ensemble de mesures sélectionnées).
Si vous réduisez la durée d'une note ou d'un silence, la durée restante sera remplie de silences.
Si vous augmentez la durée d'une note ou d'un silence, cela soustrait la durée des notes/silences suivantes pour
compenser la durée. Si cela est fait sur la dernière note/silence de la mesure, une note ou un silence avec la durée
requise sera inséré au début de la mesure suivante, et les deux seront liés ensemble.

Voir aussi

Saisie des notes
Copier / Coller

Liens externes

Video: Semi-Realtime MIDI Demo Part 1: New note entry modes  (en anglais)
Introduction to the new Repitch Mode  (YouTube) (en Anglais)

Outils

Un grand nombre de commandes très utiles se trouvent dans le menu Outils.

Transposer...

Cette option ouvre la boîte de dialogue Transposer avec de nombreuses options pour transposer des passages de votre
partition.

Voir Transposition automatique.

Éclater

La commande Éclater vous permet de sélectionner un passage musical dans une seule portée et d'éclater les accords en
leurs notes ou voix qui les constituent sur plusieurs portées :

Si le passage est tout en voix 1, la note supérieure de l'accord est conservée sur la portée supérieure, tandis que
les notes inférieures sont déplacées sur les portées suivantes.
Si le passage contient plusieurs voix, les notes de la voix 1 sont maintenues sur la portée supérieure, tandis que les
autres voix sont déplacées sur les portées suivantes. Toutes les voix éclatées sont maintenant dans la voix 1.

Pour Éclater une partie de la partition :

1. Assurez-vous qu'il y a suffisamment de portées sous la portée à éclater pour recevoir les notes des accords. Créez
des portées supplémentaires si nécessaire en utilisant la boîte de dialogue Instruments.

2. Choisissez l'une des deux options :
Sélectionner une plage de mesures dans la portée initiale : cela permet d'exploser toutes les notes s'il y a
suffisamment de portées disponibles.
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Sélectionner un ensemble de mesures incluant à la fois la portée initiale et une ou plusieurs portées de
destination : Cela limite le nombre de notes/voix éclatées au nombre de portées sélectionnées.

3. Choisissez Outils→Éclater.

Notes : (1) Si la sélection est entièrement en voix 1, MuseScore écartera la ou les notes les plus basses de tout accord
qui contient plus de notes que le nombre de portées de la sélection. (2) Si la sélection est entièrement en voix 1, et si un
accord donné contient moins de notes que le nombre de portées de destination, alors les notes seront dupliquées selon
les besoins afin que chaque portée reçoive une note. (3) Toute musique existante dans les portées de destination est
écrasée. (4) Si vous sélectionnez une mesure partielle, la commande sélectionnera automatiquement en une mesure
complète.

Rassembler

La commande Rassembler fait l'inverse de la commande "Éclater" :

Avec une portée sélectionnée, toutes les notes des voix 1-4 sont combinées dans la voix 1.
Lorsque plusieurs portées sont sélectionnées, les notes de la deuxième portée sont copiées sur la première voix
disponible de la portée supérieure, les notes de la troisième portée sont copiées sur la voix disponible suivante de la
portée supérieure, et ainsi de suite.

Pour Rassembler les notes d'une seule portée

1. Sélectionner un ensemble de mesures dans la portée désirée.
2. Choisir Outils→Rassembler.

Toutes les notes sélectionnées dans la portée sont maintenant regroupées dans la voix 1.

Pour Rassembler les notes de plusieurs portées

1. Veiller à ce qu'il n'y ait qu'une seule voix dans chaque portée.
2. Sélectionner un ensemble de mesures dans la portée de destination et étendre cette sélection vers le bas pour

inclure les autres portées à rassembler.
3. Choisissez Outils→Rassembler.

Voix

Cela vous permet d'échanger les voix d'un ensemble de notes sélectionnées. Voir Échanger les voix.

Mesures

Scinder ou joindre des mesures. Voir Opérations sur les mesures : Scinder et joindre.

Supprimer un ensemble de mesures sélectionnées

Cette commande est utilisée pour supprimer complètement un élément ou une série d'éléments de la partition.

Pour supprimer des mesures (y compris des mesures partielles) :

1. Sélectionner un ensemble de notes/de silences, ou un ensemble de mesures .
2. 2. Utiliser l'une des méthodes suivantes :

Appuyer sur Ctrl+Suppr.
Sélectionner Outils→Supprimez la plage sélectionnée .

Note : Si la plage sélectionnée ne comprend qu'une partie d'une mesure, le résultat comprendra une mesure de durée
inférieure à celle de l'Indication de Mesure. Ceci est indiqué par un petit signe - (moins) juste au-dessus du système.

Pour joindre des mesures :

1. Sélectionner deux ou plusieurs mesures.
2. Utiliser "Outils"->"Mesures"->"Joindre les mesures sélectionnées".

Le tableau suivant est un résumé comparatif des commandes Supprimer et Supprimer la plage sélectionnée lorsqu'elles
sont appliquées à des éléments individuels :

Élément sélectionné Commande Supprimer Commande Supprimer la plage sélectionnée
Note Remplace les notes par des silences Supprime la plage sélectionnée de la portée
Silence (voix 1) Pas d'effet Supprime la plage sélectionnée de la portée
Silence (voices 2-4) Supprime les silences Supprime la plage sélectionnée de la portée

Barre de mesure Pas d'effet Supprime les barres de mesure et joint les
mesures
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Mesure Remplace le contenu par des
silences

Supprime la mesureÉlément sélectionné Commande Supprimer Commande Supprimer la plage sélectionnée

Note : Pour insérer des notes, voir Insertion.

Remplir avec des slashs

Cette commande remplit les mesures sélectionnées avec des slashs, un par temps :

1. Sélectionner une ou plusieurs mesures;
2. Dans le menu, choisir Outils→Remplir avec des slashs.

Si une mesure est vide, les slashs sont ajoutées à la voix 1, en taille réelle et centrées sur la ligne médiane de la portée :

Notes : (1) S'il y a déjà des notes dans une mesure de la sélection, la commande mettra les slashs dans la première voix
vide disponible. (2) Les slashs de la voix 2 sont de taille normale et centrés sur la ligne médiane de la portée ; les slashs
de la voix 3 apparaissent petits et au-dessus de la portée ; les slashes de la voix 4 sont petits et en dessous de la portée.
(3) Si une mesure contient des notes dans les 4 voix, la voix 1 sera écrasée. (4) Tous les slashs sont réglées pour ne pas
être transposés ou lus.

Activer/Désactiver la notation rythmique avec des slashs

Cette commande permet de basculer les notes sélectionnées entre les notes normales et la notation rythmique avec des
slashs :

1. Sélectionner un ensemble de notes ou de mesures (Note : utiliser le filtre de sélection si vous voulez exclure
certaines voix);

2. Dans le menu, choisir Outils→Activer/Désactiver la notation rythmique avec des slashs .

Les têtes de note sélectionnées sont remplacées par des têtes de note slashs qui ne seront ni transposés ni jouées.

Les notes à tête de slashs des voix 1 ou 2 sont fixées à la ligne intermédiaire de la portée ; celles des voix 3 ou 4 sont
petites (notation "accent") et fixées au-dessus ou en dessous de la portée :

Dans les portées de percussion, les notes des voix 3 et 4 ne sont pas converties en petites barres obliques mais en
petites notes au-dessus ou en dessous de la portée.

Recalculer les altérations

Corrige les altérations accidentelles qui ne tiennent pas dans l'armure. Voir Altérations : Recalculer les altérations.

Regrouper les Rythmes

Cette option corrige les liaisons de prolongation des notes, les durées et les ligatures afin qu'elles soient regroupées selon
la pratique standard de notation musicale. Par exemple :

Avant :

Après :
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Toute note qui est liée et qui a la même longueur qu'une note entière sera remplacée par la note entière avec deux
limitations. (i) Seule la dernière note d'un groupe de notes liées sera modifiée. Les notes comportant plus d'un point ne
sont pas modifiées en utilisant cette option. (ii) Les notes non liées ne passeront pas d'un groupe de notes liées à un autre
à moins que leur durée ne soit la même que celle de tous les groupes de notes liées qu'elles couvrent. Les notes
comportant plus d'un point seront regroupées selon les règles ci-dessus.

Pour appliquer :

1. Sélectionner les mesures à traiter. Si rien n'est sélectionné, l'opération portera sur la totalité de la partition.
2. Choisir Outils→Regrouper les rythmes.

Note : Il s'agit d'un dispositif expérimental et il y a des dysfonctionnements connus. Les articulations et les ornements
sont supprimés et certaines notes sont ré-étiquetées. Les liaisons de prolongation entre les barres de mesure peuvent
être perdus sur CTRL-Z.

Remettre les repères dans l'ordre

La commande Remettre les repères dans l'ordre vous permet de réorganiser la numérotation/lettre des Repères si, pour
une raison quelconque, ils ne sont plus dans l'ordre. Pour plus de détails, voir Renuméroter automatiquement les repères.

Linéariser les reprises (version 3.1 and above)

Cette commande crée une nouvelle partition, dans un nouvel onglet, éliminant les barres de répétition et en développant
toutes les mesures à jouer.

Copier les paroles dans le presse-papier

Cette commande copie toutes les paroles d'une partition dans le presse-papier :

Dans le menu, choisir Outils→Copier les paroles dans le presse-papier .

Capture d'image

Faites une copie d'écran d'une partie sélectionnée de la fenêtre du document. Les formats PNG, PDF et SVG sont pris en
charge. Voir Capture d'image.

Supprimer les mesures restantes

Cette commande supprime toutes les mesures vides à la fin de partition.

Voir aussi

Sauts et espacements
Marqueurs

Liens externes

How to merge/combine/implode two staves in one with two voices  (MuseScore HowTo)

Palette principale

La Palette principale est un référentiel de symboles utilisé pour alimenter les Espaces de travail (De base, Avancé, et
Personnalisé). Elle est également utilisée pour créer de nouvelles Indications de mesure et Armures personnalisées.

Pour ouvrir, utilisez l'une des options suivantes:

Appuyez sur Maj+F9 (Mac: fn+Maj+F9).
Dans le menu, sélectionnez Affichage → Palette principale.
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La palette principale est divisée en sections en fonction du type de symbole. Passer la souris sur un élément affiche une
info-bulle (une courte définition en noir sur fond jaune).

Pour transférer un élément de la palette principale vers une Palette personnalisée:

Faites glisser le symbole de la fenêtre Palette principale vers une palette personnalisée.

Remarque: À l'exception de la section Symboles (ci-dessous), il n'est pas habituel d'ajouter des éléments directement à la
partition à partir de la palette principale: utilisez plutôt les palettes de l'espace de travail. Cependant, si vous le souhaitez,
des éléments peuvent être ajoutés directement en utilisant soit (i) glisser-déposer ou (ii) en sélectionnant une ou plusieurs
notes/silences et en double-cliquant sur l'élément.

Symboles

La section Symboles de la Palette principale est un vaste référentiel de centaines de symboles musicaux en plus de ceux
trouvés dans les palettes des Espaces de travail. Vous pouvez l'ouvrir depuis la palette principale, ou directement depuis
la partition en utilisant le raccourci Z.
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Trouver un symbole

Les sous-catégories Symboles peuvent être affichées en cliquant sur "Symboles". Utilisez le menu Police en bas à droite
de la fenêtre pour spécifier les symboles spécifiques aux polices Leland, Bravura, Emmentaler, Gonville, MuseJazz ou
Petaluma. Vous pouvez rechercher un symbole particulier en entrant un mot-clé dans la zone de recherche.

Utiliser un symbole

Pour ajouter un élément à la partition à partir de la section Symboles, utilisez l'une des options suivantes:

Faites glisser et déposez un symbole sur une portée.
Sélectionnez une note ou un silence et double-cliquez sur un symbole.

La position du symbole peut être ajustée en faisant glisser ou en modifiant les décalages horizontal / vertical dans
l'Inspecteur. La couleur et la visibilité peuvent également être ajustées dans l'inspecteur.

Remarque: Les éléments de la section Symboles ne suivent aucune règle de positionnement (dans de nombreux cas,
contrairement aux éléments identiques d'autres sections de la palette principale), et n'affectent pas la lecture de la
partition.

Fusion de symboles

Les éléments de la section Symboles peuvent être fusionnés les uns aux autres sur la page de la partition, de sorte qu'ils
puissent être déplacés comme une seule unité:

1. Déposez le premier symbole sur la partition. Ajustez la position au besoin.
2. Double-cliquez ou faites glisser et déposez un deuxième élément sur le premier symbole. Ajustez la position au

besoin.

Faites glisser le premier élément et l'élément attaché suivra.

Voir également

Palettes
Symboles et caractères spéciaux (ajouter des symboles musicaux à des objets texte)

Parties

MuseScore vous permet non seulement de créer et d'imprimer une partition complète, mais aussi de générer les parties
pour chaque instrumentiste à partir de celle-ci.

225



Une partie peut être créée à partir d'une portée d'instrument spécifique dans la partition principale ou même à partir d'une
voix spécifique dans une portée. Cela vous permet d'afficher plusieurs parties (par exemple, Flûte 1 & 2) sur une seule
portée dans la partition mais de les extraire en tant que parties séparées.

Créer toutes les parties

La méthode la plus simple consiste à créer toutes les parties en même temps. Les parties sont générées sur une base
individuelle à partir des instruments correspondants dans la partition :

1. Dans le menu, sélectionnez Fichier → Parties....

2. Cliquez sur Toutes les parties  (MuseScore 3.2-3.6 : Générer ; avant MuseScore 3.2 : Toutes les parties) (les parties sont
nommées avec le nom de l'instrument, et un numéro est ajouté pour différencier les parties qui ont le même label
dans la partition principale).

3. Cliquer sur OK.

Les parties sont maintenant accessibles en cliquant sur les onglets situés au-dessus de la fenêtre du document.

Créer des parties spécifiques

Cette méthode vous permet de générer des parties spécifiques uniquement pour des instruments sélectionnés (plutôt que
des parties tout en un) :

1. Dans la fenêtre Parties, cliquez sur Une seule partie (avant MuseScore 3.4 Nouveau) pour créer une partie ;

2. Dans le volet central, saisissez le texte que vous souhaitez utiliser pour le "Titre de la partie" (cela sert également
pour la partie correspondante au nom de fichier lors de l'exportation) ;

3. Choisir l'instrument que vous voulez voir apparaître dans votre partie grâce au panneau "Instruments de la partition",
et appuyez sur + pour l'ajouter au panneau "Instruments dans la partition".

Si vous souhaitez créer d'autres parties, répétez les étapes 1 à 3 (ci-dessus) pour chaque partie.

4. Cliquer sur OK pour enregistrer les parties.

Vous avez maintenant terminé la mise en place des parties. Vous n'avez pas besoin de recommencer, sauf si vous
ajoutez ou retirez un instrument de votre partition complète.

Personnaliser les parties

Une fois que vous avez généré une partie (ou toutes les parties), vous pouvez sélectionner n'importe quelle partie en haut
et utiliser les commandes en bas pour contrôler non seulement quel instrument est dans la partie, mais aussi quelles
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portées et quelles voix de l'instrument sont incluses.

Ajouter des instruments à une partie

Pour ajouter des instruments à une partie existante :

1. Sélectionnez la partie dans la zone "Selectionner une partie".
2. Sélectionnez l'instrument dans la zone "Instruments de la partition".
3. Appuyez sur + pour l'ajouter au panneau "Instruments de la partie".

Retirer des instruments d'une partie

Pour supprimer des instruments d'une partie existante :

1. Sélectionnez la partie dans la zone "Sélectionner une partie".
2. Sélectionnez l'instrument dans la zone "Instruments de la partie".
3. Appuyez sur - pour retirer l'instrument.

Sélectionner les portées d'un instrument

Pour sélectionner les portées d'un instrument à inclure dans la pièce :

1. Sélectionnez la partie dans la zone "Sélectionner une partie".
2. Cliquez sur la flèche à côté de l'instrument dans "Instruments de la partie" pour élargir la liste afin d'afficher toutes

les portées et les voix de l'instrument.
3. Sélectionnez la portée à supprimer.
4. Appuyez sur - pour la retirer de l'instrument.

Sélectionner des voix pour un instrument

1. Sélectionner la partie dans la zone "Sélectionner une partie".
2. Cliquer sur la flèche à côté de l'instrument dans "Instruments de la partie" pour élargir la liste afin d'afficher toutes

les portées et les voix de l'instrument.
3. Décocher les voix à supprimer.

Si vous sélectionnez uniquement la voix 1 pour une portée donnée, alors seul le contenu de la voix 1 pour cette portée
sera inclus dans la partie. Ainsi, pour partager la flûte 1 & 2 sur la même portée, vous devrez entrer toutes les notes sur
les deux voix, même dans les passages où elles partagent le contenu. Vous ne pouvez pas non plus entrer les deux
parties en tant qu'accords dans les passages où elles partagent des rythmes.

Supprimer une partie

1. Ouvrez le dialogue Parties (Fichier → Parties...) ;
2. Sélectionnez la partie concernée dans le volet "Sélectionner une partie" ;
3. Appuyez sur Supprimer.

Exporter des parties
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Pour pouvoir exporter des parties, celles-ci doivent avoir été créées au préalable, voir ci-dessus

1. Dans le menu, sélectionnez Fichier → Export parties... ;
2. Naviguez jusqu'à l'endroit où vous souhaitez les exporter et sélectionnez le format de fichier (PDF est le format par

défaut) ;
3. Pour le nom du fichier, entrez simplement le préfixe utile pour toutes les parties, ou laissez la valeur par défaut (le

nom du fichier de votre partition) ;
4. Cliquez sur OK.

Cela va générer des fichiers avec les noms "<title&gt ;" + "-" + "<part name&gt ;.<extension&gt ;". De plus, lors de
l'exportation au format PDF, cela générera également "<title&gt ;" + "-Score_And_Parts.pdf".

Enregistrer les parties

Les parties et la partition sont "liées", ce qui signifie que toute modification du contenu de l'une affectera l'autre, mais pas
la mise en page. Lorsque vous avez créé les parties, elles sont enregistrées avec la partition (si vous ouvrez la partition,
vous avez des onglets pour la partition et chaque partie que vous avez créée).

Toutefois, si vous souhaitez enregistrer une partie individuellement, vous pouvez le faire :

1. Assurez-vous que la partie est "active". Sélectionnez son onglet si ce n'est pas le cas ;
2. Dans le menu, sélectionnez Fichier → Enregistrer sous....

Imprimer une pièce

1. Assurez-vous que la partie est "active". Sélectionnez son onglet si ce n'est pas le cas ;
2. Dans le menu, sélectionnez Fichier → Imprimer pour ouvrir la boîte de dialogue d'impression.

Placement automatique

La fonction Placement automatique de MuseScore garantit que, dans la plupart des cas, les éléments sont correctement
espacés et ne se heurtent pas ou ne se chevauchent pas.

Remarque : Lorsque vous créez un élément, le placement automatique est automatiquement activé, mais peut être
désactivé si nécessaire (voir Désactiver le placement automatique).

Position par défaut

Un élément nouvellement créé, tel que Texte de portée ou Doigté, prend une position par défaut sur la Portée spécifiée
par les propriétés "positionnelles" contenues dans le menu Format / Style. Ces propriétés "positionnelles" peuvent inclure
des éléments tels que:

Position : Si l'élément apparaît au-dessus ou en dessous de la portée.
Décalage : Pour les éléments sans propriétés "Position au dessus / au dessous", cela spécifie la position par
défaut. Voir Décalage X/Y.
Distance min. du placement automatique : Distance minimale par rapport aux autres éléments lorsque la fonction
de mise en place automatique est activée.

Pour plus de détails sur les paramètres disponibles pour chaque type d'élément, voir Mise en page et mise en forme:
Style.

Modifier la Position par défaut d'un élément

Utilisez l'une des méthodes suivantes:

Dans le menu, sélectionnez Format→Style; choisissez un type d'élément, puis ajustez les paramètres de
Position/Distance.
Sélectionnez un élément pertinent dans la partition et modifiez les paramètres de Position/Distance dans
l'Inspecteur ; puis appuyez sur le bouton Définir comme style" (S) pour mettre à jour les paramètres du Style.

Réglages manuels

Ajuster la position de l'élément

Utilisez l'une des méthodes suivantes :

Sélectionnez l'élément et ajustez les décalages X et Y dans l'inspecteur (voir Décalage X/Y).
Déplacer l'élément à l'aide des boutons fléchés. Changer pour Mode édition d'abord, si nécessaire.
Faites glisser et déposez l'élément à l'aide de la souris. Utilisez cette méthode de préférence à la méthode ci-
dessus, si vous souhaitez déplacer un élément sur un autre (par exemple, doigté sur une liaison). Une fois situé de
l'autre côté, vous pouvez utiliser les décalages X / Y dans l'inspecteur ou les touches fléchées du clavier pour affiner
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la position.

Positionner l'élément au-dessus / au-dessous de la portée

Éléments avec une propriété "Position" disponible dans l'Inspecteur peut être facilement déplacé de au-dessus de la
portée vers en dessous, et vice versa:

1. Sélectionnez un ou plusieurs éléments.
2. Utilisez l'une des méthodes suivantes :

Modifiez le paramètre "Position" dans l'inspecteur.
Pressez X pour basculer entre haut / bas.

Remarque: Lorsque le placement automatique est activé pour un élément, vous ne pouvez pas le positionner de manière
à provoquer une collision avec d'autres éléments.

Désactiver le placement automatique

Sélectionnez l'élément et décochez la case "Placement automatique" dans l'Inspecteur.

L'élément revient à sa position par défaut. Il peut être repositionné à volonté et n'est plus évité lors de la mise en place
d'autres éléments.

Position dans la pile (Z)

Pour modifier la valeur de Position dans la pile (Z) :

Sélectionnez l'élément et modifiez la valeur "Position dans la pile (Z)" dans l'Inspecteur.

Dans les cas où les éléments sont autorisés à se chevaucher, Position dans la pile (Z) contrôle l'ordre dans lequel ils
sont placés les uns sur les autres. L'élément avec la valeur la plus basse sera placé derrière.

Plugins

Que sont les plugins ? Qu'est-ce que c'est ?

Les plugins sont de petits morceaux de logiciels qui ajoutent une fonctionnalité particulière à MuseScore. En activant un
plugin, une nouvelle option de menu est ajoutée au menu Plugins : par la suite, lorsque cette option est sélectionnée, le
plugin effectue une tâche particulière dans la partition.

Certains plugins sont pré-installés avec MuseScore-voir Plugins installés par défaut (ci-dessous). Vous pouvez trouver
beaucoup d'autres plugins dans le dépôt de plugins  : certains fonctionnent avec MuseScore 3, d'autres seulement avec
des versions plus anciennes de MuseScore, et d'autres encore avec l'un ou l'autre. Pour distinguer l'un de l'autre : Les
fichiers de code des plugins MuseScore 3.x et 2.x ont une extension en .qml ; pour les versions plus anciennes, c'est .js.

Avertissement : Les plugins peuvent potentiellement contenir du code incorrect ou malveillant, qui pourrait compromettre
ou endommager vos partitions, ou le système d'exploitation de votre ordinateur. Les plugins ne font l'objet d'aucune
vérification (sauf ceux qui sont installés par défaut). Vous devez soit faire confiance à l'auteur, soit vérifier le code vous-
même.

Installation

Note : Certains plugins peuvent nécessiter l'installation d'autres composants (polices, par exemple) pour fonctionner.
Consultez la documentation du plugin pour plus d'informations.

La plupart des plugins sont fournis sous forme d'archives ZIP : téléchargez le fichier .zip du plugin et décompressez-le
dans l'un des répertoires mentionnés ci-dessous (en fonction de votre système d'exploitation). Si le plugin est fourni
directement sous forme de fichier .qml non compressé, il suffit de le télécharger et de le placer dans l'un des mêmes
répertoires.

Une fois qu'un plugin est installé, il doit être activé dans le Gestionnaire de Plugins… afin de pouvoir l'utiliser - voir
Activer/Désactiver les Plugins.

Windows

Sous Windows, les nouveaux plugins doivent être installés dans %HOMEPATH%\Documents\MuseScore3\Plugins. Vous pouvez
également spécifier un dossier différent dans le répertoire Préférences de MuseScore.

Les [plugins préinstallés] (#plugins-installed-by-default) se trouvent dans %ProgramFiles%\MuseScore 3\Plugins (ou
%ProgramFiles(x86)%\MuseScore 3\Plugins pour les versions 32 bits) et dans %LOCALAPPDATA%\MuseScore\MuseScore 3\plugins sous
Windows ! --Vista, -->7 et ultérieur< ! ou C:\Documents and Settings\NAME\Local Settings\Application Data\MuseScore\MuseScore 3\plugins
(adapté à votre version linguistique) sur XP-->. Ces dossiers ne doivent pas être modifiés.
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MacOS

Sur macOS, les nouveaux plugins doivent être installés dans ~/Documents/MuseScore3/Plugins. Vous pouvez également
spécifier un dossier différent dans le répertoire Préférences de MuseScore.

Les [plugins préinstallés] (#plugins-installed-by-default) se trouvent dans le paquet MuseScore dans /Applications/MuseScore
3.app/Contents/Resources/plugins (pour afficher les fichiers du paquet, faites un clic droit sur MuseScore 3.app et choisissez
"Afficher le contenu du paquet"), et dans ~/Bibliothèque/Application Support/MuseScore/MuseScore3/plugins. Ces dossiers ne doivent
pas être modifiés.

Linux

Sous Linux, les nouveaux plugins doivent être installés dans ~/Documents/MuseScore3/Plugins. Vous pouvez également
spécifier un dossier différent dans le répertoire Préférences de MuseScore.

Les [plugins préinstallés] (#plugins-installed-by-default) se trouvent dans /usr/share/mscore-3.x/plugins et dans
~/.local/share/data/MuseScore/MuseScore3/plugins. Ces dossiers ne doivent pas être modifiés.

Les noms des répertoires peuvent être légèrement différents, en fonction de la langue de votre système d'exploitation.

Activer/désactiver les plugins

Pour pouvoir accéder aux plugins installés à partir du menu Plugins, ils doivent être activés dans le Gestionnaire de
Plugins… :

Pour ce faire, il vous suffit de cocher la case correspondante. Cela ajoute le nom du plugin à la liste dans le menu
Plugins.

Créer/modifier/exécuter des plugins

Il est possible de créer de nouveaux plugins ou de modifier des plugins existants et de les exécuter via le Créateur de
plugins :
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La documentation de tous les éléments disponibles peut également être trouvée ici.

Plugins installés par défaut

Certains plugins sont pré-installés avec MuseScore, mais ils ne sont pas activés par défaut. Voir Activer/désactiver les
plugins (ci-dessus) pour activer les plugins.

abc import

Ce plugin importe le texte ABC  d'un fichier ou du presse-papiers et le convertit en MusicXML. Une connexion Internet
est nécessaire, car il utilise un service web externe  pour la conversion.

Notes → color-notes

Ce plugin de démonstration colore les notes dans la zone sélectionnée (ou la partition entière), en fonction de leur
hauteur. Il colore la tête de toutes les notes de toutes les portées et voix selon la convention Boomwhackers. Chaque
hauteur a une couleur différente. C et C♯ ont une couleur différente. C♯ et D♭ ont la même couleur.
Pour colorer toutes les notes en noir, il suffit de relancer ce plugin (sur la même sélection). Vous pouvez également
utiliser le plugin 'plugin' Remove Notes Color  pour cela.

createscore

Ce plugin de démo crée une nouvelle partition. Il crée une nouvelle partition de piano avec 4 noires : C, D, E, F. C'est un
bon début pour apprendre à créer une nouvelle partition et à ajouter des notes à partir d'un plugin.

helloQml

Plugin de démo

Notes → note-names

Ce plugin indique le nom des notes dans la plage sélectionnée ou pour l'ensemble de la partition. Il affiche les noms des
notes (comme texte de la portée) selon les paramètres linguistiques de MuseScore : voix 1 et 3 notes au-dessus de la
portée ; voix 2 et 4 notes en dessous de la portée ; et notes d'accords dans une liste séparée par des virgules,
commençant par la note du haut.

Panel

Plugin de démo.

random
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Crée une partition aléatoire.

run

Ce plugin de démo exécute une commande externe. Il ne fonctionnera probablement que sous Linux.

scorelist

Plugin de démo

ScoreView

Plugin de démo

walk

Plugin de démo

Voir aussi

Outils

Liens externes

Plugins pour 3.x

Préférences

Les paramètres par défaut de MuseScore sont personnalisables dans le menu: Édition→Préférences... (Mac:
MuseScore→Préférences...).

La fenêtre des Préférences est composée de plusieurs onglets:

Rétablir toutes les préférences par défaut  rétablit toutes les préférences aux valeurs par défaut de la 1ère installation.
Ok enregistre les modifications et ferme la fenêtre.
Annuler ferme la fenêtre sans appliquer les modifications.
Appliquer enregistre et applique les modifications et laisse la fenêtre des préférences ouverte.

Général
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Dans cet onglet vous choisissez:

Démarrage du programme: Indiquez si vous souhaitez démarrer la session vide ou afficher une partition. Les
options sont l'une des suivantes: Démarrer à vide (aucune partition) / Continuer la dernière session / Démarrer avec
une nouvelle partition (c'est-à-dire que l'assistant de création de nouvelles partitions s'ouvre automatiquement) /
Démarrer avec la partition (le programme par défaut, ou celui de votre choix).
Vous pouvez également choisir les panneaux à afficher. Cela peut être n'importe quelle combinaison de Écran de
démarrage, Fenêtre de lecture, Navigateur, Centre de démarrage. Sélectionnez également si Visites guidées sera
actif.
Répertoires: Spécifiez les dossiers par défaut pour les fichiers de partition, les Fichiers de style, les Modèles de
partitions personnalisés, les Plugins, les SoundFonts additionnelles, les Images, et les Extensions.
Langue: Choisissez la langue d’affichage. Les traductions peuvent être téléchargées à partir de cet onglet ou par le
menu Aide→Gestionnaire de ressources.
Télémétrie: Cochez / décochez la case pour autoriser ou non MuseScore à collecter des données d’utilisation du
logiciel, La liste des données collectées est repertoriée dans cet article Telemetry  (En anglais).
Thème: Choisissez entre le thème clair ou sombre, la taille des icones, la largeur des icônes et la hauteur des
icônes, ainsi que la police d’affichage, "Police de caractères" et "taille de Police".
Enregistrement automatique: Sélectionner le délai (en minutes) entre deux enregistrements automatiques.
Contrôle à distance OSC

Fond

233

https://musescore.org/fr/node/300080


Utilisez l’onglet Fond pour personnaliser les couleurs de l’arrière-plan et du papier de la partition. La couleur de l’Arrière-
plan par défaut est bleu foncé (RGB 20, 36, 51 ; Alpha 255), la couleur par défaut du papier de la partition est blanche.

Arrière-plan: Permet de choisir la couleur du fond autour des pages de la partition. Cliquez sur la barre "Couleur"
pour ouvrir le sélecteur de couleurs pour la modifier, ou choisissez "Image" et cliquer sur l’icône de fichier pour
sélectionner un fichier d’arrière-plan.
Zoom: Permet de choisir le "Zoom par défaut" des nouvelles partitions, en Pourcentage, Largeur de page, Page
entière, Deux pages; la "Précision du zoom au clavier" est exprimée en Nombres de pas nécessaires pour doubler le
zoom au clavier; la "Précision du zoom à la souris" est exprimée en Nombres de pas nécessaires pour doubler le
zoom à la souris.
Papier: Permet de choisir la couleur des pages de la partition. Les réglages sont identiques à l’Arrière-plan ci-
dessus, de plus, vous pouvez choisir de "Utiliser la même couleur pour les palettes" en cochant la case.
Faire défiler les pages: Paramètre l’affichage des pages de la partition. Soit "Horizontalement", en ligne, soit
"Verticalement" en colonne, Cochez la case "Limiter la zone de défilement aux bordures de la page" pour limiter la
zone de défilement.
Divers: Pour lisser les lignes obliques et les bords de formes, cochez "Anticrénelage" (cochée par défaut). La
"Proximité des éléments sélectionnés" permet de régler la distance entre le pointeur de souris et l’élément à
sélectionner, plus le chiffre est petit, plus la précision de sélection est grande, mais l’élément plus difficile a
sélectionner, plus le chiffre est grand, moins la précision de sélection est grande, rendant difficile de ne pas
sélectionner les éléments voisin, la valeur par défaut est de 6 pixels.

Saisie des notes
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Les paramètres de saisie des notes, de la lecture pendant l’édition, et le contrôle à distance MIDI, sont réglables dans cet
onglet:

Saisie des notes

Activer l'entrée MIDI: Doit être cochée si un clavier maître MIDI est utilisé pour la saisie des notes.
Mettre en couleur les notes extrêmes de l'étendue de l'instrument: Veuillez consulter Saisie des notes et
Tessiture utilisable (Propriétés de la portée: Toutes les portées).
Délai entre les notes en mode Temps réel automatique: Veuillez consulter Temps réel (Automatique).

Jouer les notes pendant l'édition

MuseScore joue la note au moment de sa saisie ou de sa sélection.

Durée par défaut: Permet de régler la durée d’écoute en millisecondes.
Pour entendre toutes les notes de l’accord, cochez Jouer l'accord complet pendant l'édition.
Pour entendre les symboles d'accord, cochez Jouer les symboles d'accord pendant l'édition.

Contrôle à distance MIDI

Le Contrôle à distance MIDI vous permet d'utiliser certaines touches de votre clavier MIDI pour saisir des notes et des
silences et pour sélectionner la durée des notes, sans utiliser la souris ou le clavier (d'ordinateur). Le paramètre par défaut
est désactivé.

Pour affecter une commande à une touche MIDI:

1. Assurez-vous que "Contrôle à distance MIDI" est coché (votre clavier MIDI doit être connecté avant d'ouvrir le
programme).

2. Cliquez sur le bouton rouge à côté de l'option à laquelle vous souhaitez affecter une touche MIDI: le bouton rouge
s'allume maintenant.

3. Appuyez sur une touche du clavier MIDI. Le bouton rouge s'éteint et le bouton vert s'allume à la place. La touche
MIDI a maintenant été affectée à l'option souhaitée.

4. Répétez "2" et "3" pour attribuer d'autres touches.

Une fois que vous avez défini vos paramètres de touches, vous pouvez utiliser le clavier MIDI pour contrôler les
opérations de saisie des notes. Vous pouvez vérifier vos paramètres de touches en observant la Barre d'outils saisie de
notes de MuseScore, tout en appuyant sur les touches MIDI.

Pour désactiver temporairement la télécommande MIDI: décochez "Contrôle à distance MIDI": tous les boutons d'action
des touches d'entrée MIDI sont maintenant grisés. Remarque: vos affectations de clés sont toujours enregistrées entre les
sessions MuseScore et ne sont pas affectées par la désactivation.

Remarques: (1) L'option "Effacer" désactive tous les boutons verts de la session courante MuseScore mais tous les
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paramètres de touches MIDI enregistrés par l'utilisateur sont conservés et seront rechargés à la session suivante. (2) Un
réglage de touche MIDI qui est activé ne peut plus être désactivé par la suite, et le bouton vert restera toujours allumé:
cependant il peut être écrasé par une touche MIDI différente en utilisant à nouveau le bouton rouge. (3) Si la même
touche MIDI est affectée accidentellement à plus d'une option, alors tous les boutons verts associés restent allumés bien
qu'un seul fonctionne. Pour réparer, voir "(2)".

Partition

Fichiers par défaut

Fichiers de liste d'instruments par défaut (deux peuvent être sélectionnés)
Fichiers de liste de l'ordre des instruments par défaut (deux peuvent être sélectionnés)
Style par défaut pour la partition et les parties (voir Charger un style / Enregistrer le style)

Affichage

cochez Afficher les controles MIDI dans le mélangeur si besoin.

E/ S
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PortAudio (API / Périphérique)

Cela vous permet de définir l'interface audio API et de spécifier le Périphérique à utiliser pour la lecture audio: par ex.
haut-parleurs / écouteurs intégrés, casque USB, sans fil, etc.

MIDI Entrée/Sortie/Latence de la sortie

Lorsqu'un périphérique d'entrée MIDI externe est connecté, son identifiant apparaît dans Entrée MIDI.
Lorsque l'appareil est connecté pour la première fois, vous devez également sélectionner l'option Sortie MIDI
appropriée afin d'activer la saisie de notes et de corriger la lecture audio (par exemple sous Windows, cela peut être
"MMS<nom de l'appareil>"): puis fermez et rouvrez le programme pour confirmer les modifications.
Régler la Latence de la sortie MIDI selon votre matériel.

Serveur JACK Audio

Cochez ces options si nécessaire si vous utilisez le JACK  Audio Connection Kit.

Moteur Audio

En cas de perte de communication entre votre appareil audio ou votre clavier MIDI et MuseScore (pas de sortie audio ni
d'action MIDI), cliquez sur Redémarrer les périphériques Audio and MIDI  pour les restaurer.

Importer
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Ces paramètres déterminent la manière dont les fichiers provenant d'autres sources sont importés:

Style utilisé pour l'import

En utilisant le Style intégré de MuseScore ou Utiliser le fichier de style de votre choix (voir Charger un style /
Enregistrer le style).

Jeu de caractères utilisé pour l'import de fichiers binaires

Choisir le jeu de caractère selon le fichier importé:

Jeux de caractères pour l'import Guitar Pro.
Jeux de caractères pour l'import Overture.

MusicXML

Cochez ces options si nécessaire:

Importer la mise en page.
Importer les sauts de système et de page.
Appliquer la police par défaut (Edwin) aux partitions importées.

MIDI

Régler la Note la plus courte des fichiers MIDI importés sur la durée voulue de Noire à Octuple-croche.

Lors de l'ouverture de partitions d'anciennes versions de MuseScore

Cochez la case pour Afficher les options de style et de gravure améliorés.

Exporter
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Ces paramètres déterminent comment les différents fichiers sont exportés à partir de MuseScore:

PNG

Réglage de la Résolution de l'image exportée pour PNG ou SVG en DPI.
Cochez la case pour avoir un Arrière-plan transparent.

PDF

Réglage de la Résolution du PDF exporté.

MIDI

Cochez les cases pour:

Développer les répétitions dans les fichiers MIDI exportés.
Exporter les RPNs (Numéros de Paramètres Référencés) dans les fichiers MIDI exportés.

Audio

Cocher la case pour Normaliser le fichier audio exporté.
Choisir le Taux d'échantillonage voulu.
Choisir le bitrate MP3 voulu.

MusicXML

Choisir une des quatre options suivantes:

Exporter toute la mise en page.
Exporter tous les sauts de système et de page.
Exporter uniquement les sauts de système et de page ajoutés manuellement.
Ne pas exporter les sauts de sytème ou de page.

Raccourcis
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Toutes les actions possibles avec MuseScore sont répertoriées, avec le raccourci associé s'il existe. Pour définir un
nouveau raccourci, sélectionnez une entrée existante dans la liste et cliquez sur Définir... (ou double-cliquez simplement
sur l'entrée), puis entrez le nouveau raccourci en utilisant jusqu'à quatre touches. Vous pouvez également réinitialiser
n'importe quel raccourci de la liste à sa valeur par défaut ou effacer un raccourci que vous sélectionnez. Les raccourcis
répertoriés dans les préférences apparaissent à côté de leurs commandes associées dans les menus.

Remarque: Certains raccourcis, y compris ceux par défaut, peuvent ne pas fonctionner avec certains claviers.

Vous pouvez Enregistrer la liste des raccourcis vers un fichier de votre choix, et la Charger plus tard, ce qui facilite le travail
avec différents paramètres de raccourcis à des fins différentes.
La liste des raccourcis peut être imprimée ou exportée vers d'autres supports (pdf, etc.) à l'aide du bouton Imprimer en bas
à droite de la fenêtre.

Mettre à jour
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Vérification automatique des mises à jour

Cochez les cases pour vérifier au démarrage de Musescore:

Vérifier la disponibilité d'une nouvelle version de MuseScore.
Vérifier la disponibilité de nouvelles versions des extensions de MuseScore.

Les mises à jour peuvent être vérifiées manuellement dans Aide→Rechercher les mises à jour .

Avancé

Vous permet de contrôler des paramètres spécifiques pour "application, "export", "i/o" et "user interface", ainsi que les
paramètres de couleur.

Voir aussi

Raccourcis clavier
Langue, traductions, et extensions
Rechercher les mises à jour

Propriétés de la partition

La boîte de dialogue Propriétés de la partition contient des métabalises de document telles que "workTitle", "composer",
"Copyright", etc.

Pour afficher le dialogue :

1. Assurez-vous que la partition ou la partie d'instrument concernée est l'onglet actif ;
2. Dans le menu, sélectionnez Fichier → Propriétés de la partition.

Plusieurs méta-tags sont générés automatiquement lorsque vous créez une partition à l'aide de Assistant Créer une
Nouvelle Partition, et d'autres peuvent être ajoutés ultérieurement. Les méta-tags peuvent également être incorporés dans
un en-tête ou un pied de page si nécessaire - voir ci-dessous.

Modifier les méta-tags

1. Assurez-vous que la partition ou la partie d'instrument concernée possède le sous-menu actif ;

2. Dans le menu, sélectionnez Fichier → Propriétés de la partition.
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3. Modifiez le texte des différentes métabalises selon vos besoins ;

4. Pour ajouter une autre méta-tag, cliquez sur le bouton Nouveau…. Remplissez le champ "Nom" de la nouvelle balise
et appuyez sur OK ;

Métabalises préexistantes

Chaque partition affiche les champs suivants dans Propriétés de la partition :

Chemin du FIchier : L'emplacement du fichier de la partition sur votre ordinateur.
Version de MuseScore : La version de MuseScore avec laquelle la partition a été enregistrée en dernier lieu.
Révision : La version de MuseScore avec laquelle la partition a été enregistrée en dernier : La révision de
MuseScore avec laquelle la partition a été enregistrée en dernier lieu.
Niveau d'API : La version du format de fichier.
arranger : (vide)
composer : Le texte initial est le même que celui de "Compositeur" sur la première page du Assistant Créer une
Nouvelle Partition.
copyright : Le texte initial est le même que celui du "Copyright" sur la première page du Assistant Créer une
Nouvelle Partition (si vous avez besoin d'un symbole de copyright, copiez/collez ceci : &copy ;).
creationDate : Date de création de la partition. Elle peut être vide si la partition a été enregistrée en mode test (voir
Options de la ligne de commande).
lyricist : Le texte initial est le même que celui de "Parolier" sur la première page du Assistant Créer une Nouvelle
Partition.
movementNumber : (vide)
movementTitle : (vide)
originalFormat : Cette balise n'existe que si la partition est importée (voir formats de fichiers).
platform : La plateforme informatique sur laquelle la partition a été créée. Elle peut être vide si la partition a été
enregistrée en mode test.
poet : (vide)
source : Peut contenir une URL si la partition a été téléchargée à partir de Enregistrer la partition sur MuseScore.
translator : (vide)
__ woekNumber__ : (vide)
workTitle : Le texte initial est le même que celui du "Titre" sur la première page du Assistant Créer une Nouvelle
Partition.

Saisie des métadonnées de travail / mouvement / partie
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workNumber est le numéro de l'œuvre la plus importante (par exemple 8 pour "Les quatre saisons", op. 8, de
Vivaldi).
titre de l'œuvre est le titre de l'œuvre la plus importante (par exemple, "Les quatre saisons").
movementNumber est le numéro du mouvement dans l'œuvre plus grande (par exemple 3 pour Automne).
movementTitle est le titre du mouvement dans l'œuvre plus grande (par exemple "Automne").

Il est d'usage, lors de l'utilisation de l'assistant de nouvelle partition, de créer une œuvre avec le movementTitle comme
titre (même si elle se termine alors par workTitle) et, directement après avoir créé la partition, de modifier ces
informations dans la boîte de dialogue Propriétés de la partition.

Chaque partie possède en outre la balise meta suivante, générée et remplie lors de la création de la partie :

partName : Le nom de la partie tel qu'il a été donné lors de la création de la partie (qui est également utilisé pour
remplir le texte du nom de la partie correspondante dans le cadre vertical supérieur-sachez que les modifications
ultérieures apportées à l'une ne se reflètent pas dans l'autre).

En-tête/Pied de page

Pour afficher le contenu d'une ou plusieurs métabalises dans un en-tête ou un pied de page pour votre partition :

1. Assurez-vous que la bonne partition ou partie d'instrument est l'onglet actif ;

2. Dans le menu, sélectionnez Format &rarr ; Style... &rarr ; Header, Footer :

Si vous survolez avec votre souris la région de texte de l'en-tête ou du pied de page, une liste de macros apparaîtra,
indiquant leur signification, ainsi que les balises méta existantes et leur contenu.
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3. Ajoutez des balises (par exemple $:workTitle:) et des macros (par exemple $M) aux cases appropriées, selon les
besoins ;

4. Cliquez sur Appliquer pour voir à quoi ressemble l'en-tête ou le pied de page dans la partition. Apportez des
corrections à la boîte de dialogue si nécessaire ;

5. Si une partie d'instrument se trouve dans a feuille active, cliquez sur Appliquer à toutes les parties , si vous voulez
appliquer ces paramètres à toutes les parties de la partition ;

6. Cliquez sur OK pour attribuer l'en-tête ou le pied de page et quitter la boîte de dialogue.

Voir aussi

Mise en page et formatage: En-tête et Pied de Page
Option par ligne de commande:

Propriétés des Portées / Parties

La boîte de dialogue Propriétés de la Portée / Partie permet de modifier l'apparence ddes portées, d'ajuster leurs
tonalités et les transpositions, de changer d'instrument, etc. Pour l'ouvrir :

Faire un clic droit sur une zone vide de la portée ou sur le nom de l'instrument, puis sélectionner Propriétés de la
Portée/Partie....

Boîte de dialogue "Propriétés de la Portée / Partie", version 3.0.

Types de portée
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Il existe quatre types de portées différentes :

1a. Portée standard I. Portée avec clef utilisée par la plupart des instruments, à l'exception des instruments à cordes
pincées à frettes.
1b. Portée standard II : Portée avec clef octaviée utilisée par certains instruments à cordes pincées à frettes, avec
possibilité de régler le nombre de cordes et l'accordage.
2. 2. Tablature : Portée pour instrument à cordes pincées, qui affiche la musique en utilisant des chiffres ou des lettres
dessinées sur les cordes. Elle contient également des options permettant de régler le nombre de cordes et l'accordage de
l'instrument. Les tablatures sont souvent utilisée lorsqu'il existe plusieurs solution pour produire le même son.
3. 3. Portée de percussion : Une portée sans clef pour les instruments à percussion.

(NDT : MuseScore ne propose pas de tablature pour accordéon diatonique de façon native, mais il existe un plugin dédié
à cela.)

Il est possible de changer un type de portée en une autre en utilisant le dialogue Instruments, à condition que la portée
originale soit chargée avec le bon instrument. Par exemple, pour changer une portée standard en tablature, elle doit
contenir un instrument à cordes pincées. De même, pour changer une portée standard en une portée de percussion, vous
devez vous assurer qu'elle contient un instrument de percussion approprié, etc.

La plupart des options du dialogue "Propriétés de la Portée / Partie" de la partition sont identiques pour toutes les portées,
mais chaque type de portée peut également présenter une ou deux options spécifiques.

Propriétés des Portées / Parties : commun à toutes les portées

Les options suivantes de sont communes à tous les type portées :

Lignes : Nombre de lignes affichées sur la portée.

Interligne : Distance entre deux lignes de la portée, mesurée en espaces (abbr. : sp.). Remarque : Il n'est pas
recommandé de modifier la valeur par défaut. Si vous devez agrandir ou réduire la portée, utilisez plutôt la boîte de
dialogue Paramètres de la page....

Distance supplémentaire au-dessus de la portée : Augmente ou diminue la distance entre la portée et celle du dessus
dans tous les systèmes. Remarque : Ce paramètre ne s'applique pas à la portée supérieure d'un système, qui est
contrôlée par la distance minimum/maximum du système (voir Mise en page et mise en forme : Format → Style ... →
Page).

Remarque : Pour modifier l'espacement au-dessus d'une seule ligne de portée dans un système particulier, voir Sauts et
espacements .

Échelle : Modifie (en pourcentage) la taille de la portée sélectionnée et de tous les éléments qu'elle contient.
Remarque_pour ajuster _globalement la taille de la partition, utilisez Échelle depuis le menu Format→Paramètres de la
page...Menu).

Masquer lorsque vide : Avec le paramètre "Cacher les portées vides" dans Format → Style ... → Partition, cela
détermine si la portée sera cachée lorsqu'elle est vide ou pas.

Valeurs possible :

Automatique (par défaut) : La portée sera cachée si elle est vide et la fonction du paramètre "Masquer les portées
vides dans les système" dans dans Format → Style ... → Partition.
Toujours : La portée sera cachée lorsqu'elle est vide, même si le paramètre "Masquer les portées vides dans les
systèmes" n'est pas activé.
Jamais : La portée ne sera jamais caché lorsqu'elle est vide.
Instrument : Pour les instruments contenant plusieurs portées, la portée n'est cachée que si toutes les portées de
cet instrument sont vides.

Afficher la clef : Afficher ou masquer la clef.

Afficher l'indication de mesure : Afficher ou masquer l'indication de mesure.

Afficher les barres de mesures : Afficher ou masquer les barres de mesure.

Masquer la barre de mesure du système : Afficher ou masquer la barre de mesure à gauche du système.

Fusionner les silences similaires : Les silences similaires et sur le même temps des voix 1, 2, 3 et même 4, rarement
tous ensembles, sont regroupés en un seul silence qui se superposent comme c'était le cas, par défaut, dans les toutes
premières versions de MuseScore. Les afficionados "d'Elaine Gould" avaient exigé qu'il n'en soit rien et que les silences
de voix différentes soient séparés. Cette superposition est désormais optionnelle pour ceux qui y tiennent.

Ne pas masquer si le système est vide : Ne pas masquer jamais cette portée, même si tout le système est vide. Ceci
annule tout paramètre "Masquer les portées vides dans les systèmes" dans Format → Style ... → Partition.

Petite portée : Réduit la taille de la portée. Vous pouvez définir la valeur par défaut dans le menu Format → Style ... →
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Tailles.

Lignes de portée invisibles : Rend les lignes invisibles à l'exportation PDF ou à l'impression.

Couleur des lignes de portée : Utilisez le sélecteur de couleur pour choisir la couleur des lignes de la portée.

Découper : Utilisé pour créer une portée dans laquelle seules les mesures contenant des notes sont visibles (pour créer
ossias  (Wikipedia) par exemple). Cette fonction peut être utilisée indépendamment de "Masquer lorsque vide".

Instrument : Nom de l'instrument choisi dans la boîte de dialogue Instruments (I) ou dans la boîte de dialogue Sélection
d'un instrument. Le son associé à cet instrument peut être changé dans le Mélangeur.

Remarque : Les propriétés ci-dessous (c'est-à-dire Nom de la partie, Nom long de l'instrument etc.) sont issues des
valeurs par défaut définies dans le fichier MuseScore instruments.xml .

Nom de la partie : Nom de la partie. Ce nom sera égalament affiché dans le Mélangeur et dans la boîte de dialogue
Instruments (I). Toute modification que vous apportez au nom de la Partie n'affecte que cet instrument particulier et aucun
autre.

Remarque : Le nom de la Partie est défini par la valeur de l'élément trackName dans le fichier instruments.xml . Si
trackName n'a pas été défini, la valeur de longName (c'est-à-dire "Nom long de l'instrument" - voir ci-dessous) est utilisée
à la place.

Nom long de l'instrument : Nom affiché à gauche de la portée dans le premier système. Le nom long de l'instrument
peut également être édité directement en tant qu'objet texte (voir Édition du texte). Le nom peut tenir sur plusieurs lignes.

Nom abrégé de l'instrument : Nom affiché à gauche de la portée dans les systèmes suivants. Le nom abrégé de
l'instrument peut également être édité directement en tant qu'objet texte (voir Édition de texte). L'édition affecte toutes les
occurrences de la partition. Le nom peut tenir sur plusieurs lignes.

Tessiture utilisable :
* Amateur : Les notes en dehors de la fourchette seront colorées en vert olive/jaune foncé dans la partition.
* Professionnel : Les notes en dehors de la fourchette seront colorées en rouge dans la partition.

Pour désactiver la coloration des notes hors fourchette : Dans le menu, sélectionner Édition→Préférences... (Mac :
MuseScore→Préférences...), cliquez sur l'onglet "Saisie des notes", et décocher "Mettre en couleur les notes extrêmes de
l'étendue de l'instrument".

Voir aussi, Mettre en couleur les notes extrêmes de l'étendue de l'instrument.

Transposition : Cette option garantit que les portées des instruments transpositeurs affichent la musique à la bonne
hauteur écrite. Il est possible de régler la transposition en termes d'intervalle musical (plus une octave si nécessaire) vers
le haut ou vers le bas.

Utiliser les nuances sur une seule note (à partir de la version version 3.1) : Laisser coché cette case pour permettre
l'expression de la nuance sur une seule note (comme sfz etc.) et des lignes de diminendo et de crescendo sur des notes
simples (ou liées).

Flèches de navigations : Utiliser les boutons ↑ et ↓, en bas à gauche de la fenêtre Propriétés de la Portée / Partie, pour
se déplacer vers les portées précédentes ou suivantes.

Propriétés de la Portée / Partie : instruments à cordes pincées

Les portées des instruments à cordes pincées à frettes ont quelques options supplémentaires en plus de celles
énumérées ci-dessus :

Nombre de cordes : Affiche le nombre de cordes de l'instrument.

Éditer les paramètres des cordes… : Ce bouton ouvre une boîte de dialogue qui vous permet de définir comment
l'instrument est accordé. Voir Changement d'accord.

Propriétés avancées de style

Cliquer sur le bouton Propriétés avancées de style...  pour ouvrir une boîte de dialogue permettant de régler quelques options
avancées des portées. Elles varient en fonction du [type de portée] (#types de personnel) choisi : voir les sections
correspondantes ci-dessous pour plus de détails.

Modèle

En bas de la boîte de dialogue des propriétés de style avancées, vous trouverez un certain nombre de boutons qui vous
permettent de modifier facilement les éléments suivants :

Le nombre de lignes affichées par une portée de percussion.
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Le type de portée d'un instrument à cordes pincées. Par exemple, vous pouvez passer d'une portée standard à une
tablature et vice versa, ou choisir parmi un certain nombre d'options de tablature.

1. Faire une sélection dans la liste déroulante intitulée "Modèle" ;
2. Appuyer sur &lt ; Rétablir par rapport au modèle  ;
3. Appuyer sur OK pour accepter les modifications et quitter le dialogue (ou Annuler pour annuler l'opération).

Options pour les portées Standard et de Percussion

Afficher la clef / l'armure / les barres de mesure / l'indication de mesure / sans hampe
Ces options affichent ou masquent les différents éléments.

Type de tête de note
Voir Forme de têtes de note.

Options pour les portées Tablature

Inverser
Si cette option n'est pas cochée, la ligne supérieure de la tablature fera référence à la corde la plus haute, et la ligne
inférieure de la tablature à la corde la plus basse (c'est l'option la plus courante). Si elle est cochée, la ligne de tablature
supérieure se rapporte à la corde la plus basse, et la ligne de tablature inférieure à la corde la plus haute (par exemple,
les tablatures de luth à l'italienne). Par exemple :

'Tablature inversée'.

Options pour les portées 'Tablature' : Instruments à frettes

Les repères sont des nombres ou des lettres utilisés pour indiquer l'emplacement des notes sur le manche. Le groupe de
propriétés suivant définit l'apparence des repères :

Police
8 polices sont fournies, supportant tous les symboles nécessaires dans 8 styles différents (Serif moderne, Sans moderne,
Renaissance, Phalèse, Bonneuil-de Visée, Bonneuil-Gaultier, Dowland, Didactique du luth).

Taille
Taille de la police en points typographiques. Les polices intégrées ont généralement une bonne apparence avec une taille
de 9-10pt.

Décalage vertical
MuseScore essaie de placer les repères de manière sensée et vous n'avez généralement pas besoin de modifier cette
valeur (fixée à 0.00) pour les polices intégrées. Si la police comporte des symboles non alignés sur la ligne de base (ou
d'une autre manière que MuseScore n'attend pas), cette propriété vous permet de déplacer les repères vers le haut
(décalages négatifs) ou vers le bas (décalages positifs) pour un meilleur positionnement vertical. Les valeurs sont en sp.

Les repères sont
Choisir entre Nombres ('1', '2'...) ou Lettres ('a', 'b'...). Lorsque des lettres sont utilisées, "j" est sauté et "k" est utilisé pour
la 9ème case.

Les repères sont représentés
Choix entre Sur les lignes ou Au dessous des lignes. Par exemple :

Lettres placées au dessous des lignes

Les lignes sont
Choisir entre Continues (lles lignes passent sur les marqueurs) ou Discontinue (un petit espace est ménagé pour laisser
la place au repère). Par exemple :

247



Tablature avec lignes discontinues

Afficher les repères liés
Si cette case n'est pas cochée, seule la première note d'une série de notes liées est affichée. Si elle est cochée, toutes
les notes de la série de notes liées sont affichées.

Afficher les doigtés dans la tablature
Cocher cette case pour permettre l'affichage des symboles de doigté appliqués à partir d'une palette.

Options pour les portées 'Tablature' : Figures de rythme

Ce groupe de propriétés définit l'apparence des symboles indiquant les valeurs des notes.

Police
La police de caractères utilisée pour dessiner les notes. Actuellement, 5 polices sont fournies, supportant tous les
symboles nécessaires dans 5 styles différents (moderne, tablature italienne, tablature française, baroque français (sans
tête), baroque français). Utilisée uniquement avec l'option Figure de rythme.

Taille
Taille de la police, en points typographiques. Les polices intégrées ont généralement une bonne apparence avec une taille
de 15pt. Utilisée uniquement avec l'option Figure de rythme.

Décalage vertical
S'applique uniquement lorsque l'option Figure de rythme est sélectionnée (voir ci-dessous). Utilisez des valeurs de
décalage négatives pour augmenter les symboles de valeur de note, des valeurs positives pour les diminuer.

Affiché comme :

Aucune : Aucune figure de rythme ne sera dessinée (comme dans les exemples ci-dessus)
Figure de rythme : Des symboles sous forme figure de rythme seront dessinés au-dessus de la portée. Lorsque
cette option est sélectionnée, les symboles sont dessinés seulement lorsque la valeur de la note change, sans être
répétés (par défaut) pour une séquence de notes ayant toutes la même valeur. Par exemple
NOT FOUND: TabExemple_durée_1.png
Hampes et ligatures : Les hampes et les ligatures (ou crochets) seront dessinées. Les valeurs sont indiquées pour
chaque note, en utilisant la même mécanique typographique que pour une portée normale ; toutes les commandes
de la palette de ligatures standard peuvent être appliquées à ces ligatures également. Par exemple :

Répétées :

Si plusieurs notes qui se suivent ont la même durée, vous pouvez spécifier si et où répéter le même symbole de note,
c'est-à-dire :

Jamais
À chaque nouveau système
À chaque nouvelle mesure
Toujours

Remarque : Cette option n'est disponible que si "Afficher comme : Figure de rythme" est sélectionné (voir ci-dessus).

__Style de hampe: __

Au-dessous de la portée : Les hampes sont tracées comme des lignes à hauteur fixe au-dessus/en dessous de la
portée.
À l'intérieur de la portée : Les hampes sont dessinées dans la portée, collées aux repères.

Remarque : Cette option n'est disponible que si "Afficher comme : Hampes et ligatures" est sélectionné (voir ci-dessus).

Position de la hampe :

_Au-dessous _ : Les hampes et les ligatures sont dessinées au dessus de la portée.
Au-dessus : Les hampes et les ligatures sont dessinées au dessous de la portée.
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Remarque : Cette option n'est disponible que si "Afficher comme : Hampes et ligatures" est sélectionné ainsi que and
"Style de hampe : Au dessous de la portée" (voir ci-dessus).

Blanches :

Aucune
Avec une hampe courte
Avec une hampe barrée

Remarque : Cette option n'est disponible que si "Afficher comme : Hampes et ligatures" et "Style de hampe : Au-dessous
de la portée" sont sélectionnés (voir ci-dessus).

Afficher les silences
Les symboles de note peuvent être utilisés pour indiquer les silences. Lorsqu'ils sont utilisés pour les silences, les
symboles de note sont dessinés à une position légèrement inférieure. Utilisé uniquement avec l'option Symboles de
notes.

Aperçu

Affiche une courte portée sous forme de tablature avec tous les paramètres actuels appliqués.

Changer d'instrument

À tout moment, vous pouvez changer l'instrument d'une portée. La méthode suivante permet de mettre à jour le son de
l'instrument, le nom de la portée et la transposition en une seule fois.

1. Faire un clic droit sur une partie vide d'une mesure OU sur le nom de l'instrument et choisissez Propriétés de la Portée /
Partie... ;

2. Cliquer sur Changer d'instrument... (sous "Propriétés de la partie") ;
3. Choisir votre nouvel instrument et cliquez sur OK pour revenir à la boîte de dialogue "Propriétés de la Portée/Partie" ;
4. Cliquer à nouveau sur OK pour revenir à la partition.

À ne pas confondre avec Changement d'instrument au cours d'une portée.

Liens externes

How to create an ossia with another staff  (for MuseScore 2, still works for MuseScore 3, but here the Cutaway
option might be the better choice)
How to create an ossia using image capture  (for MuseScore 2, still works for MuseScore 3, but here the Cutaway
option might be the better choice)

Timeline

Introduction

La timeline a été développée dans le cadre du Google Summer of Code 2017, et incluse pour la première fois dans
MuseScore 3.0.

Présentation globale

La timeline est un outil de navigation qui propose une vue schématique de la partition où les mesures et les instruments
sont ordonnés. La timeline se présente en quatre parties :

Meta-étiquettes

Les méta-étiquettes sont situées dans la partie supérieure gauche de la timeline. Chacune contient le nom d'une
métadonnée et à chacune correspond une méta-ligne .

Étiquettes des instruments

Elles sont situées dans la partie inférieure gauche de la timeline. À chacune correspond une portée de la partition.

Méta-lignes

Elles constituent la partie supérieure droite de la timeline. Chacune montre l'évolution d'un type de méta-éléments.

Grille principale

Elle constitue la partie inférieure droite de la timeline. Elle est divisée en plusieurs "cellules" (chaque mesure de chaque
portée étant ainsi représentée par une colonne, avec une cellule par instrument)
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Méta-éléments

Les méta-éléments sont les éléments de la partition qui ne sont pas des notes, mais qui ont leur importance (clef,
indication de mesure, tempo, repères, barres de répétition, les reprises, les marqueurs).

Actions de bases

Sélectionner une mesure

Pour sélectionner une mesure dans la timeline, cliquez sur la cellule correspondante. Un cadre bleu apparait alors autour
de la cellule, signifiant que la mesure a été sélectionnée. La partition s'affiche alors centrée sur la mesure sélectionnée.

Sélectionner plusieurs mesures

Étendre la sélection

Maintenez Maj ainsi que le bouton gauche de la souris et déplacez le curseur sur la grille pour sélectionner toute la plage
ainsi parcourue. Toutes les cellules de la grille ainsi que les mesures sur la partition sont ainsi sélectionnées.

Sélectioner avec [Maj]

Si vous avez déjà sélectionné une mesure, vous pouvez maintenir Maj et sélectionner une autre cellule dans la timeline
pour étendre la sélection jusqu'à cette autre cellule comme vous pouvez le faire directement sur la partition.

Sélectionner avec [Ctrl]

Si aucune cellule n'est sélectionnée , maintenez Ctrl et sélectionnez une cellule pour sélectionner la mesure
correspondante sur toutes les portées en même temps.

Effacer la sélection

Si une ou plusieurs cellules sont sélectionner, maintenez Ctrl et cliquez n'importe où dans la grilles ou dans les méta-
rangées pour effacer la sélection.

Sélectionner des méta-valeurs

De même que pour les mesures, vous pouvez sélectionnez les méta-valeurs sur la timeline pour les sélectionner
également sur la partition.

Naviguer dans la fenêtre

Navigation de base

Actionnez la roulette de la souris vers le haut ou le bas pour vous déplacer la grille des mesures dans les portées Les
méta-rangées et méta-étiquettes ne bougent pas.

Navigation [Maj]

Maintenez Maj et actionnez la roulette de la souris vers le haut ou le bas pour déplacer la grille respectivement vers la
gauche ou la droite. Les méta-rangées et méta-étiquettes ne bougent pas.

Naviguer avec [alt]

Maintenez Altet déplacez la souris vers le haut ou le bas pour déplacer plus rapidement la grilles et les méta-données,
respectivement vers la gauche ou la droite, plus rapidement qu'en naviguant avec Maj. Les méta-étiquettes et le nom des
instruments ne bougent pas.

Faire glisser le contenu de la fenêtre

Pour faire glisser le contenu de la timeline, maintenez le bouton gauche de la souris enfoncé et déplacez-le.

Action sur les étiquettes
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Réorganiser les méta-étiquettes

Toutes les méta-étiquettes (en dehors étiquettes de portées) peuvent être réorganisées. En déplaçant le curseur de la
souris sur l'une des méta-étiquettes, de petites flèches vers le haut et vers le bas apparaissent. Cliquez sur la flèche vers
le haut pour échanger ligne avec celle qui se trouve au-dessus. Cliquez sur la flèche vers le bas pour échanger la ligne
avec celle qui se trouve en dessous.

Masquer les méta-étiquettes

Avec un clic droit sur les méta-étiquette, une petite fenêtre s'ouvre vous permettant de sélectionner les lignes que vous
voulez voir s'afficher ou pas.

Masquer les portées

Cette action correspond à rendre visible ou pas une portée dans la fenêtre "Instrument" (Raccourci clavier "I").

Tous les instruments - visible ou non - seront affichés sur la timeline. Lorsque curseur de la souris est amener sur
l'étiquette d'un instrument, un petit œil apparaît sur le côté droit, qui est ouvert si l'instrument est visible sur la partition, et
fermé si l'instrument est invisible. Cliquez sur l'œil pour basculer entre les deux options.

Zoomer

Pour effectuer un zoom avant ou arrière sur la timeline, maintenez la touche Ctrl et faites rouler la molette de la souris vers
le haut ou vers le bas.

Menus Contextuels

Pour faire apparaître un menu contextuel, cliquez avec le bouton droit de la souris sur la timeline. Deux menus
contextuels se trouvent à ces endroits : sur les méta-étiquettes, sur les étiquettes d'instruments.

Menus contextuels des méta-étiquettes

En cliquant avec le bouton droit sur les méta-étiquettes, un menu contextuel apparaît affichant toutes les méta-étiquettes
possibles ainsi que deux options : "Cacher tout" et "Afficher tout". À côté de chaque méta-étiquette dans le menu, il y a
une case à cocher qui indique si la méta-étiquette est actuellement affichée sur la timeline ou pas. Pour afficher ou
masquer l'une des méta-étiquettes, cocher/décocher la case du méta-étiquette. Si vous sélectionnez "Cacher tout", tous
les méta-étiquettes seront masquées, sauf les méta-mesures.

Menus contextuels des instruments

En cliquant avec le bouton droit sur les étiquettes des instruments, un menu contextuel s'affiche avec l'option "Éditer les
instruments". En sélectionnant cette option, vous accéderez à la même boîte de dialogue que celle de l'option "Édition >
Instruments..." ou en appuyant sur I.

Support
Ce chapitre décrit comment trouver de l'aide à l'utilisation de MuseScore : les endroits à consulter, le meilleur moyen pour
poser une question sur le forum, et les conseils pour rapporter un bug.

Aider à améliorer les traductions

Vous pouvez aider à améliorer les traductions du logiciel et/ou de la documentation, dans votre langue ; voir
Développement / Traduction .

Traduction du logiciel

1. Demandez dans le forum forum to improve translation
2. Connectez-vous sur Transifex/MuseScore http://translate.musescore.org , qui vous redirigera sur

https://www.transifex.com/projects/p/musescore
3. Sélectionnez la langue et la section où vous voulez aider (MuseScore ou instruments)
4. Cliquez sur le bouton "translate" (le texte est dans la langue choisie).
5. Recherchez la chaine (string) à traduire ou à modifier (vous pouvez filtrer les chaines déjà traduites).

Information techniques : Continuous translation for MuseScore 2.0

Traduction du site web et du manuel

Un "How to" décrivant en vidéo comment traduire le manuel est disponible ici : https://musescore.org/fr/node/315468
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Voir Translation instructions , en anglais.

Voir aussi

Langue, traductions, et extensions

Restaurer les paramètres par défaut

MuseScore peut revenir aux préréglages intégrés standard ou aux "Paramètres par défaut". Cela peut être nécessaire si
vos paramètres sont corrompus.
Avertissement : Le retour aux paramètres par défaut supprime toutes les modifications que vous avez apportées aux
préférences, aux palettes, et aux paramètres de fenêtre.
Ce n'est pas une procédure couramment nécessaire; consultez d'abord les forums, car il existe peut-être un moyen de
résoudre votre problème sans tout réinitialiser.

À partir de la barre de menus

Si MuseScore démarre toujours, il est possible de restaurer les paramètres par défaut à partir de la barre de menus de
MuseScore.
Aller dans la barre de menus à Aide→ Restaurer les paramètres par défaut . Un message d’avertissement apparaîtra :

Cliquer sur Oui, réinitialisera les paramètres comme ils étaient à l’installation du programme, et MuseScore redémarrera
immédiatement.
Non annulera la procédure.
Cliquer sur Non annulera la réinitialisation sans rien modifier.

À partir de la ligne de commande

Si MuseScore ne démarre pas, vous devez lancer la procédure à partir de la ligne de commande.

Instructions pour Windows

1. Si MuseScore est ouvert, vous devez d'abord le fermer (Fichier→Quitter)
2. Tapez ⊞ Win+R pour ouvrir la boîte de dialogue Exécuter. Sinon, cliquer sur l’icône du menu "Démarrer" à l'aide de

votre souris, aller à "Système Windows", et cliquer sur "Exécuter".
3. Cliquer sur Parcourir...
4. Recherchez MuseScore3.exe sur votre ordinateur. L'emplacement peut varier en fonction de votre installation, mais

c'est probablement "Poste de travail" ou "Ce PC" → Disque local → Programmes → MuseScore 3 → bin →
MuseScore3.exe

5. Cliquer sur Ouvrir pour quitter la fenêtre Parcourir et revenir à celle de Exécuter.

C:\Program Files\MuseScore 3\bin\MuseScore3.exe (en fait %ProgramFiles%\MuseScore 3\bin\MuseScore3.exe)

Pour la version 32 bits de MuseScore sur une version 64 bits de Windows, l'emplacement est :

C:\Program Files (x86)\MuseScore 3\bin\MuseScore3.exe (en fait %ProgramFiles(x86)%\MuseScore 3\bin\MuseScore3.exe)

Pour la version Windows Store (Windows 10), le programme est caché, faites une recherche dans l'Explorateur
Windows.

6. Cliquez après le guillemet US (") et ajoutez un espace suivi d'un tiret et d'un F majuscule : -F

7. Cliquer sur OK

Après quelques secondes, MuseScore redémarre et tous les paramètres sont réinitialisés à leurs "valeurs par défaut".

Pour les utilisateurs expérimentés, le fichier de préférences principal se trouve à l'emplacement suivant :

C:\Users\[Nom de la session de l’utilisateur]\AppData\Roaming\MuseScore\MuseScore3.ini
(en fait %APPDATA%\MuseScore\MuseScore3.ini)
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Les autres préférences (palettes, session, raccourcis, espaces de travail...) sont dans :

C:\Users\[Nom de la session de l’utilisateur]\AppData\Local\MuseScore\MuseScore3\ (en fait
%LOCALAPPDATA%\MuseScore\MuseScore3\)

Pour la version Windows Store (Windows 10), ces fichiers sont cachés, faites une recherche dans l'Explorateur Windows.

Instructions pour MacOS

1. Si MuseScore est ouvert, vous devez d'abord le fermer (MuseScore→Quitter)
2. Ouvrez le Terminal (dans Applications / Utilitaires, ou par la recherche Spotlight) et une fenêtre de session devrait

apparaître.

3. Tapez (ou copiez / collez) la commande suivante dans le terminal (incluez le '/' devant) :

/Applications/MuseScore\ 3.app/Contents/MacOS/mscore -F

Cela réinitialise toutes les préférences aux paramètres par défaut et lance immédiatement MuseScore. Notez que vous
ne pouvez pas quitter le Terminal sans quitter MuseScore. Vous pouvez quitter MuseScore en toute sécurité, fermer le
terminal, puis rouvrir MuseScore de la manière normale.

Pour les utilisateurs expérimentés, le fichier de préférences principal de MuseScore se trouve à
~/Library/Preferences/org.musescore.MuseScore3.plist.
Les autres préférences (palettes, session, raccourcis, espaces de travail ...) sont dans ~/Library/Application\
Support/MuseScore/MuseScore3/.

Instructions pour Linux

Ce qui suit s’applique à Ubuntu, et très probablement toutes les autres distributions Linux et systèmes d'exploitation de
style UNIX.

1. Si MuseScore est ouvert, vous devez d'abord le fermer (Fichier→Quitter)

2. Dans le menu principal d'Ubuntu, choisissez Applications→Accessoires→Terminal. Une fenêtre Terminal doit apparaître
Tapez (ou copiez / collez) la commande suivante dans terminal (Ctrl+Maj+V pour coller dans Terminal) :

mscore -F

Ou, si vous utilisez la version AppImage, vous devez d'abord utiliser la commande cd pour changer de répertoire où
vous avez sauvegardé l'AppImage. Par exemple, si vous l'avez enregistré sur votre bureau (et qu'il n'y en a qu'un) :

cd ~/Desktop
./MuseScore*.AppImage -F

Cela réinitialise toutes les préférences aux paramètres par défaut et lance immédiatement MuseScore.

Pour les utilisateurs experimentés, le fichier de préférences principal de MuseScore se trouve à ${XDG_CONFIG_HOME:-
~/.config}/MuseScore/MuseScore3.ini.
Les autres préférences (palettes, session, raccourcis, espaces de travail…) sont dans ${XDG_DATA_HOME:-
~/.local/share}/MuseScore/MuseScore3/.

Voir aussi

Options de la ligne de commande

Comment demander de l'assistance ou transmettre un rapport de bug

Avant de déposer des rapports de bugs ou des demandes de fonctionnalités dans le Issue Tracker , il est recommandé
de le publier d'abord dans le Forum  concerné afin que d'autres utilisateurs puissent aider à établir un bug comme
authentique, ou fournir des idées et un deuxième avis pour les nouvelles fonctionnalités.
Incluez un lien vers une telle discussion lors de la création du problème.

Rapports de bugs

Avant de publier dans le Issue tracker :

Essayez de reproduire le problème avec la dernière nightly . Vous pouvez également consulter l'historique des
développements récents  pour vérifier s'il a déjà été corrigé/implémenté.

Veuillez inclure autant d'informations que possible et limitez chaque problème à un rapport:

Version/révision de MuseScore que vous utilisez (e.g. 3.6.2.548021803, revision: 3224f34 ). Voir Aide → À
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propos... (Mac: MuseScore → À propos de MuseScore... ).
Votre système d'exploitation (e.g. Windows 10, macOS Mojave 10.14.6 ou Ubuntu 20.04)
Décrivez les étapes précises qui mènent au problème (où cliquez-vous, sur quelles touches appuyez-vous,
que voyez-vous, etc.).
Si vous ne parvenez pas à reproduire le problème avec vos propres étapes, cela ne vaut probablement pas la
peine de le signaler car les développeurs ne pourront pas non plus le reproduire (et le résoudre). N'oubliez pas
que le but d'un rapport de bug n'est pas seulement de montrer le problème, mais de permettre aux autres de
le reproduire facilement.

Souvenez vous:

Joignez la partition qui montre le problème, au moins un exemple minimal -utilisez l'option "Choose a file" en
bas de la page, juste au-dessus des boutons Save et Preview lorsque vous tapez votre message.

Demandes de nouvelles fonctionnalités

Lors de la publication dans le Issue Tracker :

Soyez bref, mais décrivez l'objectif aussi précisément que possible
Décrivez le contexte dans lequel la nouvelle fonctionnalité est censée fonctionner
Suggérer un organigramme des actions spécifique, si vous le pouvez

Problèmes de liaison croisée

Lorsque vous écrivez un commentaire dans un sujet de forum, vous pouvez faire référence à un problème dans le "Issue
tracker" en utilisant la notation suivante: ´[#numéro]´
De cette façon, le lien dans le commentaire inclura le titre du problème et reflètera l'état actuel du problème. De plus, cela
mettra le commentaire du forum dans le "Issue Traker" lui-même..
Écrivez [#317163] obtenez #317163: Dashed volta lines come back as continuous after the score is saved.

Liens externes

How to write a good bug report: step-by-step instructions  (MuseScore HowTo en anglais)
How to attach a file  (MuseScore HowTo en anglais)
Compose tips (Conseils de rédaction)  (MuseScore en anglais)

Annexes

Raccourcis clavier

La plupart des raccourcis clavier peuvent être personnalisés via le menu: Sélectionnez Édition→Préférences...→Raccourcis
(Mac : MuseScore→Préférences...→Raccourcis). Vous trouverez ci-dessous une liste de certains des paramètres de raccourcis
initiaux.

Navigation

Début de la partition : Home (Mac : Fn+←)
Dernière page de la partition: Fin (Mac : Fn+→)
Recherche (numéro de mesure, marque de répétition, ou pXX avec XX étant un numéro de page) : Ctrl+F (Mac : Cmd+F)

Onglet suivant : Ctrl+Tab
Onglet précédent : Maj+Ctrl+Tab

Zoom " + " : Ctrl++ (ne fonctionne pas sous certains systèmes) (Mac : Cmd++) ; ou Ctrl (Mac : Cmd) + molette
Zoom " - " : Ctrl+- (Mac : Cmd+-) ; ou Ctrl (Mac : Cmd) + molette

Page suivante : Pg Dn ; ou Maj + Molette (Mac : Fn+↓)
Page précédente : Pg Up ; ou Maj + Molette (Mac : Fn+↑)

Mesure suivante : Ctrl+→ (Mac: Cmd+→)
Mesure précédente : Ctrl+← (Mac: Cmd+←)

Note suivante : →
Note précédente : ←

Note supérieure (dans un accord ou sur la portée supérieure) : Alt+↑
Note inférieure (dans un accord ou sur la portée inférieure ) : Alt+↓

Note la plus haute dans un accord : Ctrl+Alt+↑ (Ubuntu utilise à la place ce raccourci pour les espaces de travail)
Note la plus basse dans un accord : Ctrl+Alt+↓ (Ubuntu utilise à la place ce raccourci pour les espaces de travail)
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Élément suivant (accessibilité): Alt+→
Élément précédent (accessibilité): Alt+←

Saisie de notes

Démarrer la saisie : N
Quitter la saisie : N ou Esc

Durée

1 ... 9 sélectionne une durée. Voir aussi Saisie de notes.

Moitié de la note précédente : Q
Double de la note précédente : W
Diminuer la durée de la valeur du point : (depuis la version 2.1) Maj+Q (ex : une noire pointée devient une Noire ; une noire
devient une croche pointée)
Augmente la durée de la valeur du point : (depuis la version 2.1) Maj+W (ex : une croche devient une croche pointée ; une
blanche pointée devient une ronde)

Voix

Pour sélectionner une voix, en mode Saisie de notes.

Voix 1 : Ctrl+Alt+1 (Mac : Cmd+Option+1)
Voix 2 : Ctrl+Alt+2 (Mac : Cmd+Option+2)
Voix 3 : Ctrl+Alt+3 (Mac : Cmd+Option+3)
Voix 4 : Ctrl+Alt+4 (Mac : Cmd+Option+4)

Hauteurs

Les hauteurs peuvent être entrées par leur nom (A-G), ou via un clavier MIDI. Voir Saisie de notes pour plus de détails.

Répéter la note ou l'accord précédent: R (la répétition peut avoir une valeur de note différente en sélectionnant
préalablement durée)

Répéter la sélection: R (La sélection sera répétée à partir de la première position de note après la fin de la sélection).

Monter d'une octave: Ctrl+↑ (Mac : Cmd+↑)
Diminuer d'une octave: Ctrl+↓ (Mac : Cmd+↓)

Monter d'un 1/2 ton (préférence aux dièses): ↑
Diminuer d'un 1/2 ton (préférence aux bémols): ↓
Augmentation diatonique: Alt+Maj+↑
Diminution diatonique: Alt+Maj+↓

Changer une hauteur de note pour son enharmonique (également en tonalité de concert): J
Changer une hauteur de note pour son enharmonique (mais pas en tonalité de concert): Ctrl+J (Mac: Cmd+J)

Silence: 0 (zéro)

Intervalles

Ajoute un intervalle au-dessus de la note courante: Alt+[Numéro]

Mise en page

Inverser la direction (hampe, liaisons de prolongation ou de phrasé, crochet de division irrégulière, etc.): X
Tête de note en miroir: Maj+X
Augmente l'étirement de la (des) mesure(s): }
Diminue l'étirement de la (des) mesure(s): {
Saut de ligne sur la barre de mesure sélectionnée: Entrée
Saut de page sur la barre de mesure sélectionnée: Ctrl+Entrée (Mac: Cmd+Entrée)
Ajustez l'espace au-dessus d'une portée (sauf la portée supérieure) pour l'ensemble de la partition: Appuyez Maj, cliquez
sur la portée et faites glisser

Articulations

Staccato: Maj+S
Tenuto: Maj+N
Sforzato (accent): Maj+V
Marcato: Maj+O
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Fioritures (acciaccatura) : /
Crescendo : <
Decrescendo : >

Saisie des Textes

Texte de portée: Ctrl+T (Mac :Cmd+T)
Texte système: Ctrl+Maj+T (Mac : Cmd+Maj+T)
Texte de Tempo: Alt+T
Repère: Ctrl+M (Mac : Cmd+M)

Saisie des Paroles

Entrez des paroles sous la note sélectionnée: Ctrl+L (Mac: Cmd+L)
Syllabe précédente: Maj+Espace
Syllabe suivante si la syllabe courante et les suivantes sont séparées par un '-': -, sinon Espace
Déplace la syllabe sur la gauche de 0.1 esp.: ←
Déplace la syllabe sur la droite de 0.1 esp.: →
Déplace la syllabe sur la gauche de 1 esp.: Ctrl+← (Mac: Cmd+←)
Déplace la syllabe sur la droite de 1 esp.: Ctrl+→ (Mac: Cmd+→)

Aller au couplet précédent (en mode d'édition): Ctrl+↑ (Mac: Cmd+↑)
Aller au couplet suivant (en mode d'édition): Ctrl+↓ (Mac: Cmd+↓)

Pour plus de raccourcis, voir Paroles.

Affichage

Navigateur: F12 (Mac : fn+F12)
Fenêtre de lecture: F11 (Mac : fn+F11)
Mélangeur: F10 (Mac : fn+F10)
Palette: F9 (Mac : fn+F9)
Inspecteur: F8 (Mac : fn+F8)
Clavier de piano virtuel: P
Filtre de sélection: F6
Affichage plein écran: Ctrl+U (Mac: aucun, utilisez Affichage→Plein Écran à la place)

Divers

Bascule Visible / Invisible de la sélection : V
Fenêtre Instruments : I
Activer ou désactiver les silences multi-mesures: M
Réinitialiser l'élément à l'emplacement par défaut: Ctrl+R (Mac: Cmd+R)

Voir aussi

Préférences: Raccourcis

Options de la ligne de commande

MSCORE(1) — Général Commandes Manuel Page

NOM

mscore, MuseScore3 — MuseScore 3 éditeur de partition de musique

SYNOPSIS

Vous pouvez lancer MuseScore en ligne de commande en tapant :

mscore [options] [ filename …] (Mac et Linux/BSD/Unix)
musescore [options] [ filename …] (Linux/BSD/Unix)
MuseScore3.exe [options] [ filename …] (Windows)

[options] et [filename] sont optionels. Pour que ça fonctionne MuseScore.exe doit être dans le %PATH% (Windows) resp.
$PATH (Mac and Linux). Si tel n'est pas le cas, voir Retaurer les paramètres par défaut for detailed instructions on how and
where to find and execute the MuseScore executable from the command line on the various supported platforms.

A more detailed synopsis follows:
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mscore [-deFfhIiLmnOPRstvw]
[-a | --use-audio driver]
[-b | --bitrate bitrate]
[-c | --config-folder pathname]
[-D | --monitor-resolution DPI]
[-E | --install-extension extension file]
[-j | --job file.json]
[-M | --midi-operations file]
[-o | --export-to file]
[-p | --plugin name]
[-r | --image-resolution DPI]
[-S | --style style]
[-T | --trim-image margin]
[-x | --gui-scaling factor]
[--debug]
[--diff]
[--dump-midi-in]
[--dump-midi-out]
[--experimental]
[--export-score-parts]
[--factory-settings]
[--force]
[--help]
[--layout-debug]
[--load-icons]
[--long-version]
[--new-score]
[--no-fallback-font]
[--no-midi]
[--no-synthesizer]
[--no-webview]
[--raw-diff]
[--revert-settings]
[--run-test-script]
[--score-media]
[--score-mp3]
[--score-parts-pdf]
[--template-mode]
[--test-mode]
[--version]
[file ...]

DESCRIPTION

MuseScore is a Free and Open Source WYSIWYG cross-platform multi-lingual music composition and notation software,
released under the GNU General Public Licence (GPLv2).

Running mscore without any extra options launches the full graphical MuseScore program and opens any files specified
on the command line.

The options are as follows:

-a | --use-audio driver

Use audio driver: one of jack, alsa, portaudio, pulse

-b | --bitrate bitrate

Set MP3 output bitrate in kbit/s

-c | --config-folder pathname

Override configuration and settings directory

-D | --monitor-resolution DPI

Specify monitor resolution (override autodetection)

-d | --debug

Start MuseScore in debug mode

-E | --install-extension extension file
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Install an extension file; soundfonts are loaded by default unless -e is also specified

-e | --experimental

Enable experimental features, such as layers

-F | --factory-settings

Use only the standard built-in presets (“factory settings”) and delete user preferences; compare with the -R option
(see also Revert to factory settings)

-f | --force

Ignore score corruption and version mismatch warnings in “converter mode”

-h | --help

Display an overview of invocation instructions (doesn’t work on Windows)

-I | --dump-midi-in

Display all MIDI input on the console

-i | --load-icons

Load icons from the filesystem; useful if you want to edit the MuseScore icons and preview the changes

-j | --job file.json

Process a conversion job (see EXAMPLES below)

-L | --layout-debug

Start MuseScore in layout debug mode

-M | --midi-operations file

Specify MIDI import operations file (see EXAMPLES below)

-m | --no-midi

Disable MIDI input

-n | --new-score

Start with the New Score wizard regardless whether it’s enabled or disabled in the user preferences

-O | --dump-midi-out

Display all MIDI output on the console

-o | --export-to file

Export the given (or currently opened) file to the specified output file. The file type depends on the extension of the
filename given. This option switches to “converter mode” and avoids the graphical user interface.

-P | --export-score-parts

When converting to PDF with the -o option, append each part’s pages to the created PDF file. If the score has no
parts, all default parts will temporarily be generated automatically.

-p | --plugin name

Execute the named plugin

-R | --revert-settings

Use only the standard built-in presets (“factory settings”) but do not delete user preferences; compare with the -F
option

-r | --image-resolution DPI

Set image resolution for conversion to PNG files. Default: 300 DPI (actually, the value of “Resolution” of the PNG
option group in the Export tab of the preferences)

-S | --style style
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Load a style file first; useful for use with the -o option

-s | --no-synthesizer

Disable the integrated software synthesiser

-T | --trim-image margin

Trim exported PNG and SVG images to remove whitespace surrounding the score. The specified margin, in pixels,
will be retained (use 0 for a tightly cropped image). When exporting to SVG, this option only works with single-page
scores.

-t | --test-mode

Set test mode flag for all files

-v | --version

Display the name and version of the application without starting the graphical user interface (doesn’t work on
Windows)

-w | --no-webview

Disable the web view component in the Start Centre

-x | --gui-scaling factor

Scale the score display and other GUI elements by the specified factor; intended for use with high-resolution
displays

--diff

Print a conditioned diff between the given scores

--long-version

Display the full name, version and git revision of the application without starting the graphical user interface (doesn’t
work on Windows)

--no-fallback-font

Don’t use Bravura as fallback musical font

--raw-diff

Print a raw diff between the given scores

--run-test-script

Run script tests listed in the command line arguments

--score-media

Export all media (except MP3) for a given score as a single JSON document to stdout

--score-mp3

Generates an MP3 for the given score and exports it as a single JSON document to stdout

--score-parts-pdf

Generates parts data for the given score and exports it as a single JSON document to stdout

--template-mode

Save files in template mode (e.g. without page sizes)

MuseScore also supports the automatic Qt command line options .

Batch conversion job JSON format

The argument to the -j option must be the pathname of a file comprised of a valid JSON document honouring the following
specification:

The top-level element must be a JSONArray, which may be empty.
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Each array element must be a JSONObject with the following keys:

in: Value is the name of the input file (score to convert), as JSONString.
plugin: Value is the filename of a plugin (with the .qml extension), which will be read from either the global or per-
user plugin path and executed before the conversion output happens, as JSONString. Optional, but at least
one of plugin and out must be given.
out: Value is the conversion output target, as defined below. Optional, but at least one of plugin and out must be
given.

The conversion output target may be a filename (with extension, which decided the format to convert to), as
JSONString.

The conversion output target may be a JSONArray of filenames as JSONString, as above, which will cause the
score to be written to multiple output files (in multiple output formats) sequentially, without being closed, re-opened
and re-processed in between.

If the conversion output target is a JSONArray, one or more of its elements may also be, each, a JSONArray of two
JSONStrings (called first and second half in the following description). This will cause part extraction: for each such
two-tuple, all extant parts of the score will be saved individually, with filenames being composed by concatenating
the first half, the name (title) of the part, and the second half. The resulting string must be a valid filename (with
extension, determining the output format). If a score has no parts (excerpts) defined, this will be silently ignored
without error.

Valid file extensions for output are:

flac
Free Lossless Audio Codec (compressed audio)

metajson
various score metadata (JSON)

mid
standard MIDI file

mlog
internal file sanity check log (JSON)

mp3
MPEG Layer III (lossy compressed audio)

mpos
measure positions (XML)

mscx
uncompressed MuseScore file

mscz
compressed MuseScore file

musicxml
uncompressed MusicXML file

mxl
compressed MusicXML file

ogg
OGG Vorbis (lossy compressed audio)

pdf
portable document file (print)

png
portable network graphics (image) — Individual files, one per score page, with a hyphen-minus followed by the
page number placed before the file extension, will be generated.

spos
segment positions (XML)

svg
scalable vector graphics (image)

wav
RIFF Waveform (uncompressed audio)

xml
uncompressed MusicXML file

See below for an example.

ENVIRONMENT

SKIP_LIBJACK
Set this (the value does not matter) to skip initialisation of the JACK Audio Connection Kit library, in case it causes
trouble.

XDG_CONFIG_HOME
User configuration location; defaults to ~/.config if unset.

XDG_DATA_HOME
User data location; defaults to ~/.local/share if unset.
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Note that MuseScore also supports the normal Qt environment variables such as QT_QPA_GENERIC_PLUGINS,
QT_QPA_PLATFORM, QT_QPA_PLATFORMTHEME, QT_QPA_PLATFORM_PLUGIN_PATH, QT_STYLE_OVERRIDE, DISPLAY, etc.

FILES

/usr/share/mscore-3.0/ contains the application support data (demos, instruments, localisation, system-wide plugins,
soundfonts, styles, chords, templates and wallpapers). In the Debian packages, system-wide soundfonts are installed into
/usr/share/sounds/sf2/, /usr/share/sounds/sf3/ or /usr/share/sounds/sfz/, respectively, instead.

The per-user data (extensions, plugins, soundfonts, styles, templates) and files (images, scores) are normally installed
into subdirectories under ~/MuseScore3/ but may be changed in the configuration. Note that snapshot, alpha and beta
versions use MuseScore3Development instead of MuseScore3 in all of these paths.

$XDG_CONFIG_HOME/MuseScore/MuseScore3.ini contains the user preferences, list of recently used files and their locations,
window sizes and positions, etc. See above for development version paths.

$XDG_DATA_HOME/data/MuseScore/MuseScore3/ contains updated localisation files downloaded from within the program, plugin
information, cached scores, credentials for the musescore.com community site, session information, synthesiser settings,
custom key and time signatures and shortcuts. See above for development version paths.

EXAMPLES

Convert a score to PDF from the command line

mscore -o 'My Score.pdf' 'My Score.mscz'

Run a batch job converting multiple documents

mscore -j job.json

This requires the file job.json in the current working directory to have content similar to the following:

[
  {
    "in": "Reunion.mscz",
    "out": "Reunion-coloured.pdf",
    "plugin": "colornotes.qml"
  },
  {
    "in": "Reunion.mscz",
    "out": [
      "Reunion.pdf",
      [ "Reunion (part for ", ").pdf" ],
      "Reunion.musicxml",
      "Reunion.mid"
    ]
  },
  {
    "in": "Piece with excerpts.mscz",
    "out": [
      "Piece with excerpts (Partitura).pdf",
      [ "Piece with excerpts (part for ", ").pdf" ],
      "Piece with excerpts.mid"
    ]
  }
]

The last part of the job would, for example, cause files like “Piece with excerpts (part for Violin).pdf ” to be generated alongside the
conductor’s partitura and a MIDI file with the full orchestra sound, whereas the equivalent part of the Reunion conversion
will be silently ignored (because the Reunion piece (a MuseScore demo) has no excerpts defined).

MIDI import operations

The attached midi_import_options.xml  is a sample MIDI import operations file for the -M option.

DIAGNOSTIQUES

The mscore utility exits 0 on success, and >0 if an error occurs.

Voir aussi

fluidsynth(1), midicsv(1), timidity(1), qtoptions(7)

https://musescore.org/handbook
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Online Handbook, full user manual

https://musescore.org/forum

Support Forum

https://musescore.org/en/node/278582

Reverting to factory settings (troubleshooting)

https://musescore.org/project/issues

Project Issue Tracker — Please check first to if the bug you’re encountering has already been reported. If you just
need help with something, then please use the support forum  instead.

http://doc.qt.io/qt-5/qguiapplication.html#supported-command-line-optio…

Documentation of automatic Qt command line options

STANDARDS

MuseScore attempts to implement the following standards:

MusicXML 3.1 (score interchange format)
SF2 (SoundFont 2.01)
SF3 (SoundFont with OGG Vorbis-compressed samples)
SFZ (Sforzato soundfont)
SMuFL (Standard Music Font Layout 1.20)

HISTORY

MuseScore was split off the MusE sequencer in 2002 and has since become the foremost Open Source notation software.

AUTEURS

MuseScore is developed by Werner Schweer and others.

This manual page was written by mirabilos <tg@debian.org >.

CAVEATS

The automatic Qt command line options are removed from the argument vector before the application has a chance at
option processing; this means that an invocation like mscore -S -reverse has no chance at working because the -reverse is
removed by Qt first.

BUGS

MuseScore does not honour /etc/papersize.

Probably some more; check the project’s bug tracker (cf. SEE ALSO).

MuseScore — December 18, 2018

Nouvelles fonctionnalités de MuseScore 3.6

Nouveaux paramètres de configuration et de mise en page des partitions

MuseScore 3.6 introduit une nouvelle police de symboles musicaux, Leland, une nouvelle police de texte , Edwin (une
version de New Century Schoolbook), Il introduit aussi d’autres fonctionnalités disponibles par défaut dans toutes les
nouvelles création de partitions et qui peuvent aussi être appliquées automatiquement ou manuellement aux partitions
existantes.

Les trois principales fonctionnalités, dépendantes l’une de l’autre, sont les suivantes :

Mise en ordre automatique des instruments
Positionnement automatique des crochets et des accolades
Justification verticale des portées

Les deux premières s'appliquent à la création de la partition dans l'assistant Créer une nouvelle partition. bien qu'elles
soient aussi accessibles ultérieurement dans la boîte de dialogue de choix des Instruments. Auparavant, c'était à
l'utilisateur de mettre en ordre les instruments et d'ajouter manuellement les crochets une fois la partition créée. Le but de
ces nouvelles fonctionnalités est de gagner du temps et de donner un meilleur résultat par défaut dans la majorité des
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cas, mais il n'est pas destiné à s’adapter à toutes les configurations de partition possibles. Pour les mises en page
inhabituelles, les résultats peuvent être personnalisés après la création de la partition, les fonctionnalités peuvent être
complètement désactivées ou un modèle peut être utilisé.

Mise en ordre automatique des instruments

Lors de la création d'une nouvelle partition via « Choisir les instruments », il y a maintenant une liste déroulante « Ordre
des instruments » affichant le l’ordre actuel des instruments. « Orchestral » est la valeur par défaut. Au fur et à mesure
que les instruments sont ajoutés à la partition, ils seront positionnés selon l'ordre choisi. (Auparavant, chaque instrument
apparaissait sous celui qui était actuellement sélectionné dans la liste de droite). Cela facilite aussi, par exemple, l'ajout
d'une double section d’instruments à vent, en sélectionnant Flûte, Hautbois, Clarinette et Basson dans la liste de gauche,
et en cliquant deux fois sur « Ajouter à la partition ».

Chaque ordre définit une position dans la partition des instruments solos. Par exemple, dans l’ordre orchestral, ils sont au-
dessus des instruments à cordes. En sélectionnant un instrument dans la liste de droite, le bouton « Soliste » le déplace à
cette position. Vous pouvez désigner plusieurs solistes ; l'ordre général s'appliquera dans la section solistes. Les
instruments solos auront « solo » ajouté à leur nom par défaut, et seront numérotés séparément des instruments non
solos, le cas échéant. Notez que la désignation de soliste est une fonctionnalité de mise en page de partition uniquement
et n'a aucun impact sur la lecture.

Une limitation est que, pour l'instant, une seule position de soliste est définie par type d’ordre d’instruments, ainsi une
œuvre avec un chœur et des solistes vocaux et instrumentaux placera les solistes instrumentaux au-dessus du chœur.
Ceux-ci devront être déplacés manuellement.

Comme auparavant, les instruments peuvent être déplacés manuellement de haut en bas avec les boutons qui se
trouvent maintenant à droite de la liste. Dans la liste déroulante, le type d’ordre aura « Personnalisé » ajouté à son nom.
L’ordre personnalisé est enregistré dans la partition. Vous pouvez réinitialiser l’ordre en sélectionnant celui d'origine (ou
une autre) dans la liste déroulante.

Sélectionner « Personnalisé » désactive complétement l’ordre automatique, ainsi que le positionnement automatique des
crochets et des accolades.

Positionnement automatique des crochets et des accolades

Les ordres prédéfinis attribuent les instruments à des familles (flûtes, hautbois, clarinettes, etc.) et arrange ces familles en
sections (bois, cuivres, percussions, etc.). Les crochets sont ajoutés automatiquement selon ces règles simples :

Un crochet large est appliqué à tous les instruments adjacents de la même section, en supposant qu'il y en ait plus
d'un
Un crochet carré fin est appliqué à tous les instruments identiques adjacents (quatre cors, par exemple)
Une accolade est appliquée à chaque instrument unique qui est noté sur plus d'une portée (piano et harpe, le plus
souvent)

Cependant, bien que les valeurs par défaut donnent des bons résultats pour la plupart des partition, cela pourra ne pas
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être parfait pour tous les styles ou mises en page possibles.

Justification verticale des portées

Un nouvel algorithme est ajouté pour justifier verticalement les portées pour remplir correctement la page, qui est activé
par défaut pour les nouvelles partitions de MuseScore 3.6. Pour désactiver cette option, cochez le bouton radio dans
Format > Style > Page > Désactiver la justification verticale des portées.

Le principe de base de l'algorithme est d'essayer de rendre égal l'espace entre les portées, à l’aide de deux réglages (qui
se trouvent dans Format > Style > Page) :

L'espace de chaque côté d'un système peut être augmenté proportionnellement en ajustant le paramètre « Facteur
de distance au-dessus / au-dessous du crochet » à une valeur supérieure à 1. Par exemple, si cette valeur est
définie à 1,5, l'algorithme tentera de faire de l'espace de chaque côté du crochet à 1,5 l'espace « standard » utilisé
ailleurs.
La même chose peut être appliquée aux accolades avec le paramètre « Facteur de distance au-dessus / au-
dessous de l'accolade ».

L'espace entre une accolade et un crochet sera déterminé par la plus grande de ces deux valeurs. Le paramètre «
Distance max. entre portées de claviers » est utilisé pour limiter la distance entre les portées reliées par une accolade.
Ceci est utile car ces portées doivent généralement être lues en un seul coup d'œil par le musicien.

La « Distance max. entre systèmes » et la « Distance max. entre portées » doivent avoir des valeurs suffisamment
grandes pour permettre à la routine de remplir des pages peu remplies. Parfois, une page n'a pas assez de portées pour
qu'il y ait un sens à la justifier. Dans ce cas, une fois que l'algorithme a égalisé une première fois l'espace comme décrit
ci-dessus, il ajoute ensuite un espace supplémentaire entre les portées jusqu'au maximum paramétré dans « Distance
max. du remplissage de la page » (multiplié par le paramètre de facteur correspondant). Si vous trouvez que de
nombreuses pages ne sont pas entièrement justifiées, mais que vous aimeriez qu'ils le soient, essayez d'ajuster ce
paramètre. En général, une valeur faible est surement la meilleure pour une partition avec un petit nombre de portées par
système, et une plus grande pour un plus grand nombre de portées.

La justification verticale est dynamique, et non lié aux affectations de section des instruments utilisés pour déterminer
l'ordre des partitions à l’étape de la configuration, donc si vous ajoutez ou supprimez des crochets, l'espacement changera
en conséquence. De la même manière, si des portées vides sont cachées sur un système donné, l'espacement sera
déterminé uniquement par les crochets présents sur ce système.

Heureusement les paramètres par défaut donnent de bons résultats dans la plupart des cas, mais il faut un peu
expérimenter la modification des paramètres en fonction de la composition d'une partition. Si vous avez l'habitude
d'utiliser des espacements pour obtenir des résultats similaires, il est préférable d'essayer de trouver des réglages qui
donnent un bon résultat pour l’ensemble de la partition, et n'utilisez des espacements que lorsque des ajustements locaux
sont nécessaires. Nous avons prévu de rendre cela plus configurable dans les futures versions. Par exemple, l'espace
supplémentaire peut être supprimé pour un crochet spécifique, ou la valeur peut être augmentée ou diminuée pour une
page ou un système particulier.
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Indentation du premier système

Cette nouvelle option, activée par défaut, se trouve dans Format > Style > Partition > Activer l'indentation du premier
système. Comme son nom l'indique, il indentera le premier système d'une section de la manière que les partitions
classiques. (L'ancienne solution de consistant à utiliser un cadre n'est plus nécessaire). Si les noms des instruments sont
présents, le maximum de la valeur donnée à ce paramètre ou celui de la longueur des noms s'appliquera.

Appliquer les nouvelles fonctionnalités aux partitions existantes

Lors de l'ouverture d'une ancienne partition, une boîte de dialogue offre la possibilité d'appliquer soit la nouvelle police de
notation Leland, soit la nouvelle police de texte Edwin, ou les deux. Chacun de ceux-ci applique un sous-ensemble des
nouveaux paramètres de style par défaut de MuseScore 3.6 au-delà des seuls changements de police, par exemple, les
largeurs de ligne et tailles de texte, mais n'applique pas toutes les nouvelles valeurs par défaut, pour minimiser les
changements de mise en page trop importants.

Pour appliquer tous les nouveaux paramètres par défaut, y compris les modifications de police de texte et de notation,
ouvrez la fenêtre Format > Style et cliquez sur le bouton « Réinitialiser tous les styles » en bas à gauche. Il s'agissait
auparavant de l'option du menu Format > Réinitialiser le style. Ce bouton se comporte de la même manière, sauf qu'il ne
réinitialise plus les options de mise en page qui sont définies dans la fenêtre Format > Paramètres de la page ; cette
fenêtre a maintenant son propre bouton de réinitialisation, qui ne réinitialisera que les paramètres qu'elle contient. Cela
signifie que les nouvelles options de style peuvent être essayées sans ruiner complétement la mise en page de la
partition, bien que certains paramètres des fenêtres Partition et Page de la boîte de dialogue Style doivent être
réinitialisés manuellement.

Comme c'est une option, supprimez tout système et saut de page non essentiels, puis sélectionnez toute la partition et
cliquez sur Format > Étirement > Réinitialiser l'étirement des mesures. Supprimez aussi les espacements si vous
souhaitez voir les résultats du nouvel algorithme de justification verticale (voir ci-dessous).

Edwin a une taille de caractères plus large que FreeSerif (bien que la taille en point soit légèrement plus petite) il est donc
certain que l'option Edwin provoquera des changements de mise en page, en particulier pour les partitions avec paroles.
Leland affectera moins radicalement l’espacement, mais certains ajustements pourront être nécessaires.

Les éléments de texte qui ont un de style local personnalisé ne verront pas ces personnalisations supprimées, soit à partit
de la fenêtre de migration de partition, soit via les options de réinitialisation des styles. Cela fera une partition incohérente
où un texte conserve son ancienne police ou sa taille. La nouvelle option de menu Format > Réinitialiser les
personnalisations de style de texte supprimera ces personnalisations, réinitialisant tous les éléments de texte pour qu'ils
correspondent aux styles de texte actuellement définis. (Ce qui équivaut à cliquer sur « Réinitialiser au style par défaut »
pour chaque attribut dans la zone Texte de l'inspecteur). Notez que cela ne supprime pas le formatage personnalisé, qui
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doit être effectué manuellement si nécessaire.

Appliquer l’ordre automatique et de mise entre crochets des instruments

Appuyez sur I pour ouvrir la fenêtre des Instruments ou choisissez le menu Édition > Instruments. En supposant que le
score a été créé avant la 3.6, l’ordre sélectionné sera « Personnalisé ». Si vous voulez appliquer un ordre standard,
sélectionnez-en un dans le menu déroulant, par exemple « Orchestral ». Les instruments de la partition seront
réorganisés selon cette définition, et aura les crochets et accolades appliqués en conséquence. Notez que tous les
crochets et accolades existants seront supprimés.

Appliquer la justification verticale des portées

Pour utiliser cette fonctionnalité alors que vous avez déjà utilisé des espacements pour créer une distance
supplémentaire ou fixe entre les portées, vous devez d’abord supprimer tous ces espacements, car le fonctionnement du
nouvel algorithme sera perturbé. Un moyen rapide de le faire est de cliquer avec le bouton droit sur n'importe quel
espacement, de choisir Sélectionner > Tous les éléments similaires et d'appuyer sur Supprimer.

Activez cette fonction en sélectionnant Style > Page > Activer la justification verticale des portées. Vous pouvez
réintroduire des espacements s'il y a des endroits spécifiques où l'espacement par défaut doit être ajusté.

Autres améliorations de la gravure dans la version 3.6

En étudiant les paramètres de style, les problèmes de gravure et la création d'une nouvelle police de symboles musicaux,
de nombreux problèmes ont été découverts qui devaient être corrigés et qui ont un léger impact sur l'apparence des
partitions existantes. Dans certains cas, il est possible de les corriger manuellement.

Espacement des ligatures

Une très ancienne erreur dans l'interprétation du paramètre Distance des lignes de ligature qui est défini dans les polices
SMuFL font que cette valeur est souvent deux fois moins élevée qu'elle ne devrait l'être dans MuseScore, autant avec
Emmentaler qu’avec Bravura. (MuseScore définit la distance entre les lignes de ligature comme un pourcentage de
l'épaisseur d'une ligature, alors que pour SMuFL, ce paramètre est une distance absolue en Espace de portée.
L'épaisseur normale d'une ligature est de 0,5esp, et la distance standard entre les lignes de ligature est égale à 0,25esp ,
que MuseScore a interprété comme 25 % de 0,5esp, soit 0,125esp).

La nouvelle implémentation correcte de cette valeur, 50 %, est appliquée même aux partitions existantes, sauf si cette
valeur a été explicitement remplacée. L'espace supplémentaire est ajouté vers l'intérieur, de sorte que la position des
ligatures les plus externes reste la même. Si vous voulez vraiment l'ancien espacement très serré, définissez
manuellement la valeur Style > Ligatures > Distance de la ligature (relative à son épaisseur) à 25 %.

Avant (Distance de la ligature 25 %) :

Après (Distance de la ligature 50 %) :

Longueur des lignes supplémentaires

De la même manière, MuseScore interprète cette valeur SMuFL comme l'extension totale de la ligne supplémentaire au-
delà de la tête de note (c'est-à-dire x/2 de chaque côté), Cette erreur est masquée par un bloc carré à l’extrémité de ligne,
plutôt qu'une ligne droite, ce qui ajoute en plus la moitié de l'épaisseur de ligne à chaque extrémité.

Comme pour l'espacement des ligatures, si ce paramètre n'a pas été explicitement remplacé dans le fichier, la nouvelle
valeur par défaut sera appliquée même pour les anciennes partitions, mais cela donnera la même apparence. Si vous
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avez ajusté cette valeur, elle sera conservée, mais produira des lignes supplémentaires trop longues. Vous pouvez
convertir la valeur manuellement à l’aide de la formule :

nouvelle valeur = (x / 2) - (y / 2)

où x est la valeur précédente « Longueur des lignes supplémentaires », et y la valeur de « Épaisseur des lignes
supplémentaires ». Ou, utilisez les nouveaux paramètres par défaut de chaque police :

Leland : 0.35esp
Bravura, Gonville, Petaluma : 0.40esp
Emmentaler : 0.38esp

Extrémités des hampes et positions des croches

Des extrémités rondes étaient utilisées pour les hampes, nous les avons remplacées par des extrémités plates. C'est en
partie pour rendre la longueur de la hampe plus exacte, mais principalement pour que l’extrémité ronde ne cache pas celle
de la pointe des symboles de croche de chaque police. Les croches d'Emmentaler, par exemple, sont conçus avec une
pointe plate ; celles de Bravura et Leland ont des pointes arrondies qui ne sont pas exactement symétriques.

Le placement des croches était également en contradiction avec les polices SMuFL : MuseScore calculait de combien il
fallait étendre la hampe en fonction du nombre de croches, puis le symbole de croche était dessiné à partir du haut ou du
bas de son dessin à l'extrémité de la hampe. Désormais, la présence de croches n'affecte pas la longueur de la hampe
(c'est-à-dire qu'une hampe de longueur normale est utilisée pour chaque note en fonction de sa position verticale et de la
direction de sa hampe) et le symbole de croche est alors placé avec son paramètre y = 0 à la fin de la hampe. Toute «
extension » de la hampe est donc déterminée par la valeur à laquelle le symbole de croche s'étend au-dessus ou au-
dessous de y = 0. Les croches dans Emmentaler, tels qu'utilisés dans MuseScore, ont été repositionnés pour
correspondre aux autres polices SMuFL.

Le résultat est que les croches peuvent apparaître légèrement plus basses ou plus hautes qu'auparavant ; cependant,
leur position reflète désormais les intentions des concepteurs de chacune des polices disponibles. Les notes reliées par
des ligatures ne sont pas affectées.

Avant (Bravura, dans la version 3.5) :

Après (Bravura, dans la version 3.6) :

Altérations entre parenthèses

Auparavant, MuseScore n'ajoutait aucun espace entre les altérations et les parenthèses autour d'eux. Maintenant, une
petite quantité d’espace est ajoutée, qui peut être personnalisée via Style > Altérations > Espace à l’intérieur des
parenthèses.

Avant (Bravura, dans la version 3.5) :
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Après (Bravura, dans la version 3.6) :

Altérations dans la police Emmentaler

Ceux-ci ont été remplacés par ceux pris dans la police Parnassus. Pour plus de détails, consultez PR #6747 .

Nouvelles fonctionnalités de MuseScore 3.x

MuseScore 3 comprend un certain nombre de fonctionnalités nouvelles/améliorées. Pour un bref résumé, voir les Notes
de publication pour MuseScore 3 . Vous trouverez plus de détails dans les résumés ci-dessous et en consultant les
pages pertinentes du manuel.

Placement automatique

MuseScore place initialement les éléments dans la partition en fonction de (a) les propriétés spécifiées dans style par
défaut et (b) tout ajustement manuel effectué. Cependant, pour les éléments dont le positionnement automatique est
activé, MuseScore tentera d’éviter les collisions en déplaçant un ou plusieurs d’entre eux au besoin.

Voir Placement automatique.

Position par défaut

La position par défaut de la plupart des éléments est contrôlée par les paramètres dans Format → Style. Vous pouvez soit
changer la valeur par défaut ici, soit le faire dans l'Inspecteur. Appliquez un réglage manuel (voir ci-dessous) puis utiliser
la commande "Définir un style" (le S à droite de la valeur que vous souhaitez définir)

Les propriétés spécifiques que vous pouvez définir varient selon le type d’élément mais incluent :

placement (si l’élément apparaît au-dessus ou en dessous de la portée par défaut)
position au-dessus/dessous (positions spécifiques lorsqu’elles sont placées au-dessus ou en dessous)
décalage (identique à la position au-dessus/dessous, pour laquelle le placement est par défaut)
placement automatique Distance minimum (distance minimale par rapport aux autres éléments lorsque le placement
automatique est activé)

Voir Placement automatique.

Réglages manuels

De nombreux éléments peuvent être placés au-dessus ou en dessous de la portée. Pour basculer un élément du haut
vers le bas ou vice versa, utilisez le paramètre « Placement » dans l'Inspecteur, ou appuyez sur le raccourci "X".

Les réglages manuels de la position peuvent être effectués en faisant glisser ou en modifiant les parramètres du décalage
dans l’inspecteur. Cependant, aucune des deux méthodes ne vous permettra de positionner un élément de manière à
provoquer une collision. Pour prendre le contrôle total de la position d’un élément, vous pouvez désactiver le placement
automatique pour celui-ci.

Voir Placement automatique.

Désactiver le placement automatique

Pour désactiver le placement automatique d’un élément, décochez la case "Placement automatique" dans l’Inspecteur.
L’élément reviendra à sa position par défaut, et il ne sera plus pris en compte lors du placement automatique d’autres
éléments.

Voir Placement automatique.

Position dans la pile (Z)

Le paramètre "Position dans la pile (Z)" dans l'Inspecteur contrôle quels éléments se chevauchent dans les cas où ils se
chevauchent réellement et ne sont pas déplacés en raison du placement automatique.

Voir Placement automatique.

Formatage du Texte
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Le formatage du texte est contrôlé par trois facteurs :

Le style de texte associé à l’élément définit les valeurs par défaut pour les propriétés telles que la police,
l’alignement et le cadre.
Les modifications apportées à ces propriétés de texte peuvent être appliquées aux éléments sélectionnés via
l’Inspecteur
Le formatage personnalisé peut être appliqué à des caractères spécifiques dans le texte à l’aide de la barre d’outils
de texte

Voir Bases sur les textes, Styles de texte et propriétés.

Styles de Texte

Chaque élément de texte est associé à un style de texte. Le style par défaut d’un élément est déterminé par le type de
l’élément lui-même - par défaut, le texte de la portée correspond au style de texte Portée, la dynamique au style de texte
Dynamique, etc. Ce style de texte détermine la police par défaut, la taille, le style (gras/italique/souligné), l’alignement et
les propriétés du cadre.

Vous pouvez modifier les valeurs par défaut pour n’importe lequel de ces styles de texte en utilisant Format → Style →
Styles de texte. Par exemple, vous pouvez agrandir les marques de répétition ou mettre les paroles en italique. Cela
affectera tous les éléments existants utilisant ce style ainsi que les éléments que vous ajouterez plus tard. Certains
éléments contiennent également un ensemble limité de paramètres de style de texte dans leurs propres sections de la
Format → Boîte de dialogue de style (bien que ce ne soit peut-être pas le cas dans la version finale). Les paramètres sont
liés : vous pouvez modifier la taille de la police pour les numéros de mesure dans Format → Style → Numéros de mesure,
ou dans Format → Style → Styles de textes : Numéros de Mesure. L’effet est le même : tous les nombres de mesure
dans la partition prendront cette taille. Vous pouvez également modifier les valeurs par défaut d’un style de texte à l’aide
de l’Inspecteur; voir Propriétés du Texte ci-dessous.

Pour la plupart des éléments de texte que vous créez directement (comme le texte de la portée, les marques de répétition
et les paroles), vous pouvez appliquer un style de texte différent à l’aide du paramètre Style de l’Inspecteur. Cela les fera
s'afficher en utilisant ce style au lieu du style "natif" pour l’élément. Par exemple, vous pouvez sélectionner un ou plusieurs
éléments de texte de la portée et leur donner le style Tempo pour les forcer à s’afficher comme s’ils étaient des marques
de tempo.

Voir Bases sur les textes, Styles de texte et propriétés.

Propriétés du Texte

Le style de texte contrôle les propriétés par défaut pour les éléments utilisant ce style, mais vous pouvez outrepasser
n’importe laquelle de ces propriétés pour des éléments sélectionnés en utilisant l’Inspecteur. Par exemple, vous pouvez
sélectionner une poignée d’éléments de texte de portée en utilisant Ctrl+click, puis utiliser l’Inspecteur pour les agrandir.
Le bouton Réinitialiser au Style par Défaut situé à côté de chaque contrôle de propriété le ramène à la valeur par défaut.
Vous pouvez également cliquer sur le bouton Définir un Style pour modifier le style. Donc, une autre façon de changer la
taille de tous les numéros de mesure est d'en sélectionner un, changer sa taille dans l’inspecteur, puis cliquez sur Définir
un Style.

Voir Bases sur les textes, Styles de texte et propriétés.

Formatage Personnalisé

Le formatage personnalisé est appliqué au texte en utilisant la barre d'outils au bas de la fenêtre principale de la même
manière que dans les versions précédentes. Ainsi, vous pouvez mettre en gras un mot dans une phrase alors que le reste
est normal, ou utiliser un caractère particulier, etc. Vous pouvez également supprimer tout formatage personnalisé sur les
éléments de texte sélectionnés en utilisant le bouton "Supprimer le formatage personnalisé" dans l’Inspecteur. Cela remet
le texte aux paramètres actuellement affichés dans l’Inspecteur.

Voir Édition des textes.

Changement de type de portée

Vous pouvez modifier différentes propriétés de la portée même au milieu de la partition, y compris la taille de la portée,
formes de têtes de notes (e.g., for pitch name noteheads), generation of time signatures, and others. The staff type
change element is found on the Text palette (currently, but see #278205: Move Staff Type Change to another palette (it is
not text)  - it may move). Add it to the measure where you want the change to occur, then use the Inspector to change
properties of the staff type change element.

See Staff Type Change

Temporary and Cutaway Staves

To create a temporary staff that appears on certain systems only: first add the staff normally (Edit / Instruments), then add
notes, then right-click the staff, click Staff Properties, and set "Hide when empty" to "Always". This will cause the staff to
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show only where needed even without needing to turn on "Hide empty staves" for the whole score (in Format / Style). The
default for "Hide when empty" is "Auto", meaning the staff will be hidden when empty if "Hide empty staves" is enabled.
Additional values include "Never" (the staff will not be hidden when empty even if "Hide empty staves" is enabled) and
"Instrument" (for instruments containing multiple staves, the staff is hidden only if all staves for that instrument are empty).

To create a cutaway staff in which only the measures containing notes are visible (for ossia or cutaway scores, for
example), right-click the staff, click Staff Properties, and enable the "Cutaway" option. This can be used independently of
"Hide when empty" or "Hide empty staves".

System Dividers

System dividers are a set of short diagonal lines that are used to visually separate systems on a page. MuseScore can
add these to your score automatically. In Format → Style → System, you can enable dividers on the left, right, or both,
and you can set their default position. You can also adjust the position of individual dividers in your score manually or
mark them invisible (this currently does not survive saving).

Staff Spacing

As part of the automatic placement in MuseScore, staves are now spaced automatically, so you can set a comfortable
minimum distance and depend on MuseScore to open up more space where needed. You can use staff spacers as in
MuseScore 2 to increase distance between staves, but MuseScore 3 now also provides a way to decrease it—the "fixed"
staff spacer, found on the Breaks & Spacers palette. Just add the spacer and adjust its height. This will also prevent
MuseScore from automatically adding more space to avoid collisions, allowing you to manage this yourself.

See Spacers.

Don't Break

Currently disabled

In addition to the system, page, and section breaks familiar from MuseScore 2, the "Breaks & Spacers" palette now
contains a new "Don't Break" element. This allows you to force two measures to be kept together, for example, if there is
some complex passage that spans the measures and you want to make sure they are adjacent. If both measures don't fit
on a system, MuseScore moves them both to the next system. (currently, this leaves a "hole" at the end of the first staff -
is this a bug or is there some purpose behind it?)

Parts from Voices

In addition to the ability to generate parts from the different instruments in your score, you can now also associate a part
with a specific staff within the instrument or even a specific voice within a specific staff. This allows you to combine
multiple parts (e.g., Flute 1 & 2) onto a single staff in the score while still generating separate parts.

The Parts dialog now contains two sections at the bottom, Instruments in Score and Instruments in Part. Once you have
generated a part (or all parts) using the New and New All buttons, you can select any part at the top and use the controls
at the bottom to control not only what instrument is in the part, but also which staves and voices within the instrument are
included.

To add an instrument to a part, select it from "Instruments in Score" and press "+". To remove an instrument from a part,
select it from "Instruments in Part" and press "-". To customize the part at the staff or voice level, click the arrow next to
the instrument in "Instruments in Part" to expand the listing to show all staves and voices of the instrument. You can
remove a staff by selecting it and pressing "-", or remove a voice by unchecking it.

Limitations: If you select only voice 1 for a given staff, then only the content in voice 1 for that staff will be included in the
part. Thus, in order to share flute 1 & 2 on the same staff, you will need to enter all notes onto both voices, even in
passages where they share content. You also cannot enter the two parts as chords in the passages where they share
rhythms.

Explode and Implode

Explode has been updated to allow separation of voices as well as notes. See Explode.

The implode tool (Tools / Implode) works in one of two modes.

With a single staff selected, the implode command merges notes in different voices into chords where possible (when
notes are on the same beat and have the same duration). This is the same as recent versions of MuseScore, although
some bugs have been fixed.

With multiple staves selected, the implode command combines the content of the first four non-empty voices (on any
staves) into multiple voices on the top selected staff. This is different from MuseScore 2, where notes would be combined
into chords rather than using multiple voices, and thus required the rhythms to match. The MuseScore 3 approach
preserves the original rhythms even where they differ, and is intended to produce the expected results when combining
two different parts onto one staff for use with the parts from voices feature, or when reducing an open (four-stave) SATB
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score into a closed (two-stave) version. To further merge the voices into chords where possible, simply run the command
again.

See Tools.

Insert mode

You can insert and delete notes and have the measure automatically expand or contract to accommodate the change.
This can be useful in creating unmetered music or in ordinary editing.

To insert a note before the currently-selected note, press Ctrl+Shift while adding the note normally. For example, in note
input mode, Ctrl+Shift+click will insert a note of the currently-selected duration at that location. Ctrl+Shift+B will insert a B of
the currently-selected duration before the note at the current cursor position. You can also switch to Insert mode using the
dropdown menu next to the note input button on the toolbar. In this mode, all notes you add act as if you were pressing
Ctrl+Shift - they are inserted rather than replacing the existing notes or rests at that location.

To delete notes, you must be in normal (not note input) mode. Select either a single note or a range and press Ctrl+Del.

See Note input modes, Remove selected range (Tools)

Split/Join Measures

To split a measure before a given note, simply insert a barline from the palette at that point while holding Ctrl. For example,
you can select the note, and Ctrl+double-click the barline in the palette, or Ctrl+drag the barline to the note. You can also
use Tools → Measure → Split Measure Before Selected Note/Rest.

To join two measures, Ctrl+Del the barline between them. You can also use the menu command Tools → Measure → Join
Measures.

See Measure operations.

Timeline

The Timeline presents a graphical overview of your score. To access it, use View →Timeline (F12). The top portion of the
Timeline shows the location of tempo, key, and time signature changes as well as rehearsal marks, repeats, and double
barlines. The bottom portion shows the staves of your score, with non-empty measures highlighted. You can click
anywhere within this view to jump to the corresponding spot in the score.

See Timeline

Score Comparison Tool

The Score Comparison Tool (View / Score Comparison Tool) allows you to compare two versions of a score to find the
differences between them. Select the two scores you want to compare and whether you want to compare the current
version or the last saved version (note you can compare the current version of a score against the last saved version of
the same score to see what you have changed since the last save), then click the Compare button. A list of differences
will be displayed to the right. The score view will automatically change to Documents Side by Side, with the two scores
you have selected displayed within. Double-click on a difference from the list and both score views will automatically pan
to show you the changed element, which will also be highlighted.

Normally you would want the default Intelligent comparison, which displays the differences in human-readable format (e.g.
"Measure 1: Note: property pitch changed from B4 to C5"). There is also a Raw mode to show the results according to the
actual XML code.

See Score comparison.

Mixer

See Mixer.

Piano Roll Editor

See Piano roll editor (preliminary page).

Capo changes

Capo changes are now a property of staff text, and can be used to automatically change the pitch of all notes that follow
them, up until another capo change.

See Capo playback.
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Fretboard Diagrams

New UI. See Fretboard diagrams.

External links

Release notes for MuseScore 3.x
Transitioning from version 2 to version 3

Limitations connues de MuseScore 3.x

Bien que tous les membres de l’équipe de développement aient fait de leur mieux pour rendre le logiciel facile à utiliser et
exempt de bogues, il y a quelques problèmes et limites connus dans MuseScore 3.x.

Indications de mesure locales

La fonction d'indication de mesure locale, qui vous permet d’avoir différentes indications de mesure dans différentes
portées en même temps, est très limitée. Vous ne pouvez ajouter une indication de mesure locale qu’aux mesures qui
sont vides, et seulement s’il n’y a pas de parties liées. Lorsque vous ajoutez des notes à des mesures avec des
indications de mesures locales, vous pouvez entrer des notes normalement via le mode saisie des notes, mais le copier-
coller ne fonctionne pas correctement et peut entraîner une corruption ou même des plantages. Les commandes joindre
et scinder sont désactivées pour les mesures avec des indications de mesure locales.

Rassembler les rythmes

La commande Rassembler les Rythmes trouvable dans le menu Outils peut avoir des effets secondaires involontaires, y
compris la modification des hauteurs et la suppression de certains éléments tels que les articulations, glissandos,
tremolos, ornements musicaux et, plus particulièrement avec annuler, les liaisons. Utilisez cet outil avec prudence sur des
sélections limitées, de sorte que vous pouvez voir si des modifications indésirables sont apportées.

Portée de tablature liée à la portée standard

Lors de la saisie d’accords avec plusieurs notes sur une portée standard dans un système ou la portée standard et la
tablature sont liées, les notes doivent être entrées dans l’ordre de la corde supérieure (première) à la corde inférieure pour
assurer la bonne distribution des frettes.

Cette limitation ne s’applique pas si vous entrez des notes directement sur une portée de tablature, ou lors de l’utilisation
d’un système ou la portée standard et la tablature ne sont pas liées.

Mélangeur

Changer les paramètres dans le mixeur autre que le son ne marque pas la partition comme étant 'sale'. Cela signifie que
si vous fermez une partition, il se peut que vous n'obteniez pas l’avertissement "Enregistrer les modifications de la
partition avant de fermer?". Une fois les valeurs du mélangeur modifiées il n'est pas possible de revenir en arrière.

En-tête et Pied de page

Il est impossible de modifier l’en-tête et le pied de page avec un mode WYSIWYG. Les champs dans Format → Style →
En-tête, Pied de page sont en texte brut. Ils peuvent contenir une syntaxe "type HTML", mais le style du texte, la mise en
page, etc. ne peut pas être modifié avec un éditeur WYSIWYG.

Mise à niveau depuis MuseScore 1.x ou 2.x

Comment mettre à niveau MuseScore

Téléchargez et installez la version la plus récente depuis la page de téléchargement  comme décrit dans Installation.

Installer MuseScore 3 ne désinstallera pas 1.x ou 2.x — les trois versions peuvent coexister pacifiquement et peuvent
même être utilisées en parallèle. Ce n’est donc pas vraiment une mise à niveau mais une installation d’un nouveau
programme différent.

Ouvrir des partitions 1.x ou 2.x dans MuseScore 3

MuseScore 3 a considérablement amélioré la qualité de la typographie pour rendre les partitions attrayantes et plus
simples à lire. Les améliorations couvrent de nombreux éléments tels que l'inclinaison des ligatures, la hauteur des
hampes, la disposition des altérations accidentelles dans les accords et l'espacement général des notes. Cependant, cela
signifie que les partitions faites avec MuseScore 1.x ou 2.x sont légèrement différentes des partitions faites avec 3.x.

Cela signifie également que les partitions enregistrés avec 3.x ne s’ouvrent pas avec 1.x ou 2.x.
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Pour vous empêcher d’écraser accidentellement vos partitions 1.x ou 2.x, 3.x les traite comme une importation, ce qui
signifie que :

La partition est marquée comme étant modifiée, même si vous n’avez rien changé
En fermant MuseScore, il vous est demandé d’enregistrer la partition (résultat de ce qui précède)
MuseScore utilise la boîte de dialogue "Enregistrer Sous" pour l’enregistrer, et non la boîte de dialogue "Enregistrer"
MuseScore utilise le titre de la partition pour créer un nom de fichier par défaut plutôt que de prendre l’ancien nom
de fichier

Re-mise en page

Si vous n’avez pas ajusté manuellement la mise en page d’une partition 1.x ou 2.x, MuseScore utilise le moteur
typographique 3.x pour mettre en page la partition. Si vous avez touché la disposition de la partition 1.x ou 2.x, les
ajustements individuels que vous avez pu faire devraient rester après l’ouverture dans MuseScore 3.x, mais en raison de
légers changements dans la disposition environnante, ils peuvent toujours ne pas apparaître corrects dans le contexte. Si
vous souhaitez réinitialiser même les réglages manuels pour utiliser le moteur typographique 3.x, sélectionnez la partition
complète avec le raccourci Ctrl+A (Mac: Cmd+A) et réinitialisé la mise en page avec Ctrl+R (Mac: Cmd+R).

Note: Quand vous ouvrez un fichier 1.x or 2.x dans MuseScore 3, il vous demandera si vous souhaitez réinitialiser la mise
en page par défaut.

Obtenir le son de MuseScore 1.x

Bien que le son dans 2.x/3.x ait été beaucoup amélioré, vous pouvez toujours préférer le son de MuseScore 1.x. Dans ce
cas, vous pouvez obtenir le son 1.x dans la version 3.x en téléchargeant le SoundFont 1.3 et en l'ajoutant à la 3.x. Vous
pouvez le faire en deux étapes :

1. Télécharger le SoundFont 1.3 nommé TimGM6mb
2. Installer et utiliser le SoundFont TimGM6mb dans la version 2.0

Incompatibilités connues

Incompatibilités matérielles

Les logiciels suivant sont connus pour faire planter MuseScore au démarrage :

Samson USB Microphone, nom du pilote "Samson ASIO Driver", samsonasiodriver.dll. Plus d'information
Digidesign MME Refresh Service. Plus d'information
Windows XP SP3 + Pilote Realtek Azalia Audio Driver. Plus d'information
Tablettes Wacom. Plus d'information  et QTBUG-6127

Incompatibilités logicielles

Maple virtual cable est connu pour empêcher MuseScore  de se fermer correctement.
KDE (Linux) : les paramètres des fenêtres peuvent entraîner le déplacement de toute la fenêtre lors du déplacement
d’une note. Modifier les paramètres de fenêtre du système d’exploitation  permet d'éviter ce problème.
Nitro PDF Creator peut empêcher MuseScore 2 de démarrer  sur Windows 10, si il est utilisé comme imprimante
par défaut. Même problème avec Amyumi/Quickbooks PDF Printer, voir ici  et quelques services d’impression via
le cloud, voir ici .
Le pilote Creative Sound Blaster Z Series ASIO driver peut empêcher MuseScore 2 de démarrer  sur Windows 10.
La politique de blocage des polices non approuvées empêche MuseScore 2 de démarrer  (sauf en mode sans
échec, c'est à dire en utilisant l'option -d) sur Windows 10. (Solution dans le lien fourni ici )
La Visualiseur audio de SteelSeries Engine 3 empêchera MuseScore de démarrer, ou fera planter MuseScore si le
visualiseur audio est démarré alors que MuseScore est déjà en cours d’exécution.

AVG Internet Security bloque MuseScore

MuseScore nécessite l’accès à votre connexion internet avec AVG. MuseScore n’a pas besoin d’une connexion Internet
pour fonctionner, mais si AVG lui empêche l'accès, MuseScore se bloque.

Si AVG vous demande : Autoriser MuseScore et cochez "Enregistrer ma réponse comme une règle permanente et ne
me demandez pas la prochaine fois."

Si il ne vous le demande pas,

1. Ouvrez l’interface utilisateur d'AVG (faites un clic droit sur l’icône d'AVG, près de votre horloge -> Ouvrez l’interface
utilisateur d'AVG)

2. Cliquez sur Pare-feu
3. Cliquez sur Paramètres avancés
4. Cliquez sur Applications
5. Cherchez MSCORE.EXE dans la liste et faites un double clic sur lui
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6. Changez Action de l'application à Autoriser pour tout

Problème de police sur macOS

MuseScore est connu pour afficher des notes carrées lorsque certaines polices sont endommagées sur macOS.
Pour résoudre ce problème :

1. Allez dans Applications -> Livre des polices
2. Sélectionnez une police et appuyez sur ⌘+A pour tous les sélectionner.
3. Allez dans Fichier -> Valider les Polices
4. Si une police est signalée comme étant endommagée ou avec des problèmes mineurs, sélectionnez-la et

supprimez-la.
5. Redémarrez MuseScore si nécessaire

Dans cet article du forum , un utilisateur croit avoir trouvé la police "Adobe Jenson Pro (ajenson)" comme étant le
coupable, même si elle n'a pas été déclarée comme étant endommagé ou problématique selon la validation ci-dessus, et
résolu le problème en supprimant cette police, donc cela vaut la peine de vérifier aussi.

Problème de police sur Linux

Si la police de l’application d’environnement de bureau par défaut est paramétrée sur gras, MuseScore n’affichera pas
correctement les notes.
Pour résoudre ce problème (utilisateurs de gnome 2.*/MATE):

1. Cliquez avec le bouton droit de la souris sur votre bureau et sélectionnez Modifier l’arrière-plan du bureau.
2. Cliquez sur l’onglet Polices.
3. Définir le style Régulier pour la police d'Application
4. Redémarrez MuseScore si nécessaire

Pour les utilisateurs de GNOME 3/SHELL

1. Ouvrez shell et ouvrez "Paramètres avancés"
2. Cliquez sur l’option Polices dans la liste
3. Définissez la police par défaut sur quelque chose de non gras
4. Redémarrez MuseScore si nécessaire

Boîte de dialogue Enregistrer Sous vide sous Linux

Certains utilisateurs ont signalé que la boîte de dialogue Enregistrer Sous est vide sur Debian 6.0 et Lubuntu 10.10.
Pour résoudre ce problème :

1. Tapez ce qui suit dans un terminal

which mscore

2. La commande répondra avec le chemin de mscore. Modifiez-le avec votre éditeur de texte préféré et ajoutez la ligne
suivante au début

export QT_NO_GLIB=1

Lancez MuseScore et le problème devrait être résolu.

Glossary

The glossary is a work in progress—please help if you can. You can discuss this page in the documentation forum .

The list below is a glossary of frequently used terms in MuseScore as well as their meaning. The differences between
American English and British English are marked with "(AE)" and "(BE)", respectively.

A

Acciaccatura

 A short →grace note which appears as a small note with a stroke through the stem. It is quickly executed and
technically takes no value from its associated note.

Accidental
A sign appearing in front of a note that raises or lowers its pitch. The most common accidentals are →sharps, →flats
or →naturals, but double sharps and double flats are also used. Also →koron, and →sori and other quarter tone
accidentals. Accidentals affect all notes on the same →staff position only for the remainder of the measure in which
they occur, but they can be canceled by another accidental. In notes tied across a →barline, the accidental
continues across the →barline to the tied note, but not to later untied notes on the same →staff position in that
measure.
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Ambitus
Note (or vocal) range used in a →staff. Used particularly in Early Music

Anacrusis
See →Pickup measure.

Anchor
The point of attachment to the score of objects such as Text and Lines: When the object is dragged, the anchor
appears as small brown circle connected to the object by a dotted line. Depending on the object selected, its anchor
may be attached to either (a) a note (e.g. fingering), (b) a staff line (e.g. staff text), or (c) a barline (e.g. repeats).

Appoggiatura
A long →grace note which takes value from its associated note. Its functions include: passing tone, anticipation,
struck suspension, and escape tone.

Arpeggio
An arpeggio tells the performer to break up the chord into the constituent notes, playing them separately and one
after the other. An arrow on the arpeggio indicates the direction in which the player should play the notes of the
chord.

B

Bar (BE)
See →measure.

Barline
Vertical line through a →staff, staves, or a full →system that separates →measures.

Beam
Notes with a duration of an →eighth  or shorter either carry a →flag or a beam. Beams are used for grouping
notes.

BPM
Beats Per Minute is the unit for measuring tempo, traditionally counted in quarter note durations. See →metronome
mark

Breve
Brevis

A double whole note or breve is a note that has the duration of two whole notes.

C

Caesura
A caesura (//) is a brief, silent pause. Time is not counted for this period, and music resumes when the director
signals.

Cent
An interval equal to one hundredth of a semitone.

Chord
A group of two or more notes sounding together. To select a chord in MuseScore, press Shift and click on a note. In
the Inspector, however, the word "Chord" only covers notes in the same voice as the selected note(s).

Clef
Sign at the beginning of a →staff, used to tell which are the musical notes on the lines and between the lines.
Clefs are very useful for →transposition.

Concert pitch
Enables you to switch between concert pitch and transposing pitch (see Concert pitch and Transposition).

Crotchet (BE)
See →Quarter note.

D

Double Flat
A double flat (♭♭ or �) is a sign that indicates that the pitch of a note has to be lowered two semitones.

Double Sharp
A double sharp (♯♯ or �) is a sign that indicates that the pitch of a note has to be raised two semitones.
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Demisemiquaver (BE)
A thirty-second note.

Duplet
See →tuplet.

Dynamic
A symbol indicating the relative loudness of a note or phrase of music—such as mf (mezzoforte), p (piano), f (forte)
etc., starting at that note.

Dynamic, Single note
A dynamic marking which applies only to one note—such as sfz (sforzando), fp (fortepiano) etc.

E

Edit mode
The program mode from which you can edit various score elements.

Eighth note
A note whose duration is an eighth of a whole note (semibreve). Same as a quaver (BE).

Endings
See →volta.

Enharmonic notes
Notes that sound the same pitch but are written differently. Example: G♯ and A♭ are enharmonic notes.

F

Flag
See →beam.

Flat
Sign (♭) that indicates that the pitch of a note has to be lowered one semitone.

G

Grace note
Grace notes appear as small notes in front of a normal-sized main note. See →acciaccatura and →appoggiatura.

Grand Staff (AE)
Great Stave (BE)

A system of two or more staves, featuring treble and bass clefs, used to notate music for keyboard instruments and
the harp.

H

Half Note
A note whose duration is half of a whole note (semibreve). Same as a minim (BE).

Hemidemisemiquaver (BE)
A sixty-fourth note.

I

Interval
The difference in pitch between two notes, expressed in terms of the scale degree (e.g. major second, minor third,
perfect fifth etc.). See Degree (Music)  (Wikipedia).

J

Jump
In MuseScore, "jumps" are notations such as "D.S. al Coda", found in the "Repeats & Jumps" palette.

K

Key Signature
Set of →sharps or →flats at the beginning of the →staves. It gives an idea about the tonality and avoids repeating
those signs all along the →staff.
A key signature with B flat means F major or D minor tonality.

Koron
An Iranian →accidental which lowers the pitch of a note by a quarter tone (in comparison to the →flat which lowers a
note by a semitone). It is possible to use this accidental in a →key signature.
See also →Sori.

L

Longa
A longa is a quadruple whole note.
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Ledger Line
Line(s) that are added above or below the staff.

M

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into measures provides regular reference
points to pinpoint locations within a piece of music. Same as → bar (BE).

Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in →BPM. In MuseScore,
metronome marks are used in Tempo texts.

Minim (BE)
See →Half note.

N

Natural
A natural (♮) is a sign that cancels a previous alteration on notes of the same pitch.

Normal mode
The operating mode of MuseScore outside note input mode or edit mode: press Esc to enter it. In Normal mode you
can navigate through the score, select and move elements, adjust Inspector properties, and alter the pitches of
existing notes.

Note input mode
The program mode used for entering music notation.

O

Operating System
OS

Underlying set of programs which set up a computer, enabling additional programs (such as MuseScore). Popular
OSes are Microsoft Windows, macOS, and GNU/Linux.
Not to be confused with a sheet music →system.

P

Part
Music to be played or sung by one or a group of musicians using the same instrument. In a string quartet, 1st part =
Violin 1, 2nd part = Violin 2, 3rd part = Viola, 4th part = Cello, in a choir there might be parts for soprano, alto, tenor
and bass. A part has one or more →staves (e.g. Piano has 2 staves, Organ can have 2 or 3 staves).

Pickup Measure (also known as an Anacrusis or Upbeat)
Incomplete first measure of a piece or a section of a piece of music. See Measure duration and Create new score:
Pickup measure. Also Exclude from measure count.

Q

Quadruplet
See →tuplet.

Quarter note
A note whose duration is a quarter of a whole note (semibreve). Same as a crotchet (BE).

Quaver (BE)
See →eighth note.

Quintuplet
See →tuplet.

R

Respell Pitches
Tries to guess the right accidentals for the whole score (see Accidentals).

Rest
Interval of silence of a specified duration.

Re-pitch mode
Allows you to rewrite an existing passage of music by changing the note pitches without altering the rhythm.

S

Semibreve (BE)
A whole note (AE). It lasts a whole measure in 4/4 time.

Semiquaver (BE)
A sixteenth note.

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)

277



An hundred and twenty eighth note.
Sextuplet

See →tuplet.
Slash chord

See Slash chord  (Wikipedia).
Slash notation

A form of music notation using slash marks placed on or above/below the staff to indicate the rhythm of an
accompaniment: often found in association with chord symbols. There are two types: (1) Slash notation consists of a
rhythm slash on each beat: the exact interpretation is left to the player (see Fill with slashes); (2) Rhythmic slash
notation indicates the precise rhythm for the accompaniment (see Toggle rhythmic slash notation).

SFZ
A virtual instrument format supported by MuseScore (along with →SoundFonts). An SFZ library consists of one or
more SFZ text files, each defining a particular instrument setup, and many audio sound samples.

Sharp
Sign (♯) that indicates that the pitch of a note has to be raised one semitone.

Slur
A curved line over or under two or more notes, meaning that the notes will be played smooth and connected
(legato).
See also →tie.

Sori
An Iranian →accidental which raises the pitch of a note by a quarter tone (in comparison to the sharp which raises it
by a semitone). It is possible to use this accidental in a →key signature.
See also →Koron.

SoundFont
A virtual instrument format supported by MuseScore (along with →SFZ). A SoundFont is a special type of file
(extension .sf2, or .sf3 if compressed) containing sound samples of one or more musical instruments. In effect, a
virtual synthesizer which acts as a sound source for MIDI files. MuseScore 2.2 comes with the SoundFont
"MuseScore_General.sf3" pre-installed.

Spatium (plural: Spatia) / Space / Staff Space / sp. (abbr./unit)
The distance between the midpoints of two lines of a music staff (or one-quarter the size of the full five-line staff,
assuming a hypothetical staff line thickness of 0). The sizes of most elements in the score are based on this setting
(see Page settings).

Staff (AE) / Staves (plural)
A set of lines and spaces, each representing a pitch, on which music is written. In ancient music notation (before
11th century) the staff may have any number of lines.

Staff Space
See Spatium (above).

Stave (BE)
See Staff (above).

Step-time input
MuseScore's default note input mode, allowing you to enter music notation one note (or rest) at a time.

System
Set of staves to be read simultaneously in a score.
See also →Operating System (OS).

T

Tie

A curved line between two or more notes on the same pitch to indicate a single note of combined duration:

Quarter note + Tie + Quarter note = Half note
Quarter note + Tie + Eighth note = Dotted Quarter note
Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note
See also →slur.

Transposition

The act of moving the pitches of one or more notes up or down by a constant interval. There may be several
reasons for transposing a piece, for example:

1. The tune is too low or too high for a singer. In this case the whole orchestra will have to be transposed as well
—easily done using MuseScore.

2. The part is written for a particular instrument but needs to be played by a different one.
3. The score is written for an orchestra and you want to hear what the individual instruments sound like. This

requires changing the transposing instrument parts to concert pitch.
4. A darker or a more brilliant sound is desired.

Triplet
See →tuplet.

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time signature. For example
a →triplet divides the next higher note value into three parts, rather than two. Tuplets may be: →triplets, →duplets,
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→quintuplets, and other.

U

Upbeat
See →pickup measure.

V

Velocity
The velocity property of a note controls how loudly the note is played. This usage of the term comes from MIDI
synthesizers. On a keyboard instrument, it is the speed with which a key is pressed that controls its volume. The
usual scale for velocity is 0 (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes or chords of different duration at the
same time on the same →staff. To write such things each horizontal succession of notes or chords has to be written
on the staff independently. In MuseScore you can have up to 4 voices per staff. Not to be confused with vocalists,
singing voices like soprano, alto, tenor and bass, which are better viewed as instruments.

Volta
In a repeated section of music, it is common for the last few measures of the section to differ. Markings called voltas
are used to indicate how the section is to be ended each time. These markings are often referred to simply as
→endings.

External links

http://www.robertcarney.net/musical-terms-definitions.htm
https://en.wikipedia.org/wiki/List_of_musical_symbols
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